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Rendeltetésszerű használat

Rendeltetésszerű használat
A CFX96 Dx System és a CFX96 DeepWell Dx System rendszer és a CFX Manager Dx szoftver
együttes használatával fluoreszcencia alapú PCR vizsgálatok végezhetők nukleinsav-szekvenciák
detektálása és kvantifikálása céljából. A rendszereket és a szoftvert kizárólag képzett laboratóriumi
technikusoknak szabad használniuk, és nekik is kizárólag in vitro diagnosztikai célra. A rendszereket
kizárólag olyan – harmadik felek által készített – diagnosztikai nukleinsavtesztekkel szabad használni,
amelyeket diagnosztikai célokra gyártottak és ezt jelző címkével láttak el.

Szimbólumjegyzék
Fontos: A jelentős változások kiemelve!

Gyártó Tétel száma

Felhasználhatóság lejárata In vitro diagnosztikai használatra

Hőmérsékleti határérték Katalógusszám

Olvassa el a használati utasítást Vizsgálatok száma

A következő eszközökkel
használható: Sorozatszám
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Csak előírt használatra Latexet tartalmaz

CE-jelölés – 2017/746 (EU)
rendelet az in vitro diagnosztikai
orvostechnikai eszközökről

Fordítások
A termékdokumentumok további nyelveken is rendelkezésre állhatnak az elektronikus
adathordozókon.
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Biztonság és szabályozási megfelelőség
A CFX96 Dx System, illetve a CFX96 DeepWell Dx System with CFX Manager Dx Software (a jelen
dokumentumban a továbbiakban: CFX Dx rendszer) biztonságos működése érdekében a Bio-Rad
fokozottan ajánlja Önnek, hogy tartsa be a jelen szakaszban és a jelen kézikönyv többi részében
meghatározott biztonsági előírásokat.

Fontos: A CFX96 Dx és a CFX96 DeepWell Dx rendszerek jóváhagyással rendelkeznek in vitro
diagnosztikai (IVD) orvostechnikai eszközként történő felhasználás tekintetében.

Biztonsági figyelmeztető címkék
Aműszeren és ebben a kézikönyvben található figyelmeztető címkék sérülési veszélyekre
figyelmeztetnek. Az 1. táblázat az egyes biztonsági figyelmeztető címkéket definiálja.

Ikon Jelentés

Figyelmeztetés a személyi sérülés vagy a berendezés károsodásának a
veszélyére
A(z) CFX Dx rendszer ennek a kézikönyvnek a körültekintő elolvasása nélküli
üzemeltetése személyi sérülés veszélyével járhat. A biztonságos használat
érdekében ezt a műszert tilos az ebben a kézikönyvben nemmeghatározott
bármilyen más módon használni. A műszert kizárólag az elektromos berendezések
biztonságos használatára kiképzett laboratóriumi szakemberek üzemeltethetik. A
rendszer minden alkatrészét óvatosan, tiszta, száraz kézzel kell kezelni.

Biológiailag veszélyes anyagok kezelésére vonatkozó figyelmeztetés
Biológiailag veszélyes minták kezelésekor tartsa be az ajánlott óvintézkedéseket és
irányelveket, és tartsa be a saját laboratóriumára és helyszínére vonatkozó
esetleges helyi irányelveket.

1. táblázat. A biztonsági figyelmeztető címkék jelentése

Kezelési kézikönyv | 13



Biztonság és szabályozási megfelelőség

Ikon Jelentés

Égési sérülés veszélyére való figyelmeztetés
Egy PCR készülék elegendő hőt fejleszt ahhoz, hogy súlyos égési sérüléseket
okozzon. Az üzemeltetés során mindig viseljen védőszemüveget vagy egyéb
szemvédő eszközt. A fedél felnyitása és a minták eltávolítása előtt mindig várja
meg, hogy a mintablokk lehűljön az alaphőmérsékletre. A bőr véletlenszerű égési
sérüléseinek az elkerülése érdekében mindig tartsa be a lehető legnagyobb
távolságot.

Robbanásveszélyre való figyelmeztetés
Amintablokkok a normál üzemelés során elég forróvá válhatnak ahhoz, hogy
folyadékok forrását, illetve robbanását okozzák.

1. táblázat. A biztonsági figyelmeztető címkék jelentése, folytatás

A biztonságos használatra vonatkozó specifikációk és
megfelelőség

Az 2. táblázat a Bio-Rad CFX Dx valós idejű PCR detektálási rendszereinek a biztonságos
használatára vonatkozó specifikációkat határozza meg. Az A. osztályú eszközökre vonatkozó FCC-
határértékeknek való megfelelés biztosítása érdekében a jelen műszereket a hozzájuk mellékelt
árnyékolt kábelekkel kell használni.

Használati szempont A biztonságos használatra vonatkozó feltételek

Névleges bemeneti teljesítmény 100–240 VAC, 50–60 Hz, max. 850 W

Túlfeszültségi kategória II

Olvadóbiztosítékok 10 A, 250 V, 5 x 20 mm, gyors típusú (mennyiség: 2)

Környezet Kizárólag beltéri használat

Használati hőmérséklet 15–31 °C

Tárolási hőmérséklet -20 és +60 °C között

Relatív páratartalom Legfeljebb 80% (nem lecsapódó)

Tengerszint feletti magasság Legfeljebb 2000 méterrel a tengerszint felett

Szennyezési fok 2

2. táblázat. A biztonságos használatra vonatkozó feltételek

14 | CFX96 Dx és CFX96 DeepWell Dx rendszerek



A biztonságos használatra vonatkozó specifikációk és megfelelőség

Szabályozási megfelelőség
A CFX Dx valósidejű PCR detekciós rendszer tesztelése alapján eleget tesz az alábbi biztonsági és
elektromágneses szabványok valamennyi követelményének:

n IEC 61010-1:2010 (3. kiadás), EN61010-1:2010 (3. kiadás). Méréstechnikai, irányítástechnikai és
laboratóriumi felhasználásra szolgáló elektromos berendezések - 1. rész: Általános
követelmények

n IEC 61010-2-010:2014, EN 61010-2-010:2014. Méréstechnikai, irányítástechnikai és
laboratóriumi felhasználásra szolgáló elektromos berendezések biztonsági követelményei.
2-010. rész: Részletes követelménye anyagok hevítésére szolgáló laboratóriumi
berendezésekhez

n IEC 61010-2-081:2015, EN 61010-2-081:2015. Méréstechnikai, irányítástechnikai és
laboratóriumi felhasználásra szolgáló elektromos berendezések biztonsági követelményei.
2-081. rész: Részletes követelmények analizálási és egyéb célú automatikus és félautomatikus
laboratóriumi berendezésekhez (beleértve az 1. Kiegészítést is)

n IEC 61010-2-101:2015 (2nd ed.). Méréstechnikai, irányítástechnikai és laboratóriumi
felhasználásra szolgáló elektromos berendezések biztonsági követelményei. Részletes
követelmények in vitro diagnosztikai (IVD) orvosi berendezésekhez.

n IEC 61326-1:2012 (Class A), EN 61326-1:2013 (Class A). Méréstechnikai, irányítástechnikai és
laboratóriumi villamos berendezések. EMC követelmények, 1. rész: Általános követelmények

n IEC 61326-2-6:2012, EN 61326-2-6:2013 (Class A). Méréstechnikai, irányítástechnikai és
laboratóriumi villamos berendezések. EMC követelmények Részletes követelmények in vitro
diagnosztikai (IVD) orvosi berendezésekhez.

Fontos: Ez a berendezés rádiófrekvenciás energiát generál, használ és képes sugározni,
továbbá ha nem a mellékelt utasításokkal összhangban telepítik és használják, káros
interferenciát okozhat a rádiókommunikációban. A rendszerek lakókörnyezetben történő
használata esetén a jelen berendezés valószínűleg káros interferenciát fog okozni. Ilyen esetben
az interferencia elhárításáról a felhasználónak a saját költségén kell gondoskodnia.
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Biztonság és szabályozási megfelelőség

Veszélyek
A CFX Dx valós idejű PCR detektálási rendszer úgy lett tervezve, hogy a gyártó által leírt módon
használva üzemeltetése biztonságos legyen. Ha a CFX Dx valós idejű PCR detektálási rendszer vagy
bármely hozzá kapcsolódó komponens használata nem a gyártó által leírt módon történik, akkor a
műszer által nyújtott alapvédelem gyengülhet. A Bio-Rad Laboratories, Inc. nem felelős azokért a
sérülésekért vagy károkért, amelyek a jelen berendezés előírástól eltérő használata vagy a nem a Bio-
Rad vagy annak hivatalos képviselője által elvégzett módosítása miatt következtek be. A CFX Dx
valós idejű PCR detektálási rendszer szervizelését kizárólag a Bio-Rad képzett munkatársai
végezhetik.

Biológiai veszélyek
A CFX Dx valós idejű PCR detektáló rendszer egy laboratóriumi eszköz. Biológiailag veszélyes minták
jelenlétében azonban kövesse az alábbi irányelveket, és tartsa be a saját laboratóriumára és
helyszínére vonatkozó helyi esetleges irányelveket.

Megjegyzés: Ez az eszköz normál működés során nem bocsát ki biológiailag veszélyes
anyagokat.

Általános óvintézkedések

n Minden esetben viseljen laboratóriumi köpenyt, laboratóriumi kesztyűt, védőszemüveget vagy
oldalvédelemmel ellátott biztonsági szemüveget.

n Ne nyúljon a szájához, orrához és a szeméhez.

n Teljes mértékben fedje le az összes vágást vagy horzsolást a potenciálisan fertőző anyagokkal
való munkavégzés előtt.

n Miután bármilyen potenciálisan fertőző anyaggal dolgozott, mossa meg a kezét alaposan
szappannal és vízzel, mielőtt elhagyná a laboratóriumot.

n Amunkapadnál való munkavégzés előtt vegye le óráját és ékszereit.

n Tároljon minden fertőző vagy potenciálisan fertőző anyagot törés- és szivárgásbiztos
tartályokban.

n Mielőtt kimegy a laboratóriumból, vegye le a védőruhát.

n Kesztyűs kézzel ne írjon, ne vegye fel a telefont, ne kapcsolja fel a villanyt, illetve ne érintsen meg
semmit, amit mások megérinthetnek kesztyű nélkül.
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Veszélyek

n Cseréljen gyakran kesztyűt. Azonnal vegye le a láthatóan szennyeződött kesztyűt.

n Megfelelően nem szennyezésmentesíthető anyagokat nem szabad potenciálisan fertőző
anyagok hatásának kitenni.

n Egy biológiailag veszélyes anyagokkal kapcsolatos művelet befejezésekor
szennyezésmentesítse a munkaterületet megfelelő fertőtlenítővel (például 1:10 arányban hígított
háztartási fehérítővel).

Az IVD vizsgálatokra vonatkozó óvintézkedések

n Az összes páciensminta potenciális biológiai veszélyt jelent, ezért azokat ennek megfelelően,
univerzális óvintézkedésekkel kell kezelni.

n A jelen készülék a normál működése során nem bocsát ki biológiailag veszélyes anyagot a
levegőbe.

Felületi szennyezésmentesítés

FIGYELMEZTETÉS! Az áramütés elkerülése érdekében a fertőtlenítési művelet
végrehajtása előtt mindig kapcsolja ki a műszert, és a csatlakozódugóját húzza ki a
hálózati dugaszolóaljzatból.

Az alábbi területek bármilyen kórházi minőségű baktériumölő, vírusölő, vagy gombaölő
fertőtlenítőszerrel tisztíthatók:

n Külső fedél és ház

n A belső reakcióblokk felülete és reakcióblokk lyukak

n Vezérlőpanel és kijelző

A fertőtlenítőszer elkészítéséhez és alkalmazásához kövesse a termék gyártója által biztosított
utasításokat. Fertőtlenítőszer alkalmazása után mindig többször öblítse le vízzel a reakcióblokkot és a
reakcióblokk cellákat. A vízzel történt leöblítés után laposan szárítsa meg a reakcióblokkot és a
reakcióblokk cellákat.

Fontos: Ne használjon dörzsölő vagy korrozív hatású tisztítószereket vagy erős lúgos oldatokat.
Ezek a szerek megkarcolhatják a felületeket és a reakcióblokk sérülését okozhatják, ami a pontos
hőmérsékletszabályzás elvesztését eredményezi.

Kezelési kézikönyv | 17



Biztonság és szabályozási megfelelőség

Biológiai veszélyt jelentő anyagok ártalmatlanítása

A következő potenciálisan szennyezett anyagokat a laboratóriumra vonatkozó helyi, regionális és
nemzeti jogszabályokkal összhangban ártalmatlanítsa:

n Klinikai minták

n Reagensek

n Használt reakciós edények, valamint egyéb fogyóeszközök, amelyek szennyezettek lehetnek

Kémiai veszélyek
A CFX Dx valós idejű PCR detektálórendszer nem tartalmaz esetlegesen veszélyes vegyi anyagokat.

Robbanékonysággal vagy gyúlékonysággal kapcsolatos
veszélyek
A CFX Dx valós idejű PCR detektáló rendszer nem jelent gyúlékonysággal vagy robbanással
kapcsolatos rendkívüli veszélyt, ha a Bio-Rad Laboratories által előírt megfelelő módon használják.

Elektromossági veszélyek
A(z) CFX Dx valós idejű PCR detekciós rendszer nem jelent rendkívüli elektromos veszélyt a kezelők
számára, ha azt megfelelő módon telepítették és használják fizikai módosítás nélkül, és az a
megfelelő specifikációjú elektromos táphálózathoz van csatlakoztatva.

Szállítás
A CFX Dx valós idejű PCR detekciós rendszernek vagy optikai reakciómoduljának, illetve PCR
alapjának a mozgatása vagy szállítása előtt fertőtlenítési eljárást kell végrehajtani. A CFX Dx valós
idejű PCR detekciós rendszert és az optikai reakciómodult mindig külön dobozokban, a készüléket
sérüléstől védő mellékelt csomagolóanyagokkal együtt kell mozgatni, illetve szállítani. Ha nem talál
megfelelő dobozokat, akkor lépjen kapcsolatba a helyi Bio-Rad irodával.

18 | CFX96 Dx és CFX96 DeepWell Dx rendszerek



Veszélyek

Akkumulátor
A CFX Dx rendszer PCR készülék egy 3 V lítium-fém gombelemet és egy 4,8 V nikkel-fémhidrid
tölthető akkumulátoregységet használ az időbeállítások és a futtatási adatok megőrzéséhez a hálózati
tápfeszültség kimaradása esetén. Ha az idő és/vagy futtatási adatok nemmaradnak a beállított értéke
a készülék kikapcsolása után, akkor ez azt jelzi, hogy az elem és az akkumulátor kezd gyengülni. Ha
ez történik, akkor tanácsért lépjen kapcsolatba a Bio-Rad Műszaki ügyfélszolgálattal.

Ne kísérelje meg kicserélni az elemet, illetve az akkumulátort. Lépjen kapcsolatba a Bio-Rad Műszaki
ügyfélszolgálattal.

Ártalmatlanítás
A CFX Dx valós idejű PCR detektáló rendszer elektromos anyagokat tartalmaz; ezeket nem szabad
válogatatlan hulladékként elhelyezni, valamint elkülönítve kell összegyűjteni, az Európai Uniónak az
elektromos és elektronikus berendezés hulladékokról szóló 2012/19/EU számú direktívája szerint —
WEEE Direktíva. A Bio-Rad hulladékba helyezés előtt lépjen kapcsolatba a helyi képviselőjével az
adott országra vonatkozó utasításokért.

Jótállás
A CFX Dx valós idejű PCR detekciós rendszerre és a hozzá tartozó tartozékokra szokványosBio-Rad
jótállás érvényes. A jótállás részleteihez lépjen kapcsolatba a Bio-Rad helyi irodájával.
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Biztonság és szabályozási megfelelőség
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1. fejezet Bevezetés
A Bio-Rad CFX Dx in vitro diagnosztikához (IVD) tervezett, valós idejű PCR amplifikációs rendszerei a
legújabb technológiai fejlesztések segítségével lehetővé teszik a PCR kvantifikációt standardgörbe-
rajzolással, génexpresszió-elemzéssel, alléldiszkriminációval és végpontelemzéssel.

A CFX Dx rendszerek két hardvermodulból és egy szoftverből tevődnek össze:

n CFX96 Dx vagy CFX96 DeepWell Dx optikai reakciómodul (ORM)

n C1000 Dx PCR készülék

n CFXManager Dx szoftver

A(z) CFX Manager Dx szoftverrel történő együttes használat esetén a következőkre nyílik lehetőség:

n Azonnal eredmények generálása a Startup Wizard (Indítási varázsló) segítségével

n Cellainformációk beírása vagy szerkesztése futtatás előtt, közben vagy után

n Komplex adatok értelmezése és a génexpressziós vizsgálat megértése olyan eszközökkkel, mint
amilyen például a PrimePCR kontrollelemzés és a referenciagén-választó eszköz

n Átfogó jelentések készítése az Ön valós idejű PCR adataiból

CFX Dx PCR detektáló rendszerek
A(z) 3. táblázat a Bio-Rad IVD PCR CFX Dx rendszerrendszerekkel szállított termékeit sorolja fel.

Megjegyzés: A CFX Dx rendszer a CFX Manager Dx szoftverrel, a C1000 Dx PCR készülékés
vagy a CFX96 Dx vagy a CFX96 DeepWell Dx optikai reakciómodullal kerül leszállításra.

Katalógusszám Leírás

1845097-IVD CFX96 Dx ORM *

1844095-IVD CFX96 DeepWell Dx ORM

1841000-IVD C1000 Dx PCR készülék

12007917 CFX Manager Dx Szoftver, v3.1

3. táblázat. CFX IVD PCR detektáló rendszerek

* Optikai reakciómodul

Kezelési kézikönyv | 21



1. fejezet Bevezetés

További információk
Ez a dokumentum a The CE-IVD jelzésű CFX96 Dx és CFX96 DeepWell Dx valós idejű PCR
detekciós rendszerek biztonságos üzembehelyezését ismerteti. Ebben a dokumentumban ezekre a
rendszerekre a CFX Dx rendszer elnevezéssel utalunk. A dokumentum ezen felül a CFX Manager Dx
szoftver szoftver CFX Dx rendszer rendszerrel való használatát is ismerteti.

Tipp: Kattintson a Bio-Rad logóra bármelyik CFX Manager Dx szoftver ablak jobb felső sarkában
a Bio-Rad webhelyének a megnyitásához. Ez a webhely műszaki megjegyzésekhez,
kézikönyvekhez, termékinformációkhoz, és műszaki segélyszolgálathoz nyújt kapcsolatokat. A
webhely számos műszaki információforrást is tartalmaz a legkülönfélébb módszerekről és
alkalmazásokról a PCR, valós idejű PCR és génexpresszió vonatkozásában.
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2. fejezet A C1000 Dx PCR készülék beállítása
A jelen fejezetben azt mutatjuk be, hogy a CFX Dx rendszer C1000 Dx PCR készülékét hogyan kell
beállítani az Ön telephelyén.

Tipp: A PCR készülék beállítása előtt ismerje meg a PCR készüléket és annak optikai reakció
modulját, portjait és kiegészítőit.

A helyszínre vonatkozó követelmények
A jelen szakaszban található táblázatokban a(z) CFX Dx rendszer PCR készülék sikeres
telepítéséhez és használatához teljesítendő, a munkavégzési helyiségre, a környezetre és az
elektromos ellátásra vonatkozó követelményeket ismertetjük.

Megjegyzés: A CFX Dx rendszer PCR készüléket olyan vízszintes és száraz felületre telepítse,
amelyen a készüléket a megfelelő működéséhez szükséges mennyiségű hideg légáramlás éri.

A munkaterületre vonatkozó követelmények

Pont Specifikáció

Bemeneti teljesítmény Maximum 850W

Frekvencia 50–60 Hz, egyfázisú

USB-portok 5 A, 1 B

Méretek Szélesség: 13 hüvelyk; 33 cm

Mélység (hosszúság): 18 hüvelyk; 46 cm

Magasság: 14 hüvelyk; 36 cm

Tömeg 47 font; 21 kg

4. táblázat. A CFX Dx rendszer PCR készülék munkaterületére vonatkozó követelmények
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2. fejezet A C1000 Dx PCR készülék beállítása

A környezetre vonatkozó követelmények

Paraméter Tartomány Páratartalom-tartomány

Üzemi körülmények 15–31 °C

59-87,8 °F

0–80% relatív páratartalom
(nem lecsapódó)

Tárolási körülmények 15–31 °C

59-87,8 °F

0–80% relatív páratartalom
(nem lecsapódó)

5. táblázat. A CFX Dx rendszer PCR készülék környezetére vonatkozó követelmények

Elektromos ellátásra vonatkozó követelmények
Amegfelelő működés biztosítása érdekében a CFX Dx rendszer PCR készülék elektromos
ellátásának stabilnak kell lennie és a meghatározott specifikációkon belül kell maradnia. A bemeneti
táp-csatlakozóaljzathoz csatlakoztatni kívánt tápkábelnek legalább 7 amper névleges
teljesítményűnek kell lennie.

Pont Specifikáció

Elektromos hálózati bemeneti
feszültség

100–240 VAC; 50–60 Hz, egyfázisú

Maximális áramfogyasztás < 850 watt

Táp-csatlakozóaljzatok száma Legalább 2 táp-csatlakozóaljzat:

n 1 csatlakozóaljzat a PCR készülék számára

n 1 csatlakozóaljzat a CFX Manager Dx szoftvert futtató
számítógép számára

6. táblázat. A CFX Dx rendszer rendszer elektromos ellátására vonatkozó követelmények
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A rendszer áttekintése

A rendszer áttekintése
A jelen szakaszban található ábrák a C1000 Dx PCR készülék bázis egységének a fő komponenseit
ábrázolják.

Elölnézet

1. Optikai reakciómodul—egy optikai rendszert tartalmaz a fluoreszcens adatok
begyűjtéséhez, valamint egy PCR blokkot. A CFX Dx valós idejű PCR detektáló rendszerek
vagy egy CFX96 Dx, vagy egy CFX96 DeepWell Dx modult támogatnak.

2. Állapotjelző LED— jelzi a blokk használatát.

3. Fedélzáró gomb—az optikai reakciómodul fedelét nyitja vagy zárja, és tömíti a
reakciókamrát.

4. C1000 Dx PCR alapegység—biztosítja a rendszer áramellátását és a kommunikációt,
valamint tartalmazza a CFX96 Dx és CFX96 DeepWell optikai reakciómodulokat.

JELMAGYARÁZAT
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2. fejezet A C1000 Dx PCR készülék beállítása

5. Az előlapon található kijelzők és gombok— lehetővé teszik a rendszer vezérlését
önálló üzemmódban.

Fontos: Az IVD génvizsgálati adatok integritásának biztosítása érdekében a CFX
Manager Dx szoftver nem támogatja az önálló üzemmódú PCR által generált adatokat.

6. Fűtött belső fedél— fenntartja a fedél hőmérsékletét a kondenzáció és a párolgás
megakadályozása céljából.

7. Minta/reakció blokk—a reakcióedényt tartalmazza a kémcsövekkel és mikrolemezekkel.

Hátulnézet

1. Ethernet csatlakozóaljzat—aC1000 Dx PCR készüléket az Ön hálózatához
csatlakoztatja.

2. „B” típusú USB csatlakozóaljzat—aC1000 Dx PCR készüléket egy CFX Manager Dx
szoftvert futtató számítógéphez csatlakoztatja.

3. „A” típusú USB csatlakozóaljzatok—adatok továbbítása egy USB pendrive-hoz, illetve
pendrive-tól.

Fontos: Az IVD génvizsgálati adatok integritásának biztosítása érdekében a CFX
Manager Dx szoftver nem támogatja az önálló üzemmódú PCR által generált adatokat.

JELMAGYARÁZAT
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A rendszer áttekintése

4. Soros teszt csatlakozóaljzat—kizárólag szervizteszteléshez.

5. Hűtőnyílások—a PCR készülék hűtéséhez.

Fontos: Ne zárja el hűtőnyílásokat. Az optimális üzemelés érdekében gondoskodjék
arról, hogy a PCR készülék alapzata mögött elegendő hely van a levegő áramlásához.

6. Hálózati csatlakozó—Váltóáramú hálózati tápfeszültség; használja a mellékelt hálózati
kábelt.

7. Főkapcsoló—a PCR készülék be- és kikapcsolására szolgáló billenőkapcsoló.

8. Biztosítékok—a biztosítékok műszaki adataihoz lásd: A biztonságos használatra
vonatkozó specifikációk és megfelelőség a(z) 14. oldalon.
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2. fejezet A C1000 Dx PCR készülék beállítása

Optikai reakciómodulok
A C1000 Dx PCR készülék a következő Bio-Rad optikai reakciómodulokkal kompatibilis valósidejű
PCR-hez.

n CFX96 Dx optikai reakciómodul

n CFX96 DeepWell Dx optikai reakciómodul

A kiválasztott CFX Dx optikai reakciómodul és a PCR készülék külön dobozokban kerül leszállításra.
A(z) CFX Manager Dx szoftver az optikai reakciómodullal együtt kerül leszállításra.

Fontos: Az optikai reakciómodul azzal a PCR alappal van kalibrálva, amelyikkel együtt szállítják
le. Éppen ezért ne használja az optikai reakciómodult semmilyen másik PCR alappal, illetve a
PCR alapot ne használja más optikai reakciómodullal.

Mindkét optikai reakciómodul tartalmaz egy teljesen állítható fűthető fedelet, amely a reakcióedények
széles skálájával használható megbízhatóan. Mindegyik optikai reakciómodul hűtőventilátorokat
tartalmaz a gyors felfűtéshez és lehűtéshez.

Mindegyik CFX Dx optikai reakciómodul az alábbi alkatrészekből áll:

n Fűtött belső fedél— fenntartja a fedél hőmérsékletét a kondenzáció és a párolgás
megakadályozása céljából.

n Minta/reakció blokk—a reakcióedényeket tartalmazza a kémcsövekkel és a mikrolemezekkel.

n Fedélzáró gomb—az optikai reakciómodul fedelét nyitja vagy zárja, és tömíti a reakciókamrát.

n Állapotjelző LED—ha világít, akkor az azt jelzi, hogy a blokk használatban van.

Ajánlott mintatérfogatok
A C1000 Dx PCR készülék használatakor a maximális mintatérfogatot az alkalmazott reakciómodul
típusa határozza meg. Az 7. táblázat az egyes reakciómodulokkal történő használathoz ajánlott
térfogatokat sorolja fel.

Cellák száma Blokkok száma
Ajánlott mintatérfogat, µl

(Felső határérték)

96 cellás 1 10-50

96 mély cellás 1 10-125

7. táblázat. Méret- és térfogat határérték reakciómodulokhoz
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A C1000 Dx PCR készülék telepítése

A C1000 Dx PCR készülék telepítése
A C1000 Dx PCR készülék alapegységét nem az optikai reakciómodullal együtt, hanem egy attól
különálló dobozban szállítjuk. A csomag tartalma:

n A C1000 Dx PCR készülék alapegysége

n Tápkábel

n 1 darab USB-kábel

A C1000 Dx PCR készülék telepítése:

1. Csomagolja ki és készítse elő a C1000 Dx PCR készülék alapegységét.

2. Csatlakoztassa a reakciómodult az alapegységhez.

3. Távolítsa el a szállítási rögzítőcsavart.

A jelen szakaszban ezeket a feladatokat ismertetjük részletesen.

A C1000 Dx PCR készülék
Fontos: A PCR készülék üzemeltetése előtt olvassa el aBiztonság és szabályozási megfelelőség
a(z) 13. oldalon és a Biztonsági figyelmeztető címkék a(z) 13. oldalon.

Tipp: Az üzembehelyezés során gondoskodjék arról, hogy elegendő hely álljon rendelkezésére a
PCR készülék közelében egy, a CFX Manager Dx szoftver futtatásához szolgáló számítógép
számára.

A PCR készülék alapegység kicsomagolásához és üzembehelyezéséhez

1. Keresse meg a PCR készülék alapegységet tartalmazó csomagot.

2. Vegye ki az alapegységet a csomagolóanyagból.

Tipp: A csomagolóanyagokat őrizze meg későbbi felhasználáshoz. Ha bármely elem
hiányzik vagy megsérült, akkor vegye fel a kapcsolatot a Bio-Rad helyi irodájával.

3. A PCR alapegységet a megfelelő üzemeléshez lapos, száraz, megfelelő hűtőlevegő áramlást
biztosító felületre helyezze el.

4. Keresse meg a hálózati csatlakozókábelt a szállító csomagban, és egyik végét dugja a PCR
készülék hátulján levő hálózati csatlakozóaljzatba.

Fontos: Ekkor még ne kapcsolja be a műszert.

5. Csatlakoztassa az IVD reakciómodult az alapegységhez. Lépjen az Az optikai reakciómodul
csatlakoztatása a(z) 30. oldalon.

Kezelési kézikönyv | 29



2. fejezet A C1000 Dx PCR készülék beállítása

Az optikai reakciómodul csatlakoztatása
A Bio-Rad a CFX96 Dx, illetve a CFX96 DeepWell optikai reakciómodult is szállítja a C1000 Dx PCR
készülék bázisegységéhez (de egy külön dobozban). Óvatosan csomagolja ki az optikai reakció
modult, és győződjön meg arról, hogy a szállítási csomagban megtalálható a tápkábel és az USB-
kábel is.

Fontos: Az egyes optikai reakciómodulok a vele együtt szállított PCR készülék bázisegységgel
vannak kalibrálva. Ezért az optikai reakció modult ne használja más PCR készülék
bázisegységgel.

Ügyeljen arra, hogy a C1000 Dx PCR készülék egy olyan vízszintes és száraz felületen helyezkedjen
el, amelyen a készüléket a megfelelő működéséhez szükséges mennyiségű hideg légáramlás éri.

A reakciómodul csatlakoztatása a PCR készülék bázis egységéhez

1. Helyezze a C1000 Dx PCR készüléket egy megfelelő helyre úgy, hogy a reteszelőrúd le van
engedve.

2. Az oldalsó szellőzőnyílások felett található fogássegítő bemélyedések segítségével emelje meg
az optikai reakciómodult, majd helyezze a C1000 Dx reakciómodul-foglalatába úgy, hogy elöl
körülbelül 2 cm hely maradjon. A foglalatba történő behelyezést követően az optikai modulnak
ideális esetben el kell takarnia a foglalat elején található Bio-Rad logót.
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A C1000 Dx PCR készülék telepítése

3. Húzza fel a reteszelőrudat addig, amíg szintbe nem áll a modul foglalatának oldalaival. E művelet
során a modul előrefelé mozog, és rögzül a helyén.

4. Ellenőrizze, hogy a modul teljesen és egyenletesen illeszkedik-e a C1000 Dx PCR készülék
bázisegységében. Ideális esetben a modul és a bázis egység között nincs extra hézag.

5. Csatlakoztassa a tápkábelt a C1000 Dx PCR készülék bázisegységének a hátuljához, és egy
megfelelő elektromos hálózati aljzathoz, majd a rendszer bekapcsolásához nyomja meg a C1000
Dx PCR készülék hátlapján található főkapcsolót.

A szállítási rögzítőcsavar eltávolítása
Fontos: A Bio-Radoptikai reakciómoduljai a belső fedélbe illesztett piros színű szállítási
rögzítőcsavarral kerülnek leszállításra, amelynek célja az optikai reakciómodul stabilizálása a
szállítás közben. Mielőtt az optikai reakciómodult használni tudná, el kell távolítania a szállítási
rögzítőcsavart.

A szállítási rögzítőcsavar eltávolításához

1. A C1000 Dx PCR készülék felismeri, ha a szállítási rögzítőcsavar az optikai reakciómodulba van
illesztve, és egy üzenetet jelenít meg, amellyel felszólítja Önt a csavar eltávolítására.
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2. fejezet A C1000 Dx PCR készülék beállítása

2. A szállítási rögzítőcsavar eltávolításához kövesse az utasításokat. A szállítási rögzítőcsavar
helye az alábbi ábrán látható.

Megjegyzés: Ha a reakciómodult bármilyen ok miatt vissza kell küldenie, akkor a szállítási
rögzítőcsavart ismét a helyére kell dugnia. A csavart őrizze meg biztonságos és könnyen
elérhető helyen.

Mintalemezek betöltése
Aminták egységes fűtésének és hűtésének biztosítása érdekében a lemezeknek teljesen érintkezniük
kell a reakcióblokkal. A megfelelő érintkezés biztosítása érdekében tegye a következőket:

n Aminták betöltése előtt győződjön meg arról, hogy a blokk tiszta.

n Határozott mozdulattal nyomja be az egyes kémcsöveket, kémcsősorokat, illetve mikrolemezeket
a blokk celláiba.

n Ha csak egyetlen vagy néhány kémcsövet szeretne használni, akkor használja a kémcsőkeretet
(katalógusszám: 1849000 vagy 1849001) vagy töltsön be legalább egy-egy üres kémcsövet a
blokk összes sarkába, hogy a fedél egyenletes nyomást fejtsen ki az egyes kémcsövekre.
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A C1000 Dx PCR készülék telepítése

Lemezek betöltése az optikai reakciómodulba

Fontos: A CFX Dx rendszermindig egyensúlyozza ki a kémcsősorokat, vagy adjon
kémcsőkupakokat a sarkokon levő lyukakba annak biztosításához, hogy a fűtött fedél egyenletes
nyomást fejtsen ki az egész blokkra.

A lemezeknek az optikai reakciómodulba történő betöltéséhez

1. A motorizált tető megnyitásához végezze el az alábbiak egyikét:

n A CFXManager Dx szoftver Detected Instruments (Felismert készülékek) táblájában
kattintson az Open Lid (Fedél felnyitása) opcióra.

n A szoftver Start Run (Futtatás indítása) fülében kattintson az Open Lid (Fedél felnyitása)
opcióra.

n Nyomja meg a készülék elején levő fedél gombot.

2. Helyezze a blokkba a mikrolemezt, az egyedi kémcsöveket vagy kémcsősorokat a lezárt
fedelekkel.

Fontos: A szivárgás elkerülése érdekében ellenőrizze, hogy a kémcsövek teljesen
tömítetten le vannak zárva.

Tipp: Az optimális eredmények érdekében töltsön be 10–25 µl térfogatú mintákat a CFX Dx
rendszer.

3. A pontos adatelemzés érdekében ellenőrizze, hogy a blokkban a reakciók orientációja
megegyezik a CFX Manager Dx szoftver Lemez fülében szereplő, a cellák tartalmának
orientációjára vonatkozó tájékoztatással.

Tipp: A cellatartalmakat a CFX Manager Dx szoftver használatával a futtatás előtt, közben,
vagy után is módosíthatja.

4. A motorizált fedél lezárásához végezze el az alábbiak egyikét:

n Nyomja meg a készüléken levő fedél gombot.

n A szoftver Detected Instruments (Felismert készülékek) táblájában kattintson a Close Lid
(Fedél lezárása) opcióra.

n A szoftverben a Start Run (Futtatás indítás) fülben kattintson a Close Lid (Fedél lezárása)
opcióra.

Fontos: Ügyeljen arra, hogy semmi ne akadályozza a fedél lezárását. Bár egy biztonsági
mechanizmus megakadályozza a fedél lezáródását, ha valamilyen akadályt érzékel, semmit
ne helyezzen a fedél útjába a lezárás előtt.
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2. fejezet A C1000 Dx PCR készülék beállítása

PCR műanyag és reagens fogyóeszközök

Ha szeretné megkeresni és megrendelni a(z) CFX Dx rendszerhez ajánlott műanyag
fogyóeszközöket, akkor látogasson el a Bio-Rad webhelyére. Ezt a webhelyet a CFX Manager Dx
szoftver Help > PCR Plastic Consumables Web Site (Segítség > PCRműanyag fogyóeszközök
webhelye) menüpontjából is elérheti. Továbbá a műanyag fogyóeszköz-választó és a
reagensválasztó eszközök segítenek Önnek könnyen megkeresni és megrendelni az Ön hardveréhez
és PCR-vizsgálati igényeihez való műanyag fogyóeszközöket és reagenseket.

Csatlakoztatott műszerek észlelése
A telepítés során a CFX Manager Dx szoftver szoftvertelepítő automatikusan telepíti a
készülékmeghajtó programokat a CFX Manager Dx szoftver szoftvert futtató számítógépre. A CFX
Manager Dx szoftver elindításakor érzékeli a csatlakoztatott készülékeket.

Fontos: A szoftver telepítése vagy frissítése előtt le kell választania a C1000 Dx PCR készüléket
a CFX Manager Dx számítógépről. A szoftver telepítése során a PCR készüléket nem kell
kikapcsolnia.

Csatlakoztatott készülékek detektálásához

1. Ha még nem tette meg, akkor dugja be a mellékelt „B” típusú USB kábel négyzet alakú (dugó)
végét a alapzatának hátulján található „B” típusú USB csatlakozóaljzatba.

2. A kábel másik (aljzat) végét dugja be a CFX Manager Dx számítógép egyik USB
csatlakozóaljzatába.

3. Ha a PCR készülék még nem fut, akkor nyomja meg a készülék hátulján levő kapcsolót a
készülék bekapcsolásához.

4. Indítsa el a CFX Manager Dx szoftver szoftvert.

A szoftver automatikusan érzékeli a csatlakoztatott műszert, és megjeleníti annak nevét a Detected
Instruments (Felismert készülékek) panelen a Home (Kezdőlap) ablakban.

Megjegyzés: Ha a műszer nem jelenik meg a Detected Instruments (Felismert készülékek)
panelen, akkor ellenőrizze, hogy megfelelően be van-e dugva a USB kábel. A
meghajtóprogramok újratelepítéséhez a Home (Kezdőlap) ablakban, a CFX Manager Dx
szoftverszoftverben válassza ki a Tools > Reinstall Instrument Drivers (Eszközök >
Készülékmeghajtó programok újratelepítése) parancsot.
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A C1000 Dx PCR készülék telepítése

reakciómodul leválasztása
Fontos: Egy reakciómodul leválasztása előtt kapcsolja ki a C1000 Dx PCR készüléket (lásd: A
C1000 Dx PCR készülék leállítása a(z) 35. oldalon). Közvetlenül egy protokoll vagy egy inkubáció
futtatása után a reakciómodul belsejében található hűtőbordák forrók lehetnek. A reakciómodult
csak akkor válassza le, amikor a bordák már lehűltek.

Az optikai reakciómodul leválasztása a PCR készülék bázisegységéről

1. Nyomja le a PCR készülék bázisegységének a hátulján található reteszelőrudat az optikai
reakciómodul kioldásához.

2. Óvatosan emelje ki az optikai reakciómodult a foglalatból az egyes oldalakon található
fogássegítő bemélyedések segítségével.

3. Helyezze az optikai reakciómodult egy olyan tiszta és vízszintes felületre, ahol a modult nem
érhetik ütések vagy karcolások, és ahonnan a modul nem eshet le.

A C1000 Dx PCR készülék leállítása
A PCR készülék leállítása

1. Futtatás után nyomja meg a CFX optikai reakciómodul elülső részén található fedélnyitó gombot,
hogy hozzáférhessen a tömbbe betöltött mintákhoz.

2. Távolítsa el a mintákat a tömbből, majd nyomja meg a fedélzáró gombot a fedél bezárásához.

3. A rendszer kikapcsolásához nyomja meg a C1000 Dx PCR készülék hátlapján található
főkapcsolót.
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2. fejezet A C1000 Dx PCR készülék beállítása
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3. fejezet A CFX Manager Dx szoftver telepítése
A jelen fejezetben bemutatjuk, hogy hogyan kell telepíteni a CFX Manager Dx szoftvert.

A CFX Manager Dx szoftver szükséges ahhoz, hogy a CFX96 Dx és a CFX96 DeepWell Dx
rendszerekből származó valós idejű PCR-adatokat elemezni lehessen. Ezt a szoftvert – szoftver által
vezérelt módban – arra is használhatja, hogy vezérelhesse ezeket a rendszereket.

Ha bővebb információkat szeretne olvasni a CFX Dx rendszer PCR készülék és az optikai reakció
modul telepítéséről, akkor lásd: A C1000 Dx PCR készülék beállítása a(z) 23. oldalon.
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3. fejezet A CFX Manager Dx szoftver telepítése

Rendszerkövetelmények
Az 8. táblázat a CFX Manager Dx szoftver szoftvert futtató számítógépre (más néven a CFX Manager
Dx számítógépre) vonatkozó minimális és ajánlott rendszerkövetelményeket határozza meg.

Rendszer Minimális Ajánlott

Operációs
rendszer

Microsoft Windows 7 SP1
Pro

A következők bármelyike:

n Microsoft Windows 7 SP2 Pro (32 és 64 bites)

n Microsoft Windows 10 Pro (csak 64 bites)

n Microsoft Windows 10 Enterprise (csak 64
bites)

Fontos: AMicrosoft Windows 10 Pro és Enterprise operációs rendszereknél a Biztonságos
rendszerindítás funkciót le kell tiltani.

Portok 2 darab USB 2.0 nagy
sebességű port

2 darab USB 2.0 nagy sebességű port

Szabad hely a
merevlemez-
meghajtón

128 GB 128 GB

Processzor
sebessége

2,4 GHz, kétmagos 2,4 GHz, négymagos

RAM 4 GB RAM 8 GB RAM

Képernyő
felbontása

1024 x 768 képpont, True
Color móddal

1280 x 1024 képpont, True Color móddal

PDF-olvasó Adobe PDF Reader, vagy a támogatott Microsoft
Office programcsomagok egyikéből származó
Windows PDF Reader:

n 2007

n 2010

n 2013

8. táblázat. A CFX Manager Dx szoftver számítógép-követelményei
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A CFXManager Dx szoftver telepítése

A CFX Manager Dx szoftver telepítése
Fontos: A szoftver telepítése vagy frissítése előtt a CFX Manager Dx számítógépről le kell
választani az esetlegesen hozzá csatlakoztatott készülékeket. A szoftver telepítése során a PCR
készüléket nem kell kikapcsolnia. Gondoskodjon arról, hogy az összes futtatás el legyen mentve,
valamint hogy egyetlen kísérlet se fusson éppen.

Megjegyzés: Ha a CFX Manager Dx szoftver programot a Windows 10 operációs rendszer
telepíti, akkor gondoskodjon arról, hogy a Biztonságos rendszerindítás funkció a telepítés idejére
le legyen tiltva.

A CFX Manager Dx szoftver telepítése

1. Szükség szerint válassza le a számítógépről az esetlegesen hozzá csatlakoztatott készülékeket.

Keresse meg a műszer USB-kábelét a CFX Manager Dx számítógépen, és válassza le ezt a
kábelt a számítógépről. A kábelnek a műszerhez csatlakoztatott vége a helyén maradhat.

2. Jelentkezzen be a CFX Manager Dx számítógépbe rendszergazdai jogosultságokkal.

3. Helyezze a CFX Manager Dx szoftvert tartalmazó CD-lemezt a számítógép CD-meghajtójába.

4. Ideális esetben automatikusan megjelenik a szoftver indítására szolgáló oldal. A szoftver
indítására szolgáló oldalon kattintson kétszer az Install Software (Szoftver telepítése) elemre.

Megjegyzés: Ha az indítási oldal nem jelenik meg automatikusan, akkor keresse meg és
nyissa meg a CD-meghajtón a CFX_Manager mappát, majd kattintson kétszer a setup.exe
fájlra a szoftvertelepítési varázsló elindításához.

Tipp: A telepítési varázslóban kattintson a Documentation (Dokumentáció) gombra a kiadási
megjegyzések, a műszerre vonatkozó kézikönyvek, valamint az egyéb dokumentumok
kereshető példányainak a megkereséséhez.

5. A telepítés befejezéséhez kövesse a képernyőn megjelenő utasításokat. Amikor a művelet
befejeződik, akkor a CFX Manager szoftver ikonja megjelenik a számítógép Asztalán.

6. A telepítés befejeződését követően a CD-lemez biztonságosan eltávolítható a meghajtóból.
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3. fejezet A CFX Manager Dx szoftver telepítése

Csatlakoztatott műszerek észlelése
A telepítés során a CFX Manager Dx szoftvertelepítő automatikusan telepíti a készülékmeghajtó
programokat a CFX Manager Dx számítógépre. A CFX Manager Dx szoftver elindításakor érzékeli a
csatlakoztatott készülékeket.

Csatlakoztatott készülékek detektálásához

1. Ha még nem tette meg, akkor dugja be a mellékelt „B” típusú USB kábel négyzet alakú (dugó)
végét a készülék alapzatának hátulján található „B” típusú USB csatlakozóaljzatba.

2. A kábel másik (aljzat) végét dugja be a CFX Manager Dx számítógép egyik USB
csatlakozóaljzatába.

3. Ha a készülék még nem fut, akkor nyomja meg a készülék hátulján levő kapcsolót a készülék
bekapcsolásához.

4. Indítsa el a CFX Manager Dx szoftvert.

A szoftver automatikusan érzékeli a csatlakoztatott készüléket, és megjeleníti annak nevét a Detected
Instruments (Detektált készülékek) panelen a Home (Kezdőlap) ablakban.

Megjegyzés: Ha a készülék nem jelenik meg a Detected Instruments (Detektált készülék)
panelen, akkor ellenőrizze, hogy megfelelően be van-e dugva a USB kábel. A
meghajtóprogramok újratelepítéséhez a Home (Kezdőlap) ablakban, a CFX Manager Dx
szoftverben válassza ki a Tools > Reinstall Instrument Drivers (Eszközök > Készülékmeghajtó
programok újratelepítése) parancsot.
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Szoftverfájlok

Szoftverfájlok
A(z) 9. táblázat a(z) CFX Manager Dx szoftver fájltípusokat határozza meg.

Fájltípus Kiterjesztés Részletek

Protokoll .prcl A PCR futtatás elvégzéséhez szükséges
protokollbeállítási részleteket tartalmazza.

Lemez .pltd A PCR futtatás elvégzéséhez szükséges
lemezbeállítási részleteket tartalmazza.

Adat .pcrd Egy kísérleti futtatás és a hozzá kapcsolódó PCR
elemzés eredményeit tartalmazza.

PrimePCR futtatás .csv A PrimePCR lemezekre vonatkozó protokollt és
lemezelrendezést tartalmazza.

Génvizsgálat .mgxd Több PCR futtatás és génexpresszió-elemzés
eredményeit tartalmazza.

LIMS .plrn Egy LIMS-kompatibilis futttatás elvégzéséhez
szükséges lemezbeállítási és protokollinformációkat
tartalmazza.

9. táblázat. CFX Manager Dx szoftver fájltípusok

Ajánlott kiberbiztonsági intézkedések
A Bio-Rad azt ajánlja Önnek, hogy az Ön informatikai osztályával együttműködésben léptessenek
életbe kiberbiztonsági intézkedéseket a CFX96 Dx rendszerrel használt számítógépre vonatkozóan.
Például:

n Megfelelő vírusvédelmi és tűzfalalkalmazások telepítése és konfigurálása.

Fontos: A víruskeresés konfigurálása oly módon, hogy az a nyitva tartási időn kívül vagy
olyankor történjen, amikor a műszer éppen nem fut aktívan. Ha a rendszer olyankor
kezdeményez víruskeresést, amikor a CFX Manager Dx egy kísérletet futtat, akkor a futtatás
megszakadhat, és az adatok elveszhetnek.

n A CFXManager Dx szoftver nem rendelkezik olyan funkcióval, amely meghatározott idejű
inaktivitás esetében kiléptetné a felhasználót. Ezért azt ajánljuk, hogy aktiválja a Windows
rendszer felhasználói hozzáférésre vonatkozó biztonsági funkcióit vagy harmadik felektől
származó – felhasználói hozzáférésre vonatkozó – biztonsági funkciókat (például egy
képernyőkímélőt, amelynek a feloldásához be kell jelentkezni).
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3. fejezet A CFX Manager Dx szoftver telepítése

n Cserélhető adathordozók biztonsága:

o Az adatok védelme érdekében használjon jelszavakat és titkosítást az USB-eszközén.

o Tiltsa le az automatikus futtatás és az automatikus lejátszás funkciót az összes cserélhető
adathordozóra vonatkozóan.

o Úgy állítsa be a rendszert, hogy az minden esetben végezzen USB-vizsgálatot, amikor a
számítógéphez egy pendrive-ot csatlakoztatnak.

n Az adatok esetleges helyreállításának az elősegítése érdekében használjon egy biztonsági
mentési segédprogramot.
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4. fejezet A munkaterület
CFXManager Dx szoftver egy olyan kezelőfelület kínál a lemezek beállításához, amelynek a
segítségével ki lehet dolgozni PCR protokollokat, azokat futtatni lehet CFX Dx műszereken, valamint
elemezni lehet a PCR futtatásokból származó adatokat.

A CFX Manager Dx szoftver öt elsődleges munkafelületet kínál:

n A Home (Kezdőlap) ablak

n A Startup Wizard (Indítási varázsló)

n A Protocol Editor (Protokoll szerkesztő) ablak

n A Plate Editor (Lemez szerkesztő) ablak

n A Data Analysis (Adatelemzés) ablak

Ez a fejezet bemutatja és röviden ismerteti az egyes munkaterületeket.
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4. fejezet A munkaterület

A Home (Kezdőlap) ablak
A(z) CFX Manager Dx szoftver program elindításakor megnyílik a Home (Kezdőlap) ablak és
megjelenik a Startup Wizard (Indítási varázsló), amelynek a segítségével Ön beállíthat egy kísérletet,
elvégezhet vagy megismételhet egy futttatást, vagy elemezhet egy meglévő futttatást. A Home
(Kezdőlap) ablakból továbbá megtekintheti az alkalmazásra és a műszerekre vonatkozó naplókat,
létrehozhat új felhasználókat, és kezelheti a meglévőket, valamint számos hasznos eszközt elérhet.
További információkért lásd: 5. fejezet, A Home (Kezdőlap) ablak.
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A Startup Wizard (Indítási varázsló)

A Startup Wizard (Indítási varázsló)
A Startup Wizard (Indítási varázsló) segítségével gyorsan beállíthat és futtathat felhasználó által
beállított kísérleteket, valamint gyorsan kiválaszthat és futtathat egy PrimePCR kísérletet. Ennek a
varázslónak a segítségével továbbá megismételhet egy futtatást vagy kielemezhet futtatási adatokat.
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4. fejezet A munkaterület

A Protocol Editor (Protokoll szerkesztő) ablak
A Protocol Editor (Protokoll szerkesztő) ablakban létrehozhat, megnyithat, áttekinthet, és szerkeszthet
egy protokollt. Módosíthatja a fedélhőmérsékletet is a megnyitott protokollhoz. A Protocol Editor
(Protokollszerkesztő) működését az 6. fejezet, Protokollok létrehozása.
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A Plate Editor (Lemez szerkesztő) ablak

A Plate Editor (Lemez szerkesztő) ablak
A Plate Editor (Lemez szerkesztő) ablakban létrehozhat, megnyithat, áttekinthet, és szerkeszthet egy
lemezt. A Plate Editor (Lemezszerkesztő) működésének részletei az 7. fejezet, Lemezek
előkészítése.
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4. fejezet A munkaterület

A Data Analysis (Adatelemzés) ablak
A Data Analysis (Adatelemzés) ablakban Ön megtekinthet és összehasonlíthat futtatási adatokat,
statisztikai elemzéseket végezhet, adatokat exportálhat, valamint publikációra kész jelentéseket
hozhat létre. A Data Analysis (Adatelemzés) funkció részletes leírásához lásd: 9. fejezet, Az
adatelemzés áttekintése. Lásd még: 10. fejezet, Az adatelemzéssel kapcsolatos részletek.
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5. fejezet A Home (Kezdőlap) ablak
A CFXManager Dx szoftver egy olyan kezelőfelület kínál, amelynek a segítségével ki lehet dolgozni
PCR protokollokat, azokat futtatni lehet CFX Dx rendszereken, valamint a PCR futtatási adatokat
elemezni lehet.

A jelen fejezet bevezetőként szolgál a(z) CFX Manager Dx szoftver programhoz és bemutatja a Home
(Kezdőlap) ablakból elérhető funkciókat.
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5. fejezet A Home (Kezdőlap) ablak

A Home (Kezdőlap) ablak
A(z) CFX Manager Dx program elindításakor megnyílik a Home (Kezdőlap) ablak, és megjelenik a
Startup Wizard (Indítási varázsló), amelynek a segítségével Ön beállíthat egy futtatást, elvégezhet
vagy megismételhet egy futtatást vagy elemezhet egy meglévő futtatást. A Home (Kezdőlap) ablakból
továbbá megtekintheti az alkalmazásra és a műszerekre vonatkozó naplókat, létrehozhat új
felhasználókat, és kezelheti a meglévőket, valamint számos hasznos eszközt elérhet.

1. A szoftver címsorában a szoftvernek és a bejelentkezett felhasználónak a neve látható.

2. A menüsor gyors hozzáférést kínál a File (Fájl), a View (Nézet), a Users (Felhasználók), a
Run (Futtatás), a Tools (Eszközök), a Window (Ablak) és a Help (Segítség) menüpontban
található parancsokhoz.

3. Az eszköztárban található parancsok gyors hozzáférést kínálnak a menüpontokhoz.

4. A bal oldali panelen a(z) CFX Manager Dx számítógéphez csatlakoztatott készülékek,
valamint olyan gombok láthatók, amelyeknek a segítségével Ön működtetheti a fedelet és
megtekintheti a műszerek állapotát.

JELMAGYARÁZAT
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A Home (Kezdőlap) ablak

5. A fő panelen a munkavégzési ablak látható. A Home (Kezdőlap) képernyőn a Startup
Wizard (Indítási varázsló) az alapértelmezett munkavégzési ablak.

6. A státuszsorban a csatlakoztatott készüléknek és a bejelentkezett felhasználónak a neve
látható.

File (Fájl) menüparancsok
New (Új) —megnyit egy párbeszédpanelt, amelyből választhat egy új protokoll, lemez, vagy
génvizsgálat létrehozása közül.

Open (Megnyitás) —megnyit egy párbeszédpanelt, amelyből választhat egy meglevő protokollra,
lemezre, adatfájlra, vagy génvizsgálatra, LIMS fájlra, vagy PrimePCR futtatási fájlra történő navigálás
és annak megnyitása közül.

Recent Data Files (Legutóbbi adatfájlok) —megjeleníti a legutóbb megnyitott PCR fájlok listáját.

Repeat a Run (Egy futtatás megismétlése) — aWindows Explorer-ben megnyitja az elmentett PCR
fájlok helyét, ahonnan megkereshet egy megismételni kívánt futtatást.

Exit (Kilépés) — bezárja a CFX Manager Dxszoftvert.

A View (Nézet) menüpontban található parancsok
Application Log (Alkalmazásnapló)—egy szoftverhasználati napló megjelenítése, amelyben a
kezdeti telepítéstől az aznapi dátumig láthatók az adatok.

Run Reports (Futtatási jelentések)—a futtatási jelentések megjelenítése egy listában.

Startup Wizard (Indítási varázsló)—a Startup Wizard (Indítási varázsló) megjelenítése a fő
panelen.

Run Setup (Futtatás beállításai)—aRun Setup (Futtatás beállításai) ablak megjelenítése a fő
panelen.

Instrument Summary (Készülék összefoglaló)—az Instrument Summary (Készülék összefoglaló)
ablak megjelenítése a fő panelen.

Detected Instruments (Felismert készülékek)—váltókapcsoló annak a beállításához, hogy a
szoftver a bal oldali panelen megjelenítse-e a csatlakoztatott műszereket, vagy ne. A szoftver
alapértelmezés szerint megjeleníti a csatlakoztatott műszereket a bal oldali panelen.

Toolbar (Eszköztár)—váltókapcsoló annak a beállítására, hogy a szoftver megjelenítse-e az
eszköztárat a képernyő tetején, vagy ne. A szoftver alapértelmezés szerint megjeleníti az eszköztárat.
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5. fejezet A Home (Kezdőlap) ablak

Status Bar (Állapotsor)—váltókapcsoló annak a beállítására, hogy a szoftver megjelenítse-e az
állapotsort a képernyő alján, vagy ne. A szoftver alapértelmezés szerint megjeleníti az állapotsort.

Show (Mutatás)—párbeszédpanel megnyitása, amelynek a segítségével Ön a következőket teheti:

n A Status (Státusz) napló megtekintése vagy zárolása.

n A CFXManager Dx adatmappa megnyitása és megtekintése.

n A felhasználó adatmappájának a megnyitása és megtekintése.

n A LIMS fájl mappájának a megnyitása és megtekintése.

n A PrimePCRmappa megnyitása és megtekintése.

n A futtatási előzmények megtekintése.

n Az összes csatlakoztatott készülék tulajdonságainak a megtekintése.

User (Felhasználó) menüparancsok
Select User (Felhasználó kiválasztása) —megnyitja a Login (Bejelentkezés) képernyőt, amelyen
kiválaszthat egy felhasználót a User Name (Felhasználónév) legördülő listáról, és bejelentkezhet az
applikációba.

Change Password (Jelszó megváltoztatása) —megnyitja a Change Password (Jelszó
megváltoztatása) párbeszédpanelt, amelyben a felhasználók megváltoztathatják CFX Manager Dx
szoftver jelszavukat.

User Preference s (Felhasználói preferenciák) —megnyitja a User Preferences (Felhasználói
preferenciák) párbeszédpanelt, amelyben a felhasználók módosíthatják az alapértelmezett
beállításokat az alábbiakhoz

n E-mail értesítés küldése és kapása a lefutás befejezésekor

n Adatfájlok elmentése

n Protokollok létrehozása a Protocol Editor (Protokoll szerkesztő) vagy a Protocol AutoWriter
(Automatikus protokollíró) használatával

n Lemezek létrehozása

n Adatok elemzése

n Génexpresszió-elemzés végrehajtása

n Az adatok minőségének meghatározása

n A CFX Dx készülékadatok exportálása
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A Home (Kezdőlap) ablak

User Administration (Felhasználó adminisztráció) —megnyitja a User Administration (Felhasználó
adminisztráció) párbeszédpanelt, amelyben a rendszergazdák felhasználókat hozhatnak létre,
szerepkör engedélyezéseket módosíthatnak, és szerepköröket rendelhetnek a felhasználókhoz.

Bio-Rad Service Login (Szerviz bejelentkezés) — kizárólag Bio-Rad műszaki szervizszemélyzet
által történő használatra. Ezt a parancsot tilos kiválasztani.

Run (Futtatás) menüparancsok
User-defined Run (Felhasználó által definiált futtatás) —megnyitja a Run Setup (Futtatás beállításai)
ablakot, amelyben beállíthat egy felhasználó által definiált protokollt és lemezt, majd lefuttathat egy
PCR kísérletet a kiválasztott készülékeken.

PrimePCR Run (PrimePCR futtatás) —megnyitja a Start Run (Futtatás indítása) fület a Run Setup
(Futtatás beállításai) ablakban az alapértelmezett PrimePCR (PrimePCR) protokollal és a kiválasztott
készüléken alapuló lemezelrendezéssel.

End-Point Only Run (Csak végpont futtatása) —megnyitja a Start Run (Futtatás indítása) fület a Run
Setup (Futtatás beállításai) ablakban az alapértelmezett végpont protokollal és a kiválasztott
készüléken alapuló lemezelrendezéssel.

Qualification Run (Kvalifikációs futás) —megnyitja a Start Run (Futtatás indítása) fület a Run Setup
(Futtatás beállításai) ablakban az Bio-Rad alapértelmezett kvalifikációs protokollal és a kiválasztott
készülékhez betöltött lemezelrendezéssel.

A Tools (Eszközök) menüpontban található parancsok
Master Mix Calculator (Master mix kalkulátor)—aMaster Mix Calculator (Master mix kalkulátor)
megnyitása, amelynek a segítségével létrehozhat egy reakciókeveréket, és kinyomtathatja a
számításokat.

Protocol AutoWriter (Protokollíró varázsló)—a Protocol AutoWriter (Protokollíró varázsló)
párbeszédpanel megnyitása, amelynek a segítségével könnyen létrehozhat egy új protokollt.

Ta Calculator (Ta kalkulátor)—a Ta Calculator (Ta kalkulátor) megnyitása, amelynek a
segítségével könnyen kiszámíthatja a primerek izzítási hőmérsékleteit.

Dye Calibration Wizard (Festékkalibráció varázsló)—aDye Calibration Wizard (Festékkalibráció
varázsló) megnyitása, amelynek a segítségével bekalibrálhat egy műszert egy új fluorofórhoz.

Reinstall Instrument Drivers (A műszer illesztőprogramjainak az újratelepítése)—a(z) Bio-Rad
valós idejű PCR rendszereivel történő kommunikációt vezérlő illesztőprogramoknak az újratelepítése.
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5. fejezet A Home (Kezdőlap) ablak

Zip Data and Log Files (Adat- és naplófájlok tömörítése)—egy párbeszédpanel megnyitása,
amelynek a segítségével kiválaszthatja azokat a fájlokat, amelyeket szeretne tömöríteni és elmenteni
egy tömörített fájlba tárolás vagy e-mail üzenetben történő elküldés céljából.

Batch Analysis (Batch analízis)—a Batch Analysis (Batch analízis) párbeszédpanel megnyitása,
amelynek a segítségével beállíthatja az egynél több adatfájl egyidejű elemzésére vonatkozó
paramétereket.

Options (Opciók)—párbeszédpanel megnyitása, amelynek a segítségével a következőket teheti:

n Az Ön e-mail-kiszolgálójának a beállításainak a konfigurálása.

n Az LIMS és más adatfájlokra vonatkozó exportálási beállítások konfigurálása.

Help (Súgó) menüparancsok
Tipp: A Help (Súgó) menü minden CFX Manager Dx szoftver ablakban elérhető a menüsorban.

Open Operation Manual (Kezelési kézikönyv megnyitása) —megnyitja ennek a(z)kézikönyvnek a
PDF változatát.

Gene Expression Gateway (Génexpresszió átjáró) webhely—megnyitja a Bio-Rad honlapját a
CFX Dx rendszerműszerhez.

PCR Reagents (Reagensek) webhely —megnyitja a Bio-Rad PCR Reagents webhelyet, ahonnan
PCR reagenseket, szupermixeket, festékeket, és készleteket rendelhet.

PCR Plastic Consumables (Műanyag fogyóeszközök) webhely —megnyitja a Bio-Rad PCR
Plastics and Consumables webhelyet, ahonnan PCR lemezeket, lemez tömítéseket, kémcsöveket és
kupakokat, valamint egyéb műanyag tartozékokat rendelhet.

Software webhely (Szoftver) webhely —megnyitja a Bio-Rad CFX Manager Dx szoftverPCR
Analysis Software webhelyet, ahonnan megrendelheti a Bio-Rad frissített verzióit.

About (Névjegy) —megjeleníti a CFX Manager Dx copyright és verzió információkat.
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A Home (Kezdőlap) ablak

Az eszköztárban található parancsok

– aWindows Intéző megnyitása, amelynek a segítségével megkereshet és megnyithat egy
adatfájlt vagy egy génvizsgálatfájlt.

– a Master Mix Calculator (Master mix kalkulátor) párbeszédpanel megnyitása.

– a Run Setup (Futtatás beállításai) ablak megnyitása.

– a Run Setup (Futtatás beállításai) ablak megnyitása a kiválasztott műszer alapján betöltött
alapértelmezett PrimePCR protokollal és lemezelrendezéssel.

– a Startup Wizard (Indítási varázsló) megnyitása.
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5. fejezet A Home (Kezdőlap) ablak

A Startup Wizard (Indítási varázsló)
A CFXManager Dx elindulásakor a munkatáblán megjelenik a Startup Wizard (Indítási varázsló). A
Startup Wizard (Indítási varázsló) ablakból a következőket tudja elvégezni:

n Kiválaszthat egy készüléket a felismert készülékek közül, és beállíthat egy felhasználó által
definiált PrimePCR (PrimePCR) futtatást.

n Megnyithat és megismételhet egy futtatást.

n Megnyithat egy adatfájlt egy futtatásból vagy többszörös génexpresszió lefutások eredményeihez
egy génvizsgálati fájlból származó eredmények elemzéséhez.

Ezeket a füleket a későbbi fejezetekben részletesen ismertetjük.

Állapotsor
A szoftver fő ablakának alján található állapotsor bal oldalán az észlelt műszerek aktuális állapota
látható. Az állapotsor jobb oldalán az aktuális felhasználó neve, valamint a dátum és az idő látható.
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Detected Instruments (Detektált készülékek) panel
A Detected Instruments (Felismert készülékek) panel a(z) CFX Manager Dx számítógéphez csatlakoztatott
egyes műszereket jeleníti meg. Alapértelmezettként mindegyik műszer egy ikonként jelenik meg, amelynek
a neve a készülék sorozatszáma.

A következő kép például négy detektált készüléket mutat:

n Két C1000 PCR készülék CFX96 DeepWell reakciómodulokkal (CFX96DW1 és CFX96DW2)

n Két C1000 PCR készülék CFX96 reakciómodulokkal (CFX96l01 és CFX96l02)

Ebből a táblából az alábbiak egyikét teheti:

n Egy kiválasztott készülék jellemzőinek és kalibrált festékeinek a megtekintése.

A készülék jellemzőivel kapcsolatos információkért lásd: Készülék tulajdonságainak a
megtekintése a(z) 61. oldalon.

n Egy csatlakoztatott készülék státuszának a megtekintése.

n A kiválasztott készülék motorizált tetejének felnyitása.

n A kiválasztott készülék motorizált tetejének lezárása.

n Az összes csatlakoztatott készülék státuszának megtekintése.
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Egy csatlakoztatott készülék státuszának megtekintése

u A Detected Instruments (Detektált készülékek) panelen válassza ki a célkészüléket, és végezze
el az alábbiak egyikét:

n Kattintson a View Status (Státusz megtekintése) opcióra a Selected Instrument (Kiválasztott
készülék) részben.

n Jobb gombbal kattintson, és válassza ki a View Status (Státusz megtekintése) opciót a
megjelenő menüben.

Megjelenik a Run Details (Futtatás részletei) párbeszédpanel, amelyen látható a Run Status
(Futtatás állapota) fül. A kiválasztott készülék státusza megjelenik a futtatás állapota panel alatt,
pl.:

Egy készülék fedelének a felnyitásához vagy lezárásához

u A Detected Instruments (Detektált készülékek) panelen válassza ki a célkészüléket, és végezze
el az alábbiak egyikét:

n Kattintson a Open Lid (Fedél felnyitása) vagy a Close Lid (Fedél lezárása) opcióra a Selected
Instrument (Kiválasztott készülék) részben.

n Jobb gombbal kattintson, és válassza ki a megfelelő műveletet a megjelenő menüben.

n Nyissa meg a Run Details (Futtatás részletei) párbeszédpanelt, válassza ki a Run Status
(Futtatás állapota) fület, és kattintson az Open Lid (Fedél felnyitása) vagy a Close Lid (Fedél
lezárása) parancsra.
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Az összes csatlakoztatott készülék státuszának a megtekintéséhez

u Végezze el az alábbiak egyikét:

n Az All Instruments (Összes készülék) részben a Detected Instruments (Detektált készülékek)
panelen kattintson a View Summary (Összefoglalás megtekintése) parancsra.

n Amenüsorban válassza ki a View > Instrument Summary (Megtekintés > Készülék
összefoglalás) opciót.

Megjelenik az Instrument Summary (Készülék összefoglalás) párbeszédpanel:

Tipp: Ha a rendszer csak egy csatlakoztatott készüléket érzékel, akkor az All Instruments
(Összes készülék) rész nem jelenik meg a Detected Instruments (Detektált készülékek)
panelen. Egyetlen készülék összefoglalásának a megtekintéséhez válassza ki a View >
Instrument Summary (Megtekintés > Készülék összefoglalás) opciót.
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Instrument Summary (Készülék összefoglalás) eszköztár vezérlők

Az 10. táblázat az Instrument Summary (Készülék összefoglalás) eszköztárban található vezérlőket
és funkciókat sorolja fel.

Gomb Gomb neve Funkció

Új futtatás létrehozása Létrehoz egy futtatás a kiválasztott
blokkon a Run Setup (Futtatás
beállítás) ablak megnyitásával.

Leállítás Leállítja a pillanatnyi futtatást a
kiválasztott blokkokon.

Szünet Szünetelteti a pillanatnyi futtatást a
kiválasztott blokkokon.

Újraindítás Újraindítja a futtatást a kiválasztott
blokkokon.

Blokk indikátor villogtatása Villogtatja a kijelző LED-et a
kiválasztott blokkok fedelén.

Fedél felnyitása Felnyitja a kiválasztott blokk motorizált
fedelét.

Fedél lezárása Lezárja a kiválasztott blokk motorizált
fedelét.

Kiválasztott blokkok
elrejtése

Elrejti a kiválasztott blokkokat az
Instrument Summary (Készülék
összefoglalás) listában

Összes blokk
megjelenítése

Megjeleníti a kiválasztott blokkokat az
Instrument Summary (Készülék
összefoglalás) listában

10. táblázat. Instrument Summary(Készülék összefoglalás) eszköztár vezérlők
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Gomb Gomb neve Funkció

Megjelenítés Annak kiválasztása, hogy melyik
blokkokat jelenítse meg a listában.
Válassza ki az egyik opciót az összes
detektált blokk, az összes
használatban nem lévő blokk, a
pillanatnyi felhasználóval futó összes
blokk, vagy az összes futó blokk
megjelenítésére

10. táblázat. Instrument Summary(Készülék összefoglalás) eszköztár vezérlők, folytatás

Készülék tulajdonságainak a megtekintése
A Detected Instruments (Felismert készülékek) panelból megtekintheti egy kiválasztott készülék
részleteit, köztük annak tulajdonságait, a szállítási rögzítőcsavar státuszát, valamint kalibrált festékei
(fluorofórjai) listáját.

A készülék tulajdonságok megtekintéséhez

u A Detected Instruments (Felismert készülékek) panelben kattintson a jobb gombbal a
célkészülékre, és válassza ki a megjelenő menüről a Properties (Tulajdonságok) opciót.
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Properties (Tulajdonságok) fül

A Properties (Tulajdonságok) fül a kiválasztott készülékkel kapcsolatos műszaki részleteket sorol fel,
mint például a típust, az alkatrészek sorozatszámát, valamint a firmware verziókat. A készülék
alapértelmezett neve (annak sorozatszáma) sok helyen megjelenik, köztük a Detected Instruments
(Felismert készülékek) panelben, valamint az Instrument Properties (Készüléktulajdonságok)
párbeszédpanel fejléc sorában. A könnyebb azonosítás érdekében a készüléket átnevezheti.

Készülék átnevezése

u Az Instrument Properties (Készüléktulajdonságok) fülben írjon be egy nevet a Rename
(Átnevezés) mezőbe a Properties (Tulajdonságok) fül tetején, és kattintson a Rename
(Átnevezés) gombra.

Az új név megjelenik a Nickname (Becenév) sorban a Properties (Tulajdonságok) fülben,
valamint az Instrument Properties (Készüléktulajdonságok) fejléc sorban és a Detected
Instruments (Felismert készülékek) panelben.

Shipping Screw (Szállítási rögzítőcsavar) fül

A Shipping Screw (Szállítási rögzítőcsavar) fül a kiválasztott műszer szállítási rögzítőcsavarjának
aktuális státuszát (Eltávolítva vagy Beszerelve) jeleníti meg. A fül a piros színű szállítási rögzítőcsavar
beszerelésére vagy eltávolítására vonatkozó utasításokat is tartalmazza.

Tipp: Ha a szoftver érzékeli a szállítási rögzítőcsavart, akkor az Instrument Properties
(Készüléktulajdonságok) párbeszédpanel automatikusan megjeleníti a Shipping Screw (Szállítási
rögzítőcsavar) fület. Kövesse az utasításokat a csavar eltávolításához.

Megjegyzés: Mielőtt a műszert használni tudná, el kell távolítania a szállítási rögzítőcsavart.
További információért lásd: A szállítási rögzítőcsavar eltávolítása a(z) 31. oldalon.
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Calibrated Dyes(Kalibrált festékek) fül

A Calibrated Dyes (Kalibrált festékek) fül a kalibrált fluorofórokat és lemezeket jeleníti meg a
kiválasztott műszerhez.

Egy adott kalibrációval kapcsolatos részletes információk megtekintéséhez kattintson annak Info
gombjára a Detail (Részlet) oszlopban.
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Kezdés előtt

Felhasználói beállítások
Tipp: Ezeket a műveleteket nem szükséges elvégezni a CFX Manager Dx
szoftverhasználatához. Nyugodtan kihagyhatja ezt a részt, vagy ezeket a műveleteket bármikor
elvégezheti.

A CFX Manager Dx lehetővé teszi saját munkaterületének testreszabását. Ha rendszergazdája
létrehozott szoftver felhasználókat, akkor mindegyik felhasználó testre szabhatja saját
munkakörnyezetét. Ha rendszergazdája nem hozott létre felhasználókat, akkor a beállítás
módosítások mindenkire érvényesek, aki bejelentkezik a(z) CFX Manager Dxszoftverbe. (A CFX
Manager Dx felhasználók létrehozásával kapcsolatos információkért lásd: B. melléklet, A CFX
Manager Dx felhasználóinak és szerepköreiknek kezelése.)

Például a Users > User Preference (Felhasználók > Felhasználói preferenciák) menüben a
következőket végezheti el:

n E-mail értesítések beállítása a futtatás befejezéséről.

n Alapértelmezett beállítások módosítása:

o A fájlok kimentési helye

o A futtatásbeállítási fájlok

o A fájlok elnevezési előtagja

n Alapértelmezett paraméterek beállítása egy új protokoll és lemez létrehozásakor.

n Az alapértelmezett adatelemzési és génexpressziós paraméterek beállítása.

n Az alapértelmezett minőség-ellenőrzési paraméterek testreszabása.

n Az adatexportálásra vonatkozó adatparaméterek testreszabása.

A Tools (Eszközök) menüben a következőket végezheti el:

n Egy master mix létrehozása.

n Festékek kalibrálása egy adott műszerhez.

Megjegyzés: Amaster mix és a festék kalibrálás bárki számára elérhető, aki bejelentkezik a CFX
Manager Dxszoftverbe.

Ez a rész ezeknek a műveleteknek az elvégzését ismerteti részletesen.
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Az e-mail értesítés beállítása

A(z) CFX Manager Dx programot az Ön kimenő e-mail-kiszolgálójához csatlakoztathatja és így e-mail
üzenetben értesítheti a meghatározott felhasználókat a futtatás befejeződéséről. Ezen kívül adatfájlt
és elemzési jelentést is csatolhat a meghatározott felhasználóknak. A(z) CFX Manager Dx és az Ön
SMTP-kiszolgálója közötti kapcsolat beállításához lásd: A CFX Manager Dx csatlakoztatása egy
SMTP szerverhez a(z) 67. oldalon.

Megjegyzés: Az, hogy egy felhasználó hozzáférhet-e az e-mail-beállítási funkciókhoz, attól függ,
hogy a rendszergazda milyen felhasználói csoportot és jogosultságokat állít be az adott
felhasználóhoz. A felhasználók és a szerepköreik kezelésére vonatkozó részletekért lásd:
Felhasználók kezelése a(z) 279. oldalon.

E-mail értesítések beállítása

1. Válassza ki a Users > User Preferences (Felhasználók > Felhasználói preferenciák) elemet a
User Preferences (Felhasználói preferenciák) párbeszédpanel megnyitásához.

Megjelenik a User Preferences (Felhasználói preferenciák) párbeszédpanel és rajta az Email (E-
mail) fül.

Megjegyzés: Ha a rendszer úgy érzékeli, hogy Ön még nem állított be érvényes SMTP-
kiszolgálót a(z) CFX Manager Dx programhoz, akkor erről értesíti Önt. Kattintson a Configure
Outgoing Email (Kimenő e-mail konfigurálása) elemre az Options (Opciók) párbeszédpanel
megnyitásához, majd konfigurálja be az SMTP e-mail-kiszolgálót. További információkért
lásd: A CFX Manager Dx csatlakoztatása egy SMTP szerverhez a(z) 67. oldalon.
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2. A To (Címzett) szövegbeviteli mezőbe írja be minden egyes személy e-mail címét, akit
tájékoztatni szeretne a futás befejeződéséről. A futtatás befejeződése után az összes címzett e-
mail üzenetet kap.

Megjegyzés: Az egyes e-mail címeket külön-külön sorokba kell írnia. Az egyes címek
beírása után nyomja le az Enter (Bevitel) vagy a Return (Vissza) billentyűt.

3. (Opcionális) A cc (Másolat) szövegbeviteli mezőbe adott esetben írja be azoknak a címzetteknek
az e-mail címeit, akiknek másolatot szeretne küldeni az egyes e-mail értesítésekből.

4. (Opcionális) A rendszer alapértelmezés szerint az összes címzettnek elküldi csatolmányként az
adatfájl másolatát. Ha nem szeretné csatolni az adatfájl másolatát, akkor törölje ebből a
jelölőnégyzetből a jelölést.

5. (Opcionális) Ha az e-mail üzenethez szeretné csatolni az elemzési jelentést PDF formátumban,
akkor jelölje be az Attach Analysis Report (Elemzési jelentés csatolása) elemet.

6. A módosítások mentéséhez és a User Preferences (Felhasználói preferenciák) párbeszédpanel
bezárásához kattintson az OK gombra.

Címzett e-mail címének a szerkesztése

u Szükség szerint módosítsa az e-mail címet, majd kattintson az OK gombra.

E-mail címzett eltávolítása

1. Válassza ki az e-mail címzettet, majd nyomja le a Delete (Törlés) billentyűt.

2. A módosítások mentéséhez és a párbeszédpanel bezárásához kattintson az OK gombra.

Fontos: Ha a User Preferences (Felhasználói preferenciák) párbeszédpanelen a Restore
Defaults (Visszaállítás az alapértelmezett beállításokra) elemre kattint, akkor a rendszer az
összes fülön visszaállítja az összes preferenciát az eredeti, gyári beállításokra. Legyen
körültekintő, ha erre a gombra kattint.
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A CFX Manager Dx csatlakoztatása egy SMTP szerverhez

Fontos: Egyes kereskedelmi webmail szolgáltatók (pl. Yahoo! és Gmail) fokozott e-mail
biztonsági szisztémát alkalmaznak. Ha Ön ezeket a fiókokat használja, akkor engedélyeznie kell
az Allow less secure apps (Kevésbé biztonságos app-ok engedélyezés) beállítást ahhoz, hogy
a CFX Manager Dx e-mailt tudjon küldeni. További információkért olvassa el saját webmail
szolgáltatója biztonsági információit.

Mielőtt a szoftver e-mail értesítést tudna küldeni, Önnek létre kell hoznia a CFX Manager Dx és az Ön
e-mail szervere közötti csatlakozást.

A CFX Manager Dx egy e-mail szerverhez történő csatlakoztatásához

1. Végezze el az alábbiak egyikét:

n Válassza ki a User > User Preferences (Felhasználó > Felhasználói preferenciák) opciót és
kattintson a Configure Outgoing Email (Kimenő e-mail konfigurálása) gombra az Email (E-
mail) fülön.

n Válassza ki a Tools > Options (Eszközök > Opciók) lehetőséget.

Megjelenik az Options (Opciók) párbeszédpanel és rajta az Email (E-mail) fül.
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2. Adja meg a következő információkat a cégéhez:

n SMTP Server Name (SMTP szerver név) — a kimenő e-mail szerver neve a cégénél.

n Port—SMTP szerverének a portszáma. Ez általában 25.

n Use SSL (Használjon SSL-t) — Secure Sockets Layer (SSL; biztonságos csatlakozási
réteg) opció. Egyes SMTP szerverek megkövetelik ezt a beállítást. Ha ez nem szükséges az
Ön cégénél, akkor szüntesse meg a jelölőnégyzet bejelölését.

n Use Default “From” Address (Használja az alapértelmezett „Feladó” címet) — az e-mail
szerver neve az Ön cégénél. Egyes SMTP szerverek megkövetelik, hogy minden elküldött e-
mail tartalmazzon egy bizonyos domainből származó „feladó” címet, pl.
név@AzÖnCége.com. Ha ez az eset áll fenn, akkor szüntesse meg a jelölőnégyzet
bejelölését, és adjon meg egy érvényes e-mail címet.

n Authentication Required (Hitelesítés szükséges) — ha az Ön helyszíne megköveteli a fiók
hitelesítését, akkor ellenőrizze, hogy ez a jelölőnégyzet be legyen jelölve.

n User Name (Felhasználónév) — a hitelesített fiók neve. Ez csak akkor szükséges, ha az
Authentication Required (Hitelesítés szükséges) be van jelölve.

n Password (Jelszó) — a hitelesített fiók jelszava. Ez csak akkor szükséges, ha az
Authentication Required (Hitelesítés szükséges) be van jelölve.

3. Az SMTP beállítások helyességének ellenőrzéséhez írjon be egy érvényes e-mail címet a Test
Email Address (E-mail cím tesztelése) szövegmezőbe és kattintson a Test Email (Email
tesztelése) gombra.

Megjegyzés: Egyes SMTP szerverek nem engedélyezik a mellékleteket, mások pedig csak
egy bizonyos méretig engedélyezik a mellékleteket. Ha Ön adatfájlok és/vagy jelentések e-
mail mellékletként való elküldését tervezi a CFX Manager Dxhasználatával, akkor válassza
ki a Test Attachment (Melléklet tesztelése) opciót és állítsa be az Attachment Size in MB
(Melléklet mérete MB-ban) lehetőséget 5 megabájt (MB) vagy annáll magasabb értékre.

4. A módosítások mentéséhez és a párbeszédpanel bezárásához kattintson az OK gombra.
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Az alapértelmezett fájlbeállítások módosítása

A User Preference (Felhasználói preferencia) párbeszédpanelen levő Files (Fájlok) fülben
módosíthatja a következőket:

n A CFXManager Dx fájlok elmentésére szolgáló alapértelmezett hely

n A futtatás beállításának alapértelmezett fájljai

n Az alapértelmezett fájlelnevezési paraméterek

Az alapértelmezett fájlbeállítások módosításához

1. Válassza ki a Users > User Preferences (Felhasználók > Felhasználói preferenciák) elemet a
User Preferences (Felhasználói preferenciák) párbeszédpanel megnyitásához.

2. A User Preferences (Felhasználói preferenciák) párbeszédpanelben válassza ki a Files (Fájlok)
fület.
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3. A Default Folder for File Creation (Alapértelmezett mappa fájl létrehozásához) részben válasszon
ki egy alapértelmezett mappát, ahová el akarja menteni az új fájlokat. Az egyes fájltípusokhoz
más és más helyet választhat:

n Protokoll

n Lemez

n Adatfájl

n Génvizsgálat

4. A File Selection for Run Setup (Fájl kiválasztás futtatás beállításához) részben válassza ki a cél
protokollt és lemezfájlokat az Experiment Setup (Kísérlet beállítás) ablakban való
megjelenéshez.

5. A Data File (Adatfájl) részben definiálja az adatfájlok elő- és/vagy utótagját. Bármelyik részhez
válasszon ki egy új értéket saját legördülő listájából. Egyéni előtag és utótag értékeket is
megadhat a Prefix (Előtag) és Suffix (Utótag) szövegmezőkben.

A CFX Manager Dx megjeleníti az új fájlnév előnézetét a kiválasztó ablakok alatt.

6. A módosítások mentéséhez és a párbeszédpanel bezárásához kattintson az OK gombra.

Fontos: Ha a User Preferences (Felhasználói preferenciák) párbeszédpanelen a Restore
Defaults (Visszaállítás az alapértelmezett beállításokra) elemre kattint, akkor a rendszer az
összes fülön visszaállítja az összes preferenciát az eredeti, gyári beállításokra. Legyen
körültekintő, ha erre a gombra kattint.
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A protokollra vonatkozó alapértelmezett paraméterek beállítása

Az alapértelmezett protokollparaméterek beállítása a Protocol Editor (Protokoll
szerkesztő) és a Protocol AutoWriter (Protokollíró varázsló) eszközökhöz

1. Válassza ki a Users > User Preferences (Felhasználók > Felhasználói preferenciák) elemet a
User Preferences (Felhasználói preferenciák) párbeszédpanel megnyitásához.

2. A User Preferences (Felhasználói preferenciák) párbeszédpanelen válassza ki a Protocol
(Protokoll) fület.

3. A Protocol Editor (Protokoll szerkesztő) szakaszban határozza meg a Protocol Editor (Protokoll
szerkesztő) ablakban megjelenő következő beállítások értékeit:

n Sample volume (Mintatérfogat) – a cellákban található egyes minták térfogata (µl
mértékegységben kifejezve).

n Lid Shutoff temperature (Kikapcsolási fedélhőmérséklet) – az a hőmérséklet (ºC
mértékegységben kifejezve), amelyen a fedélfűtő futtatás közben kikapcsolódik.

4. A Protocol AutoWriter (Automatikus protokollíró) szakaszban határozza meg a Protocol
AutoWriter (Automatikus protokollíró) ablakban megjelenő következő beállítások értékeit:

n Annealing temperature (Izzítási hőmérséklet) – a ºC mértékegységben kifejezett
hőmérséklet az iProof DNS polimerázt, iTaq DNS polimerázt vagy egyéb polimerázokat
használó kísérletekhez.

n Amplicon length (Amplikonhosszúság) – az amplikon hosszúsága bázispárokban (bp)
kifejezve.
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5. A módosítások mentéséhez és a párbeszédpanel bezárásához kattintson az OK gombra.

Fontos: Ha a User Preferences (Felhasználói preferenciák) párbeszédpanelen a Restore
Defaults (Visszaállítás az alapértelmezett beállításokra) elemre kattint, akkor a rendszer az
összes fülön visszaállítja az összes preferenciát az eredeti, gyári beállításokra. Legyen
körültekintő, ha erre a gombra kattint.

A lemezre vonatkozó alapértelmezett paraméterek beállítása

A Plate (Lemez) fülön Ön által végrehajtott módosítások a szoftver összes felhasználójának a
rendelkezésére állnak. A lemezbeállítás során Ön által végrehajtott módosítások azt követően állnak
a felhasználók rendelkezésére, hogy Ön elmentette és bezárta a lemezfájlt.

A User Preferences (Felhasználói preferenciák) párbeszédpanelen a következőket végezheti el:

n Alapértelmezett lemezparaméterek beállítása.

n Új célérték és minta nevek hozzáadása saját könyvtáraikhoz.

n A célérték és minta nevek törlése saját könyvtáraikból.

Az alapértelmezett lemezparaméterek beállításához

1. Válassza ki a Users > User Preferences (Felhasználók > Felhasználói preferenciák) elemet a
User Preferences (Felhasználói preferenciák) párbeszédpanel megnyitásához.

2. A User Preferences (Felhasználói preferenciák) párbeszédpanelben válassza ki a Plate (Lemez)
fület.
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3. Határozza meg a következő beállítások értékeit egy új lemezfájlhoz. Ezek az értékek jelennek
meg a Plate Editor (Lemez szerkesztő) ablakban:

n Lemeztípus

n Lemezméret

n Egységek—a standardot tartalmazó cellák indítási sablonjának a koncentrációja.

A CFX Manager Dx ezeket az egységeket egy standard görbe létrehozására használja a
Data Analysis Quantification (Adatelemzés kvantifikálás) fülön.

n Scientific notation (Tudományos jelölés) — ha ez van kiválasztva, akkor a CFX Manager
Dx a koncentráció egységeket tudományos jelölés formában jeleníti meg.

n Scan mode (Leolvasási mód) — a leolvasandó csatornák száma és típusa futtatás közben.

n Fluorophores (Fluorofórok) — a „Plate Editor” (Lemez szerkesztő) cellabetöltő vezérlőiben
megjelenő alapértelmezett fluorofórok.

n Libraries (Könyvtárak) — az Ön által a kísérleteiben jellemzően használt célérték és minta
nevek:

o Target names (Célértéknevek) — a célgének és szekvenciák nevei.

o Sample names (Minta nevek) — a kísérleti minták nevei vagy egy azonosító jellemző a
mintákhoz (pl. Egér1, Egér2, Egér3).

4. A módosítások mentéséhez és a párbeszédpanel bezárásához kattintson az OK gombra.

Egy új célérték vagy minta név hozzáadásához

u A könyvtár megfelelő mezőjébe írja be a nevet a célhoz vagy mintához, és kattintson az OK
gombra.

Egy célérték vagy minta név törléséhez

u Amegfelelő könyvtár mezőben válassza ki a nevet és nyomja meg a Delete (Törlés) gombot,
majd kattintson az OK (Rendben) gombra.

Fontos: A könyvtárból törölt nevek véglegesen eltávolításra kerülnek a szoftverből, és többé nem
állnak a felhasználók rendelkezésére. Az alapértelmezett CFX Manager Dx nevek
visszaállításához kattintson a Restore Defaults (Alapértelmezett beállítások visszaállítása)
gombra. Ha a User Preferences (Felhasználói preferenciák) párbeszédpanelen a Restore
Defaults (Visszaállítás az alapértelmezett beállításokra) elemre kattint, akkor a rendszer az
összes fülön visszaállítja az összes preferenciát az eredeti, gyári beállításokra. Járjon el
körültekintően az alapértelmezett CFX Manager Dx nevek törlésénél és ennek a gombnak a
megnyomásánál.
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Az adatelemzésre vonatkozó alapértelmezett paraméterek beállítása

Az alapértelmezett adatelemzési paraméterek beállításához

1. Válassza ki a Users > User Preferences (Felhasználók > Felhasználói preferenciák) elemet a
User Preferences (Felhasználói preferenciák) párbeszédpanel megnyitásához.

2. A User Preferences (Felhasználói preferenciák) párbeszédpanelben válassza ki a „Data
Analysis” (Adatelemzés) fület.

3. Az Analysis Mode (Analízis mód) részben válassza ki azt a módot, amellyel elemezni kívánja az
adatokat (vagy Fluorophore (Fluorofór), vagy Target (Célérték)).

4. A PCR Quantitation (PCR kvantitáció) részben állítsa be az alapértelmezett paramétereket a
következő opciókhoz:

n Baseline Setting (Kiindulási érték beállítása) — a kiindulási érték módszer az analízis
módhoz.

n Cq Determination Mode (Cq meghatározás mód) — az a mód, amelyben a Cq értékek az
egyes fluoreszcencia jelvonalakhoz kerülnek kiszámításra (vagy regresszió, vagy egyetlen
küszöbérték).
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n Threshold Calc. Mode (Küszöbérték számítási mód) — a végpont cél mennyiség.

Az alapértelmezett mód az Auto (Automatikus). Azaz a szoftver automatikusan kiszámítja a
végpont célt. Egy megadott küszöbérték beállításához ürítse ki az Auto (Automatikus)
jelölőnégyzetet, és írja be saját végpont mennyiségét relatív fluoreszcencia egységekben
(RFE) kiszámítva. A maximális érték 65000,00 RFE. Az adatfájlok a további futtatásokban
ezt a küszöbérték-beállítást fogják használni.0

n Baseline Calc. Mode (Alapvonal számítási mód) — az alapvonal érték az összes
jelvonalhoz.

Az alapértelmezett mód az Auto (Automatikus). Azaz a szoftver automatikusan kiszámítja az
alapvonalat az összes jelvonalhoz. Egy meghatározott alapvonal érték beállításához ürítse ki
az Auto (Automatikus) jelölőnégyzetet, és írja be a minimum és maximum értékeket a ciklus
tartományhoz (1-től 9999-ig). Az adatfájlok a további futtatásokban ezt a ciklustartományt
fogják használni.

n Log View (Log nézet) — azt határozza meg, hogy a szoftver hogyan ábrázolja az
amplifikációs adatokat:

o On (Be) — az amplifikációs adatok egy fél-logaritmikus diagramon vannak ábrázolva.

o Off (Ki) — (az alapértelmezett mód) az amplifikációs adatok egy lineáris grafikonban
vannak ábrázolva.

5. Az End Point (Végpont) részben válassza ki a végciklusok számát átlagra a végpont
számításoknál:

n PCR —a végciklusok száma az átlaghoz képest a kvantifikációs adatokhoz (az
alapértelmezett 5).

n End Point Only run (Csak végpontok futtatása) — a végpontok száma átlagra végpont
adatokhoz (az alapértelmezett 2).

6. A Melt Curve (Olvadási görbe) részben válassza ki a detektálandó csúcs típust (vagy pozitív,
vagy negatív).

7. A Well Selector (Cellaválasztó) részben válassza ki, hogyan legyenek megjelenítve a cellacímkék
(mintatípus, célnév, vagy mintanév szerint).

8. A módosítások mentéséhez és a párbeszédpanel bezárásához kattintson az OK gombra.

Fontos: Ha a User Preferences (Felhasználói preferenciák) párbeszédpanelen a Restore
Defaults (Visszaállítás az alapértelmezett beállításokra) elemre kattint, akkor a rendszer az
összes fülön visszaállítja az összes preferenciát az eredeti, gyári beállításokra. Legyen
körültekintő, ha erre a gombra kattint.
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A génexpresszió-adatfájlra vonatkozó alapértelmezett paraméterek beállítása

Az alapértelmezett paraméterek beállítása egy új génexpresszió-adatfájlhoz

1. Válassza ki a Users > User Preferences (Felhasználók > Felhasználói preferenciák) elemet a
User Preferences (Felhasználói preferenciák) párbeszédpanel megnyitásához.

2. A User Preferences (Felhasználói preferenciák) párbeszédpanelen válassza ki a Gene
Expression (Génexpresszió) fület.

3. Határozza meg a következő beállítások értékeit:

n Relative to (Viszonyítási alap) – a génexpresszió-adat grafikus ábrázolása egy 1-es
origójú kontrollhoz vagy nullához viszonyítva:

o Zero (Nulla) – a szoftver figyelmen kívül hagyja a kontrollt. Ez az alapértelmezett
beállítás olyankor, amikor az Experiment Settings (Kísérlet beállítások) ablakban nincs
hozzárendelve kontroll minta.

o Control (Kontroll) – a szoftver az Experiment Setup (Kísérletbeállítás) ablakban
hozzárendelt kontroll mintához viszonyítva számítja ki az adatokat.

n X-axis (X-tengely) – a minta vagy a célérték grafikus ábrázolása az X-tengelyen.
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n Y-axis (Y-tengely) – a lineáris, a log2 vagy a log10 skála grafikus ábrázolása az Y-
tengelyen.

n Scaling (Skálázás) – a grafikonhoz kapcsolódó skálázási opció (az alapértelmezett opció:
Unscaled (Nem skálázott)):

o Highest (Legmagasabb) – a szoftver a legmagasabb adatponthoz skálázza a
grafikont.

o Lowest (Legalacsonyabb) – a szoftver a legalacsonyabb adatponthoz skálázza a
grafikont.

o Unscaled (Nem skálázott) – a szoftver skálázás nélkül ábrázolja az adatot a
grafikonon.

n Mode (Mód) – az elemzés módja: relatív mennyiség (∆Cq) vagy normalizált expresszió
(∆∆Cq).

n Error Bar (Hibasáv) – az adatvariabilitás szórásként (Std. Dev.) vagy a középérték standard
hibájaként (Std. Error Mean) ábrázolva.

n Error Bar Multiplier (Hibasávszorzó) – a standard deviációs szorzó, amelyet a rendszer a
hibasávok grafikus ábrázolásához használ (az alapértelmezett érték: 1).

A szorzót a következő értékekre növelheti: 2 vagy 3.

n Sample Types to Exclude (Kizárni kívánt mintatípusok) – az elemzésből kizárni kívánt
mintatípusok.

Egy vagy több mintát is választhat, amelye(ke)t ki szeretne zárni az elemzésből. Ha az
összes mintatípust ki szeretné zárni, akkor törölje a kijelölt mintatípusok jelölőnégyzeteiből a
jelölést.

4. A módosítások mentéséhez és a párbeszédpanel bezárásához kattintson az OK gombra.

Fontos: Ha a User Preferences (Felhasználói preferenciák) párbeszédpanelen a Restore
Defaults (Visszaállítás az alapértelmezett beállításokra) elemre kattint, akkor a rendszer az
összes fülön visszaállítja az összes preferenciát az eredeti, gyári beállításokra. Legyen
körültekintő, ha erre a gombra kattint.

A minőség-ellenőrzési szabályok testreszabása

A CFXManager Dxszoftverben minőségellenőrzési szabályokat állíthat be, amelyeket a rendszer a
Data Analysis (Adatelemzés) ablakban levő adatokra alkalmaz. A szoftver az Ön által beállított
szabályokkal szemben validálja az adatokat.

Megjegyzés: Alapértelmezettként az összes minőség-ellenőrzési szabály engedélyezve van.
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Tipp: A Data Analysis (Adatelemzés) ablak QCmoduljában egyszerűen kizárhatja azokat a
cellákat az elemzésből, amelyek nem felelnek meg egy QC paraméternek.

A minőség-ellenőrzési szabályok testreszabásához

1. Válassza ki a Users > User Preferences (Felhasználók > Felhasználói preferenciák) elemet a
User Preferences (Felhasználói preferenciák) párbeszédpanel megnyitásához.

2. A User Preferences (Felhasználói preferenciák) párbeszédpanelben válassza ki a QC (Minőség-
ellenőrzés) fület.

ahol:

n NTC—sablon nélküli kontroll

n NRT— reverz transzkriptáz nélküli kontroll

n Efficiency (Hatásfok) — a reakció hatásfoka

n Std Curve R^2—a standard görbe R négyzet értéke

n Replicate group Cq Std Dev (Replikátum csoport) Cq Std Dev— az egyes replikátum
csoportokhoz kiszámított szórás
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3. Mindegyik QC (Minőség-ellenőrzés) szabályhoz végezze el az alábbiak egyikét:

n Az alapértelmezett érték használatához ne tegyen semmit.

n Az érték módosításához kattintson annak Value (Érték) szövegmezőjébe, írjon be egy új
értéket, és nyomja meg az Enter gombot.

n A szabály letiltásához ürítse ki annak Use (Használat) jelölőnégyzetét.

4. A módosítások mentéséhez és a párbeszédpanel bezárásához kattintson az OK gombra.

Fontos: Ha a User Preferences (Felhasználói preferenciák) párbeszédpanelen a Restore
Defaults (Visszaállítás az alapértelmezett beállításokra) elemre kattint, akkor a rendszer az
összes fülön visszaállítja az összes preferenciát az eredeti, gyári beállításokra. Legyen
körültekintő, ha erre a gombra kattint.

Az adatexportálásra vonatkozó paraméterek testreszabása

A CFXManager Dx adatokat a következő formátumban exportálhatja:

n Szöveg (.txt)

n CSV (.csv)

n Excel 2007 (.xlsx)

n Excel 2003 (.xls)

n XML (.xml)

n HTML (.html)

Megadhatja az exportálandó adatok típusát, és testre szabhatja az exportált adatok outputját.
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Az export paraméterek tesztre szabásához

1. Válassza ki a Users > User Preferences (Felhasználók > Felhasználói preferenciák) elemet a
User Preferences (Felhasználói preferenciák) párbeszédpanel megnyitásához.

2. A User Preferences (Felhasználói preferenciák) párbeszédpanelben válassza ki a Custom Export
(Egyedi exportálás) fület.

3. Az Export Format (Export formátum) legördülő listán válassza ki az adatok exportálási
formátumát.

4. A Data to Export (Exportálandó adatok) részben jelölje be vagy ürítse ki az exportálandó adatok
típusainak a jelölőnégyzeteit. A kiválasztott elemek megjelennek az Exported Columns (Exportált
oszlopok) lista mezőben.

Megjegyzés: Alapértelmezettként a futtatási információk szerepelnek a fejlécben. Ha nem
akarja szerepeltetni a futtatási információkat, akkor ürítse ki ezt a jelölőnégyzetet.

5. Módosíthatja a kiválasztott elemek output megjelenítési sorrendjét

Az Exported Columns (Exportált oszlopok) lista mezőben emelje ki az elemet, majd kattintson a
listától balra levő nyíl gombokra annak felfelé vagy lefelé mozgatásához.
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6. Opcionálisan módosíthatja a kiválasztott elemek output oszlop neveit:

a. Kattintson a Customize Column Names (Oszlopnevek testreszabása) opcióra.

Megjelenik a Column Name Customizer (Oszlop nevét testreszabó) párbeszédpanel.

b. Minden módosítani kívánt alapértelmezett oszlop névhez írja be az új nevet annak Custom
Name (Egyedi név) mezőjébe.

c. Végezze el az alábbiak egyikét:

n Kattintson az OK gombra a módosítások elmentéséhez és a Custom Export
(Testreszabott export) fülre való visszatéréshez. Az új név zárójelben jelenik meg az
alapértelmezett oszlopnév mellett az Exported Columns (Exportált oszlopok) lista
mezőben.

n Kattintson a Cancel (Mégse) gombra a módosítások kiürítéséhez és a Custom Export
(Testreszabott export) fülre való visszatéréshez.

7. A módosítások mentéséhez és a párbeszédpanel bezárásához kattintson az OK gombra.

Fontos: Ha a User Preferences (Felhasználói preferenciák) párbeszédpanelen a Restore
Defaults (Visszaállítás az alapértelmezett beállításokra) elemre kattint, akkor a rendszer az
összes fülön visszaállítja az összes preferenciát az eredeti, gyári beállításokra. Legyen
körültekintő, ha erre a gombra kattint.

Kezelési kézikönyv | 81



5. fejezet A Home (Kezdőlap) ablak

Reakció master mix létrehozása
A CFXManager Dx Master Mix Calculator (Master mix kalkulátor) eszközének a segítségével
könnyen kiszámíthatja, hogy az egyes komponsekből mennyire van szükség a master mix
elkészítéséhez. A mastermix-számítási táblát kinyomtathatja az alapértelmezett nyomtatója
segítségével, valamint az egyes célértékekhez tartozó számításokat elmentheti későbbi használat
céljából.

Reakció master mix létrehozása a Master Mix Calculator (Master mix kalkulátor)
segítségével

1. A Master Mix Calculator (Master mix kalkulátor) megnyitásához tegye a következők egyikét:

n Válassza ki a Tools > Master Mix Calculator (Eszközök > Master mix kalkulátor) elemet.

n Kattintson a Master Mix Calculator (Master mix kalkulátor) elemre az eszköztárban.

Megjelenik a Master Mix Calculator (Master mix kalkulátor).
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2. A Reaction (Reakció) szakaszban válasszon egy detektálási módszert:

n SYBR®Green/EvaGreen

n Probes (Szondák)

3. Új célérték létrehozásához a Target (Célérték) szakaszban kattintson a Create New (Új
létrehozása) elemre. A célértékek legördülő listájában megjelenik egy új célértéknév.

4. (Opcionális) Az alapértelmezett célértéknév módosítása:

a. Jelölje ki a célérték nevét a célértékek legördülő listájában.

b. Írjon be egy új célértéknevet a Target (Célérték) mezőbe.

c. Nyomja le az Enter (Bevitel) billentyűt.

5. Állítsa be a kezdési és a végső koncentrációkat a forward és a reverz primekhez és az esetleges
szondákhoz.

6. A Master Mix Setup (Master mix beállítása) szakaszban állítsa be a következő paraméterek
értékeit:

n Futtatni kívánt reakciók száma

n Cellánkénti reakciós térfogat

n Cellánkénti sablontérfogat

n Cellánkénti supermix koncentráció

n Cellánkénti reakciós többlettérfogat

7. (Opcionális) Végezze el a 2–6. lépéseket annyi célértékhez, amennyihez szükséges.

8. A Choose Target to Calculate (Kiszámítani kívánt célérték kiválasztása) szakaszban válassza ki
a kiszámítani kívánt célértéket.

Tipp: Egyidejűleg csak egy, több vagy az összes célértéket számíthatja ki.

Az egyes kiválasztott célértékekhez szükséges komponensek kiszámított térfogatai megjelennek
a master mix táblában.

9. Ha a Target (Célérték) és a Master Mix Setup (Master mix beállítása) szakaszban beírt
mennyiségeket szeretné beállítani új alapértelmezett értékekként, akkor kattintson a Set as
Default (Beállítás alapértelmezettként) elemre.

10. Kattintson az OK gombra, ha el szeretné menteni a Master Mix Calculator (Master mix kalkulátor)
párbeszédpanel tartalmát.
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A mastermix-számítási tábla kinyomtatása

u Ha szeretne kinyomtatni egy mastermix-számítási táblát, akkor kattintson a Print (Nyomtatás)
elemre.

A rendszer a számítási táblát az Ön alapértelmezett nyomtatójának a segítségével nyomtatja ki.

A mastermix-számítási tábla PDF-fájlként történő mentése

u Módosítsa az alapértelmezett nyomtatóját egy PDF-meghajtóra, majd a Master Mix Calculator
(Master mix kalkulátor) párbeszédpanelen kattintson a Print (Nyomtatás) elemre.

Célértékek törlése

u Válassza ki a célértéket a célértékek legördülő listájának a segítségével, majd kattintson a
Remove (Eltávolítás) elemre.

Fontos: Ha egy célértéket eltávolít a célértékek listájából, akkor a rendszer az adott
célértéket azokból a mastermix-számításokból is eltávolítja, amelyekben az adott célérték
esetlegesen használva van. Legyen körültekintő a célértékek törlésekor.
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Új festékek kalibrálása
A CFX96 Dx rendszerek a fehércellás és átlátszó cellás lemezekben általánosan használt
fluorofórokhoz gyárilag kalibrálva vannak. Az 11. táblázat azokat a fluorofórokat és csatornát sorolja fel,
amelyhez az egyes műszerek kalibrálva vannak.

Megjegyzés: A CFX96 rendszerek egy FRET kémiához rendelt csatornát is tartalmaznak. Ez a
csatorna nem igényel kalibrációt a specifikus festékekhez.

Fluorofórok Csatorna Gerjesztés, nm Detektálás, nm

FAM, SYBR® Green I 1 450-490 515-530

VIC, HEX, CAL Fluor Gold 540, Cal
Fluor Orange 560

2 515-535 560-580

ROX, Texas Red, CAL Fluor Red
610, TEX 615

3 560-590 610-650

CY5, Quasar 670 4 620-650 675-690

Quasar 705, Cy5.5 5 672-684 705-730

11. táblázat. Gyárilag kalibrált fluorofórok valamint csatornák

Új festékek CFX rendszerekhez történő kalibrálásához

1. A Home (Kezdőlap) ablakban válasszon ki egy cél műszert a Detected Instruments (Felismert
készülékek) táblában.

2. Válassza ki a Tools > Calibration Wizard (Eszközök > Kalibráció varázsló) lehetőséget a Dye
Calibration (Festék kalibrálás) varázsló megnyitásához.
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A cél műszerhez már kalibrált fluorfórok megjelennek a Calibrated Fluorophores (Kalibrált
fluorofórok) táblázatban.

3. A Calibrate New or Existing Fluorophores (Új vagy létező fluorofórok kalibrálása) részben
válassza ki a kalibrálandó fluorofórt a legördülő listából.

Ha a fluorofór neve nem szerepel a listában, akkor írja be annak nevét a szövegablakba a listához
való hozzáadáshoz.

4. Válassza ki a lemeztípust a fluorofórhoz.

Ha a lemeztípus nem szerepel a listában, akkor írja be annak nevét a szövegablakba a listához
való hozzáadáshoz.

5. Válasszon ki egy csatornát a fluorofórhoz.

6. Válasszon ki egy lemez oszlopot a fluorofórhoz.

7. (Opcionális) Írjon be egy színt a fluorofórhoz rendeléshez.

8. Kattintson az Add to Plate (Hozzáadás lemezhez) gombra a fluorofór hozzáadásához.

9. (Opcionális) Ismételje meg a 3—8 lépéseket az lemezhez kalibrálni tervezett egyes fluorofórok
hozzáadásához.

10. Amikor befejezte a fluorofórok hozzáadását, kattintson a View Plate (Lemez megtekintése)
gombra a Pure Dye Plate Display (Tiszta festék lemez megjelenítés) ablak megjelenítéséhez.

Használja ezt az ablakot útmutatóul a festékek lemezekbe történő betöltéséhez.

11. Készítsen elő egy 96-cellás lemezt a festék kalibráláshoz:

a. Pipettázzon festékoldatot az egyes cellákba, a Pure Dye Plate Display (Tiszta festék lemez
megjelenítés) képen látható minta szerint.

b. Minden fluorofórhoz töltsön négy cellába 50 µl (96-cellás lemez) 300 nM festékoldatot.
Megjegyzendő, hogy a lemeznek legalább a fele üres cellákat tartalmaz.

c. Zárja le a lemezt a kísérleténél használandó tömítési módszer alkalmazásával.

12. Helyezze a kalibrációs lemezt a blokkba és zárja le a fedelet.

13. A Dye Calibration (Festék kalibrálás) varázslóban kattintson a Calibrate (Kalibráció) és OK
(Rendben) gombokra annak megerősítéséhez, hogy a lemez a blokkban van.

14. Amikor a CFX Manager Dx szoftver végrehajtotta a kalibrálás futását, megjelenik egy
párbeszédpanel. Kattintson a Yes (Igen) gombra a kalibrálás befejezéséhez és nyissa meg a Dye
Calibration Viewer (Festék kalibrálás megtekintés) ablakot.

15. Kattintson az OK (Rendben) gombra az ablak bezárásához.
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Egy protokoll egy meghatározott sorrendben végrehajtott lépések összessége. A CFX Manager Dx
szoftverben valamennyi lépés a műszeren levő opciókhoz van rendelve. A lépések például a műszert
a blokk- és fedélhőmérséklet szabályzására, a blokkban hőmérséklet-különbség alkalmazására,
lemez leolvasására, vagy olvadási görbe elemzésének végrehajtására utasítják. Minden opció
különböző lemez- és lefutástípusokhoz van specifikálva.

A CFX Manager Dx két opciót biztosít a protokollok létrehozásához: Protocol Editor (Protokoll
szerkesztő) és Protocol AutoWriter (Automatikus protokollíró).

A Protocol Editor (Protokoll szerkesztő) jellemzői a következők :

n Standard protokollvezérlők a protokollok gyors létrehozásához

n Grádiens gyors kiszámításának lehetősége a kiválasztott sorokhoz

n Futtatási idő gyors kiszámításának lehetősége a kiválasztott lemeztípushoz

n Protokolllépések szerkesztésének lehetősége

n Protokollok elmentésének a lehetősége újrafelhasználáshoz

n A protokoll alapértelmezett nyomtatón történő kinyomtatásának a lehetősége

A Protocol AutoWriter (Automatikus protokollíró) az Ön által megadott paraméterek felhasználásával
automatikusan generál egy testreszabott PCR protokollt a következő lépésekkel: forróindítás, kezdeti
denaturálás, kapcsolódás, valamint kiterjesztés. Megtekintheti a javasolt protokoll grafikus
ábrázolását, valamint szerkesztheti, futtathatja vagy elmentheti a protokollt.
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Protocol Editor (Protokoll szerkesztő) ablak
A Protocol Editor (Protokoll szerkesztő) ablakot használja protokollok létrehozására, megnyitására,
áttekintésére, és szerkesztésére. A Protocol Editor (Protokoll szerkesztő) alapértelmezettként egy
általános, valós idejű, 2 lépéses, 96 cellás lemezhez szolgáló protokoll megjelenítésével nyílik meg.

1. A menüsor gyors hozzáférést biztosít a File (Fájl), Settings (Beállítások), és Tools
(Eszközök) menüparancsokhoz.

2. Az eszközsor gyors hozzáférést biztosít a protokoll elmentéséhez és kinyomtatásához,
annak meghatározásához, hogy hova illesszen be egy lépést, a mintatérfogat
beállításához, és a becsült protokollfuttatási idő megtekintéséhez.

3. A fő panel a protokoll grafikus ábrázolását mutatja.

4. Az alsó panel a protokoll körvonalát mutatja.

5. A bal oldali panel a protokoll kontrollokat mutatja, amelyeket hozzáadhat a protokoll
testreszabásához.

JELMAGYARÁZAT

File (Fájl) menüparancsok
Save (Mentés) – az aktuális protokoll mentése.
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Save As (Mentés másként) – az aktuális protokoll mentése új névvel vagy egy új helyre.

Close (Bezárás) – a Protocol Editor (Protokollszerkesztő) ablak bezárása.

A Settings (Beállítások) menüpontban található parancs
Lid Settings (Fedélbeállítások) – a Lid Setting (Fedélbeállítás) párbeszédpanel megnyitása,
amelyen Ön beállíthatja vagy módosíthatja a fedélhőmérsékletet.

A Tools (Eszközök) menüpontban található parancsok
Gradient Calculator (Gradiens kalkulátor) – egy párbeszédpanel megnyitása, amelynek a
segítségével kiválaszthatja a blokktípust egy gradiens lépéshez. Az alapértelmezett beállítás: 96
cella.

Run time Calculator (Futtatási idő kalkulátor) – egy párbeszédpanel megnyitása, amelynek a
segítségével Ön kiválaszthatja a lemeztípust és a leolvasási módot, hogy a rendszer a Run Setup
(Futtatás beállításai) ablakban kiszámíthassa a becsült futtatási időt. Az alapértelmezett beállítás: 96
cella, összes csatorna.

Az eszköztárban található parancsok

– az aktuális protokollfájl mentése.

– a kiválasztott ablak nyomtatása.

– ennek a parancsnak a segítségével kiválaszthatja, hogy a rendszer az
aktuálisan kiválasztott lépéshez viszonyítva hova illesszen be lépéseket.

– ennek a parancsnak a segítségével beírhat egy mintatérfogatot µl
mértékegységben. A mintatérfogatok a tömbtípustól függően eltérők:

n 96 mélycellás blokk esetében a tartomány: 0–125 µl.

n 96 cellás blokk esetében a tartomány: 0–50 µl.

– a protokoll-lépések, a növekedési/csökkenési sebesség, valamint a
kiválasztott blokktípus alapján a becsült futtatási idő megjelenítése.
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– a protokollokra vonatkozó súgóinformációk megjelenítése.

Protokollszerkesztési vezérlők
A Protocol Editor (Protokoll szerkesztő) ablak bal oldali panelén olyan vezérlők találhatók, amelyek
segítségével Ön protokollokat hozhat létre.

Az egyes vezérlők olyan paraméterekből tevődnek össze, amelyek a protokoll egy-egy lépését
alkotják. Protokollját testreszabhatja az egyes paraméterek módosításával, valamint hozzáadásukkal
vagy eltávolításukkal. A jelen szakaszban az egyes vezérlőkben található opciókat mutatjuk be.

n Insert Step (Lépés beillesztése) – egy lépés beillesztése a
kiválasztott lépés elé vagy mögé. A hőmérsékletre és a tartásidőre
vonatkozó értékeket a protokoll grafikus kijelzőjén és a protokoll
áttekintő nézetében is szerkesztheti.

n Insert Gradient (Gradiens beilesztése) – egy gradiens lépés
beillesztése a gradiens kalkulátorban kiválasztott lyuktömb típusa
alapján. A gradienstartományt a Gradient (Gradiens) panelen
szerkesztheti; ez a panel egy gradiens lépés beillesztésekor jelenik
meg.

n Insert GOTO (GOTO beillesztése) – egy ciklikus (hurok) lépés
beillesztése, amely tájékoztatja a szoftvert, hogy meghatározott

számú cikluson keresztül ismételje egy szekvencia meghatározott lépéseit. Az ismétlések akkor
kezdődnek, miután az első ciklus befejeződik. Például tájékoztathatja a szoftvert, hogy 39
alkalommal ismételje meg a 2–4. lépéseket. Az utolsó ismétlés végére a szoftver összesen 40
alkalommal végzi el a 2–4. lépéseket. A visszatérési (GOTO (lépj)) lépést és a ciklusok számát a
protokoll grafikus kijelzőjén és a protokoll áttekintő nézetében is szerkesztheti.

n Insert Melt Curve (Olvadási görbe beillesztése) – egy olvadásigörbe-leolvasási lépés
beillesztése.

n Insert Plate Read to Step (Lemezleolvasás beillesztése a lépéshez) – egy lemezleolvasási
parancs hozzáadása a kiválasztott lépéshez. A lemezleolvasás funkció célja a fluoreszcencia
mennyiségének a mérése egy ciklus végén. A lemezleolvasási lépés általában az utolsó lépés
egy GOTO (Lépj) hurokban.

Tipp: Ha egy lépéshez hozzáad egy lemezleolvasási parancsot, akkor az adott lépés
kiválasztásakor a gomb a következőre változik: Remove Plate Read (Lemezleolvasás
eltávolítása).
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n Remove Plate Read (Lemezleolvasás eltávolítása) – egy lemezleolvasási parancs eltávolítása
a kiválasztott lépésből.

Tipp: Ha egy lépésből eltávolít egy lemezleolvasási parancsot, akkor az adott lépés
kiválasztásakor a gomb a következőre változik: Add Plate Read to Step (Lemezleolvasás
hozzáadása a lépéshez).

n Step Options (Lépésopciók) – a Step Options (Lépésopciók) párbeszédpanel megnyitása és a
kiválasztott lépéshez elérhető opciók megjelenítése. A lépésopciókra vonatkozó részletes
információkért lásd: Step Options (Lépésopciók) a(z) 91. oldalon.

Tipp: A Step Options (Lépésopciók) párbeszédpanel úgy is elérhető, ha a grafikus kijelzőn a
jobb egérgombbal rákattint a lépésre.

n Delete Step (Lépés törlése) – a kiválasztott lépés törlése a protokollból.

Step Options (Lépésopciók)

Nyissa meg a Step Options (Lépés opciók) párbeszédpanelt azoknak az opcióknak a
megtekintéséhez, amelyeket hozzáadhat, módosíthat, vagy eltávolíthat egy lépésből.

n Plate Read (Lemez leolvasása) — kiválasztásakor hozzáad egy lemezleolvasást a lépéshez.

n Temperature (Hőmérséklet) — beállítja a célhőmérsékletet a kiválasztott lépéshez.

n Gradient (Grádiens) — beállítja a grádienstartományt a lépéshez; a tartomány 1–24 °C.

Megjegyzés: Egy grádiens a blokk elején levő legalacsonyabb hőmérséklettel (ezen a
képen a „H” sor) és a blokk hátulján levő legmagasabb hőmérséklettel (ezen a képen az „A”
sor) fut.
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n Increment (Növekedés) — a kiválasztott lépés hőmérsékletének növelésének (vagy
csökkentésének) a mértéke; ez a mennyiség érték hozzáadásra kerül a célhőmérséklethez
mindegyik ciklussal. A tartomány ±0,1–10 °C.

Megjegyzés: A hőmérséklet csökkentéséhez írjon egy mínusz jelet (-) a számérték elé
(például: –5°C).

n Ramp Rate (Felfutási sebesség) — a felfutási sebesség a kiválasztott lépéshez; a tartomány a
blokk méretétől függ.

n Time (Idő) — a várakozási idő a kiválasztott lépéshez.

n Extend (Meghosszabbítás) — az idő mennyisége (mp-ben) a kiválasztott lépés
meghosszabbításához vagy csökkentéséhez; ez az opció hozzá van adva a várakozási időhöz
mindegyik ciklusban; a tartomány 1–60 mp.

n Beep (Sípszó) — ha ki van választva, akkor a lépés végén egy sípszó hallható.

Tipp: Ha egy olyan számot ír be, amely kívül esik az opció tartományán, a szoftver a számot
a tartományon belüli legközelebbi értékre módosítja.
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Protokoll létrehozása a Protocol Editor (Protokoll
szerkesztő) menüpontban

A Protocol Editor (Protokoll szerkesztő) segítségével Ön egyedi protokollfájlokat hozhat létre.
Továbbá lehetősége van a korábban mentett protokollfájlokat, illetve a(z) CFX Manager Dx szoftver
szoftverhez mellékelt minta protokollfájlokat szerkeszteni és elmenteni.

Új protokollfájl létrehozásához tegye a következőket:

n Nyisson meg egy protokollfájlt a Protocol Editor (Protokoll szerkesztő) ablakban.

Tipp: A Protocol Editor (Protokoll szerkesztő) ablakban egy új vagy egy meglévő protokollt is
megnyithat.

n Állítsa be az új protokollt.

n Adjon lépéseket a protokollhoz a protokollvezérlőket tartalmazó panelről.

n Állítsa be a lépések tulajdonságait.

n Mentse el a protokollt.

Tipp: Ha egy korábban mentett vagy egy minta protokollfájlból szeretne létrehozni egy új
protokollt, akkor lásd: Létező protokoll megnyitása a Protocol Editor (Protokoll szerkesztő)
segítségével a(z) 95. oldalon.

Új protokollfájl megnyitása a Protocol Editor (Protokoll
szerkesztő) menüpontban
A CFXManager Dx több opciót kínál egy új protokollfájl megnyitására:

n A Home (Kezdőlap) ablakból

n A Startup Wizard (Indítási varázsló) párbeszédpanelről

n A Run Setup (Futtatás beállításai) párbeszédpanelről

Új protokollfájl megnyitása a Home (Kezdőlap) ablakból

u Válassza ki a File > New > Protocol (Fájl > Új > Protokoll) elemet.

Megnyílik a Protocol Editor (Protokoll szerkesztő) ablak és rajta az alapértelmezett protokollfájl.

Tipp: Az alapértelmezett protokoll beállítására vonatkozó információkért lásd: Az
alapértelmezett fájlbeállítások módosítása a(z) 69. oldalon.

Kezelési kézikönyv | 93



6. fejezet Protokollok létrehozása

Új protokollfájl megnyitása a Startup Wizard (Indítási varázsló) párbeszédpanelről

1. A Home (Kezdőlap) ablakban tegye a következők egyikét a Startup Wizard (Indítási varázsló)
megnyitásához, ha az jelenleg nem látható a képernyőn:

n Válassza ki a View > Startup Wizard (Nézet > Indítási varázsló) elemet.

n Kattintson a Startup Wizard (Indítási varázsló) elemre az eszköztárban.

A Startup Wizard (Indítási varázsló) párbeszédpanelen alapértelmezés szerint a Run Setup
(Futtatás beállításai) fül jelenik meg és a CFX96 műszertípus van kiválasztva.

2. Ha szükséges, akkor válassza ki a műszer típusát a legördülő listából.

3. Kattintson a User-defined (Felhasználó által beállított) elemre, mint a futtatás típusára.

Megnyílik a Run Setup (Futtatás beállításai) párbeszédpanel és rajta a Protocol (Protokoll) fül,
amelyen az alapértelmezett protokollfájl látható.

4. Kattintson a Create New (Új létrehozása) elemre.

Megnyílik a Protocol Editor (Protokoll szerkesztő) ablak és rajta az alapértelmezett valós idejű
protokoll.

Új protokoll megnyitása a Run Setup (Futtatás beállításai) párbeszédpanelről

1. A Home (Kezdőlap) ablakban tegye a következők egyikét a Run Setup (Futtatás beállításai)
párbeszédpanel megnyitásához:

n Válassza ki a Run > User-defined Run (Futtatás > Felhasználó által beállított futtatás)
elemet.

n Kattintson a User-defined Run Setup (Felhasználó által meghatározott futtatás beállítása)
elemre az eszköztárban.

Megnyílik a Run Setup (Futtatás beállításai) párbeszédpanel és rajta a Protocol (Protokoll) fül,
amelyen az Ön alapértelmezett protokollfájlja látható.

2. Kattintson a Create New (Új létrehozása) elemre.

Megnyílik a Protocol Editor (Protokollszerkesztő) ablak és rajta az alapértelmezett valós idejű
protokoll.
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Létező protokoll megnyitása a Protocol Editor (Protokoll
szerkesztő) segítségével
A CFXManager Dx példa protokollfájlokat biztosít, amelyeket szerkeszthet és új testreszabott
protokollként elmenthet. Egy létező testreszabott protokollból új protokollt is létrehozhat.

Példa protokollfájl megnyitásához

1. A HomeWindow (Kezdőlap) ablakban válassza ki a File > Open > Protocol (Fájl > Megnyitás >
Protokoll) opciót.

A Windows Explorer alapértelmezettként a CFX Manager Dx Példa fájlok mappát nyitja meg.

2. Nyissa meg a Sample files (Minta fájlok) mappát. A következő mappákat láthatja:

n ConventionalProtocols— (Konvencionális protokollok) hagyományos PCR analízis példa
protokollfájljait tartalmazza.

n DataFiles (Adat Fájlok) — példa adatfájlokat tartalmaz, amelyeket a CFX Manager Dx
jellemzőinek a felderítéséhez használhat.

n MeltCalibration (Olvadás Kalibráció) — a Bio-Rad Precision Melt Analysis (Precíziós
olvadás analízis) szoftverrel használandó példa protokollfájlokat tartalmaz.

n Plates (Lemezek) — példa lemezfájlokat tartalmaz.

n RealTimeProtocols (Valós Idejű Protokollok) – példa protokollfájlokat tartalmaz valósidejű
PCR elemzéshez.

3. Nyissa meg a protokoll mappát a végrehajtani kívánt lefutás típushoz: azaz vagy a
ConventionalProtocols (Konvencionális Protokollok), vagy a RealTimeProtocols (Valós Idejű
Protokollok) mappát.

4. Válassza ki a megfelelő protokollt, és kattintson az Open (Megnyitás) gombra.

A példa protokoll megnyílik a Protocol Editor (Protokoll szerkesztő) ablakban.

5. Válassza ki a File > Save As (Fájl > Mentés másként) opciót, és mentse el a protokollt egy új
névvel vagy egy új mappába.
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Létező protokoll megnyitásához

1. A Home (Kezdőlap) ablakban tegye a következők egyikét:

n Válassza ki a File > Open > Protocol (Fájl > Megnyitás > Protokoll) opciót, és keresse meg
valamint válassza ki a cél protokollt, majd kattintson az Open (Megnyitás) gombra.

n Nyissa meg a Startup Wizard (Indítási varázsló) párbeszédpanelt és tegye a következők
egyikét:

o Amegjelenített protokoll szerkesztéséhez kattintson az Edit Selected (Kiválasztott
szerkesztése) gombra.

o Egy másik létező protokoll szerkesztéséhez kattintson a Select Existing (Meglévő
kiválasztása) opcióra, majd lépjen a cél fájlhoz.

A protokoll megnyílik a Protocol Editor (Protokoll szerkesztő) ablakban.

2. Válassza ki a File > Save As (Fájl > Mentés másként) opciót, és mentse el a protokollt egy új
névvel vagy egy új mappába.

Új protokoll beállítása
Tipp: Ha az Ön protokollfájlja tartalmazza a szükséges paramétereket (pl. ha egy létező
lemezfájlt szerkeszt), akkor átugorhatja ezt a részt. Ugorjon a Lépések hozzáadása egy
protokollhoz a(z) 98. oldalon.

Az új protokollfájlokhoz a következő paraméterek szükségesek:

n Blokk típusa

n A leolvasási mód kiválasztása a kiválasztott blokk típushoz

n Fedél hőmérséklete

n Minta térfogata
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A blokktípus beállítása

A CFXManager Dx a blokktípus alapján automatikusan kiszámítja a hőmérséklet-növekményeket a
gradiens lépésekhez.

Megjegyzés: A Protocol Editor (Protokoll szerkesztő) ablakban beállított lemeztípusnak
azonosnak kell lennie a reakciómodulban található lemez típusával.

A tömbtípus beállítása

u A Protocol Editor (Protokollszerkesztő) ablakban válassza a Tools > Gradient Calculator
(Eszközök > Gradiens kalkulátor) elemet, majd a megjelenő legördülő listában válassza ki a
megfelelő lemeztípust.

A leolvasási mód kiválasztása a kiválasztott blokktípushoz

A protokoll lefutási idejének meghatározásához válassza ki a célblokk típusát és leolvasási módját.

A blokktípus és a leolvasási mód kiválasztásához

u A Protocol Editor (Protokollszerkesztő) ablakban válassza ki a Tools > Run time Calculator
(Eszközök > Futtatási idő kalkulátor) opciót, és válassza ki a megfelelő lemeztípust és leolvasási
módot a megjelenő legördülő listából.

A fedélhőmérséklet módosítása

A(z) CFX Manager Dx 105,0 °C-ra állítja be az alapértelmezett fedélhőmérsékletet.

A protokoll szükségleteinek megfelelően az alapértelmezett beállítások módosíthatók, illetve a
fedélfűtés kikapcsolható.

Tipp: Az alapértelmezett fedélhőmérsékletet a User Preferences (Felhasználói preferenciák)
párbeszédablakban lehet módosítani. Lásd: A protokollra vonatkozó alapértelmezett
paraméterek beállítása a(z) 71. oldalon.

A fedélhőmérséklet módosításához

1. A Plate Editor (Lemez szerkesztő) ablakban válassza ki a Settings > Lid Settings (Beállítások >
Fedélbeállítások) lehetőséget.

Ekkor megjelenik a Lid Settings (Fedélbeállítások) párbeszédablak.
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2. Végezze el az alábbiak egyikét:

n Válassza ki a User Defined (Felhasználó által definiált) lehetőséget, és írjon be egy
hőmérséklet értéket a szövegmezőbe.

n Válassza ki a Turn Off Lid Heater (Fedélfűtés kikapcsolása) lehetőséget.

3. Kattintson az OK gombra a módosítások elfogadásához és a párbeszédablak bezárásához.

A mintatérfogat beállítása

A CFXManager Dx alapértelmezés szerint 25 µl értékre állítja az egyes cellák mintatérfogatát.
Mindazonáltal a(z) CFX Dx rendszer tartománya: 0–125 µl.

A műszer a kétféle hőmérséklet-szabályozási mód egyikének a segítségével határozza meg, hogy a
minta mikor éri el a célhőmérsékletet egy protokollban:

n Calculated mode (Kiszámított mód) – ha a mintatérfogat a blokknak megfelelő értékre van
állítva, akkor a műszer a mintatérfogat alapján számítja ki a minta hőmérsékletét. Ez a standard
mód.

n Block mode (Blokk mód) – amikor a mintatérfogat nulla (0) µl értékre van állítva, akkor a
műszer a minta hőmérsékletét a blokk mért hőmérsékletével azonosként rögzíti.

A mintatérfogat beállítása egy meghatározott tömbhöz

u A Plate Editor (Lemez szerkesztő) ablakban írja be a helyes értéket az eszköztárban található
Sample Volume (Mintatérfogat) szövegbeviteli mezőbe.

Tipp: Az alapértelmezett mintatérfogatot módosíthatja a User Preferences (Felhasználói
preferenciák) párbeszédpanelen. Lásd: Az alapértelmezett fájlbeállítások módosítása a(z) 69.
oldalon.

Lépések hozzáadása egy protokollhoz
Egy lépés hozzáadása egy protokollhoz

1. Nyissa meg a protokollt a Protocol Editor (Protokoll szerkesztő) ablakban.

2. Döntse el, hogy hova akarja beilleszteni az új lépést. Az eszköztárban válassza ki a Before (Előtt)
vagy After (Után) lehetőséget a „Step” (Lépés) legördülő listában.

3. Az ábrán válassza ki azt a lépést, amely elé vagy után kívánja beilleszteni az új lépést.

4. A bal oldali panelen kattintson az Insert Step (Lépés beszúrása) gombra.

5. A hőmérséklet vagy a megtartási idő módosításához kattintson az alapértelmezett értékre az
ábrán vagy a protokoll körvonalon, és írjon be egy új értéket.
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6. (Opcionális) A bal oldali panelen kattintson a Step Options (Lépés opciók) gombra a Step Options
(Lépés opciók) párbeszédablak megjelenítéséhez és módosítsa a kiválasztott lépéshez
rendelkezésre álló opciókat.

Tipp: A Step Options (Lépés opciók) párbeszédablakot vagy a grafikon panelen vagy a
protokoll leírása panelen levő jobb egérgomb-kattintási menüről érheti el.

7. A protokoll módosításainak elmentéséhez kattintson az OK gombra, majd a Yes (Igen) gombra.

Ekkor megjelenik a Save As (Mentés másként) párbeszédablak

8. A Save As (Mentés másként) párbeszédablakban írjon be egy nevet az új protokollfájlhoz, és
kattintson a Save (Mentés) gombra.

Gradiens lépés beillesztése
Gradiens lépés beillesztéséhez

1. Győződjön meg arról, hogy a gradiensre vonatkozó lemezméret megfelelő a műszer
blokktípusához, vagyis 96 cellás.

2. Ha eddig még nem tette meg, akkor most válassza ki a lemezméretet a gradienshez:

Válassza a Tools > Gradient Calculator (Eszközök > Gradiens kalkulátor) elemet, majd a
legördülő listából válassza ki a megfelelő cellatípust.

3. Az eszköztárban válassza ki a Before (Előtt) vagy az After (Után) elemet az Insert Step (Lépés
beillesztése) legördülő listából.

4. A grafikonon vagy az áttekintési panelen válassza ki azt a lépést, amely elé vagy mögé be
szeretné illeszteni a gradiens lépést.
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5. A bal oldali panelen kattintson az Insert Gradient (Gradiens beillesztése) elemre. A rendszer az új
gradiens lépést kiemeli a grafikonon és az áttekintési panelen. Például:

A gradiensben található egyes sorok hőmérséklete megjelenik a jobb oldali panelen található
Gradient (Gradiens) táblázatban.

6. A gradiens hőmérséklet-tartományának a szerkesztéséhez tegye a következők egyikét:

n Kattintson az alapértelmezett hőmérsékletre a grafikonon vagy az áttekintési panelen, és
írjon be egy új hőmérsékletet.

n Kattintson a Step Options (Lépésopciók) elemre, majd írja be a gradiens tartományát a Step
Options (Lépésopciók) ablakban.

n Módosítsa a Range (Tartomány) értéket a Gradient (Gradiens) táblázatban.

7. A tartásidő szerkesztéséhez kattintson az alapértelmezett időre a grafikus vagy a szöveges
nézeten, majd írjon be egy új időt.

8. A módosítások mentéséhez kattintson előbb az OK gombra, majd a Yes (Igen) gombra.
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GOTO (Lépj) lépés beillesztése
Megjegyzés: Egy GOTO (Lépj) készleten belül nem tud GOTO (Lépj) lépést beilleszteni ; nem
lehetséges egymásba ágyazott GOTO (Lépj) hurkokat létrehozni.

GOTO (Lépj) lépés beillesztéséhez

1. Az eszköztárban válassza ki a Before (Elé) vagy After2 (Mögé) lehetőséget az Insert Step (Lépés
beillesztése) legördülő listában.

2. A grafikonon válassza ki a beilleszteni kívánt GOTO (Lépj) lépés előtti vagy az utáni lépést.

3. A bal oldali táblában kattintson az Insert GOTO (Lépj beillesztése) gombra.

4. A GOTO (Lépj) lépés számának vagy a GOTO (Lépj) ismétlések számának a szerkesztéséhez
válassza ki az alapértelmezett számot a grafikonban vagy a körvonal táblában, és írjon be egy új
értéket.

5. A módosítások mentéséhez kattintson előbb az OK gombra, majd a Yes (Igen) gombra.

Olvadási görbe lépés beillesztése
Tipp: Olvadási görbe lépés nem illeszthető be egy GOTO (Lépj) hurkon belül.

Megjegyzés: Az olvadási görbe lépés 30 másodperces várakozást tartalmaz a lépés elején,
amely nincs ábrázolva a protokollban.

Olvadási görbe lépés beillesztéséhez

1. Az eszköztárban válassza ki a Before (Előtt) vagy After (Után) lehetőséget az Insert Step (Lépés
beillesztése) legördülő listában.

2. A grafikonon válassza ki azt a lépést, amely előtt vagy után tervezi az olvadási görbe
beillesztését.
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3. A bal oldali táblában kattintson az Insert Melt Curve (Olvadási görbe beillesztése) parancsra. Az
új olvadási görbe lépés ki van emelve a grafikonban és a körvonal táblában, pl.:

4. Az olvadási görbe tartományának vagy növekedési lépésidejének a szerkesztéséhez válassza ki
az alapértelmezett számot a grafikonban vagy a körvonal táblában, és írjon be egy új értéket.

5. A módosítások mentéséhez kattintson előbb az OK gombra, majd a Yes (Igen) gombra.
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Lemezleolvasási lépés hozzáadása vagy eltávolítása
Tipp: Ha egy lépéshez hozzáad egy lemezleolvasási parancsot, akkor az adott lépés
kiválasztásakor a gomb a következőre változik: Remove Plate Read (Lemezleolvasás
eltávolítása).

Lemezleolvasás hozzáadása egy lépéshez

1. Az eszköztárban válassza ki a Before (Előtt) vagy az After (Után) elemet az Insert Step (Lépés
beszúrása) legördülő listából.

2. A grafikonon válassza ki azt a lépést, amely elé vagy mögé be szeretné illeszteni a
lemezleolvasás lépést.

3. A bal oldali panelen kattintson az Add Plate Read to Step (Lemezleolvasás hozzáadása a
lépéshez) elemre egy lemezleolvasásnak a kiválasztott lépéshez történő hozzáadásához.

4. A módosítások mentéséhez kattintson előbb az OK gombra, majd a Yes (Igen) gombra.

Lemezleolvasás eltávolítása egy lépésből

u A grafikonon válassza ki a lemezleolvasást tartalmazó lépést, majd a bal oldali panelen kattintson
a Remove Plate Read (Lemezleolvasás eltávolítása) elemre.

A lépés opciók módosítása
A lépés opciók egy kiválasztott lépéshez történő módosítása

1. Válassza ki a cél lépést a diagram vagy körvonal panelen.

2. A bal oldali panelen kattintson a Step Options (Lépés opciók) gombra a Step Options (Lépés
opciók) párbeszédpanel megnyitásához.

Másik megoldásként a jobb egérgombbal kattintson valamelyik panelen a cél lépésre és válassza
ki a Step Options (Lépés opciók) lehetőséget e megjelenő menüben.

3. Opciók hozzáadásához, módosításához, vagy eltávolításához:

n Írjon be egy értéket a megfelelő szövegmezőbe.

n Módosítson egy értéket az adott szövegmezőben.

n Jelöljön be egy jelölőnégyzetet, vagy szüntesse meg annak a bejelölését.

4. Kattintson az OK (Rendben) gombra a módosítások elmentéséhez, és zárja be a Step Options
(Lépés opciók) párbeszédpanelt.

5. Kattintson az OK gombra, majd a Yes (Igen) gombra a protokoll elmentéséhez.
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Lépés törlése
A protokoll valamely lépésének törlése

1. Válassza ki a lépést a diagramban vagy a körvonal panelen.

2. A bal oldali panelen kattintson a Delete Step (Lépés törlése) opcióra a kiválasztott lépés
törléséhez.

3. Kattintson az OK gombra, majd a Yes (Igen) gombra a protokoll elmentéséhez.

Protokoll másolása, exportálása vagy nyomtatása
Protokoll másolásához

u Kattintson a jobb gombbal a protokoll körvonalába és válassza ki a Copy Protocol (Protokoll
másolása) parancsot.

A körvonalat beillesztheti egy .txt, .xls, .doc, vagy .ppt fájlba.

Protokoll exportálásához

1. Kattintson a jobb gombbal a protokoll körvonalába és válassza ki az Export Protocol (Protokoll
exportálása) parancsot.

Ekkor megjelenik a Save As (Mentés másként) párbeszédablak.

2. (Opcionális) A Windows Explorerben lépjen egy mappába, amelybe el akarja menteni a
protokollfájlt.

3. A File name (Fájlnév) mezőbe írjon be egy nevet az exportált protokollfájlhoz.

4. Kattintson a Save (Mentés) gombra.

Protokoll kinyomtatásához

u Kattintson a jobb gombbal a protokoll körvonalába és válassza ki a Print (Nyomtatás) parancsot.

A protokoll körvonalát kinyomtathatja az alapértelmezett nyomtatóján.
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Protokoll létrehozása a Protocol AutoWriter (Automatikus
protokollíró) segítségével

Fontos: A Bio-Rad nem garantálja, hogy a Protocol AutoWriter (Automatikus protokollíró)
segítségével létrehozott protokoll futtatása minden esetben valós idejű PCR terméket
eredményez.

A CFX Manager Dx Protocol AutoWriter (Automatikus protokollíró) eszköze a következő bemeneti
paraméterek alapján automatikusan generál ciklikus protokollokat:

n Amplikonhosszúság – a PCR termék várt hosszúsága

n Izzítási hőmérséklet – az aktuálisan használt primerek reakciós Ta hőmérséklete

Ha a Ta ismeretlen, akkor azt a Ta kalkulátor segítségével az Ön primerszekvenciái alapján
automatikusan kiszámíthatja.

Megjegyzés: A Ta értéke a primer olvadási hőmérsékletére (Tm) vonatkozó, a kiválasztott
enzimen és a protokoll sebességén alapuló információk helyesbítésével számítható ki.

n Enzimtípus – a DNS-polimeráz enzim (iTaq, iProof DNA (iTaq, iProof DNS) polimeráz vagy
Other (Egyéb))

Ha Ön az iTaq vagy az iProof DNS polimeráztól eltérő enzimet használ, akkor további
információkat írhat be, beleértve a gradienstartományt, a forróindítási aktiválási időt
(másodpercben), valamint a végső kiterjesztési időt (másodpercben).

n Futtatási sebesség – a reakció sebessége (standard, gyors vagy ultragyors)

A Protocol AutoWriter (Automatikus protokollíró) a kiválasztott sebességbeállításnak megfelelően
optimalizálja a protokollt. A teljes futtatási időt a következő tényezők határozzák meg: a lépések
és a ciklusok száma, az egyes lépéseknél elvégzendő inkubáció időtartama, valamint a
célhőmérsékleten az uniformitás eléréséhez szükséges időtartam.

A Protocol AutoWriter (Automatikus protokollíró) az Ön által beírt paraméterek, valamint a standard
PCR előirányzott értékek segítségével automatikusan generál egy testreszabott PCR protokollt a
következő lépésekkel: forróindítás, kezdeti denaturálás, izzítás, valamint kiterjesztés. Megtekintheti a
javasolt protokoll grafikus ábrázolását, valamint szerkesztheti, futtathatja vagy elmentheti a protokollt.
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Új protokoll létrehozása a(z) CFX Manager Dx Protocol AutoWriter (Automatikus
protokollíró) eszközének a segítségével

1. A Home (Kezdőlap) ablakban válassza ki a Tools > Protocol AutoWriter (Eszközök > Automatikus
protokollíró) elemet.

Megjelenik a Protocol AutoWriter (Automatikus protokollíró) párbeszédpanel.

2. Az Enter Target Values/Enzyme (Célértékek/enzim beírása) szakaszban tegye a következőket:

n Ha ismeri a primerek izzítási hőmérsékletét (Ta), akkor írja be azt.

Tipp: A Ta Calculator (Kalkulátor) használata a(z) 107. oldalon további információkért.

Megjegyzés: Ha bővebb információkat szeretne olvasni a Ta kalkulátorban alkalmazott
számításokról, akkor lásd: Breslauer et al. 1986.

n Írja be az amplikonhosszúságot bázispárokban (bp).

n Válasszon egy enzimtípust az opciókat tartalmazó listából (iTaq DNA (iTaq DNS) polimeráz,
iProof DNA (iProof DNS) polimeráz vagy Other (Egyéb)).

Tipp: Ha enzimtípusként az Other (Egyéb) értéket választja, akkor az Additional
Parameters (Optional) (További paraméterek (opcionális)) szakaszban található
paraméterek aktívvá válnak.
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3. Ha enzimtípusként az Other (Egyéb) értéket választotta, akkor a protokollhoz hozzáadhatja a
következő paraméterek bármelyikét vagy mindegyikét:

n Gradienstartomány

n Forróindítási aktiválási hőmérséklet

n Végső kiterjesztési idő

4. A Type (Típus) szakaszban a csúszka mozgatásával válassza ki a protokoll sebességét
(Standard, Fast (Gyors) vagy Ultrafast (Ultragyors)). A(z) CFX Manager Dx beállítja a teljes
futtatási időt.

5. Válassza ki az elvégezni kívánt PCR vizsgálat típusát (az alapértelmezett érték: Real-time PCR
(Valós idejű PCR)).

A valós idejű PCR vizsgálatnál a(z) CFX Manager Dx hozzáad egy lemezleolvasási lépést a
fluoreszcenciaadatok begyűjtése érdekében.

6. A Preview (Előnézet) szakaszban tekintse át a protokollt. Szükség szerint módosításokat
végezhet.

7. Végezze el az alábbiak egyikét:

n Az új protokoll mentéséhez kattintson az OK gombra. A protokoll az elmentését követően
megnyílik a Startup Wizard (Indítási varázsló) ablakban. Ha módosítást szeretne végezni a
protokollon, akkor kattintson az Edit Selected (Kijelölt elemek szerkesztése) gombra. Így
például lehetséges, hogy módosítania kell a fedélhőmérsékletet és a mintatérfogatot.

n Ha a protokoll mentése nélkül szeretné bezárni az ablakot, akkor kattintson a Cancel
(Mégse) gombra.

A Ta Calculator (Kalkulátor) használata
Ha a primer kapcsolódási hőmérséklete ismeretlen, akkor használhatja a Ta Calculator (Kalkulátor)
eszközt. Az értéket használhatja a Protocol AutoWriter (Automatikus protokollíró) opcióhoz vagy a
Protocol Editor (Protokollszerkesztő) opcióhoz a protokollja létrehozásához.

Tudnivalók a Ta kalkulátorról
A Ta kalkulátor standard sebességgel kiszámítja az egyes primerekhez tartozó Tm értékeket, valamint
a protokollhoz tartozó Ta értéket.

A protokollhoz tartozó Ta a következő szabályok figyelembevételével az átlagos primer Tm értékeken
alapszik:
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n Ha a primer Tm értékek közötti különbség több mint 4 °C, akkor a Ta = (a két primer Tm érték közül
az alacsonyabb + 2) – 4 °C

n Ha a Tm értékek közötti különbség ≤4 °C, akkor a Ta = (a primer Tm értékek átlaga) – 4 °C

Bázispár-számlálási módszer

A Ta Calculator (Ta kalkulátor) mindegyik primer esetében a 14 vagy annál kevesebb bázispárból (bp)
álló szekvenciához tartozó bátispár-számlálási módszert alkalmazza.

Tm = ((w*A + x*T) * 2) + ((y*G + z*C) * 4)

ahol w, x, y, és z az A, T, G, és C bázisok száma a szekvenciában.

„Legközelebbi szomszéd” módszer

A 14 bp-nél hosszabb szekvenciákhoz a rendszer a legközelebbi szomszéd módszert alkalmazza. A
legközelebbi szomszéd módszerben az olvadási hőmérséklet-számítások az entrópia (az
oligonukleotid véletlenszerűségének a sorrendje, illetve mértéke), az entalpia (az oligonukleotid által
kibocsátott vagy elnyelt hő), a szabad energia, és a hőmérséklet közötti termodinamikai
összefüggésen alapszanak.

∆H = ∆G + T* ∆S

ahol:

n ∆H = Entalpia érték, Cal/Mól*K

n T = hőmérséklet, Kelvin

n ∆S = Entrópia érték, Cal/Mól*K

n ∆G = Gibbs-féle szabad energia Cal/Mól*K egységben

Az entrópia és az entalpia változásai a(z) 12. táblázat látható nukleotidpár értékek összegzésével
kerültek közvetlenül kiszámításra (Breslauer és mtsai. 1986).

A szabad energia és a reagensek valamint termékek egyensúlyi koncentrációi közötti különbséget a

∆G = R*T*ln ((DNS * Primer)/(DNS + Primer)) adja,

ahol R a gázállandó (1,986 Cal/Mól*K).

A két egyenletben a G behelyettesítése és a T-re történő megoldás a

T = ∆H/(∆S + R*Ln((DNS * Primer)/(DNS + Primer))) eredményt adja,

feltételezve, hogy a DNS és a DNS-primer komplex koncentrációja megegyezik.
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Empirikusan meghatározásra került, hogy 5 kcal (3,4 kcal) szabad energia (Sugimoto és mtsai. 1996)
változás van az egyszálúról a B-formájú DNS-re való átmenet során. Ez feltételezhetően helix kezdési
energia. Végül pedig, egy só miatti módosítás hozzáadása azt az egyenletet adja, amelyet a Ta
kalkulátor használ:

T = (∆H – 5(KCal/K*Mól))/(∆S + (R * ln(1/(primer)))) + 16,6 log10 (SaltMolarity (SóMolaritás))

Nincs szükség módosító konstansra a sókoncentrációhoz, mivel a különböző paraméterek
meghatározása 1 M NaCl értéknél történt, és 1 log10 értéke zéró.

A termodinamikai számítások feltételezik, hogy a kapcsolódás 7,0 pH értéken történik. A Tm
számítások feltételezik, hogy a szekvenciák nem szimmetrikusak és legalább egy G vagy C
tartalommal rendelkeznek.

Az oligonukleotid szekvenciának legalább 14 bázis hosszúságúnak kell lennie ahhoz, hogy
elfogadható Tm értékeket adjon. A 14-nél kevesebb bázisok a bázispár számlálási módszert
használják (lásd: a következő 12. táblázat.

Interaktivitás ∆H ∆S ∆G

AA TT 9,1 24 1,5

AT TA 8,6 23,9 1,5

AC TG 6,5 17,3 1,3

AG TC 7,8 20,8 1,6

TA AT 6 16,9 0,9

TT AA 9,1 24 1,9

TC AG 5,6 13,5 1,6

TG AC 5,8 12,9 1,9

CA GT 5,8 12,9 1,9

CT GA 7,8 20,8 1,6

CC GG 11 26,6 3,1

CG GC 11,9 27,8 3,6

GA CT 5,6 13,5 1,6

12. táblázat. Breslauer interaktivitás konstansok
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Interaktivitás ∆H ∆S ∆G

GT CA 6,5 17,3 1,3

GC CG 11,1 26,7 3,1

GG CC 11 26,6 3,1

12. táblázat. Breslauer interaktivitás konstansok, folytatás
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A Ta Calculator (Kalkulátor) használata

A Ta Calculator (Kalkulátor) használatához

1. A Ta Calculator (Kalkulátor) megnyitásához végezze el az alábbiak egyikét:

n Ha pillanatnyilag a Protocol AutoWriter (Automatikus protokollíró) ablakban van, akkor
kattintson a Ta Calculator (Kalkulátor) opcióra.

n A Home (Kezdőlap) ablakban válassza ki a Tools > Ta Calculator (Eszközök > Ta kalkulátor)
opciót.

Megjelenik a Ta Calculator (Kalkulátor) párbeszédpanel.

2. A Forward Primer (Egyenes primer) szövegmezőbe írja be vagy illessze be az egyenes primer
szekvenciát.

Tipp: Használhatja a párbeszédpanel bal oldalán levő A, T, G, C gombokat is a szekvencia
beírásához.

3. Írja be vagy illessze be a fordított primer szekvenciát a Reverse Primer (Fordított primer)
szövegmezőbe.
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4. Kattintson a Calculate (Számítás) gombra.

A Ta Calculator (Kalkulátor) kiszámítja és megjeleníti az egyes primerek Tm értékét és az átlag Tm
és Ta értékeket, pl.:

Ha a primer Tm értékek több mint 4 °C távolságra vannak egymástól, a Protocol AutoWrite
(Automatikus protokollíró) az alacsonyabb primer Tm értéket + 2 °C-t használ alapként a Ta érték
kiszámításához, amelyet Ön tovább módosíthat az enzim és a reakciósebesség
megváltoztatásával.

A Ta Calculator (Kalkulátor) kapcsolódási hőmérsékletet generál standard sebességhez iTaq
DNA polimerázzal. Egy eltérő enzim módosításakor a sebességbeállítások automatikusan
módosítják a Ta értéket.

5. Végezze el az alábbiak egyikét:

n Ha a Ta Calculator (Kalkulátor) ablakot a Protocol AutoWriter (Automatikus protokollíró)
opcióból nyitotta meg, akkor kattintson az OK gombra. Ekkor visszatér a Protocol AutoWriter
(Automatikus protokollíró) ablakba. A kapcsolódási hőmérséklet automatikusan módosítva
lesz.

n Ha a Ta Calculator (Kalkulátor) opciót a Tools (Eszközök) menüből nyitotta meg, akkor
jegyezze fel a számításokat és kattintson a Cancel (Mégse) gombra a kalkulátor
bezárásához.
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A lemezfájl a futtatás paramétereire vonatkozó információkat tartalmaz, ideértve például a leolvasási
módot, a fluorofórokat és a cellatartalmakat. A futtatás után a CFX Manager Dx szoftver a
cellatartalmakat összekapcsolja a futtatás során gyűjtött fluoreszcenciaadatokkal, valamint
alkalmazza a megfelelő elemzést a Data Analysis (Adatelemzés) ablakban. Így például a rendszer a
standard típusú mintát tartalmazó cellák segítségével egy standard görbét generál.

A CFX Manager Dx szoftver két opciót kínál a lemezek létrehozására: a Plate Editor (Lemez
szerkesztő) eszközt valós idejű PCR futásokhoz, valamint a Setup Wizard (Beállítási varázsló)
eszközt a normalizált génexpresszió elemzéséhez.

A Plate Editor (Lemez szerkesztő) eszköz a következő funkciókat tartalmazza:

n A lemez celláihoz hozzárendelhető standard fluorofórok és mintatípusok

n Annak a lehetősége, hogy referencia célértéket és kontroll mintát lehessen beállítani a
génexpresszió-elemzéshez

n Annak a lehetősége, hogy egy futtatás előtt, közben vagy után szerkeszteni lehessen a
lemezbeállítást

n Annak a lehetősége, hogy későbbi újbóli felhasználás céljából el lehessen menteni a
lemezfájlokat

n Annak a lehetősége, hogy az alapértelmezett nyomtató segítségével ki lehessen nyomtatni a
lemezfájlt

A Setup Wizard (Beállítási varázsló) végigvezeti Önt azokon a lépéseken, amelyeknek a segítségével
lemezelrendezést hozhat létre a normalizált génexpresszió elemzéséhez. A Setup Wizard (Beállítási
varázsló) funkciót futtatás előtt, közben és után is használhatja.
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A Plate Editor (Lemez szerkesztő) ablak
A Plate Editor (Lemez szerkesztő) segítségével egyedi lemezeket hozhat létre, illetve módosíthatja a
meglévő lemezeket.

1. A menüsor gyors hozzáférést kínál a File (Fájl) és a Settings (Beállítások) menüpontban
található parancsokhoz, valamint a lemezszerkesztési eszközök által kínált opciókhoz.

2. Az eszköztár gyors hozzáférést kínál a fontos lemezbetöltési funkciókhoz.

3. A fő panelen a lemez áttekintő nézete és az Ön által esetlegesen alkalmazott lemezopciók
láthatók.

4. A jobb oldali panelen olyan opciók láthatók, amelyeknek a segítségével testreszabhatja a
lemezét.

5. Az alsó panel a lemez típusát mutatja, valamint gyors hozzáférést kínál a megtekintési
opciókhoz.

JELMAGYARÁZAT
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A Plate Editor (Lemez szerkesztő) ablak

File (Fájl) menüparancsok
Save (Mentés) – a lemezadatfájl mentése a User Preferences (Felhasználói preferenciák)
párbeszédpanel File (Fájl) fülén meghatározott helyre. További információkért lásd: Az
alapértelmezett fájlbeállítások módosítása a(z) 69. oldalon. Ez a menüpont csak új lemezfájl
létrehozásakor érhető el.

Save As (Mentés másként) – a megnyitott lemezadatfájl mentése egy Ön által megadott új névvel.
Ez a menüpont csak új lemezfájl létrehozásakor érhető el.

Extract Plate (Lemez kinyerése) – egy párbeszédpanel megnyitása, amelynek a segítségével Ön
kinyerheti/mentheti a (.pltd kiterjesztésű) lemezfájlt. Ez a menüpont csak meglévő lemezfájl
megtekintésekor vagy szerkesztésekor érhető el.

Print (Nyomtatás) – a megnyitott lemezadatfájl kinyomtatása.

Close (Bezárás) – a Plate Editor (Lemezszerkesztő) ablak bezárása.

A Settings (Beállítások) menüpontban található parancsok
Plate Size (Lemezméret) – olyan opciókat kínál, amelyek közül Ön kiválaszthatja a lemezméretet a
futáshoz.

Megjegyzés: A CFX Dx rendszer kizárólag 96 cellás lemezt képes használni.

Plate Type (Lemeztípus) – lehetővé teszi, hogy kiválassza az Ön mintáit tartalmazó lemezben
található cellák típusát a következő opciók közül: BRWhite (BR fehér) vagy BR Clear (BR átlátszó).
Az adatok pontos elemezhetősége érdekében a kiválasztott lemeztípusnak azonosnak kell lennie a
futtatás során használt lemeztípussal.

Number Convention (Számozási szabály) – kiválaszthatja, hogy a rendszer az egységeket
megjelenítse-e a tudományos jelölésekben. A rendszer alapértelmezés szerint megjeleníti az
egységeket a tudományos jelölésekben.

Units (Egységek) – lehetővé teszi, hogy kiválassza azokat az egységeket, amelyek megjelennek a
táblázatokban, amikor Ön ismeretleneket szeretne kvantifikálni egy standard görbével
összehasonlításban.
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Editing Tools (Szerkesztő eszközök) menüparancsok
Setup Wizard (Beállítás varázsló) —megnyitja a Setup Wizard (Beállítás varázsló) opciót, amelyben
definiálhatja az elrendezési és elemzési paramétereket a pillanatnyi lemezhez. A Setup Wizard
(Beállítás varázsló) funkciót egy lefutás befejeződése előtt, közben és után egyaránt használhatja.

Spreadsheet View/Importer (Táblázat Megtekintő/Importáló) —megnyitja a View (Megtekintés)
párbeszédpanelt, amely sablonként mutatja a lemezelrendezést táblázat formában. Ennek a
párbeszédpanelnek a segítségével Ön a lemezsablon adatait .csv formátumban exportálhatja, illetve
importálhatja.

Flip Plate (Lemez átfordítása) — a lemez tartalmát 180o-ban átfordítja.

Az eszköztárban található parancsok

Az aktuális lemezfájl mentése.

Legördülő lista megjelenítése, amelynek a segítségével növelheti vagy
csökkentheti a lemeznézet nagyítási fokát.

Legördülő lista megjelenítése, amelynek a segítségével kiválaszthat egy
leolvasási módot, amely megmondja a műszernek, hogy egy futtatás során
mely csatornákból gyűjtsön fluoreszcenciaadatokat.

A Well Groups Manager (Cellacsoport-kezelő) megnyitása, amelynek a
segítségével cellacsoportokat hozhat létre az aktuális lemezhez.

Párbeszédpanel megjelenítése, amelynek a segítségével kiválaszthatja az
amplifikációs jelek színeit és szimbólumait.

A View (Nézet) párbeszédpanel megnyitása, amely sablonként,
táblázatos formátumban megjeleníti a lemezelrendezést. Ennek a
párbeszédpanelnek a segítségével Ön a lemezsablon adatait .csv
formátumban exportálhatja, illetve importálhatja.

Lemez beállításához és a cellákba történő betöltéshez szükséges
lépések megjelenítése.
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Lemezfájl létrehozása a Plate Editor (Lemez szerkesztő)
segítségével

A Plate Editor (Lemez szerkesztő) segítségével egyedi lemezfájlokat hozhat létre. Továbbá
lehetősége van a korábban mentett lemezfájlokat, illetve a CFX Manager Dx szoftver szoftverhez
mellékelt minta lemezfájlokat szerkeszteni és elmenteni.

Új lemezfájl létrehozásához tegye a következőket:

n Nyisson meg egy lemezfájlt a Plate Editor (Lemez szerkesztő) ablakban.

n Válassza ki a lemez típusát.

Megjegyzés: A lemezfájlban meghatározott lemeztípusnak azonosnak kell lennie a reakció
modulban található lemez típusával.

n Válassza ki a protokollban használni kívánt leolvasási módot.

n Válassza ki a lemezben használni kívánt fluorofórokat.

n Válassza ki a minta típusát, a célértékeket, valamint a mintákat.

n Adott esetben válassza ki a replikátumokat.

n Mentse el a lemezelrendezést.

Tipp: Ha egy korábban mentett vagy egy minta lemezfájlból szeretne létrehozni egy új lemezt,
akkor lásd: Meglévő lemezfájl megnyitása a Plate Editor (Lemez szerkesztő) menüpontban a(z)
120. oldalon.

Új lemezfájl megnyitása a Plate Editor (Lemez szerkesztő)
menüpontban
A CFXManager Dx szoftver több opciót kínál egy új lemezfájl megnyitására:

n A Home (Kezdőlap) ablakból

n A Startup Wizard (Indítási varázsló) párbeszédpanelről

n A Run Setup (Futtatás beállításai) párbeszédpanelről
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Új lemezfájl megnyitása a Home (Kezdőlap) ablakból

u Válassza ki a File > New > Plate (Fájl > Új > Lemez) elemet.

Megnyílik a Plate Editor (Lemez szerkesztő) ablak és rajta a kiválasztott műszerhez tartozó
alapértelmezett lemezfájl.

Tipp: Az alapértelmezett lemezfájl beállítására vonatkozó információkért lásd: Az
alapértelmezett fájlbeállítások módosítása a(z) 69. oldalon.

Új lemezfájl megnyitása a Startup Wizard (Indítási varázsló) párbeszédpanelről

1. A Home (Kezdőlap) ablakban tegye a következők egyikét a Startup Wizard (Indítási varázsló)
megnyitásához, ha az jelenleg nem látható a képernyőn:

n Válassza ki a View > Startup Wizard (Nézet > Indítási varázsló) elemet.

n Kattintson a Startup Wizard (Indítási varázsló) elemre az eszköztárban.

A Startup Wizard (Indítási varázsló) párbeszédpanelen alapértelmezés szerint a Run Setup
(Futtatás beállításai) fül jelenik meg, és a CFX96 műszer van kiválasztva.

2. Ha szükséges, akkor válassza ki a műszer típusát a legördülő listából.

3. Új lemez létrehozásához kattintson a User-defined (Felhasználó által beállított) elemre, mint a
futtatás típusára.

Megnyílik a Run Setup (Futtatás beállításai) párbeszédpanel és rajta a Protocol (Protokoll) fül.

4. Kattintson a Plate (Lemez) fülre, majd kattintson a Create New (Új létrehozása) elemre.

Megnyílik a Plate Editor (Lemez szerkesztő) ablak és rajta a kiválasztott műszerhez tartozó
alapértelmezett lemezelrendezés.

Új lemezfájl megnyitása a Run Setup (Futtatás beállításai) párbeszédpanelről

1. A Home (Kezdőlap) ablakban tegye a következők egyikét a Run Setup (Futtatás beállításai)
párbeszédpanel megnyitásához:

n Válassza ki a Run > User-defined Run (Futtatás > Felhasználó által beállított futtatás)
elemet.

n Kattintson a User-defined Run Setup (Felhasználó által meghatározott futtatás beállítása)
elemre az eszköztárban.

Megnyílik a Run Setup (Futtatás beállításai) párbeszédpanel és rajta a Protocol (Protokoll) fül.
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2. Új lemez létrehozásához kattintson a Plate (Lemez) fülre, majd kattintson a Create New (Új
létrehozása) elemre.

Megnyílik a Plate Editor (Lemezszerkesztő) ablak és rajta a kiválasztott műszerhez tartozó
alapértelmezett lemezelrendezés.
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Meglévő lemezfájl megnyitása a Plate Editor (Lemez szerkesztő)
menüpontban
A CFXManager Dx szoftver minta lemezfájlokat kínál, amelyeket Ön szerkeszthet és elmenthet új
lemezként. Továbbá egy korábban mentett lemezfájlból is létrehozhat egy új lemezfájlt.

Minta lemezfájl megnyitása

1. A Home (Kezdőlap) ablakban válassza ki a File > Open > Plate (Fájl > Megnyitás > Lemez)
elemet.

A Windows Intéző megnyílik a(z) CFX Manager Dx szoftver Sample files (Minta fájlok)
mappájánál.

2. Nyissa meg a Sample files (Minta fájlok) mappát, majd nyissa meg a Plates (Lemezek) mappát.

3. Válassza ki a kívánt lemezt, majd kattintson az Open (Megnyitás) elemre.

A minta lemezfájl megnyílik a Plate Editor (Lemez szerkesztő) ablakban.

4. Válassza ki a File > Save As (Fájl > Mentés másként) elemet, majd mentse el a lemezfájlt új
névvel vagy egy új mappába.

Egy korábban mentett lemezfájl megnyitása

1. A Home (Kezdőlap) ablakban válassza ki a File > Open > Plate (Fájl > Megnyitás > Lemez)
elemet, keresse meg és válassza ki a kívánt lemezt, majd kattintson az Open (Megnyitás) elemre.

A kívánt lemez megnyílik a Plate Editor (Lemez szerkesztő) ablakban.

2. Válassza ki a File > Save As (Fájl > Mentés másként) elemet, majd mentse el a lemezfájlt új
névvel vagy egy új mappába.
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Új lemezfájl beállítása
Tipp: Ha az Ön lemezfájlja tartalmazza a szükséges paramétereket (pl. ha Ön egy mintát vagy
egy létező lemezfájlt szerkeszt), akkor kihagyhatja ezt a részt. Ugorjon a Opcionális paraméterek
hozzárendelése a lemezfájlhoz a(z) 127. oldalon.

Az új lemezfájlokhoz a következő paraméterek szükségesek:

n Lemezméret

n Lemeztípus

n Leolvasási mód

n Egy fluorofór (festék)

n Egy mintatípus

A lemez méretének és típusának a kiválasztása

Fontos: A lemezbeállítások során ki kell választania egy lemezméretet. Futtatás közben vagy azt
követően nemmódosíthatja a lemezméretet.

A szoftver a lemezméretet és típust futtatás közben az összes cellára alkalmazza. Ügyeljen arra, hogy
a kiválasztott lemezméret megegyezzen a futtatásban használni tervezett lemezével.

A(z) Bio-Rad CFX96 és CFX96 DeepWell műszerei gyárilag számos fluoreszcens festék és lemez
kombinációkra kalibrálva vannak. A kalibráció a készülékre, festékre, és lemeztípusra specifikus.
Ügyeljen arra, hogy a használni tervezett fluorofór kalibrálva legyen a kiválasztott lemeztípushoz.

A leolvasási mód kiválasztása

A CFX96 és CFX96 DeepWell rendszerek a fluorofórokat öt csatornában gerjesztik és detektálják.
Valamennyi rendszer többszörös adatbeszerző leolvasási módszert alkalmaz futtatás közben a
fluoreszcencia adatok begyűjtésére.

A(z) CFX Manager Dx szoftver három leolvasási módot biztosít:

n Minden csatorna

o Az 1.-től az 5. csatornáig olvassa le a csatornákat a CFX96 és CFX96 DeepWell
rendszerekben
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n SYBR® /FAM

o Csak az 1. csatornát olvassa le

o Gyors leolvasást biztosít

n FRET

o Csak a FRET csatornát olvassa le

o Gyors leolvasást biztosít

Fluorofórok kiválasztása

Fontos: A futás elkezdése előtt a CFX Manager Dx szoftver ellenőrzi, hogy az Ön által a
lemezben megadott fluorofórok kalibrálva vannak-e azon a készüléken. Nem futtathat le egy
lemezt, ha az olyan fluorofórokat tartalmaz, amelyek nem lettek kalibrálva azon a készüléken.

A futtatás előtt legalább egy fluorofórt be kell töltenie a lemez elrendezésbe. Ekkor annyi fluorofórt
hozzáadhat, amennyi csak szükséges, de a lemeznek tartalmaznia kell legalább egy fluorofórt. A
kiválasztott fluorofórok cél opciókként jelennek meg a Target Names (Célértéknevek) ablakban.

Használja a Select Fluorophores (Fluorofórok kiválasztása) párbeszédpanelt a fluorfórok (vagy
lemezfestékek) betöltéséhez a Plate Editor (Lemez szerkesztő) cellabetöltő vezérlőkbe. A Select
Fluorophores (Fluorofórok kiválasztása) párbeszédpanelben megjelenő fluorofórok az Ön által
kiválasztott leolvasási módtól függenek:

n Minden csatorna

Az összes rendelkezésre álló fluorofór megjelenik.

Tipp: Annyi fluorofórt hozzáadhat, amennyi szükséges, de csak egyetlen fluorofórt tölthet be
csatornánként mindegyik lemezbe.

n SYBR®/FAM

Csak az 1. csatorna fluorofórjai jelennek meg.

n FRET

Csak a 6. csatorna fluorofórja jelenik meg.

Tipp: A 6. csatorna FRET fluorofór csak akkor jelenik meg, amikor a kiválasztott leolvasási
mód FRET. Ez nem áll rendelkezésre az All Channels (Minden csatorna) leolvasási módhoz.

Megjegyzés: Közvetlenül nem adhat fluorofórokat illetve nem távolíthatja el azokat a Select
Fluorophore (Fluorofór kiválasztás) párbeszédpanelben. Az új fluorofórokat kalibrálnia kell egy
műszeren a Calibration Wizard (Kalibrációs varázsló) használatával. A kalibrálás után az új
fluorofór automatikusan hozzáadásra kerül a listához.
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Mintatípusok kiválasztása

Fontos: A futás előtt legalább egy – a lemezcellákhoz hozzárendelni kívánt – mintatípust ki kell
választania.

A(z) CFX Manager Dx szoftver öt mintatípust kínál:

n Unknown (Ismeretlen)

n Standard

n NTC (no template control, magyarul: templát nélküli kontroll)

n Positive Control (Pozitív kontroll)

n Negative Control (Negatív kontroll)

n NRT (no reverse transcriptase, magyarul: reverz transzkriptáz nélküli kontroll)

A lemezcellákhoz Ön rendeli hozzá a mintatípusokat.

Új lemez beállítása

Új lemez beállításához

1. Nyisson meg egy új lemezt a Plate Editor (Lemez szerkesztő) ablakban.

2. A lemez méretének beállításához válassza ki a Settings > Plate Size (Beállítások > Lemezméret)
opciót, és válassza ki a megfelelő lemezméretet a legördülő menüből.

3. A lemeztípus beállításához válassza ki a Settings > Plate Type (Beállítások > Lemeztípus) opciót,
és válassza ki vagy a BRWhite (BR fehér) vagy a BR Clear (BR átlátszó) lehetőséget a legördülő
menüből.

4. Opcionálisan, a Settings (Beállítások) menüből módosíthatja a számformátumot és a
megjelenítési egységeket:

n A számformátummódosításához válassza ki a Settings > Number Convention (Beállítások >
Számformátum) opciót és válassza ki a Scientific Notation (Tudományos számformátum)
lehetőséget.

Tipp: Alapértelmezettként a Scientific Notation (Tudományos számformátum) van
kiválasztva. Ebben az esetben a Scientific Notation kiválasztása kiüríti az
alapértelmezett választást, és a számformátumot standard formátumra állítja be.

n Amegjelenítési egységek módosításához válassza ki a Settings > Units (Beállítások >
Egységek) lehetőséget és válasszon ki egy új egység értéket.
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5. A leolvasási mód beállításához válassza ki a megfelelő leolvasási módot a Scan Mode
(Leolvasási mód) legördülő listából a Plate Editor (Lemez szerkesztő) ablak eszközsorában.

6. Válassza ki a szükséges fluorfórokat a lemezhez:

a. A jobb oldali panelen kattintson a Select Fluorophores (Fluorofórok kiválasztása) opcióra.

Megjelenik a Select Fluorophores (Fluorofórok kiválasztása) párbeszédpanel. Láthatja az
Lépjen ide: 5 kiválasztott leolvasási módhoz rendelkezésre álló fluorofórokat, például:

b. Egy fluorofór kiválasztásához kattintson annak bejelölt jelölőnégyzetébe.

Tipp: Egy fluorofórnak a listából történő eltávolításához ürítse ki annak Selected
(Kiválasztva) jelölőnégyzetét.

c. A fluorofór megjelenítési színének a módosításához kattintson annak Color (Szín) mezőjébe.

Megjegyzés: Az Ön által kiválasztott szín mind a Plate Editor (Lemez szerkesztő)
ablakban, mind a Data Analysis (Adatelemzés) diagramokon a fluorofórt fogja
képviselni.

d. A Color (Szín) párbeszédpanelben válassza ki a kívánt színt, vagy kattintson a Define
Custom Colors (Egyedi színek definiálása) opcióra egy új szín létrehozásához a fluorofór
képviselésére.

e. Kattintson az OK gombra a módosítások elmentéséhez és a Select Fluorophores
(Fluorofórok kiválasztása) párbeszédpanelból történő kilépéshez.
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7. Legalább egy cellát ki kell választania egy mintatípus betöltéséhez. Alapértelmezettként az A1
cella van kiválasztva.

A lemez panelen végezze el az alábbiak egyikét:

n Több egymással szomszédos cella hozzáadásához kattintson egy cellába, és húzza a
célcellához.

n Több, egymással nem szomszédos cella betöltéséhez tartsa nyomva a Control billentyűt,
majd kattintson az egyes cellákra.

n Egy ugyanazt a mintatípust tartalmazó egész sor kiválasztásához kattintson az oszlop
számára.

n Egy egész sor betöltéséhez kattintson annak sor számára.

n Az egész lemez betöltéséhez kattintson a lemez bal felső sarkába.

Például:

8. Rendeljen hozzá egy mintatípust a kiválasztott cellához vagy cellákkhoz a Sample Type
(Mintatípus) legördülő menüből.

Kezelési kézikönyv | 125



7. fejezet Lemezek előkészítése

9. Rendeljen hozzá legalább egy fluorofórt egy mintatípust tartalmazó összes cellához. Egy
cellához vagy cellacsoporthoz egynél több fluorofórt is hozzárendelhet.

Megjegyzés: Csatornánként csak egyetlen fluorofórt rendelhet hozzá. Ugyanabból a
csatornából ugyanahhoz a cellához nem rendelhet hozzá egynél több fluorofórt.

Tipp: A fluorofórral társíthat egy célt, vagy most csak hozzárendelheti a fluorofórt a cellához,
és egy célt társíthat a fluorofórhoz a kísérlet lefuttatása után.

n Csak a fluorofórnak a kiválasztott cellákhoz történő társításához a Target Names
(Célértéknevek) rész jobb oldali paneljában válassza ki a Load (Betöltés) jelölőnégyzetet az
adott fluorofórhoz.

n Egy célérték egy fluorofórral való társításához a Target Names (Célértéknevek) részben
válasszon ki egy célértéknevet a legördülő listából az adott fluorofórhoz. A szoftver
automatikusan bejelöli annak Load (Betöltés) jelölőnégyzetét.

10. A Standard (Standard) mintatípust tartalmazó cellákhoz be kell töltenie egy koncentrációt.
Mindegyik cella különböző koncentrációértékkel rendelkezhet. A CFX Manager Dx szoftver
alapértelmezettként 1,00E+06 koncentrációt tölt be az összes cellába, Standard (Standard)
mintatípussal. Az értéket szükség esetén módosíthatja.

a. A lemez panelen válasszon ki egy Standard (Standard) cellát vagy cellacsoportot.

b. A Concentration (Koncentráció) részben kattintson a Load (Betöltés) gombra az értéknek a
kiválasztott cellába vagy cellacsoportba történő betöltéséhez.

c. (Opcionális) Egy másik koncentráció betöltéséhez írja be az új értéket a Concentration
(Koncentráció) szövegmezőbe és nyomja meg az Enter (Bevitel) gombot.

d. Végezze el ezt a lépést az összes Standard (Standard) mintatípusú cellához.

Tipp: Ugyanannak a koncentrációnak az összes Standard (Standard) cellába történő
betöltéséhez ellenőrizze, hogy az <All>(Összes) felirat megjelenik a legördülő listában a
Concentration (Koncentráció) érték alatt. Ugyanannak a koncentrációértéknek egy adott
fluorofórt tartalmazó összes cellába történő betöltéséhez kattintson a legördülő listába
és válassza ki a fluorofórt.

11. Az új lemez elmentéséhez kattintson az OK gombra.
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Opcionális paraméterek hozzárendelése a lemezfájlhoz
A lemezfájl az összes olyan cella tartalmára vonatkozó információkat tartalmaz, amelyekben egy
futtatáshoz minta található. A futtatás után a CFX Manager Dx szoftver a cellatartalmakat
összekapcsolja a protokoll során gyűjtött fluoreszcenciaadatokkal, valamint alkalmazza a megfelelő
elemzést a Data Analysis (Adatelemzés) ablakban.

A(z) CFX Manager Dx programban Ön paramétereket rendelhet a lemezében található egyes
cellákhoz a kísérletek futtatása előtt, közben vagy akár után. A paramétereket egy meglévő
lemezfájlhoz vagy egy új lemezfájlhoz is hozzárendelheti. Ezek a paraméterek a következők:

n Target names (Célértéknevek) – az egyes betöltött cellákban található releváns célérték vagy
célértékek (gének vagy szekvenciák).

n Sample names (Mintanevek) – az egyes betöltött cellákban található mintának megfelelő
azonosító vagy állapot. Például 0Hr (0 óra), 1Hr (1 óra) vagy 2Hr (2 óra).

Tipp: A célértékneveknek és a mintaneveknek azonosnak kell lenniük a cellákban ahhoz,
hogy az adatokat össze lehessen hasonlítani a Data Analysis (Adatelemzés) ablak Gene
Expression (Génexpresszió) fülén. Az egyes neveknél a kis- és nagybetűs írásmódnak, az
írásjeleknek és a szóközöknek is egyezniük kell. Így például az “Actin” nem azonos az “actin”
szóval, a “2Hr” nem azonos a “2 hr.” kifejezéssel, és a “Mouse 1” kifejezés nem azonos a
“mouse1” szóval. A nevek egyezősége érdekében a neveket írja be a Home (Kezdőlap)
ablakból elérhető User > User Preferences > Plate (Felhasználó > Felhasználói preferenciák
> Lemez) párbeszédpanel Libraries (Könyvtárak) szakaszába.

n Biological sets (Biológiai sorok) – egy cellasornak megfelelő azonosító vagy állapot. Például.

n Replicates (Replikátumok) – minden egyes cella, amelyet a rendszer a minta és célérték(ek)
ugyanazon kombinációjának (vagyis az ismétlődő (replikátum) qPCR reakcióknak) az
elemzésére használ.

n Dilution series (Hígítási sor) – ennyivel kell változnia a Standard mintatípus koncentrációjának
egy replikátumcsoporton belül ahhoz, hogy a rendszer létrehozza az elemezni kívánt
standardgörbe-adatokat.
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Célérték hozzárendelése cellákhoz
Tipp: Egy vagy több cellához is hozzárendelheti ugyanazt a célértéknevet. Továbbá több
célértéket is hozzárendelhet ugyanahhoz a cellához.

Célérték hozzárendelése egy cellához vagy egy cellacsoporthoz

1. A Plate Editor (Lemez szerkesztő) ablakban győződjön meg arról, hogy a cellához vagy a
cellacsoporthoz hozzá lett rendelve egy mintatípus.

Ha bővebb információkat szeretne olvasni a mintatípusok cellákhoz történő hozzárendeléséről,
akkor lásd: Mintatípusok kiválasztása a(z) 123. oldalon.

2. A lemezpanelen válassza ki a cellát vagy a cellacsoportot:

n Ha csak egyetlen cellát szeretne kiválasztani, akkor kattintson az adott cellára.

n Ha több – egymással szomszédos – cellát szeretne kiválasztani, akkor kattintson egy cellára,
tartsa nyomva az egérgombot, majd húzza az egérmutatót a célcellára.

n Ha több – egymással nem szomszédos – cellát szeretne kiválasztani, akkor nyomja le és
tartsa nyomva a Control billentyűt, majd kattintson az egyes cellákra.

n Ha egy egész oszlopot szeretne kiválasztani, amelyben mindegyik cella azonos mintatípusú,
akkor kattintson az adott oszlop számára.

n Ha egy egész sort szeretne kiválasztani, akkor kattintson az adott sor számára.

3. A jobb oldali panelen válasszon egy nevet a Target Name (Célérték neve) legördülő listából az
egyes kiválasztott fluorofórokhoz.

4. Ismételje meg az Lépjen ide: 3 minden olyan cellánál vagy cellacsoportnál, amelyhez célértéket
kell rendelnie.

Tipp: Az egyes kiválasztott fluorofórok esetében azonos vagy eltérő célértékneveket is
hozzárendelhet.

5. A módosítások elfogadásához és a lemez mentéséhez kattintson az OK gombra.
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Egy célértéknév eltávolítása

u Ha szeretne eltávolítani egy célértéknevet a kiválasztott cellából vagy cellacsoportból, akkor
törölje a jelölést az adott célérték Load (Betöltés) jelölőnégyzetéből.

Fontos: Ha egy célértéknevet eltávolít egy cellából, akkor a rendszer a célértéknévhez
kapcsolódó fluorofórt is eltávolítja. Legyen körültekintő, amikor egy célértéknevet eltávolít egy
cellából.

Célértéknév hozzáadása a listához

u Ha a legördülő listához szeretne hozzáadni egy célértéknevet, akkor tegye a következők egyikét:

n Írjon be egy nevet a Target Name (Célérték neve) legördülő listába, majd nyomja le az Enter
billentyűt.

Tipp: Ha egy listához hozzáad egy célértéknevet, akkor az a célértéknév az összes
többi célértéklistában is megjelenik.

n Kattintson a legördülő listától jobbra található zöld + szimbólumra, írjon be egy nevet a
célértékhez, majd nyomja le az Enter (Bevitel) billentyűt.

n Kattintson a User Preferences (Felhasználói preferenciák) gombra az eszközsoron, és adja
hozzá a nevet a Target Names (Célértéknevek) könyvtárhoz a Plate (Lemez) fülben.

Fontos: A legördülő listához hozzáadott célértéknév kizárólag az aktuális lemezhez érhető
el, és kizárólag akkor, ha az adott nevet hozzárendeli egy cellához és a lemez elrendezését
elmenti. Ha a nevet nem rendeli hozzá egy cellához, és a lemez elrendezését nemmenti el,
akkor a rendszer nemmenti el a nevet, így az a későbbiekben nem lesz elérhető. Ha egy
célértéknevet állandó jelleggel szeretne hozzáadni, akkor azt a Target Names
(Célértéknevek) könyvtárhoz is adja hozzá a User Preferences (Felhasználói preferenciák)
párbeszédpanel segítségével. A könyvtárhoz hozzáadott nevek akkor is elérhetők lesznek,
amikor később újból megnyitja a Plate Editor (Lemez szerkesztő) ablakot. További
információkért lásd: A lemezre vonatkozó alapértelmezett paraméterek beállítása a(z) 72.
oldalon.

Célértéknév törlése a listából

1. Az eszköztáron kattintson a User Preferences (Felhasználói preferenciák) elemre.

Megjelenik a User Preferences (Felhasználói preferenciák) párbeszédpanel és rajta a Plate
(Lemez) fül.

2. A Plate (Lemez) fülön található Target Names (Célértéknevek) adattárban válassza ki a törölni
kívánt nevet, majd nyomja le a Delete (Törlés) billentyűt.
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3. A módosítások mentéséhez és a User Preferences (Felhasználói preferenciák)
párbeszédpanelről történő kilépéshez kattintson az OK gombra.

Fontos: Olyan célértékneveket nem lehet törölni, amelyeket korábban egy lemezfájllal
mentett el. A rendszer automatikusan eltávolítja a listából azokat az egyedi neveket,
amelyeket Ön ugyan hozzáad a Target Names (Célértéknevek) legördülő listához, de nem
használja és nemmenti el őket a lemezzel. Ha egy nevet töröl a Target Names
(Célértéknevek) adattárból, akkor a rendszer az adott nevet véglegesen eltávolítja a
szoftverből, így az a felhasználók számára nem lesz elérhető. Legyen körültekintő a
célértéknevek törlésénél.

Mintanév hozzárendelése cellákhoz
Megjegyzés: Egy mintanév hozzárendeléséhez a kiválasztott cellákat legalább egy fluorofórhoz
hozzá kell rendelnie. Ha a kiválasztott cellák nincsenek hozzárendelve egy fluorofórhoz, akkor a
Sample Names (Mintanevek) legördülő lista nem engedélyezett. A fluorofórok hozzárendelésével
kapcsolatos információkért lásd: Célérték hozzárendelése cellákhoz a(z) 128. oldalon.

Tipp: Minden cellához vagy cellacsoporthoz csak egy mintanevet rendelhet hozzá.

Egy mintanév hozzárendeléséhez egy cellához vagy egy cellacsoporthoz

1. A Plate Editor (Lemez szerkesztő) menüben ellenőrizze, hogy a cella vagy a cellacsoport hozzá
van-e rendelve egy fluorofórhoz.

2. A lemez táblában válassza ki a cellát vagy a cellacsoportot.

3. A jobb oldali táblában válasszon ki egy nevet a Sample Names (Mintanevek) legördülő listából.

4. Ismételje meg az Lépjen ide: 3 mindegyik cellához vagy cellacsoporthoz, amelyhez hozzá kell
rendelnie egy mintanevet.

5. A módosítások elfogadásához és a lemez mentéséhez kattintson az OK gombra.

Mintanév eltávolítása

u Egy kiválasztott cellához vagy cellacsoporthoz tartozó mintanév eltávolításához szüntesse meg a
Load (Betöltés) jelölőnégyzet bejelölését.

130 | CFX96 Dx és CFX96 DeepWell Dx rendszerek



Opcionális paraméterek hozzárendelése a lemezfájlhoz

Mintanév hozzáadásához a listához

u Mintanév legördülő listához történő hozzáadásához végezze el az alábbiak egyikét:

n Írjon be egy nevet a Sample Names (Mintanevek) legördülő listába, és nyomja meg az Enter
(Bevitel) gombot.

n Kattintson a legördülő listától jobbra levő zöld színű + jelre, és írjon be egy nevet a mintához.

n Kattintson a User Preferences (Felhasználói preferenciák) gombra az eszközsoron, és adja
hozzá a nevet a Sample Names (Mintanevek) könyvtárhoz a Plate (Lemez) fülben.

Fontos: A legördülő listában hozzáadott mintanevek csak az aktuális lemezhez állnak
rendelkezésre, és csak akkor, ha a nevet egy cellához hozzárendeli és a lemezkiosztást
elmenti. Ha a név nincs hozzárendelve egy cellához és nincs elmentve a lemezkiosztás, a
rendszer nemmenti el a nevet, és az nem áll rendelkezésre későbbi felhasználásra. Egy
mintanév végleges hozzáadásához adja hozzá azt a Sample Names (Mintanevek)
könyvtárhoz is, a User Preferences (Felhasználói preferenciák) párbeszédablak
használatával. Az adattárhoz hozzáadott nevek akkor is elérhetők lesznek, amikor később
újból megnyitja a Plate Editor (Lemez szerkesztő) ablakot. További információkért lásd: A
lemezre vonatkozó alapértelmezett paraméterek beállítása a(z) 72. oldalon.

Egy mintanév listából való törléséhez

1. Az eszköztáron kattintson a User Preferences (Felhasználói preferenciák) elemre.

Megjelenik a User Preferences (Felhasználói preferenciák) párbeszédpanel és rajta a Plate
(Lemez) fül.

2. A Sample Names (Mintanevek) könyvtárban a Plate (Lemez) fülön válassza ki a törölni kívánt
nevet és nyomja meg a Delete (Törlés) gombot.

3. A módosítások mentéséhez és a User Preferences (Felhasználói preferenciák)
párbeszédpanelről történő kilépéshez kattintson az OK gombra.

Fontos: Egy lemezfájllal elmentett mintanevek nem törölhetők. A Sample Names
(Mintanevek) legördülő listához hozzáadott és nem a lemezzel használt valamint elmentett
egyéni nevek automatikusan eltávolításra kerülnek a legördülő listából. A Sample Names
(Mintanevek) könyvtárból törölt nevek véglegesen eltávolításra kerülnek a szoftverből, és
többé nem állnak a felhasználók rendelkezésére. A mintanevek törlésénél körültekintően kell
eljárni.
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Biológiai sorok hozzárendelése cellákhoz
Megjegyzés: biológiai sor hozzárendeléséhez a kiválasztott cellákat legalább egy fluorofórhoz
hozzá kell rendelni. Egy fluorofór hozzárendelése engedélyezi a (Biológiai csoportok) Biological
Set Name (Biológiai sor név) legördülő listát. A fluorofórok hozzárendelésével kapcsolatos
információkért lásd: Célérték hozzárendelése cellákhoz a(z) 128. oldalon.

Tipp: Minden cellához vagy cellacsoporthoz egy biológiai sort rendelhet hozzá.

Egy biológiai sor hozzárendelése egy cellához vagy cellacsoporthoz

1. A View (Nézet) opciók közül a Plate Editor (Lemez szerkesztő) ablak alján jelölje be a Biological Set
(Biológiai sor) jelölőnégyzetet.

2. A Plate Editor (Lemez szerkesztő) menüben ellenőrizze, hogy a cella vagy a cellacsoport hozzá
van-e rendelve egy fluorofórhoz.

3. A lemez táblában válassza ki a cellát vagy a cellacsoportot.

4. A jobb oldali táblában válasszon a (Biológiai csoport) Biological Set Name (Biológiai sor név)
legördülő listából.

A CFX Manager Dx szoftver automatikusan bejelöli annak Load (Betöltés) jelölőnégyzetét.

5. Ismételje meg a Lépjen ide: 4 mindegyik cellához vagy cellacsoporthoz, amelyhez hozzá kell
rendelnie egy biológiai sort.

6. A módosítások elfogadásához és a lemez mentéséhez kattintson az OK gombra.

Tipp: A biológiai sor nevek cellákhoz való hozzárendelése engedélyezi a Biological Set
Analysis Options-t (Biológiai sor analízis opciókat) az Experiment Settings (Kísérlet
beállítások) párbeszédablakban, amelyben mintaanalízist végezhet négy konfiguráció
egyikével. További információkért lásd: Kísérletbeállítások módosítása a(z) 139. oldalon.

Egy biológiai sor eltávolításához.

u Egy biológiai sor eltávolításához a kiválasztott cellából vagy cellacsoportból, szüntesse meg Load
(Betöltés) jelölőnégyzetének a bejelölését.

Egy biológiai sor hozzáadásához a listához

u Egy biológiai sor legördülő listához történő hozzáadásához írjon be egy nevet a Biological Set
Name (Biológiai sor név) legördülő listába, és nyomja meg az Enter (Bevitel) gombot.
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Fontos: A legördülő listában hozzáadott (Biológiai csoport nevek) Biological set names
(Biológiai sor nevek) csak az aktuális lemezhez állnak rendelkezésre, és csak akkor, ha a
név egy cellához lett hozzárendelve és a lemezkiosztás el lett mentve. Ha a név nincs
hozzárendelve egy cellához és nincs elmentve a lemezkiosztás, a rendszer nemmenti el a
nevet, és az nem áll rendelkezésre későbbi felhasználásra.

A lemezen levő összes biológiai sor megtekintéséhez

u Jelölje be a Biological Set (Biológiai sor) jelölőnégyzetet a View (Megtekintés) opciókban,
az Editor (Szerkesztő) ablak alján.

(Biológiai csoportok megjelenítése) (Biológiai csoportok elrejtése) Valamennyi cella megjeleníti a
saját biológiai sorának nevét, ha az hozzá lett rendelve. A Biological Set Name (Biológiai sor név)
vezérlő a jobb oldali lemezen jelenik meg.

A biológiai sorok elrejtéséhez szüntesse meg a Biological Set (Biológiai sor) jelölőnégyzet
bejelölését a View (Nézet) opciókban.

Replikátumok számainak cellákhoz rendelése
Fontos: A replikátumok számainak hozzárendeléséhez a kiválasztott celláknak azonos
cellatartalommal kell rendelkezniük. Vagyis a kiválasztott celláknak azonos mintatípussal és
fluorofórral kell rendelkezniük. Adott esetben további feltétel, hogy azonos célérték- és
mintaneveknek, valamint azonos biológiai sornak kell tartozniuk hozzájuk. Ha nem azonosak,
akkor a CFX Manager Dx szoftver nem engedélyezi ezt az opciót.

replikátumok számainak cellacsoporthoz rendelése

1. A Plate Editor (Lemez szerkesztő) ablakban győződjön meg arról, hogy a cellácsoportban
található cellák tartalma azonos.

2. A lemez panelen válassza ki a cél cellacsoportot.

3. Ha ugyanazt a replikátumszámot szeretné hozzárendelni az összes kiválasztott cellához, akkor a
jobb oldali panelen található Replicate # (Replikátumszám) szakaszban írja be a
replikátumszámot a mezőbe, majd jelölje be a Load (Betöltés) elemet.
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4. (Opcionális) Replikátumsorozat alkalmazása kiválasztott cellákhoz:

a. Kattintson a Technical Replicates (Technikai replikátumok) Replicate Series
(Replikátumsorozat) elemre. A Replicate # (Replikátumszám) szakasz megváltozik, és a
következő opciókat jeleníti meg:

n Replicate size (Replikátumméret) – a replikátumok egyes csoportjaiban található cellák
száma

n Starting replicate # (Kezdési replikátumszám) – a kiválasztott replikátumcsoportra
vonatkozóan a replikátumsorozatban található első szám

Megjegyzés: A CFXManager Dx szoftver alapértelmezés szerint a lemezben
hozzárendelt legutolsó replikátum számánál eggyel nagyobb számot jeleníti meg a
kezdési replikátumszámként. Ha például a lemezben az utolsó replikátum száma az
ötös, akkor a soron következő kezdési szám a hatos lesz. A kezdési számot bármilyen
számra módosíthatja, ami még nem lett hozzárendelve.

n Betöltési irány (Horizontal (Vízszintes) vagy Vertical (Függőleges))

b. A paramétereknek a sorozathoz történő alkalmazásához és a Replicate # (Replikátumszám)
kijelzőhöz történő visszatéréshez kattintson az Apply (Alkalmaz) elemre.

5. A módosítások elfogadásához és a lemez mentéséhez kattintson az OK gombra.

Egy cella eltávolítása egy replikátumsorozatból

u Válassza ki az eltávolítani kívánt cellát vagy cellacsoportot, majd törölje a Replicate # Load
(Replikátumszám-betöltés) jelölőnégyzetből a jelölést.

Másik lehetőségként a Clear Replicate # (Replikátumszám törlése) elemre is kattinthat, ha
szeretné törölni a replikátumszámot a kiválasztott cellából vagy cellacsoportból.
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Hígítási sor hozzárendelése standard mintatípusokhoz
A korábban említetteknek megfelelően valamennyi Standard mintatípusú cellához hozzá kell rendelni
egy koncentrációértéket. Egy hígítási sor több Standard mintatípusú cellához is hozzárendelhető.

Megjegyzés: Hígítási sor egy cellacsoporthoz történő hozzárendeléséhez a celláknak egy
replikátumsorozatban kell lenniük. A cellák replikátumsorozathoz történő hozzáadásával
kapcsolatos információkért lásd: Replikátumok számainak cellákhoz rendelése a(z) 133. oldalon.

Hígítási sor hozzárendelése standard mintatípusú cellacsoporthoz

1. A Plate Editor (Lemez szerkesztő) menüpontban ellenőrizze, hogy teljesültek-e az alábbi
követelmények:

n A cellacsoport mintatípusa Standard.

n A csoportban levő összes cellához legalább egy fluorofór hozzá van rendelve, és mind
ugyanazt a fluorofórt tartalmazza.

n A csoportban levő összes cella ugyanabban a replikátumsorozatban van.

Megjegyzés: A CFXManager Dx szoftver csak akkor engedélyezi a Dilution Series
(Hígítási sor) opciót, ha az összes kiválasztott cella eleget tesz ezeknek a
követelményeknek.

2. A lemez panelen válassza ki a cél cellacsoportot.

3. A jobb oldali táblában levő Concentration (Koncentráció) részben kattintson a Dilution Series
(Hígítási sorok) gombra. A Concentration (Koncentráció) rész átvált az alábbi opciók
megjelenítésére:
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n Starting concentration (Kiindulási koncentráció) — az a koncentrációérték, ahonnan a
sorozat kezdődik

n Replicates from and to (Replikátumok innentől eddig) — a sorozatban levő replikátumok,
amelyekre alkalmazva lesz a hígítási faktor

n Dilution factor (Hígítási faktor) — a koncentráció változtatásának mértéke az egyes
replikátumcsoportokban

4. Állítsa be az értékeket az opciókhoz, vagy fogadja el az alapértelmezett értékeket.

5. Alapértelmezett értékként a hígítási sorozat a hígítási faktorral csökken. A hígítási sorozat
növeléséhez válassza ki az Increasing (Növelés) lehetőséget.

6. (Opcionális) A hígítási faktor alapértelmezettként a replikátum sorozatban levő összes fluorofórra
érvényes. Ha az Ön sorozata egynél több fluorofórt tartalmaz és a hígítást egyetlen fluorofórra
akarja alkalmazni, akkor válassza ki azt a legördülő listából.

7. Kattintson az Apply (Alkalmaz) gombra a hígítási faktornak a cellacsoporthoz történő
alkalmazásához, és a Concentration (Koncentráció) nézetre történő visszalépéshez.

8. A módosítások elfogadásához és a lemez mentéséhez kattintson az OK gombra.

Cellatartalmak másolása egy másik cellába
Egy cella tartalmát kimásolhatja és beillesztheti egy egyedülálló cellába vagy több cellába. Azonban
csak egyetlen cella tartalmát tudja kimásolni. Nem tud kiválasztani több cellát és kimásolni azok
tartalmát.

A cellák tartalmának egy másik cellába történő bemásolása

1. A lemez panelen válassza ki a másolandó cellát.

2. A jobb gombbal kattintson a cellára és válassza ki a Copy Well (Cella másolása) opciót.

3. Válassza ki azt a cellát vagy cellákat, ahová be kívánja illeszteni a tartalmat:

n Egyetlen cella kiválasztásához kattintson az adott cellára.

n Több, egymással szomszédos cella kiválasztásához kattintson egy cellára, majd húzza az
egérmutatót a célcellára.

n Több, egymással nem szomszédos cella kiválasztásához tartsa nyomva a Control billentyűt,
majd kattintson az egyes cellákra.

4. Miközben a célcellák ki vannak választva, kattintson a jobb gombbal és válassza ki a Paste Well
(Cella beillesztése) parancsot.

A CFX Manager Dx szoftver beilleszti az első cella tartalmát a kiválasztott cellákba.
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Megjegyzés hozzáadása egy cellához
Lehetősége van leíró megjegyzést hozzáadni az egyes cellákhoz. A cellákhoz tartozó
megjegyzéseket a Data Analysis (Adatelemzés) ablakban található Quantification (Kvantifikáció) fülön
tekintheti meg.

Megjegyzés hozzáadása egy cellához

1. A lemezpanelen válassza ki az(oka)t a cellá(ka)t, amely(ek)hez szeretne hozzáadni egy
megjegyzést.

2. Az alsó panelen található View (Megtekintés) szakaszban válassza ki a Well Note
(cellamegjegyzés) elemet.

A Well Note (cellamegjegyzés) terület megjelenik a jobb oldali panelen.

3. Írja be a megjegyzés tartalmát a szövegbeviteli mezőbe, majd nyomja le az Enter billentyűt.

A szöveg a kiválasztott cellák alján jelenik meg.

Tipp: Ha Ön korábban már létrehozott egy cellamegjegyzést, akkor azt kiválaszthatja a
legördülő listából, és alkalmazhatja a kiválasztott cellákra.

Összes tartalom törlése cellákból
Lehetősége van egyetlen cellaból, több cellából vagy a teljes lemezből törölni az összes tartalmat. A
cellák tartalmának a törlésekor a lemezleolvasás során gyűjtött fluoreszcenciaadatokat nem távolítja
el a rendszer.

Egy cella tartalmának a törlésekor a rendszer véglegesen eltávolítja a tartalmat a cellából. Legyen
körültekintő a cellák tartalmának törlésekor.

Összes beállítás törlése cellákból

1. A Plate Editor (Lemez szerkesztő) ablak lemezpanelén válassza ki a cellát vagy a cellacsoportot:

n Ha csak egyetlen cellát szeretne kiválasztani, akkor kattintson az adott cellára.

n Ha több – egymással szomszédos – cellát szeretne kiválasztani, akkor kattintson egy cellára,
tartsa nyomva az egérgombot, majd húzza az egérmutatót a célcellára.

n Ha több – egymással nem szomszédos – cellát szeretne kiválasztani, akkor nyomja le és
tartsa nyomva a Control billentyűt, majd kattintson az egyes cellákra.
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n Ha egy egész oszlopot szeretne kiválasztani, amelyben mindegyik cella azonos mintatípusú,
akkor kattintson az adott oszlop számára.

n Ha egy egész sort szeretne kiválasztani, akkor kattintson az adott sor számára.

2. A jobb oldali panelen kattintson a Clear Wells (Cellák tartalmainak a törlése) elemre.

A(z) CFX Manager Dx szoftver az összes beállítást törli a kiválasztott cellákból.

3. A módosítások elfogadásához és a lemez mentéséhez kattintson az OK gombra.
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Kísérletbeállítások módosítása
Az Experiment Settings (Kísérlet beállítások) párbeszédpanel segítségével megtekintheti vagy
módosíthatja a célértékek és a minták listáját, vagy ha a lemezben található cellákhoz biológiai
sorokat rendelt, akkor kiválaszthatja a génexpresszió-elemzési csoportot és az elemzési opciót.

Az Experiment Settings (Kísérlet beállítások) párbeszédpanel Targets (Célértékek) fülén az egyes
PCR reakciókhoz kapcsolódó célértékek neveinek a listája látható, ideértve például a célgént vagy a
releváns génszekvenciákat.

A Samples fülön azoknak a mintáknak a nevei láthatók, amelyek a célérték forrását jelzik (például egy
1 óra után (1Hr) vagy egy meghatározott egyéntől (mouse1) vett mintát).

Lemezbeállítások módosítása az Experiment Settings (Kísérlet beállítások)
párbeszédpanel segítségével

1. Az Experiment Settings (Kísérlet beállítások) párbeszédpanel megnyitásához tegye a következők
egyikét:

n A Plate Editor (Lemez szerkesztő) ablak jobb oldali panelén kattintson az Experiment
Settings (Kísérlet beállítások) elemre.

n A Data Analysis (Adatelemzés) ablak Gene Expression (Génexpresszió) fülén kattintson az
Experiment Settings (Kísérlet beállítások) elemre.

Megjelenik az Experiment Settings (Kísérlet beállítások) párbeszédpanel és rajta a Targets
(Célértékek) fül tartalma.
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2. Ha új célértéket vagy -mintát szeretne hozzáadni, akkor írja be annak a nevét a megfelelő fülön a
New (Új) szövegbeviteli mezőbe, majd kattintson az Add (Hozzáadás) elemre.

3. Ha szeretne egy vagy több célértéket vagy -mintát eltávolítani a listából, akkor a megfelelő fülön
jelölje be az adott elem jelölőnégyzetét a Select to Remove (Jelölje be az eltávolításhoz)
oszlopban, majd kattintson a Remove checked item(s) (Bejelölt elem(ek) eltávolítása) elemre.

4. A(z) CFX Manager Dx szoftver az NTC (sablon nélküli kontroll) mintatípust kizárja a
génexpresszió-elemzésből.

Ha az NTCmintatípusokat szeretné belefoglalni az elemzésbe, akkor törölje a jelölőnégyzetéből
a jelölést az Exclude the following sample types (A következő mintatípusok kizárása)
szakaszban. A megfelelő jelölőnégyzet bejelölésével a következő mintatípusokat zárhatja ki:

n NRT (no reverse transcriptase, magyarul: reverz transzkriptáz nélküli kontroll)

n Negative Control (Negatív kontroll)

n Positive Control (Pozitív kontroll)

n Standard

5. A Targets (Célértékek) fülön:

a. Ha szeretne kiválasztani egy célértéket a génexpresszióadat-elemzés referenciájaként,
akkor azt a Reference (Referencia) oszlopban választhatja ki.

b. Ha az Analysis Settings (Elemzésbeállítások) ablak Gene Expression (Génexpresszió) fülén
szeretné elrejteni azokat az elemzési beállításokat, amelyeket a rendszer alkalmazni fog,
akkor törölje a Show Analysis Settings (Elemzésbeállítások mutatása) jelölőnégyzetből a
jelölést.

A szoftver elrejti a következő oszlopokat:

n Color (Szín)

n Show Chart (Diagrammutatása)

n Auto Efficiency (Automatikus hatásosság)

n Efficiency (%) (Hatásossági százalék)

c. Ha szeretné megváltoztatni a célértéknek a Gene Expression (Génexpresszió) diagramon
történő megjelenítési színét, akkor kattintson a célérték cellájára a Color (Szín) oszlopban,
válasszon egy új színt a megjelenő Color (Szín) párbeszédpanelen, majd kattintson az OK
(Rendben) elemre.
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d. A célértéknek a Gene Expression (Génexpresszió) diagramon a kiválasztott színnel történő
megjelenítéséhez jelölje be a célérték jelölőnégyzetét a Show Chart (Diagrammutatása)
oszlopban.

e. A(z) CFX Manager Dx alapértelmezés szerint automatikusan kiszámítja egy célérték relatív
hatásosságát, ha az adott célérték adatai standard görbét tartalmaznak.

Ha egy korábban meghatározott hatásossági értéket szeretne használni, akkor írja be az
értéket a cellájába az Efficiency (%) (Hatásossági százalék) oszlopba, majd nyomja le az
Enter (Bevitel) billentyűt. A(z) CFX Manager Dx törli az Auto Efficiency (Automatikus
hatásosság) jelölőnégyzetből a jelölést.

6. A Samples fülön:

a. Ha szeretne kiválasztani egy mintát a génexpresszióadat-elemzés kontroll mintájaként,
akkor jelölje be az adott minta vagy biológiai csoport jelölőnégyzetét a Control (Kontroll)
oszlopban.

b. Ha a kontroll feltételt szeretné hozzárendelni egy mintához egy futtatásnál, akkor jelölbe be a
jelölőnégyzetét a Control (Kontroll) oszlopban.

c. Ha a Show Analysis Settings (Elemzésbeállítások mutatása) jelölőnégyzet még nincs
bejelölve, akkor a bejelölésével a Gene Expression (Génexpresszió) fülön megtekintheti
vagy módosíthatja azokat az elemzési paramétereket, amelyeket a rendszer alkalmazni fog.
A szoftver elrejti a Color (Szín) és a Show Chart (Diagrammutatása) oszlopokat.

7. Ha Ön a lemezben található cellákhoz egy vagy több biológiai sort rendelt (lásd: Biológiai sorok
hozzárendelése cellákhoz a(z) 132. oldalon), akkor válassza ki a következő lehetőségek egyikét a
Biological Set Analysis Options (Biológiai sor elemzésére vonatkozó opciók) listából:

n Target vs. Sample (Célérték kontra minta) – A rendszer a génexpresszió-számítások során
kizárólag a cellaminta nevét fogja használni.

n Target vs. Biological Set (Célérték kontra biológiai sor) – A rendszer a számítások során
kizárólag a biológiai sor nevét fogja használni.

n Target vs. Sample_Biological Set (Célérték kontra minta_biológiai sor) – A rendszer a
minta nevét és a biológiai sor nevét összevonja, majd az így létrehozott egyetlen nevet fogja
használni a számítások során.

n Target vs. Biological Set_Sample (Célérték kontra biológiai sor_minta) – A rendszer a
biológiai sor nevét és a minta nevét összevonja, majd az így létrejött egyetlen nevet fogja
használni a számítások során.

8. Az Experiment Settings (Kísérletbeállítások) párbeszédpanelen található paraméterek
mentéséhez és a Plate Editor (Lemezszerkesztő) ablakhoz történő visszatéréshez kattintson az
OK gombra.
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Cellacsoportok létrehozása
A cellacsoportok cella-alkészletekre osztanak egy lemezt, amelyek függetlenül analizálhatók a Data
Analysis (Adatelemzés) ablakban. A cellacsoportok beállítása után válasszon ki egyet a Data Analysis
(Adatelemzés) ablakban az adatok független csoportként történő elemzéséhez. Például állítson be
cellacsoportokat egy lemezben futtatott többszörös kísérletek elemzéséhez vagy mindegyik
cellacsoport különböző standard görbével történő elemzéséhez.

Megjegyzés: Az alapértelmezett cellacsoport All Wells (Összes cella).

Cellacsoportok létrehozásához

1. A Well Groups Manager (Cellacsoport kezelő) megnyitásához végezze el az alábbiak egyikét:

n A Plate Editor (Lemez szerkesztő) eszköztárban kattintson aWell Groups (Cellacsoportok)
opcióra.

n A Data Analysis (Adatelemzés) ablakban kattintson a ManageWell Groups (Cellacsoportok
kezelése) opcióra.

Ekkor megjelenik a Well Groups Manager (Cellacsoport kezelő) párbeszédpanel.

2. Kattintson az Add (Hozzáadás) parancsra egy új csoport létrehozásához. A legördülő menüben a
csoport neveként Group 1 (1. csoport) jelenik meg az első csoporthoz.

3. Válassza ki a cellákat a cellacsoporthoz a lemez nézetben az egérrel a cellacsoportba kattintva
és keresztül húzva. A kiválasztott cellák kék színnel jelennek meg a Manager (Kezelő) ablakban.

4. (Opcionális) A csoport nevének módosításához válassza ki annak nevét a legördülő menüből és
írjon be egy új nevet.
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5. (Opcionális) Cellacsoport törléséhez válassza ki annak nevét a legördülő listából és kattintson a
Delete (Törlés) parancsra.

6. Kattintson az OK gombra a befejezéshez, és zárja be az ablakot, vagy kattintson a Cancel
(Mégse) gombra az ablak bezárásához a módosítások elmentése nélkül.

Fontos: A cellacsoportok megjelenítéséhez válassza ki a Well Groups (Cellacsoportok)
lehetőséget a View (Nézet) opciókban a Plate Editor (Lemezszerkesztő) ablak alján.
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A Well Groups Manager (Cellacsoportkezelő) párbeszédpanelen a jobb
egérgombra kattintással elérhető menüpontok

Az 13. táblázat azokat a menüpontokat határozza meg, amelyek bármely cellára a jobb egérgombbal
kattintva elérhetők a Well Groups Manager (Cellacsoportkezelő) párbeszédpanelen.

Pont Funkció

Copy (Másolás) A cellatartalmak másolása, amelyek azután beilleszthetők
egy másik cellába vagy cellákba.

Copy as Image (Másolás
képként)

A cellaválasztó nézet másolása képként.

Print (Nyomtatás) A cellaválasztó nézet nyomtatása.

Print Selection (A kiválasztott
rész nyomtatása)

Kizárólag a kiválasztott cellák nyomtatása.

Export to Excel (Exportálás
Excel-fájlba)

Az adatok exportálása Excel-táblázatba.

Export to Csv (Exportálás .csv
kiterjesztésű fájlba)

Az adatok exportálása vesszővel tagolt dokumentumként.

Export to Xml (Exportálás .xml
kiterjesztésű fájlba)

Az adatok exportálása .xml kiterjesztésű
dokumentumként.

Export to Html (Exportálás .html
kiterjesztésű fájlba)

Az adatok exportálása .html kiterjesztésű
dokumentumként.

13. táblázat. A Plate Editor (Lemez szerkesztő) ablak Well Selector (Cellaválasztó)
párbeszédpanelén a jobb egérgombra kattintással elérhető menüpontok
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Jelstílusok módosítása
A lemezbeállítás során, valamint olyankor, amikor egy futtatás folyamatban van, módosíthatja az
amplifikációs jelek színét és stílusát. Így azután könnyen megtekintheti a jeleket a valós idejű állapotot
mutató ablakban, amint a rendszer összegyűjti az adatokat.

Jelstílusok módosítása

1. Kattintson a Trace Styles (Jel stílusa) elemre a Plate Editor (Lemez szerkesztő) eszköztárban.

Megjelenik a Trace Styles (Jel stílusa) párbeszédpanel az aktuálisan megnyitott lemezhez.
Például:

2. Ha egy adott fluorofór szerint szeretné megjeleníteni a jelstílusokat, akkor válassza ki az adott
fluorofórt a Fluorophores (Fluorofórok) legördülő listából.

3. A jel megjelenítési formájának a módosítása:

a. Válassza ki a jel típusát a Wells (Cellák) legördülő listából.

b. Kattintson a színére a Color (Szín) oszlopban.

c. A megjelenő Color (Szín) párbeszédpanelen válasszon ki egy másik színt a jelhez, majd
kattintson az OK (Rendben) gombra.

Az adott cellatípushoz kapcsolódó változás megjelenik az alul található rácsban.

d. (Opcionális) Válasszon ki egy szimbólumot a jelhez a Symbols (Szimbólumok) legördülő
listából.
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4. A színbeállítás gyors módosításához kattintson a kívánt elemre a Color Quick Set (Szín
gyorsbeállítása) szakaszban.

5. Ha a cellacímkéket szeretné megtekinteni a rácsban, akkor válassza ki a címketípust a Well
Labels (Cellacímkék) szakaszban.

6. A módosítások mentéséhez kattintson az OK (Rendben) gombra, vagy a módosítások
elvetéséhez kattintson a Cancel (Mégse) gombra.
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A lemez megtekintése táblázatos formátumban
A Spreadsheet View/Importer (Táblázatos nézet / Importáló) eszköz táblázatos formátumban jeleníti
meg egy lemez tartalmait. A Spreadsheet View/Importer (Táblázatos nézet / Importáló) eszköz
segítségével tabulátorral tagolt formátumban exportálhatja a cellatartalmakat egy alkalmazásba
(például a Microsoft Excel programba). Ezen kívül importálhat is cellatartalmakat egy tabulátorral
tagolt formátumú fájlt készítő alkalmazásból.

A Spreadsheet View/Importer (Táblázatos nézet / Importáló) eszköz használata

1. A Plate Editor (Lemez szerkesztő) eszköztárban kattintson a Spreadsheet View/Importer
(Táblázatos nézet / Importáló) elemre a lemezre vonatkozó Spreadsheet View (Táblázatos nézet)
párbeszédpanel megnyitásához.

2. A Spreadsheet View (Táblázatos nézet) párbeszédpanel egyetlen fluorofórra vonatkozóan jeleníti
meg a lemez tartalmait. Ha egy másik fluorofórra vonatkozóan szeretné megtekinteni a lemez
tartalmait, akkor válassza ki az adott fluorofórt a Fluors List (Fluorofórok listája) legördülő listából.

3. Kattintson az Export Template (Sablon exportálása) elemre, ha a lemez táblázatának egy
sablonját szeretné egy (.csv formátumú) Excel-fájlba exportálni. Ezt a sablont szerkesztheti, hogy
a segítségével a cellatartalomra vonatkozó információkat importálhasson.

4. (Opcionális) Kattintson az Import (Importálás) elemre, ha cellatartalmakat szeretne importálni egy
vesszővel tagolt fájlból.
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5. Ha egy adott oszlopban található adatok szerint szeretné rendezni a táblázatot, akkor kattintson
az adott oszlop neve mellett látható háromszögre.

Tipp: Bármely olyan oszlopban található cellák tartalmát szerkesztheti, amelynek a neve
mellett egy csillag (*) látható (például *Target Name (*Célértéknév)).

Megjegyzés: Válassza ki az egységeket a Quantity (Mennyiség) oszlopban található
standardgörbe-adatokhoz oly módon, hogy megnyitja a Plate Editor (Lemez szerkesztő) ablakot
és a menüsorban kiválasztja a Settings > Units (Beállítások > Egységek) elemet. A lemez
futtatásának befejeződését követően az ezekből a standardokból származó adatok az Ön által
kiválasztott egységekkel megjelennek a Data Analysis (Adatelemzés) ablak Quantification
(Kvantifikáció) fülén látható Standard Curve (Standard görbe) diagramon.

A lemezre vonatkozó Spreadsheet View/Importer (Táblázatos nézet / Importáló)
eszközhöz a jobb egérgombra kattintással elérhető menüpontok

A(z) 14. táblázat azokat a menüpontokat határozza meg, amelyek a Spreadsheet View/Importer
(Táblázatos nézet / Importáló) eszközben elérhetők, amikor ebben az eszközben bármely cellára
rákattint a jobb egérgombbal.

Pont Funkció

Copy (Másolás) A teljes táblázat másolása.

Copy as Image
(Másolás képként)

A táblázat másolása képfájlként.

Print (Nyomtatás) A táblázat nyomtatása.

Print Selection (A
kiválasztott rész
nyomtatása)

Kizárólag a kiválasztott cellák nyomtatása.

Export to Excel
(Exportálás Excel-
fájlba)

A fájl exportálása egy Excel-táblázatba.

Export to CSV
(Exportálás .csv
kiterjesztésű fájlba)

A fájl exportálása .csv kiterjesztésű fájlként.

14. táblázat. A lemezre vonatkozó Spreadsheet View/Importer (Táblázatos nézet /
Importáló) eszközben a jobb egérgombra kattintással elérhető menüpontok
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Pont Funkció

Export to Xml
(Exportálás .xml
kiterjesztésű fájlba)

A fájl exportálása .xml kiterjesztésű fájlként.

Export to Html
(Exportálás .html
kiterjesztésű fájlba)

A fájl exportálása .html kiterjesztésű fájlként.

Find (Keresés) Meghatározott szöveg keresése.

Sort (Rendezés) A táblázat rendezése oly módon, hogy a Sort (Rendezés) ablakban
legfeljebb három oszlopnyi adat kerül kiválasztásra.

14. táblázat. A lemezre vonatkozó Spreadsheet View/Importer (Táblázatos nézet /
Importáló) eszközben a jobb egérgombra kattintással elérhető menüpontok, folytatás
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Lemezelrendezés létrehozása a Plate Setup Wizard
(Lemezbeállítás varázsló) segítségével

A Setup Wizard (Beállítás varázsló) segítségével beírhatja a normalizált génexpresszió elemzéséhez
szükséges lemezelrendezési információkat, beleértve a következőket:

n Célértéknevek

n Mintanevek

n A célértékek és a minta helye a lemezen

n Referenciagén(ek)

n Kontroll minta

A Setup Wizard (Beállítás varázsló) funkciót futtatás előtt, közben és után is használhatja.

A Plate Setup Wizard (Lemezbeállítás varázsló) használata
Ez a rész ismerteti a lemezelrendezés létrehozását a lemez Setup Wizard (Lemezbeállítás varázsló)
használatával. A lemezben levő egyes cellák egyszerűbb megtekintéséhez kattintson a Zoom plate
(Lemez beközelítése) opcióra a Setup Wizard (Beállítás varázsló) tetejénél.

Fontos: Ha visszatér az Auto layout (Automatikus elrendezés) fülre, miközben a Setup Wizard
(Beállítás varázsló) bármelyik fülén van, visszaállítja a lemez elrendezését. Legyen körültekintő,
amikor ezt a fület választja ki.

Tipp: Az elrendezést a Tools > Clear Plate (Eszközök > Lemez kiürítése) kiválasztásával
állíthatja vissza a Setup Wizard (Beállítás varázsló) ablakban.

A lemez Setup Wizard (Beállítás varázsló) használatához

1. Nyissa meg a Plate Editor (Lemez szerkesztő) ablakot.

2. A Setup Wizard (Beállítás varázsló) megnyitásához válassza ki az Editing Tools > Setup Wizard
(Szerkesztő eszközök > Beállítás varázsló) ablakot.

Megjelenik a Setup Wizard (Beállítás varázsló) az Auto layout (Automatikus elrendezés) fület
megjelenítve.
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Lemezelrendezés létrehozása a Plate Setup Wizard (Lemezbeállítás varázsló) segítségével

3. Az Auto layout (Automatikus elrendezés) fülben végezze el az alábbiak egyikét:

a. Kattintson egy cellára a hálózatban és húzza keresztbe és lefelé a lemezen annak a
területnek a meghatározására, ahová egy minta betöltését tervezi.

b. Írja be a betöltendő célok és minták számát.

Tipp: A betöltendő célok és minták számának meg kell egyeznie a kiválasztott cellák
számával. Ha a beírt szám nem fér a kiválasztott területbe, akkor módosítsa vagy a
számokat, vagy a lemezen kiválasztott terület méretét. Az elemek lemezen belül
orientációja és csoportosítása megadható.

c. (Opcionális) Módosítsa a lemez orientációját. Például beállíthatja a célokat oszlopokba, a
mintákat pedig sorokba, vagy csoportosíthat minták szerint.

d. Kattintson a Next (Tovább) gombra a „Target names” (Célértéknevek) fülre lépéshez.

Megjegyzés: Ha az Ön lemezelrendezése nem rendelkezik szabályos mintával, akkor
céljainak manuális pozícionálásához használja a Target names (Célértéknevek) fület, vagy a
minták lemezen történő manuális pozícionálásához a Sample names (Mintanevek) fület.
Több cella kiválasztásához végezzen kattintást és húzást.
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7. fejezet Lemezek előkészítése

4. A Target names (Céléertéknevek) fülben definiálja a cél neveket a cél csoportokhoz:

a. Végezze el az alábbiak egyikét:

n A célok csoportonkénti átnevezéséhez állítsa be a Select by (Kijelölési szempont) opciót
a Target (Célérték) lehetőségre.

n Célok cellánkénti átnevezéséhez állítsa a Select by (Kijelölési szempont) opciótWell
(Cella) lehetőségre.

b. Válasszon ki egy cél csoportot vagy egy cellát a hálózatban, és írjon be egy nevet a Target
name (Célértéknév) legördülő listába.

Tipp: Nyomja meg a Tab gombot a következő jobbra levő csoport vagy cella
kiválasztásához, vagy az Enter gombot a lent levő következő csoport vagy cella
kiválasztásához. Másik lehetőségként több, nem egymás mellett levő cella
kiválasztásához a Target name (Célértéknév) és Sample name (Minta név) fülekben
tartsa lenyomva a Control gombot és kattintson rá az egyes cellákra.

c. Kattintson a Next (Tovább) gombra a Sample names (Minta nevek) fülre történő
továbblépéshez.

5. A Sample names (Minta nevek) fülben határozzon meg minta neveket a mintacsoportokhoz.

6. Kattintson a Next (Tovább) gombra a Reference Targets (Referencia célok) fülre történő
továbblépéshez.

7. A Reference targets (Referencia célok) fülben válasszon ki egy vagy több célt a normalizált
génexpresszióhoz referenciaként történő felhasználásra, és kattintson a Next (Tovább) gombra a
Control sample (Kontroll minta) fülre való továbblépéshez.

8. A Control sample (Kontroll minta) fülben válasszon ki egy mintát relatív génexpresszió-
számításokhoz.

9. Kattintson az OK gombra a lemezelrendezés elmentéséhez, és térjen vissza a Plate Editor
(Lemez szerkesztő) ablakra, amelyben folytathatja a lemezparaméterek definiálását. További
információkért lásd:Opcionális paraméterek hozzárendelése a lemezfájlhoz a(z) 127. oldalon.

Másik megoldásként kattintson a Previous (Előző) gombra egy korábbi fülre való visszatéréshez
bármilyen módosítás végrehajtásához.

Megjegyzés: Az Auto layout (Automatikus elrendezés) fülre való visszatérés automatikusan
visszaállítja a lemezt. Óvatosan járjon el a Previous (Előző) gomb megnyomásakor.
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8. fejezet Kísérletek futtatása
Ez a fejezet az egyedi (felhasználó által definiált) vagy PrimePCR (PrimePCR) vizsgálati
kísérleteknek a CFX Manager Dx szoftverrel történő lefuttatását ismerteti.

A futtatás adatfájlok protokoll- és lemezinformációkat tartalmaznak a futtatáshoz. A fájl azoknak az
elemzéseknek az adatait is tartalmazza, amelyeket a CFX Manager Dx a futtatás befejezése után
végez el.

A CFX Manager Dx szoftver megkönnyíti a felhasználó által definiált vagy PrimePCR (PrimePCR)
kísérletek beállítását és futtatását. A Run Setup (Futtatás beállításai) ablak végigvezeti Önt egy
kísérlet beállításának a szokásos lépésein, ami a Start Run (Futtatás indítása) párbeszédpanelhez
vezeti, ahonnan elindíthatja a futtatást.

A Run Setup (Futtatás beállítása) ablak megnyitása
Teendők a Run Setup (Futtatás beállítása) ablak megnyitásához

u Végezze el az alábbiak egyikét:

n A Startup Wizard (Indítási varázsló) Run Setup (Futtatás beállítása) fülén kattintson a User-
defined (Felhasználó által meghatározott) vagy a PrimePCR elemre.

n A Home (Kezdőlap) ablakban található eszköztárban kattintson a User-defined Run Setup
(Felhasználó által meghatározott futtatás beállítása) vagy a PrimePCR Run Setup
(PrimePCR futtatás beállítása) elemre.

n A Home (Kezdőlap) ablakban válassza a Run > User-defined Run (Futtatás > Felhasználó
által meghatározott futtatás) vagy a Run > PrimePCR Run (Futtatás > PrimePCR futtatás)
elemet.
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8. fejezet Kísérletek futtatása

A Run Setup (Futtatás beállításai) ablak
A Run Setup (Futtatás beállításai) ablak gyors hozzáférést kínál egy kísérlet beállításához és
futtatásához szükséges fájlokhoz és beállításokhoz. Ha Ön egy felhasználó által beállított kísérlet
futtatását választja, akkor megnyílik a Run Setup (Futtatás beállításai) ablak és rajta a Protocol
(Protokoll) fül. Ha Ön egy PrimePCR kísérlet futtatását választja, akkor megnyílik a Run Setup
(Futtatás beállításai) ablak és rajta a Start Run (Futtatás indítása) fül.

Tipp: A PrimePCR típusú kísérletre vonatkozó bővebb információkért lásd: PrimePCR
(PrimePCR) kísérletek végrehajtása a(z) 172. oldalon; a Start Run (Futtatás indítása) fülre
vonatkozó bővebb információkért lásd: A Start Run (Futtatás indítása) fül a(z) 162. oldalon.
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A Run Setup (Futtatás beállításai) ablak

1. A fülek végigvezetik Önt a kísérletrk beállításának és futtatásának a lépésein:

n Protocol (Protokoll) fül – egy meglévő protokoll kiválasztása futtatás vagy
szerkesztés céljából, vagy egy új protokoll létrehozása a Protocol Editor
(Protokoll szerkesztő) ablakban.

n Plate (Lemez) fül – egy meglévő lemez kiválasztása futtatás vagy szerkesztés
céljából, vagy egy új lemez létrehozása a Plate Editor (Lemez szerkesztő)
ablakban.

n Start Run (Futtatás indítása) fül – a kísérlet beállításainak a megtekintése, egy
vagy több műszerblokk kiválasztása, valamint a futtatás elkezdése.

2. A fő ablakban megjelennek az egyes fülekre vonatkozó opciók, amikor Ön
azokat alkalmazza.

3. A navigálási gombok a Start Run (Futtatás indítása) fülre vezetik Önt.

JELMAGYARÁZAT
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8. fejezet Kísérletek futtatása

A Protocol (Protokoll) fül
A Protocol (Protokoll) fülön megjelenik az Ön által futtatni tervezett protokollfájl előnézeti képe.
A protokollfájl a műszer által alkalmazandó hőmérsékleti lépésekre vonatkozó instrukciókat, valamint
a növekedési/csökkenési sebességet, a mintatérfogatot és a fedélhőmérsékletet vezérlő
műszeropciókat tartalmazza.

A szoftver alapértelmezés szerint a File Selection for Run Setup (Fájl kiválasztása a futtatás
beállításához) szakaszban meghatározott protokollt jeleníti meg a User > User Preferences
(Felhasználó > Felhasználói preferenciák) párbeszédpanel Files (Fájlok) fülén. Az alapértelmezett
protokollt módosíthatja a User Preferences (Felhasználói preferenciák) párbeszédpanelen. További
információkért lásd: Az alapértelmezett fájlbeállítások módosítása a(z) 69. oldalon.

A Protocol (Protokoll) fülön a következőket teheti:

n Új protokoll létrehozása és futtatása

n Meglévő protokoll kiválasztása és futtatása vagy szerkesztése

Ha bővebb információkat szeretne olvasni a protokollok létrehozásáról és módosításáról, akkor lásd:
6. fejezet, Protokollok létrehozása.
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A Protocol (Protokoll) fül

Új protokoll létrehozása

1. A Protocol (Protokoll) fülön kattintson a Create New (Új létrehozása) elemre.

Megjelenik a Protocol Editor (Protokoll szerkesztő).

2. Új protokoll létrehozásához használja a Protocol Editor (Protokoll szerkesztő) ablakot.

3. A protokoll mentéséhez, valamint a Run Setup (Futtatás beállításai) ablakban található Protocol
(Protokoll) fülre történő visszatéréshez kattintson az OK gombra.

4. Tekintse meg a protokoll részleteit, majd tegye a következők egyikét:

n Ha a részletek helyesek, akkor kattintson a Next (Tovább) elemre a Plate (Lemez) fülre
történő továbblépéshez.

n Ha a részletek helytelenek, akkor kattintson az Edit Selected (Kijelölt elemek szerkesztése)
gombra a Protocol Editor (Protokoll szerkesztő) ablakhoz történő visszatéréshez. Módosítsa
a protokollt, mentse a módosításokat, majd a Protocol (Protokoll) fülön kattintson a Next
(Tovább) elemre a Plate (Lemez) fülre történő továbblépéshez.

Meglévő protokoll kiválasztása

1. A Protocol (Protokoll) fülön tegye a következők egyikét:

n Kattintson a Select Existing (Meglévő kiválasztása) elemre, majd tallózza be a meglévő
protokollt.

n Kattintson az Express Load (Expressz betöltés) elemre, és válasszon egy protokollt a
protokollok legördülő listájából.

Tipp: Lehetősége van protokollokat hozzáadni az Express Load (Expressz betöltés)
legördülő listához vagy onnan eltávolítani őket. További információkért lásd az alább
található Express Load (Expressz betöltés) protokollok hozzáadása és eltávolítása
szakaszt.

2. Tekintse meg a protokoll részleteit, majd tegye a következők egyikét:

n Ha a részletek helyesek, akkor kattintson a Next (Tovább) elemre a Plate (Lemez) fülre
történő továbblépéshez.

n Ha a részletek helytelenek, akkor kattintson az Edit Selected (Kijelölt elemek szerkesztése)
gombra a Protocol Editor (Protokoll szerkesztő) ablak megnyitásához. Módosítsa a
protokollt, mentse a módosításokat, majd a Protocol (Protokoll) fülön kattintson a Next
(Tovább) elemre a Plate (Lemez) fülre történő továbblépéshez.
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8. fejezet Kísérletek futtatása

Express Load (Expressz betöltés) protokollok hozzáadása és eltávolítása

Módosíthatja az Express Load (Expressz betöltés) legördülő lista tartalmát, amely a Protocol Editor
(Protokoll szerkesztő) ablakban jelenik meg. Az ebben a listában szereplő protokollok a következő
mappában vannak elmentve:

c:\Users\Public\Documents\Bio-Rad\CFX\Users\<user_name>\ExpressLoad\

Az Express Load (Expressz betöltés) protokoll lista módosításához

1. Keresse meg és nyissa meg az ExpressLoad mappát.

2. Tekintse át a protokollfájlokat (.pcrl) a mappában.

3. Végezze el az alábbiak valamelyikét:

n A legördülő listából történő eltávolításhoz törölje a protokollokat a mappából.

n A legördülő listához történő hozzáadáshoz másolja a protokollokat a mappába.
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A Plate (Lemez) fül

A Plate (Lemez) fül
Megjegyzés: Ha a Protocol (Protokoll) fülön kiválasztott protokoll nem tartalmaz valós idejű
PCR-elemzésre vonatkozó lemezleolvasási lépést, akkor a rendszer a Plate (Lemez) fület elrejti.
A Plate (Lemez) fül megtekintéséhez adjon legalább egy lemezleolvasást a protokollhoz.

A Plate (Lemez) fülön megjelenik az Ön által betölteni tervezett lemezfájl előnézeti képe. Valós idejű
PCR-futtatásnál a lemezfájl tartalmazza az egyes cellák tartalmának a leírását, beleértve annak
fluorofórjait, a leolvasási módot, valamint a lemeztípust. A CFX Manager Dx szoftver ezeket a
leírásokat adatok gyűjtéséhez és elemzéséhez használja.

A szoftver alapértelmezés szerint a File Selection for Run Setup (Fájl kiválasztása a futtatás
beállításához) szakaszban meghatározott lemezt jeleníti meg a User > User Preferences
(Felhasználó > Felhasználói preferenciák) párbeszédpanel Files (Fájlok) fülén. Az alapértelmezett
lemezt módosíthatja a User Preferences (Felhasználói preferenciák) párbeszédpanelen. További
információkért lásd: Az alapértelmezett fájlbeállítások módosítása a(z) 69. oldalon.

A Plate (Lemez) fülön a következőket teheti:

n Új lemez létrehozása és betöltése.

n Meglévő lemez kiválasztása és betöltése vagy szerkesztése.

Ha bővebb információkat szeretne olvasni a lemezek létrehozásáról és módosításáról, akkor lásd: 7.
fejezet, Lemezek előkészítése.
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8. fejezet Kísérletek futtatása

Új lemez létrehozása

1. A Plate (Lemez) fülön kattintson a Create New (Új létrehozása) elemre.

Megjelenik a Plate Editor (Lemez szerkesztő).

2. Új lemez létrehozásához használja a Plate Editor (Lemez szerkesztő) ablakot.

3. A lemez mentéséhez, valamint a Run Setup (Futtatás beállításai) ablakban található Plate
(Lemez) fülre történő visszatéréshez kattintson az OK gombra.

4. Tekintse meg a lemez részleteit, majd tegye a következők egyikét:

n Ha a részletek helyesek, akkor kattintson a Next (Tovább) elemre a Start Run (Futtatás
indítása) fülre történő továbblépéshez.

n Ha a részletek helytelenek, akkor kattintson az Edit Selected (Kijelölt elemek szerkesztése)
gombra a Plate Editor (Lemez szerkesztő) ablakhoz történő visszatéréshez. Módosítsa a
lemezfájlt, mentse a módosításokat, majd a Plate (Lemez) fülön kattintson a Next (Tovább)
elemre a Start Run (Futtatás indítása) fülre történő továbblépéshez.

Meglévő lemezfájl kiválasztása

1. A Plate (Lemez) fülön tegye a következők egyikét:

n Kattintson a Select Existing (Meglévő kiválasztása) elemre, majd tallózza be a meglévő
lemezfájlt.

n Kattintson az Express Load (Expressz betöltés) elemre, és válasszon egy lemezfájlt a
legördülő listából.

Tipp: Lehetősége van lemezeket hozzáadni az Express Load (Expressz betöltés)
legördülő listához vagy onnan eltávolítani azokat. További információkért lásd az alább
található Express Load (Expressz betöltés) lemezfájlok hozzáadása és eltávolítása
szakaszt.

2. Tekintse meg a lemez részleteit, majd tegye a következők egyikét:

n Ha a részletek helyesek, akkor kattintson a Next (Tovább) elemre a Start Run (Futtatás
indítása) fülre történő továbblépéshez.

n Ha a részletek helytelenek, akkor kattintson az Edit Selected (Kijelölt elemek szerkesztése)
gombra a Plate Editor (Lemez szerkesztő) ablak megnyitásához. Módosítsa a lemezfájlt,
mentse a módosításokat, majd kattintson a Next (Tovább) elemre a Start Run (Futtatás
indítása) fülre történő továbblépéshez.
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A Plate (Lemez) fül

Express Load (Expressz betöltés) lemezfájlok hozzáadása és eltávolítása

Lehetősége van módosítani a Plate Editor (Lemez szerkesztő) ablakban megjelenő Express Load
(Expressz betöltés) legördülő lista tartalmát. A listában megjelenő lemezek a következő mappában
vannak elmentve:

c:\Users\Public\Documents\Bio-Rad\CFX\Users\<user_name>\ExpressLoad\

A lemezfájlok Express Load (Expressz betöltés) listájának a módosítása

1. Keresse meg és nyissa meg az ExpressLoad mappát.

2. Tekintse át a mappában található (.pltd kiterjesztésű) lemezfájlokat.

3. Végezze el az alábbiak egyikét:

n A legördülő listából történő eltávolításhoz törölje a lemezfájlokat a mappából.

n A legördülő listához történő hozzáadáshoz másolja a lemezfájlokat a mappába.
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8. fejezet Kísérletek futtatása

A Start Run (Futtatás indítása) fül
A Start Run (Futtatás indítása) fülön a futtatni kívánt kísérletre vonatkozó információk láthatók. Ezen
kívül megjeleníti az(oka)t a csatlakoztatott műszerblokko(ka)t, amely(ek)en Ön lefuttathatja a
kísérletet.

A Start Run (Futtatás indítása) fülön a következőket teheti:

n A futtatásra vonatkozó részletes információk megtekintése, beleértve a kiválasztott protokollfájlt,
lemezfájlt és leolvasási módot.

n A futtatásra vonatkozó megjegyzések hozzáadása.

n Az összes csatlakoztatott műszerre vonatkozó részletek megtekintése, beleértve a futattási
állapotukat (értsd: éppen futnak-e vagy üresjáratban vannak), a mintatérfogat µl
mértékegységben kifejezett értékét, a fedélhőmérsékletet, az emulációs módot, valamint – ha
elérhető – az azonosítót vagy a vonalkódot.

Megjegyzés: Lehetősége van módosítani, hogy mely oszlopok jelenjenek meg a Start Run
on Selected Blocks (Futtatás indítása a kiválasztott blokkokon) táblában. Bővebb
információkért lásd: Részletek módosítása a Selected Blocks (Kiválasztott blokkok) táblában
a(z) 163. oldalon.
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A Start Run (Futtatás indítása) fül

n Annak/azoknak a blokknak/blokkoknak a kiválasztása, amelyen/amelyeken szeretné a futtatást
elvégezni.

n Az egyes kiválasztott műszerek fedelének távolról (értsd: távoli kapcsolaton keresztül) történő
kinyitása vagy lezárása.

n A futás elindítása.

Részletek módosítása a Selected Blocks (Kiválasztott blokkok) táblában

Módosíthatja a Start Run on Selected Blocks (Futtatás indítása a kiválasztott blokkokon) táblában
megjelenő oszlopokat. Az alapértelmezett mintatérfogat és fedél hőmérsékletértékeket szintén
módosíthatja a táblában. A beállítás-módosításokat a rendszer a végrehajtandó futtatásra
alkalmazza.

Oszlopoknak a Start Run on Selected Blocks (Futtatás indítása a kiválasztott blokkokon)
táblához történő hozzáadásához

u A jobb egérgombbal kattintson a táblára, és válasszon ki egy opciót a megjelenő menüben.

Oszlopoknak a Start Run on Selected Blocks (Futtatás indítása a kiválasztott blokkokon)
táblából történő eltávolításához

u A jobb egérgombbal kattintson a táblára, és ürítse ki az opciót a megjelenő menüben.

A mintatérfogat vagy a fedél hőmérséklet szerkesztéséhez egy blokkhoz

u Válassza ki a mintatérfogat vagy a fedél hőmérséklet mezőt a célblokkhoz, és írjon be egy új
értéket a mezőbe.

Futtatásazonosítónak vagy vonalkódnak a blokkhoz történő hozzáadásához

u Válassza ki az ID/Bar Code (Azonosító/Vonalkód) mezőt a célblokkhoz, és írjon be egy
azonosítót vagy szkennelje le a blokkot egy vonalkód olvasóval.

Kísérlet futtatása
Fontos: Kísérlet lefuttatása előtt ügyeljen arra, hogy a számítógépe vírusölő programja ne
kezdjen el szkennelni a futtatás közben.

Kísérlet futtatása

1. A Start Run (Futtatás indítása) fülön ellenőrizze a lemez- és protokoll részleteket a Run
Information (Futtatási információk) részben.

2. (Opcionális) A futtatással vagy a kísérlettel kapcsolatos megjegyzéseket írja be a Notes
(Megjegyzések) szövegpanelbe.
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3. Válassza ki egy vagy több blokk jelölőnégyzetét, amelyeken végre akarja hajtani a futtatást.

Tipp: Az összes blokkon futtatott kísérlethez válassza ki a Select All Blocks (Összes blokk
kiválasztása) opciót a Selected Blocks (Kiválasztott blokkok) táblázat alatt .

4. (Opcionális) Kattintson a Flash Block Indicator (Blokk indikátor villogtatása) opcióra az indikátor LED
villogtatásához a kiválasztott műszerblokkoknál.

5. Illessze a kísérleti lemezeket a blokkba:

a. Kattintson az Open Lid (Fedél felnyitása) gombra. Az egyes kiválasztott blokkok motorizált
fedele felnyílik.

b. Illesszen egy kísérleti blokkot az egyes kiválasztott blokkokba.

c. Kattintson a Close Lid (Fedél lezárása) gombra.

Tipp: Az egyes blokkok elején levő fedél gombot is megnyomhatja a fedél felnyitásához és
lezárásához.

6. Kattintson az Open Lid (Fedél felnyitása) és a Close Lid (Fedél lezárása) gombra az egyes
kiválasztott műszerblokk motorizált fedelének a felnyitásához vagy lezárásához.

7. Tekintse meg a futtatás részleteit, majd végezze el a következők egyikét:

n Ha a részletek helyesek, akkor kattintson a Start Run (Futtatás indítása) opcióra.

n Ha a részletek nem helyesek:

o Korrigálja a részleteket a Selected Blocks (Kiválasztott blokkok) táblázatban és
kattintson a Start Run (Futtatás indítása) gombra.

o Térjen vissza a helyes fülre és hajtsa végre a megfelelő módosításokat, mentse el a
módosításokat, majd kattintson a Next (Tovább) gombra a Start Run (Futtatás indítás)
fülre való visszatéréshez és indítsa el a futtatást.

Új futtatás elindítása egy korábbi futtatásból

u Végezze el az alábbiak egyikét:

n Válassza ki a File > Repeat a Run (Fájl > Futtatás megismétlése) opciót a szoftver fő
menüsorából; lépjen a megismételni kívánt futtatás fájlra, és kattintson rá duplán.

n Válassza ki a Repeat Run (Futtatás megismétlése) fület a Startup Wizard (Indítási varázsló)
ablakban, és kattintson duplán a megismételni kívánt futtatás futtatási adatfájljára.

Opcionálisan, a Repeat Run (Futtatás megismétlése) fülön rákattinthat a Browse
(Böngészés) gombra, és a megismételni kívánt adatfájlra lépve duplán rákattinthat arra.
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Run Details (Futtatás részletei) párbeszédpanel
Amikor a Start Run (Futtatás indítása) parancsra kattint, a(z) CFX Manager Dx szoftver felszólítja az
adatfájl (.pcrd) elmentésére, elindítja a futtatást, és megnyitja a Run Details (Futtatás részletei)
párbeszédpanelt. A Run Details (Futtatás részletei) párbeszédpanel három státuszfülből áll:

n Run Status (Futtatás állapota) — ezt a fület használja protokoll aktuális státuszának a
megtekintésére, a fedél felnyitására vagy lezárására, a futtatás szüneteltetésére, ismétlések
hozzáadására, lépések kihagyására, vagy a futtatás megállítására.

n Real-time Status (Valós idejű státusz— ezt a fület használja a valós idejű PCR fluoreszcencia
adatok begyűjtésükkel egyidejűleg történő megtekintésére.

n Time Statu s (Idő státusz) — ezt a fület használja a protokoll teljes képernyős lefelé számláló
időmérőjének a megtekintésére.

Ezeket a füleket a későbbi fejezetekben részletesen ismertetjük.

A Run Status (Futtatás állapota) fül
A Run Status (Futtatás állapota) fülön egy folyamatban lévő futtatás aktuális állapota látható. Ezen a
nézeten továbbá vezérelheti a fedelet és módosíthatja a folyamatban lévő futtatást.
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8. fejezet Kísérletek futtatása

1. Run Status (Futtatás állapota) panel – a protokoll aktuális előrehaladási állapotát
jeleníti meg.

2. Run Status (Futtatás állapota) vezérlők – lehetővé teszik az Ön számára, hogy
működtesse a műszert vagy félbeszakítsa az aktuális protokollt.

3. Run Information (Futtatási információk) panel – a futtatás részleteit jeleníti meg.

JELMAGYARÁZAT

Run Status (Futtatás állapota) parancsok

Használja a Run Status (Futtatás állapota) fülben levő parancsokat a készüléknek a szoftverről
történő működtetéséhez, vagy a folyamatban levő futtatás módosításához.

Megjegyzés: A protokoll módosítása egy futtatás közben, pl. ismétlések hozzáadása, nem
változtatja meg a futtatáshoz kapcsolódó protokollfájlt. Ezeket a műveleteket a Run Log (Futtatás
napló) feljegyzi.

— felnyitja a motorizált fedelet a kiválasztott műszereken.

Fontos: A fedél futtatás közben történő felnyitása szünetelteti a futtatást az aktuális
lépésben, és megváltoztathatja az adatokat.

— lezárja a motorizált fedelet a kiválasztott műszereken.

— több ismétlést ad hozzá az aktuális GOTO (LÉPJ) lépéshez a protokollban. Ez az opció csak
akkor elérhető, ha fut egy GOTO (LÉPJ) lépés.

— kihagyja az aktuális lépést a protokollban.

Megjegyzés: Ha kihagy egy GOTO (LÉPJ) lépést, akkor a szoftver felszólítja annak a
megerősítésére, hogy ki akarja hagyni az egész GOTO (LÉPJ) hurkot és protokoll következő
lépésére akar lépni.

— villogtatja a LED indikátort a kiválasztott műszeren, a kiválasztott blokkok jelzésére.

— szünetelteti a protokollt.

Megjegyzés: Ezt a műveletet a Run Log (Futtatás napló) feljegyzi.
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— folytat egy szüneteltetett protokollt.

— megállítja a futtatást a protokoll vége előtt.

Megjegyzés: Egy futtatásnak a protokoll vége előtt történő megállítása megváltoztathatja az
adatait.
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Real-time Status (Valós idejű státusz) fül
A Real-time Status (Valós idejű státusz) fül az egyes ciklusoknál a futtatás közben az első két lemez
leolvasása után begyűjtött valós idejű PCR adatokat jeleníti meg.

1. Amplifikációs jelvonal panel — valós idejű amplifikációs adatokat jelenít meg a
futtatás közben.

2. Cellacsoport azonosító — ha cellacsoportok lettek azonosítva a lemez beállítás
során, akkor a felhasználók kiválaszthatnak egy specifikus cellacsoportot annak
jelvonalainak, celláinak, és táblázatos információinak a megtekintéséhez.

Lépésszám azonosító — ha a protokoll egynél több lépésnél gyűjt adatokat (pl.
amplifikáció és olvadási görbe során), a felhasználók kiválaszthatnak egy
specifikus lépést, és megtekinthetik az annál a lépésnél begyűjtött jelvonalakat.

3. Cellaválasztó panel —megjeleníti a lemezben levő aktív, inaktív, és üres
cellákat.

4. Lemezbeállítás panel — A lemezbeállításokat mutatja táblázatos formában.

JELMAGYARÁZAT
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5. Futtatás részletei panel — a futás valós idejű státuszát jeleníti meg, ami a
következőkből áll:

n Aktuális lépés

n Aktuális ismétlés

n Aktuális hőmérséklet

n Hátralevő idő

n Minta hőmérséklete

n Fedél hőmérséklete

6. Plate Setup (Lemezbeállítás) —megnyitja a Plate Setup (Lemezbeállítás)
párbeszédpanelt, amelyben a felhasználók futtatás közben módosíthatják az
aktuális lemezbeállításokat.

A Real-time Status (Valós idejű státusz) fülön a következőket végezheti el:

n Megjeleníthet vagy elrejthet valós idejű jelvonalakat azoknak a Lemez szerkesztő táblában vagy
a lemezbeállítás táblában történő kiválasztásával.

n Megtekinthet egyes jelvonalakat vagy jelvonalcsoportokat azoknak a cellacsoport legördülő
listában történő kiválasztásával.

n Szerkesztheti a lemezt vagy kicserélheti a lemezfájlt.

n Egy PrimePCR (PrimerPCR) fájlt alkalmazhat a futtatáshoz.

Valós idejű jelek mutatása vagy elrejtése

Alapértelmezettként minden betöltött cella aktív és megjelenik a lemez beállítás táblázatban. Az aktív
cellák kék színnel jelennek meg a cellaválasztó panelen. Az elrejtett cellák világosszürke színnel, a
nem használt cellák pedig sötétszürke színnel jelennek meg, a cellaválasztó panelen.

A futtatás közben elrejthet jelvonalakat az aktív cellákból. A CFX Manager Dx továbbra is gyűjti az
adatokat az összes cellatól; ha Ön cellákat rejt el, akkor azok adatai nem jelennek meg a
lemezbeállító táblázatban..

Valós idejű jelvonalak elrejtéséhez

u A cellaválasztó panelben kattintson az elrejteni kívánt aktív (kék színű) cellákra.

Valós idejű jelvonalak megjelenítéséhez

u A cellaválasztó panelben kattintson a megjeleníteni kívánt elrejtett (világosszürke színű) cellákra.

A cellaválasztóval kapcsolatos további információkhoz lásd a Cellaválasztó a(z) 186. oldalon.
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Lemezbeállítás szerkesztése

Lemezbeállítás szerkesztéséhez

u Kattintson a Plate Setup (Lemezbeállítás) elemre, majd válassza ki a View/Edit Plate (Lemez
megtekintése/szerkesztése) elemet.

Megjelenik a Plate Editor (Lemez szerkesztő) ablak, amelyben Ön szerkesztheti a lemezt,
miközben a futtatás folyamatban van. Ha bővebb információkat szeretne olvasni a lemezek
szerkesztéséről, akkor lásd: 7. fejezet, Lemezek előkészítése.

Megjegyzés: A Plate Editor (Lemez szerkesztő) ablakból a jelstílusokat is szerkesztheti.
A változások megjelennek az amplifikációs jel grafikonján a Real-time Status (Valós idejű
státusz) fülön.

Lemezfájl cseréje

Tipp: Egy lemezfájl cseréje különösen akkor lehet hasznos, ha úgy indít el egy futtatást, hogy az
ExpressLoad (Expressz betöltés) mappában egy Quick Plate (Gyors lemez) fájl található.

Lemezfájl cseréje

u Kattintson a Plate Setup (Lemezbeállítás) elemre, majd válassza ki a következő opciók egyikét:

n Lemezfájl cseréje – válassza ki az új lemezfájlt a tallózási ablakban látható listából

n Egy PrimePCR fájl alkalmazása – a Smart (Intelligens) keresés funkció segítségével
keressen egy olyan futtatásfájlt, amelyből a szoftver a lemezelrendezést lekérdezi, vagy a
Browse (Tallózás) elemre kattintva keressen egy olyan fájlt, amelyet Ön a Bio-Rad
webhelyéről letöltött és amely nem a PrimePCRmappában található

Megjegyzés: A CFXManager Dx ellenőrzi a lemezfájlra vonatkozó leolvasási módot és
lemezméretet. Ezeknek azonosnak kell lenniük azokkal a futtatási beállításokkal, amelyekkel
a futtatás el lett indítva.
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A Time Status (Időstátusz) fül
A Time Status (Időstátusz) fülön az aktuális futtatás befejeződéséig hátralévő idő látható.
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PrimePCR (PrimePCR) kísérletek végrehajtása
A PrimePCR (PrimePCR) kísérletek a Bio-Rad által laboratóriumi kísérleti validálású és optimalizált
útvonal- vagy betegség-specifikus vizsgálatokat használnak, amelyek a következő formátumokban
állnak rendelkezésre:

n Előre lemezekkel ellátott panelek— egy biológiai útvonalra vagy vizsgálatra vonatkozó,
specifikus vizsgálatokat tartalmazó lemezek; ezek közé tartoznak a PrimePCR (PrimePCR)
kontrollok és referenciagének is

n Egyedileg konfigurált lemezek— olyan lemezek, amelyeket a felhasználó által definiált
elrendezéssel lehet felállítani, a releváns célokhoz, kontrollokhoz, és referenciákhoz való
vizsgálat kiválasztási lehetőséggel

n Egyéni vizsgálatok— egyéni primer készleteket tartalmazó kémcsövek, valós idejű reakciókban
történő használatra

Az összes lefutási idő csökkentéséhez eltávolíthatja az olvadási lépést a protokollból. A Bio-Rad
határozottan ajánlja, hogy ne végezzen semmilyen egyéb módosítást a PrimePCR (PrimePCR)
futtatásprotokollban. Az alapértelmezett protokoll az, amely a vizsgálat validálására volt használva.
Bármiféle ettől való eltérés befolyásolhatja az eredményeket. A protokoll módosítások az eredményül
kapott adatfájl Run Information (Futtatási információk) fülében, valamint minden esetleg létrehozott
jelentésben be vannak jegyezve.

Egy PrimePCR (PrimePCR) futtatás elindításához

u Egy PrimePCR (PrimePCR) futtatás elindításához végezze el az alábbiak bármelyikét:

n A Startup Wizard (Indítási varázsló) ablakban válassza ki a PrimePCR (PrimePCR) opciót a
Run Setup (Futtatás beállítása) fülben, majd válassza ki a megfelelő kémiát) (SYBER vagy
próba).

n Válasszon ki egy PrimePCR (PrimePCR) futtatást a Repeat Run fülben levő Legutóbbi
futtatások listából a Startup Wizard (Indítási varázsló) ablakban.

n Válassza ki a File > New > PrimePCR Run (Fájl > Új > PrimePCR futtatás) opciót a Home
(Kezdőlap) ablakban.

n Válassza ki a File > Open > PrimePCR Run File (Fájl > Megnyitás > PrimePCR futtatás fájl)
opciót a Home (Kezdőlap) ablakban.

n Húzzon és ejtsen egy PrimePCR (PrimePCR) futtatás fájlt a Home (Kezdőlap) ablakba.

Miután kiválasztott egy PrimePCR (PrimePCR) futtatást, megnyílik a Run Setup (Futtatás beállításai)
ablak a Start Run (Futtatás indítása) fülben, a kiválasztott készüléknek megfelelő alapértelmezett
PrimePCR (PrimePCR) lemezelrendezést betöltve.
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Az olvadás lépés eltávolítása a protokollból

u A Protocol (Protokoll) fülön ürítse ki az Include Melt Step (Olvadás lépés belefoglalása) opció
melletti jelölőnégyzetet.

Cél információk importálása PrimePCR (PrimePCR) lemezekhez egy lemezelrendezésbe

1. Végezze el az alábbiak egyikét:

n A Real-time Status (Valós idejű státusz) fülben a Run Details (Futtatás részletei)
párbeszédablakon belül válassza ki a Plate Setup > Apply PrimePCR File (Lemezbeállítás >
PrimePCR fájl alkalmazása) opciót.

n A Data Analysis (Adatelemzés) ablakban válassza ki a Plate Setup > Apply PrimePCR File
(Lemezbeállítás > PrimePCR fájl alkalmazása) opciót.

2. A PrimePCR (PrimePCR) futtatás fájl párbeszédpanelben kattintson a Browse (Böngészés)
gombra a megfelelő PrimePCR (PrimePCR) fájlra (.csv) lépéshez.

3. Válassza ki a cél PrimePCR (PrimePCR) fájlt és kattintson az Open (Megnyitás) gombra.

A(z) CFX Manager Dx a cél információt az Ön lemez elrendezésébe importálja.
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9. fejezet Az adatelemzés áttekintése
A CFXManager Dx több módszert kínál az adatfájlok megnyitásához és megtekintéséhez.
Választható lehetőségek:

n Válassza ki a File > Open (Fájl > Megnyitás) > Data File (Adatfájl) opciót a Home (Kezdőlap)
ablakban, és böngésszen a cél .pcrd fájlhoz.

n Válassza ki a File > Recent Data Files (Fájl > Legutóbbi adatfájlok) opciót a Home (Kezdőlapon) a
tíz legutóbb megnyitott adatfájl listájából való választásoz.

A Data Analysis (Adatelemzés) ablak
A Data Analysis (Adatelemzés) ablakban több fül látható; az egyes füleken egy-egy meghatározott
elemzési módszerre vonatkozó elemzett adatok, illetve a futtatásra vonatkozó információk láthatók. A
fülek csak akkor jelennek meg, ha a futtatás során gyűjtött adatok elérhetők az adott típusú
elemzéshez.

Tipp: Amegjeleníteni kívánt füleket a Data Analysis (Adatelemzés) ablakban látható View
(Megtekintés) legördülő menüből választhatja ki. Az eredeti fülelrendezéshez történő
visszatéréshez válassza ki a Settings > Restore Default Windows Layout (Beállítások >
Alapértelmezett ablakelrendezés visszaállítása) elemet.
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A Data Analysis (Adatelemzés) eszköztár
A Data Analysis (Adatelemzés) ablakban levő eszköztár gyors hozzáférést biztosít a fontos
adatelemzési funkciókhoz.

Az 15. táblázat az eszköztárban levő gombok funkcióit sorolja fel.

Gomb Név Funkció

Lemezbeállítás View/Edit plate (Lemez
megtekintése/szerkesztése): Megnyitja a
Plate Editor (Lemez szerkesztő) opciót a
cellák tartalmának a megtekintéséhez és
szerkesztéséhez.

Replace Plate file (Lemezfájl kicserélése):
Kiválaszt egy lemezfájlt a lemez elrendezés
kicserélésére.

Apply PrimePCR file (PrimePCR fájl
alkalmazása): Kiválaszt egy futtatás fájlt a
lemezelrendezés kicserélésére egy
PrimePCR (PrimePCR) luttatáshoz.

ManageWell
Groups
(Cellacsoportok
kezelése)

Megnyitja a Well Groups Manager
(Cellacsoport kezelő) ablakot
cellacsoportok létrehozásához,
szerkesztéséhez, és törléséhez.

Well Group
(Cellacsoport)

Kiválaszt egy létező cellacsoport nevet a
legördülő menüből. Az alapértelmezett
választás az All Wells (Összes cella). Ez a
gomb csak akkor jelenik meg, ha
cellacsoportok vannak létrehozva.

Analysis Mode
(Analízis mód)

Az adatokat vagy Fluorophore (Fluorofór),
vagy Target(Célérték) módban elemzi.

Help (Súgó) Megnyitja ennek a kézikönyvnek egy
digitális másolatátAcrobat PDF
formátumban.

15. táblázat. Eszköztár a Data Analysis „Adatelemzés) ablakban
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Adatelemzés menüsor
A(z) 16. táblázat a Data Analysis (Adatelemzés) ablakban levő menüsor menüpontjait sorolja fel.

Menüpont Parancs Funkció

File (Fájl) Save (Mentés) Elmenti a fájlt.

Save As (Mentés másként) Elmenti a fájlt egy új néven.

Repeat Run A pillanatnyi futtatásból kivonja a protokoll és
lemezfájlt az újrafuttatáshoz.

Close (Bezárás) Bezárja a Data Analysis (Adatelemzés)
ablakot.

View
(Megtekintés)

Run Log (Futtatás napló) Megnyit egy Run Log (Futtatás napló) ablakot
a pillanatnyi adatfájl futtatási naplójának a
megtekintéséhez.

Quantification, Melt Curve,
Gene Expression, End Point,
Custom Data View, QC, Run
Information (Kvantifikáció,
Olvadás görbe,
Génexpresszió, Végpont,
Testreszabott adat nézet, QC,
Futtatási információk)

Megjeleníti az analizált adatokat kiválasztott
fülekben a Data Analysis (Adatelemzés)
ablakban. Legalább egy fület ki kell választani.

Settings
(Beállítások)

Cq Determination Mode
(Meghatározási mód)

Válassza ki a Regression (Regresszió) vagy a
Single Threshold (Egetlen küszöbérték) módot
annak meghatározásához, hogy a Cq értékek
hogyan vannak kiszámítva az egyes
görbékhez.

Baseline Setting (Kiindulási
érték beállítása)

Válassza ki a Baseline Subtraction (Kiindulási
érték kivonása) módszert a kiválasztott
cellacsoportokhoz.

Analysis Mode (Elemzési
mód)

Az adatok elemzését Fluorophore (Fluorofór)
vagy Target (Célérték) szerinti módra állítja be.

16. táblázat. A Data Analysis (Adatelemzés) ablak menüsor menüpontjai
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Menüpont Parancs Funkció

Cycles to Analyze
(Analizálandó ciklusok)

Kiválasztja az analizálandó ciklusokat.

Baseline Threshold (Kiindulási
küszöbértékek)

Megnyitja a Baseline Threshold (Kiindulási
küszöbértékek) ablakot a kiindulási érték vagy
a küszöbérték módosításához.

Trace Styles (Jelstílusok) Megnyitja a Trace Styles (Jelstílusok) ablakot.

Plate Setup (Lemezbeállítás) Megnyitja a Plate Editor (Lemez szerkesztő)
opciót a lemez megtekintéséhez és
szerkesztéséhez; cserélje ki a pillanatnyi
lemezt egy felhasználó által definiált
lemezfájlra vagy egy PrimePCR (PrimePCR)
futtatás fájlra.

Include All Excluded Wells (Az
összes kizárt cella
belefoglalása)

Az összes kizárt cellát belefoglalja az
elemzésbe.

Mouse Highlighting
(Egérmutatóval történő
kiemelés)

Be vagy kikapcsolja az adatok egyidejű
kiemelését az egérmutatóval.

Tipp: Ha a Mouse Highlighting
(Egérmutatóval történő kiemelés) ki van
kapcsolva, akkor nyomja meg a Control
gombot a kiemelés ideiglenes
bekapcsolásához.

Restore Default Window
Layout (Alapértelmezett ablak
elrendezés visszaállítása)

Az ablakok elrendezését visszaállítja az
alapértelmezett beállításra.

16. táblázat. A Data Analysis (Adatelemzés) ablak menüsor menüpontjai, folytatás
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Menüpont Parancs Funkció

Export
(Exportálás)

Export All Data Sheets to
Excel (Az összes adatlap
exportálása Excelbe)

Az összes táblázat nézetet minden fülben egy
külön Excel fájlba exportálja.

Custom Export (Testreszabott
export)

Megnyitja a Custom Export (Testreszabott
export) ablakot, amelyben meghatározhatók
az exportálandó mezők és a fájlformátum.

Export to LIMS Folder
(Exportálás LIMS mappába)

Megnyit egy ablakot az adatok előre
meghatározott formátumban az LIMS
mappába történő elmentéséhez.

Seegene Export (Seegene
export)

Megnyit egy ablakot az összes táblázatnézet
adatainak Excel fájlként történő kimentési
helyének az azonosításához, kimondottan a
Seegene, Inc által történő használatra.

Tools (Eszközök) Reports (Jelentések) Megnyitja ennek az adatfájlnak a jelentését.

Well Group Reports
(Cellacsoport-jelentések)

Megnyitja a Well Group Report (Cellacsoport-
jelentés) ablakot, meghatározott
cellacsoportok jelentéseinek a létrehozásához.

Import Fluorophore Calibration
(Fluorofór kalibráció
importálása)

Kiválaszt egy kalibrációs fájlt a pillanatnyi
adatfájlra való alkalmazáshoz.

qbase+ Elindítja a qbase+ v2.5-t közvetlenül a
pillanatnyi .pcrd fájlból, ha telepítve van.

16. táblázat. A Data Analysis (Adatelemzés) ablak menüsor menüpontjai, folytatás
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Fülrészletek
A Data Analysis (Adatelemzés) ablakban levő összes fül az adatokat diagramokon és táblázatokban
jeleníti meg egy adott elemzési módszerhez, és tartalmaz egy cellaválasztót a megjeleníteni kívánt
adatok kiválasztásához. Kinyitásakor a Data Analysis (Adatelemzés) alapértelmezettként megjeleníti
a Quantification (Kvantifikáció) fület. Az Amplification (Amplifikáció) diagram adatokat a Quantification
(Kvantifikáció) fülben a lefutáshoz megfelelő analízis beállítások meghatározására alkalmazhatja.

Megjegyzés: A szoftver a táblákban levő adatokat az egyes Data Analysis (Adatelemzés) fülhöz
kapcsolja. Például ha az egérmutatót a cellaválasztóban egy cella fölé helyezi, az kiemeli az
adatokat az összes többi táblában.
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A Data Analysis (Adatelemzés) ablak

Step Number (Lépésszám) választó
A CFX96 és CFX96 DeepWell rendszerek képesek fluoreszcencia adatok többszörös protokoll
lépéseknél történő begyűjtésére; a szoftver függetlenül őrzi az egyes lépéseknél szerzett adatokat. A
szoftver megjeleníti a Step Number (Lépésszám) választót. Ha egy protokoll tartalmaz legalább egy
adatgyűjtési lépést, a CFX Manager Dx szoftveraz első gyűjtési lépés adatait jeleníti meg.

Ha a protokoll egynél több adatgyűjtési lépést tartalmaz, akkor kiválaszthatja a lépést egy legördülő
listából, pl.:

Ha kiválaszt egy lépést, akkor a szoftver azt a választást a Data Analysis (Adatelemzés) ablakban
megjelenített összes adatra alkalmazza.

Cellacsoportok megtekintése a Data Analysis (Adatelemzés)
ablakban
A lemezben levő cellák cellacsoportok alkalmazásával független elemzéshez alkészletekbe
csoportosíthatók. Amikor cellacsoportokat hoz létre, azok csoportnevei megjelennek a Data Analysis
(Adatelemzés) ablak Well Groups (Cellacsoportok) legördülő listájában az eszköztáron.

Ha cellacsoportokat hozott létre, akkor a szoftver az All Wells (Összes cella) alapértelmezett
cellacsoportot jeleníti meg a Data Analysis (Adatelemzés) ablak megnyitásakor, az összes olyan
cellában levő adatokat megjelenítve, amelyek a diagramokban és táblázatokban szereplő tartalommal
rendelkeznek. A cellaválasztóban abban a cellacsoportban csak a tartalommal betöltött cellák
jelennek meg, és az adatelemzési számításokban csak az azokból a cellákból származó adatok
szerepelnek.

Megjegyzés: Ha nem hozott létre cellacsoportokat, akkor a Well Groups (Cellacsoportok)
legördülő lista nem jelenik meg az eszköztárban.

Cellatartalmak módosítása futtatás után
Az adatelemzés során az adatok megjelenítésének módosítása a cellák tartalmának a Plate Editor
(Lemez szerkesztő) lehetőségben történő módosításával soha nemmódosítja a futtatás során az
egyes cellákból begyűjtött fluoreszcencia adatokat. Miután a modul begyűjti a fluoreszcencia
adatokat, Ön nem törölheti ezeket az adatokat, de választhatja az adatoknak a nézetből és az
elemzésből történő eltávolítását.
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A cellák tartalmának a módosítása egy futtatás után

u A Data Analysis (Adatelemzés) ablakban kattintson a Plate Setup (Lemezbeállítás) lehetőségre
és válasszon ki egyet az alábbi opciók közül:

n Edit/View Plate (Lemez szerkesztés/megtekintés) —megnyitja a Lemez szerkesztőt,
amelyben manuálisan módosíthatja az elrendezést.

n Replace Plate file (Lemezfájl kicserélése) —megnyitja a Select Plate (Lemez kiválasztása)
böngészőt, amelyben egy előzetesen elmentett lemezfájlra léphet, amellyel ki akarja cserélni
a pillanatnyi lemezelrendezést.

n Apply PrimePCR file (PrimePCR fájl alkalmazása) —megnyitja a Select PrimePCR
(PrimePCR fájl kiválasztása) fájl párbeszédpanelt, amelyben egy PrimePCR (PrimePCR)
futtatási fájlra léphet és azt a lemezelrendezésre alkalmazhatja.

Tipp: Hozzáadhat vagy szerkeszthet információkat egy cella tartalmáról futtatás előtt, futtatás
közben, vagy egy PCR futtatás befejezése után. A futtatás előtt hozzá kell rendelnie a
szkennelési módot és a lemezméretet. Ezek a paraméterek nem változhatnak a futtatás után.
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Adatelemzési beállítások
A Quantification (Kvantifikáció) fülben lévő Amplification (Amplifikáció) diagram adatok a relatív
fluoreszcenciát („RFU” (RFE)) mutatják az egyes cellákhoz, minden ciklusban. A diagramon látható
egyes jelek egyetlen cellában található egyetlen fluorofór adatait jelzik. Ezek az adatok az egyes
cellák C q értékeinek a meghatározására szolgálnak, fluorofóronkénti alapon. A szoftver két mód
egyikét használja a Cq értékek meghatározására:

n Regresszió—egy többváltozós, nem lineáris regressziós modellt alkalmaz az egyes
cellagörbékre, majd ezt a modellt alkalmazza egy optimális Cq érték kiszámítására.

n Egyetlen küszöbérték—egyetlen küszöbértéket használ a Cq érték kiszámítására, az egyes
fluoreszcencia görbék küszöbérték keresztezési pontja alapján.

Válassza ki a Settings > Cq Determination Mode (Beállítások > Cq meghatározási mód) opciót a Cq
meghatározási mód kiválasztásához.

A küszöbérték módosítása
Single Threshold (Egyetlen küszöbérték) módban a küszöbértéket egy fluorofórhoz az Amplification
(Amplifikáció) diagram küszöbérték vonalára kattintva és az egérmutató függőleges elmozdításával
módosíthatja. Másik megoldásként meghatározhat egy pontos keresztezési küszöbértéket a
kiválasztott fluorofórhoz.

Kiindulási értékbeállítások
A szoftver automatikusan, egyénileg beállítja az kiindulási értéket az egyes cellákhoz. Az kiindulási
értékbeállítás határozza meg azt, hogy a rendszer milyen kiindulási értékkivonási módszert alkalmaz
az összes fluoreszcenciajelhez. A szoftver három kiindulási értékkivonási opciót kínál:

n No Baseline Subtraction (Nincs kiindulási értékkivonás) – az adatok megjelenítése relatív
fluoreszcenciajelekként. Ebben az elemzési módban bizonyos elemzések nem végezhetők el,
ezért a szoftver a Gene Expression (Génexpresszió), az End Point (Végpont) és az Allelic
Discrimination (Alléldiszkrimináció) füleket nem jeleníti meg.

n Baseline Subtracted (Kiindulási érték kivonva) – az adatok megjelenítése a kiindulási érték
kivonását követő jelekként a cellákban található egyes fluorofórokra vonatkozóan. A szoftvernek
el kell végezni az kiindulási érték kivonását az adatokon a kvantifikációs ciklusok
meghatározásához, a standard görbék felépítéséhez, valamint az ismeretlen minták
koncentrációjának a meghatározásához. A szoftver egy kiindulási értékkivont jel generálásához
hozzáilleszti a legjobb egyenes vonalat az egyes cellákhoz az kiindulási értékciklusok során
rögzített fluoreszcenciaértékhez, majd a legjobban illeszkedő adatokat kivonja a háttérben az
egyes ciklusok során kivont adatokból.
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n Baseline Subtracted Curve Fit (Lindulási értékkivont görbe illesztése) – az adatok
megjelenítése kiindulási értékkivont jelekként, és a szoftver egy középpontosított középérték-
szűrő segítségével kisimítja az kiindulási értékkivont görbét. A rendszer ezt a folyamatot azért
végzi el, hogy az egyes Cq értékeket invariánsként hagyja.

Ezeken az opciókon kívül az Apply Fluorescent Drift Correction (Fluoreszcenciacsúszási korrekció
alkalmazása) opciót is választhatja. Egy futtatás első pár ciklusa során rendellenesen csúszó RFU
értékekkel rendelkező celláknál a szoftver származtat egy becsült kiindulási értéket azokból a
szomszédos cellákból, amelyekhez sikerült egy vízszintes kiindulási értéket generálni.

Az kiindulási értékkivonási beállítás módosítása

u Válassza ki a Settings > Baseline Setting (Beállítások > Kiindulási érték beállítása) elemet.

Analysis Mode (Analízis mód)
Az adatok fluorofór vagy célértéknév szerint csoportosíthatók és elemezhetők. Fluorofór szerinti
csoportosítás esetében a rendszer az adatjeleket fluorofórok szerint jeleníti meg, ahogy az az adott
futtatásra vonatkozó lemezbeállításban szerepel. Ha az amplifikációs diagram alatt található megfelelő
fluorofórválasztó jelölőnégyzetek be vannak jelölve, akkor az önálló fluorofóradatok megjelennek az
amplifikációs és standardgörbe-diagramon (ha elérhető).
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Célérték szerinti csoportosítás esetében a rendszer az adatjeleket az adott futtatásra vonatkozó
lemezbeállításban beírt célértéknév szerint jeleníti meg.

Adatelemzési mód kiválasztása

u Végezze el az alábbiak egyikét:

n Válassza ki a Settings > Analysis Mode (Beállítások > Analízis mód) elemet.

n Válasszon egy módot az eszköztárban található Analysis Mode (Analízis mód) legördülő
listából.

Analizálandó ciklusok
Ön korlátozhatja az elemezni kívánt ciklusok számát. Ezen kívül arra is lehetősége van, hogy
meghatározott ciklusokból származó adatokat elemezzen. Az elemezhető ciklusok maximális száma:
50.

Megjegyzés: Ha egy futtatás elejéről ciklusokat távolít el, akkor ez jelentős hatással lehet a
kiindulási érték meghatározására.

Az adatelemzés korlátozása meghatározott ciklustartományra

1. Válassza ki a Settings > Cycles to Analyze (Beállítások > Analizálandó ciklusok) elemet.

Megjelenik a Cycles to Analyze (Analizálandó ciklusok) párbeszédpanel.

2. Írja be a kezdési és a befejezési ciklusértékeket, majd kattintson az OK gombra.

Ha szeretne visszatérni az elemzéshez eredetileg használt ciklusokhoz, akkor a Cycles to Analyze
(Analizálandó ciklusok) párbeszédpanelen kattintson a Restore Defaults (Alapértelmezett értékek
visszaállítása) elemre.
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Cellaválasztó
AWell Selector (Cellaválasztó) párbeszédpanel segítségével megjelenítheti vagy elrejtheti a
celládatokat a Data Analysis (Adatelemzés) ablakban megjelenő diagramokon, illetve táblázatokban.
A cellaválasztóban kizárólag olyan cellák választhatók ki, amelyekbe van minta betöltve. A szoftver
beszínezi a cellákat a Well Selector (cellaválasztó) párbeszédpanelen:

n Kék – a kiválasztott cellák jelzése. A kiválasztott cellákból származó adatok megjelennek a Data
Analysis (Adatelemzés) ablakban.

n Világosszürke – a ki nem választott cellák jelzése. A ki nem választott cellákból származó
adatok nem jelennek meg a Data Analysis (Adatelemzés) ablakban.

n Sötétszürke – az üres cellák jelzése.

A cellaadatok megjelenítése vagy elrejtése

u A cellaválasztóban a következőket teheti:

n Egyetlen cella elrejtéséhez kattintson az adott cellára. Ennek a cellának a megjelenítéséhez
kattintson újból az adott cellára.

n Több cella elrejtéséhez húzza át az egérmutatót a kiválasztani kívánt cellákon. Ezeknek a
celláknak a megjelenítéséhez húzza át újból az egérmutatót ezeken a cellákon.
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n Az összes cella elrejtéséhez kattintson a lemez bal felső sarkára. Az összes cella
megjelenítéséhez kattintson újból a bal felső sarokra.

n Kattintson egy oszlop vagy egy sor elejére, ha szeretné az adott oszlopban, illetve sorban
található cellákat elrejteni. A cellák megjelenítéséhez kattintson újból az adott oszlopra,
illetve az adott sorra.

A cellaválasztó nézetben a jobb egérgombra kattintással
elérhető menüpontok
Az 17. táblázat a cellaválasztó nézetben a jobb egérgombra kattintással elérhető opciókat határozza
meg.

Pont Funkció

Well XX (XX cella) Kizárólag ennek a cellának a megjelenítése, ennek a cellának az
eltávolítása a nézetből, a szín beállítása ehhez a cellához, vagy
ennek a cellának a kizárása az elemzésből.

Selected Wells (Kiválasztott
cellák) (kattintás a jobb
egérgombbal, és húzás)

Kizárólag ezeknek a celláknak a megjelenítése, ezeknek a
celláknak az eltávolítása a nézetből, a szín beállítása ezekhez a
cellákhoz, vagy ezeknek a celláknak a kizárása az elemzésből.

Copy (Másolás) A cella tartalmának a másolása egy vágólapra, beleértve a Sample
Type (Mintatípus) és az opcionális Replicate # (Replikátumszám)
paramétert.

Copy as Image (Másolás
képként)

A cellaválasztó nézet másolása képként.

Print (Nyomtatás) A cellaválasztó nézet nyomtatása.

Print Selection (A kiválasztott
rész nyomtatása)

Az aktuálisan kiválasztott rész nyomtatása.

Export to Excel (Exportálás
Excel-fájlba)

Az adatok exportálása egy Excel-táblázatba.

Export to Csv (Exportálás .csv
kiterjesztésű fájlba)

Az adatok exportálása szöveges dokumentumként.

Export to Xml (Exportálás .xml
kiterjesztésű fájlba)

Az adatok exportálása .xml kiterjesztésű dokumentumként.

17. táblázat. A cellaválasztókban a jobb egérgombra kattintással elérhető menüpontok
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Pont Funkció

Well Labels (Cellacímkék) A cellacímkék módosítása a következő értékek egyikére: Sample
Type (Mintatípus), Target Name (Célértéknév) vagy Sample Name
(Mintanév).

17. táblázat. A cellaválasztókban a jobb egérgombra kattintással elérhető menüpontok,
folytatás
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Cellák ideiglenes kizárása az elemzésből
Celláknak az elemzésből történő ideiglenes kizárásához

1. Jobb gombbal kattintson a cellára a cellaválasztóban. Több cella kizárásához végezzen jobb
egérgombbal kattintást és húzást több cella, jelvonal, vagy pont kiemeléséhez.

2. A jobb gombbal elérhető menüről válassza ki a megfelelő opciót:

n Well > Exclude Well (Cella > Cella kizárása)

n Selected Wells > Exclude from Analysis (Kiválasztott cellák > Kizárás az elemzésből)

n Selected Traces > Exclude these wells from Analysis (Kiválasztott jelvonalak > Ezeknek a
celláknak a kizárása az elemzésből)

Másik lehetőségként, cellák végleges eltávolításához az elemzésből ürítse ki a cellák tartalmát a
Plate Editor (Lemez szerkesztő) ablakban a Clear Wells (Cellák kiürítése) gombra kattintva.

Fontos: Minden kiürített cellatartalmat újra be kell írnia.

Kizárt cella befoglalásához

u Jobb gombbal kattintson a megfelelő cellára a cellaválasztóban, és válassza ki a Well > Include
Well in Analysis (Cella > Cella belefoglalása az elemzésbe) opciót.
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9. fejezet Az adatelemzés áttekintése

Diagramok
A Data Analysis (Adatelemzés) ablakban levő valamennyi diagram különböző grafikonon jeleníti meg
az adatokat, és opciókat tartalmaz az adatok vagy a diagram grafikák módosításához és
exportálásához.

A diagramoknál a jobb egérgombra kattintással elérhető közös
menüpontok
Az 18. táblázat azokat a menüpontokat határozza meg, amelyek a diagramokon elérhetők a jobb
egérgombra kattintással. Az elérhető menüpontok némelyike az összes diagramnál jelen van, és
ezeknek a menüpontoknak a segítségével módosítható az adatok megjelenítési módja, illetve
könnyen exportálhatók az adatok egy diagramból.

Pont Funkció

Copy (Másolás) A diagrammásolása a vágólapra.

Save Image As (Kép
mentése másként)

A kép mentése meghatározott méretben, felbontással és fájltípussal.
A következő képformátumok érhetők el: PNG (ez az alapértelmezett
opció), JPG és BMP.

Page Setup (Oldalbeállítás) Előnézet, valamint a nyomtatásra vonatkozó oldalbeállítás kiválasztása.

Print (Nyomtatás) A diagram kinyomtatása.

Set Scale to Default
(Méretezés alapértelmezett
értékre állítása)

A diagram nagyítása után a diagram visszaállítása az alapértelmezett
nézetére.

Chart Options
(Diagramopciók)

A Chart Options (Diagramopciók) ablak megnyitása, amelynek a
segítségével módosíthatja a diagramot, ideértve a cím módosítását, az
X- és az Y-tengelyekre vonatkozó határértékek kiválasztását, a
rácsvonalak mutatását, valamint a másodlagos osztásjelek tengelyeken
történő mutatását.

18. táblázat. A diagramoknál a jobb egérgombra kattintással elérhető menüpontok

Megjegyzés: Ameghatározott diagramokra vonatkozó menüpontok leírását lásd: 10. fejezet, Az
adatelemzéssel kapcsolatos részletek.
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Diagramok

Diagramadatok másolása a vágólapra
A diagramnézet tartalmát kimásolhatja, majd beillesztheti bármilyen alkalmazásba, amely képes
kezelni a bitkép típusú fájlokat.

Diagramadatok másolása a vágólapra

1. A diagram jobb egérgombra kattintással elérhető menüjéből válassza ki a Copy (Másolás).

2. Nyisson meg egy alkalmazást, amely képes kezelni a bitképeket (például a Microsoft Word
programot).

3. Kattintson a jobb egérgombra, majd a vágólapra másolt bitképnek az alkalmazásba történő
beillesztéséhez válassza a Paste (Beillesztés) elemet.

A kiindulási küszöbértékre vonatkozó beállítások módosítása
Single Threshold (Egyetlen küszöbérték) módban lehetősége van módosítani egy fluorofórra
vonatkozó küszöbértéket; ehhez kattintson a küszöbérték vonalára az Amplification (Amplifikáció)
diagramon és mozgassa függőlegesen az egér mutatóját. Másik megoldásként meghatározhat egy
pontos keresztezési küszöbértéket a kiválasztott fluorofórhoz.

Tipp: Egy ciklustartomány beállításával meghatározhatja a kiindulási értéket az összes
adatfájlhoz a User > User Preferences (Felhasználó > Felhasználói preferenciák) menüpontban
található Data Analysis (Adatelemzés) fülön.

A kezdési és a befejezési kiindulási ciklus módosítása az egyes cellákhoz

1. A Quantification (Kvantifikáció) fülön látható Amplification (Amplifikáció) diagram alatt válasszon
ki egyetlen fluorofórt.

2. A diagram jobb egérgombra kattintással elérhető menüjéből válassza ki a Baseline Threshold
(Kiindulási küszöbérték) elemet.
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9. fejezet Az adatelemzés áttekintése

Megjelenik a Baseline Threshold (Kiindulási küszöbérték) párbeszédpanel.
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Diagramok

3. A Baseline Cycles (Kiindulási ciklusok) szakaszban tegye a következők egyikét:

n Ha egyetlen cellát szeretne kiválasztani, akkor kattintson az adott cella sorának a számára.

n Ha több, egymással szomszédos cellát szeretne kiválasztani, akkor kattintson az első cella
sorának a számára, tartsa nyomva az egérgombot, majd húzza le az egérmutatót az
oszlopon az utolsó celláig.

n Ha több – egymással nem szomszédos – cellát szeretne kiválasztani, akkor nyomja le és
tartsa nyomva a Control billentyűt, majd kattintson az egyes kívánt cellák sorainak a
számára.

n Az összes cella kiválasztásához kattintson a táblázatban a bal felső sarokra.

4. Módosítsa a Begin (Kezdési) és az End (Befejezési) kiindulási ciklust az összes kiválasztott
cellához, vagy módosítsa a Begin (Kezdési) és az End (Befejezési) ciklusszámot a táblázat alján.

Tipp: A beállításoknak az utoljára mentett értékekre történő visszaállításához kattintson a
Reset All User Defined Values (Az összes – felhasználó által meghatározott – érték
visszaállítása) elemre.

5. A módosítások mentéséhez és a diagramhoz történő visszatéréshez kattintson az OK gombra.

Ciklustartomány beállítása az összes adatfájlhoz

u A Home (Kezdőlap) vagy a Plate Editor (Lemezszerkesztő) ablakban válassza ki a User > User
Preferences (Felhasználó > Felhasználói preferenciák) menüpontot, majd válassza ki a Data
Analysis (Adatelemzés) fület.
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9. fejezet Az adatelemzés áttekintése

A célértékekre és a mintákra vonatkozó adatok rendezése
Megjegyzés: Ez az opció kizárólag a génexpresszió diagramokon érhető el.

A Targets and Samples (Célértékek és minták) listák alapértelmezés szerint ábécé sorrendben
jelennek meg. A Sort (Rendezés) párbeszédpanel segítségével a megjelenítést megváltoztathatja
fordított ábécé sorrendre vagy egy kifejezést kézileg áthelyezhet a lista egy másik pontjára.

A célértékek és minták adatainak a rendezése

1. A diagram jobb egérgombra kattintással elérhető menüjében kattintson a Sort (Rendezés)
elemre.

Megjelenik a Gene Expression Chart Sorting (Génexpresszió diagram rendezése)
párbeszédpanel.

2. Ha a listát fordított ábécé sorrendben szeretné megjeleníteni, akkor a párbeszédpanelen
kattintson a Z-A elemre.

3. Egy kifejezés kézileg történő áthelyezéséhez válassza ki az adott kifejezést, majd a diagramok
között kattintson a megfelelő gombra:

n A kiválasztott kifejezés egyetlen pozícióval történő áthelyezéséhez kattintson a felfelé, illetve
a lefelé mutató nyílra.

n A kiválasztott kifejezésnek a lista tetejére, illetve aljára történő áthelyezéséhez kattintson a
felfelé, illetve a lefelé mutató vonalas nyílra.

4. A módosítások mentéséhez és a Gene Expression (Génexpresszió) fülre történő visszatéréshez
kattintson az OK (Rendben) gombra.
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Diagramok

Egy terület felnagyítása a diagramon
Egy terület felnagyításához a diagramon

u Kattintson az egérrel és húzza keresztül a diagramon, majd kattintson a Zoom (Ráközelítés)
parancsra*. A szoftver átméretezi és a kiválasztott területre középpontosítja a diagramot.

Megjegyzés: * Az oszlopdiagramhoz nem szükséges a Zoom (Ráközelítés) parancsra
kattintania.

A diagram teljes nézetének a visszaállításához

u A jobb egérgombbal kattintson a diagramba és válassza ki a Set Scale to Default (Skála
beállítása alapértelmezettre) parancsot.

Diagramok másolása Microsoft-fájlba
Lehetősége van adatdiagramokat átmásolni Microsoft Word, Excel, illetve PowerPoint
dokumentumokba. A kép felbontása megegyezik annak a képernyőnek a felbontásával, amelyről a
kép rögzítése történt.

Diagramok másolása Microsoft-fájlba

1. A Data Analysis (Adatelemzés) ablakban válassza a Copy (Másolás) elemet a diagram jobb
egérgombra kattintással elérhető menüjéből.

2. Nyisson meg egy üres Microsoft-fájlt, majd illessze be a vágólapról a tartalmat.

Alternatív megoldás: kattintson a kattintás és húzás (click-and-drag) ikonra, majd húzza át a
diagramot egy Microsoft-fájlba.

Kezelési kézikönyv | 195



9. fejezet Az adatelemzés áttekintése

Táblázatok
A Data Analysis (Adatelemzés) ablakban megjelenített táblázatok opciókat tartalmaznak az adatok
rendezéséhez és továbbításához. Az oszlopokat az alábbi módszerek egyikével rendezze:

n Kattintson egy oszlopra, és húzza a kiválasztott táblázatban levő új helyre.

n Kattintson az oszlop fejlécére az adatok növekvő vagy csökkenő sorrendben történő
rendezéséhez.

Maximum három adatoszlopnak a Sort (Rendezés) ablakban történő rendezéséhez

1. Kattintson a jobb gombbal a táblázatba, és válassza ki a Sort (Rendezés) opciót.

2. A Sort (Rendezés) párbeszédpanelben válassza ki a rendezni kívánt első oszlop címét.
Rendezze az adatokat növekvő vagy csökkenő sorrendben.

3. Válasszon ki egy második vagy harmadik oszlopot, és válassza az Ascending (Növekvő) vagy a
Descending (Csökkenő) lehetőséget.

4. Kattintson az OK gombra az adatok rendezéséhez, vagy kattintson a Cancel (Mégse) gombra a
rendezés leállításához.

Az egérmutatót egy mező fölé tartva emelje ki az adatokat a társult diagramokon és a
cellaválasztóban. Kattintson egy mezőbe tartalmának a kimásolásához és egy másik szoftver
programba történő beillesztéséhez.

A táblázatoknál a jobb egérgombra kattintással elérhető közös
menüpontok
Az 19. táblázat azokat a menüpontokat határozza meg, amelyek bármely táblázatos nézeten
elérhetők a jobb egérgombra kattintással.

Pont Funkció

Copy (Másolás) A kiválasztott cellák tartalmainak a másolása egy vágólapra,
ahonnan a tartalmak beilleszthetők egy táblázatba (például egy
Excel-táblázatba).

Copy as Image (Másolás
képként)

A táblázatos nézet másolása képfájlként, amely azután
beilleszthető egy olyan fájlba, amely képes képfájlokat kezelni
(például szöveges, kép- vagy számolótáblafájlokba).

19. táblázat. A táblázatoknál a jobb egérgombra kattintással elérhető menüpontok
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Táblázatok

Pont Funkció

Print (Nyomtatás) Az aktuális nézet nyomtatása.

Print Selection (A kiválasztott
rész nyomtatása)

Az aktuálisan kiválasztott rész nyomtatása.

Export to Excel (Exportálás
Excel-fájlba)

Az adatok exportálása egy Excel-táblázatba.

Export to CSV (Exportálás .csv
kiterjesztésű fájlba)

Az adatok exportálása egy vesszővel tagolt (.csv kiterjesztésű)
fájlba.

Export to Xml (Exportálás .xml
kiterjesztésű fájlba)

Az adatok exportálása egy .xml kiterjesztésű fájlba.

Export to Html (Exportálás .html
kiterjesztésű fájlba)

Az adatok exportálása egy .html kiterjesztésű fájlba.

Find (Keresés) Szöveg keresése.

Sort (Rendezés) Az adatok rendezése legfeljebb három oszlopban.

Select Columns (Oszlopok
kiválasztása)

Annak a kiválasztása, hogy mely oszlopok jelenjenek meg a
táblázatban.

19. táblázat. A táblázatoknál a jobb egérgombra kattintással elérhető menüpontok, folytatás
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9. fejezet Az adatelemzés áttekintése

Exportálás
A CFXManager Dx szoftver négy exportálási opciót kínál az Export (Exportálás) legördülő menüből:

n Export All Data Sheets (Az összes adatlap exportálása az Excel programba)

n Custom Export (Testreszabott export)

n Export to LIMS (Exportálás LIMS rendszerbe)

n Seegene Export (Seegene export)

Az összes adatlap exportálása
A CFXManager Dx szoftver egyes fülein található összes táblázatnézetet exportálhatja önálló
fájlokba.

Az összes adatlap exportálása

u Válassza ki az Export > Export All Data Sheets (Exportálás > Az összes adatlap exportálása)
elemet, majd válassza ki a kívánt fájltípust:

n CSV (*.csv)

n Text (Szöveg) (*.txt)

n Excel 2007 (*.xlsx)

n Excel 2003 (*.xls)

n XML (*.xml)
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Exportálás

Egyedi exportfájl létrehozása
Egyedi exportfájl létrehozása

1. Válassza ki az Export > Custom Export (Exportálás > Egyedi exportálás) elemet. Megjelenik a
Custom Export (Egyedi exportálás) párbeszédpanel.

2. A megjelenő legördülő listából válassza ki az exportálási formátumot.

3. Jelölje be az exportálni kívánt elemek jelölőnégyzeteit.

4. (Opcionális) Ha módosítani szeretné az oszlopok neveit, akkor kattintson a Customize Column
Name (Oszlopnév testreszabása) elemre.

5. Kattintson az Export (Exportálás) elemre. Ekkor megjelenik a Save As (Mentés másként)
párbeszédablak.

6. A Save As (Mentés másként) párbeszédpanepen határozzon meg egy fájlnevet, valamint azt a
helyet, ahova az exportált fájlt menteni szeretné.

7. Az exportálási fájl mentéséhez kattintson az OK gombra.
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9. fejezet Az adatelemzés áttekintése

Exportálás egy LIMS mappába
Lehetősége van az adatokat LIMS-kompatibilis formátumú fájlba exportálni.

Adatok exportálása LIMS formátumban

1. Válassza ki az Export > Export to LIMS Folder (Exportálás > Exportálás LIMS mappába) elemet.

Ekkor megjelenik a Save As (Mentés másként) párbeszédablak.

2. A Save As (Mentés másként) párbeszédpanepen határozzon meg egy fájlnevet, valamint azt a
helyet, ahova az exportált fájlt menteni szeretné.

3. Az exportálási fájl mentéséhez kattintson az OK gombra.

Seegene formatálású adatok exportálása
Az adatokat valamennyi táblázatnézetből exportálhatja Excel fájlokba specifikusan, a Seegene, Inc
által történő felhasználásra strukturálva.

Adatok Seegene-specifikus formátumban történő exportálásához

1. Válassza ki az Export > Seegene Export (Exportálás > Seegene export) opciót.

Ekkor megjelenik a Save As (Mentés másként) párbeszédablak.

2. A Save As (Mentés másként) párbeszédpanelben adjon meg egy mappahelyet, ahova az
exportált Seegene formatálású Excel (.xlsx) fájlokat el akarja menteni.

3. Az exportálási fájlok elmentéséhez kattintson az OK gombra.
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10. fejezet Az adatelemzéssel kapcsolatos
részletek

A CFXManager Dx szoftver Data Analysis (Adatelemzés) ablaka több olyan fülből tevődik össze,
amelyről adatok tekinthetők meg. A jelen fejezetben ezeket a füleket mutatjuk be részletesen.

Tipp: A View (Nézet) menüpont segítségével kiválaszthatja, hogy mely füleket szeretné
megtekinteni a Data Analysis (Adatelemzés) ablakban. A rendszer a testreszabott elrendezést
elmenti az adatfájllal együtt.
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10. fejezet Az adatelemzéssel kapcsolatos részletek

A Quantification (Kvantifikáció) fül
A Quantification (Kvantifikáció) fülön található adatok segítségével beállíthatja az adatelemzési
feltételeket, beleértve az egyes cellákra vonatkozó kiindulási értékbeállításokat, valamint a
küszöbérték-beállításokat. A Quantification (Kvantifikáció) fül a következő négy nézeten jeleníti meg
az adatokat:

n Amplification (Amplifikáció) diagram – az egyes ciklusok során az egyes cellákra vonatkozó
relatív fluoreszcencia egységek (RFU (RFE)) megjelenítése. A diagramon látható egyes jelek
egyetlen cellában található egyetlen fluorofór adatait jelzik.

n Standard curve (Standard görbe) – kizárólag akkor jelenik meg, ha a futtatásban standard (Std)
mintatípusúként megjelölt cellák szerepelnek. A standard görbe a kiindulási mennyiség
logaritmusához viszonyítva ábrázolt küszöbértékciklust mutatja. A jelmagyarázatban
megtekinthető a standard mintatípusú cellákban található egyes fluorofórokra vonatkozó
reakcióhatásosság (E).

n Well Selector (Cellaválasztó) – azoknak a celláknak a kiválasztása, amelyek az Ön által
megjeleníteni kívánt fluoreszcenciaadatokat tartalmazzák.

n Spreadsheet (Táblázat) – a kiválasztott cellákban összegyűjtött adatok táblázatának a
megjelenítése.
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A Quantification (Kvantifikáció) fül

Fluorofórokra vonatkozó opciók
Ha a fluorofóradatot szeretné megjeleníteni a Quantification (Kvantifikáció) fülön elérhető
diagramokon és táblázatokban, akkor válassza ki a célfluorofór(oka)t az Amplification (Amplifikáció)
diagram alatt. Ha azt szeretné, hogy a fluorofóradat ne látszódjon a Data Analysis (Adatelemzés)
ablakban, akkor törölje a jelölőnégyzetéből a jelölést.

A Trace Styles (Jelstílusok) párbeszédpanel
A Trace Styles (Jelstílusok) párbeszédpanel segítségével módosíthatja a jelek megjelenési formáját a
Quantification (Kvantifikáció) és a Melt Curve (Olvadási görbe) füleken látható amplifikációs, illetve
olvadásigörbe-diagramokon. Ezt követően a változások előnézetét megtekintheti a Trace Styles
(Jelstílusok) párbeszédpanelen megjelenő cellaválasztóban.

A jel stílusának a módosítása

1. Az Amplification (Amplifikáció) diagram alatt válasszon ki egyetlen fluorofórt.

2. A Trace Styles (Jelstílusok) párbeszédpanel megnyitásához tegye a következők egyikét:

n Kattintson a Trace Styles (Jelstílusok) elemre az Amplification (Amplifikáció) diagramon.

n Válassza ki a Settings > Trace Styles (Beállítások > Jelstílusok) elemet a Data Analysis
(Adatelemzés) menüsorban.

n Kattintson a jobb egérgombbal egy jelre, majd válassza a Trace Styles (Jelstílusok) elemet.
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10. fejezet Az adatelemzéssel kapcsolatos részletek

Megjelenik a Trace Styles (Jelstílusok) párbeszédpanel.

3. A Trace Styles (Jelstílusok) párbeszédpanel alsó panelén található cellaválasztóban válassza ki
a kívánt cellákat. Másik megoldásként válassza ki a Wells (Cellák) oszlopban található legördülő
menüben azokat a cellákat, amelyek egyetlen mintatípust tartalmaznak.

4. Végezze el az alábbiak valamelyikét:

n A kiválasztott cellák színének a kiválasztásához kattintson a Color (Szín) oszlopban található
mezőre.

n Ha egy szimbólumot szeretne hozzárendelni a kiválasztott cellákhoz, akkor válasszon ki egy
szimbólumot a Symbol (Szimbólum) legördülő listából.

n Ha gombcímke szerint gyorsan szeretné beszínezni a cellákat, akkor kattintson a megfelelő
gyorsbeállításra:

o Random byWell (Véletlenszerűen a cella szerint)

o Random by Replicate (Véletlenszerűen a replikátum szerint)
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o Use Fluor Colors (Fluorofórszínek használata)

o Use Target Colors (Célértékszínek használata)

o Use Sample Colors (Mintaszínek használata)

n Cellacímkék hozzárendeléséhez válasszon a következő értékek közül: Sample Type
(Mintatípus), Target Name (Célértéknév), Sample Name (Mintanév) vagy Symbol
(Szimbólum).

Log Scale (Logaritmikus skála) opció
Válassza ki a Log Scale (Logaritmikus skála) opciót az Amplification (Amplifikáció) diagram alatt a
fluoreszcencia görbék fél-logaritmikus skálában való megtekintéséhez:

Tipp: Bármely terület felnagyításához a diagramon húzzon keresztbe a cél területen. A teljes
nézethez történő visszatéréshez a jobb egérgombbal kattintson a diagramba és válassza ki a Set
Scale to Default (Skála beállítása alapértelmezettre) parancsot.
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Standard Curve (Standard görbe) diagram
A szoftver egy Standard Curve (Standard görbe) diagramot hoz létre a Quantification (Kvantifikáció)
fülben, ha az adatok között a futtatáson belül legalább egy fluorofórhoz Std (Standard)-ként definiált
mintatípusok is tartoznak.

A Standard Curve (Standard görbe) diagram a következő információkat jeleníti meg:

n Az egyes görbék neve (a fluorofór vagy a célérték)

n Az egyes fluorofórok vagy célértékek színe

n Reakció hatásfoka (E). Ezt a statisztikai adatot használja egy multiplex reakció optimalizálására
és az adatok ekvalizálására egy standard görbéhez.

Megjegyzés: A reakció hatásfok azt írja le, hogy az Ön célja hányszor kerül előállításra a
protokollban levő egyes ciklusokkal. A 100%-os hatásfok azt jelzi, hogy Ön minden ciklussal
megduplázza a célját.

n Determinációs együttható, R2 (R^2 formában írva). Ezt a statisztikai adatot használja annak
meghatározására, hogy a vonal mennyire helyesen írja le az adatokat (illeszkedés helyessége).

n Meredekség

n y-metszéspont

Az Amplification (Amplifikáció) diagramnál elérhető menüpontok
A diagramoknál a jobb egérgombra kattintással elérhető közös menüpontokon (lásd: A diagramoknál a
jobb egérgombra kattintással elérhető közös menüpontok a(z) 190. oldalon) kívül vannak olyan
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menüpontok, amelyek kizárólag az Amplification (Amplifikáció) diagramon érhetők el. Ezeket a(z) 20.
táblázat mutatja be.

Megjegyzés: A Standard Curve (Standard görbe) diagramon kizárólag a jobb egérgombra
kattintással elérhető közös menüpontok érhetők el.

Menüpont Funkció

Show Threshold Values
(Küszöbértékek mutatása)

A küszöbérték megjelenítése a diagramon az egyes
amplifikációgörbékhez.

Trace Styles (Jelstílusok) A Trace Styles (Jelstílusok) ablak megnyitása, amelynek a
segítségével módosíthatja a Quantification (Kvantifikáció) és a
Melt Curve (Olvadási görbe) füleken látható jelek megjelenésének
a formáját.

Baseline Thresholds (Kiindulási
küszöbértékek)

A Baseline Thresholds (Kiindulási küszöbértékek) ablak
megnyitása, amelynek a segítségével módosíthatja az egyes
fluorofórokra vonatkozó alapvonalat, illetve küszöbértékeket (a
változások megjelennek a Quantification (Kvantifikáció) fülön
látható Amplification (Amplifikáció) diagramon).

20. táblázat. Az Amplification (Amplifikáció) diagramon a jobb és a bal egérgombra
kattintással elérhető menüpontok

A Quantification (Kvantifikáció) fülön található táblázat
Az 21. táblázat a Kvantifikáció fülön megjelenő táblázatban található adatokat határozza meg.

Információk Leírás

Cella A cella pozíciója a lemezen

Fluorofór Detektált fluorofór

Cél A Plate Editor (Lemez szerkesztő) cellákba betöltött cél neve

Tartalom A Plate Editor (Lemez szerkesztőbe) betöltött Mintatípus (kötelező)
és a Replikátumszám (opcionális) kombinációja

Minta A Plate Editor (Lemez szerkesztő) cellákba betöltött minta neve

Cq Kvantifikációs ciklus az egyes jelvonalakhoz

21. táblázat. A Kvantifikáció fül táblázatának tartalma
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Célértékekre, tartalmakra vagy mintákra vonatkozó adatok módosítása

Módosíthatja a Célérték, Tartalom, és Minta oszlopokban levő adatokat a lemezfájl „Plate Editor”-ral
(Lemez szerkesztő) történő szerkesztésével, a kísérlet lefuttatása után.

A Tartalom, Célérték, és Minta oszlopokban levő adatok módosításához

u Kattintson a Plate Setup (Lemezbeállítás) opcióra és válassza ki a View/Edit Plate (Lemez
megtekintése/szerkesztése) lehetőséget a Plate Editor (Lemezszerkesztő) megnyitásához.
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Quantification Data (Kvantifikációs adatok) fül
A Quantification Data (Kvantifikációs adatok) fül az egyes cellákban begyűjtött kvantifikációs adatokat
jeleníti meg. A(z) CFX Manager Dx szoftver az adatokat négy különböző táblázat nézetben jeleníti
meg:

n Results (Eredmények) —megjelenít egy adattáblázatot. Ez az alapértelmezett nézet.

n Standard Curve Results (Standard görbe eredmények) —megjeleníti a standard görbe adatainak
a táblázatát.

n Plate (Lemez) — az egyes cellákban levő adatokat lemeztérképként jeleníti meg.

n RFU (RFE)— az „RFU” (RFE) mennyiségeket jeleníti meg az egyes cellákban az egyes
ciklusokhoz.

Válassza ki az egyes táblázatokat a Quantification Data (Kvantifikációs adatok) fül alatt megjelenő
legördülő listából.

Results (Eredmények) táblázat
A Results (Eredmények) táblázat a lemezben levő egyes cellákhoz jeleníti meg az adatokat.

Megjegyzés: Valamennyi Std. Dev (szórás) számítás a Plate Editor (Lemez szerkesztő)
ablakban levő cellákhoz kijelölt replikátumcsoportokra vonatkozik. A számítások a Cq értéket
átlagolják az egyes cellákhoz a replikátum csoportban.

Az 22. táblázat a Results (Eredmények) táblázatban megjelenő adatokat definiálja.
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Információk Leírás

Well (Cella) A cella pozíciója a lemezen

Fluor (Fluorofór) Detektált fluorofór

Target (Célérték) Amplifikációs cél neve (gén)

Content (Tartalom) Mintatípus és Replikátumszám

Sample (Minta) A minta leírása

Biological Set Name (Biológiai
sor neve)

A biológiai sor neve

Cq Kvantifikációs ciklus

CqMean (Középérték) A kvantifikációs ciklus neve a replikátumcsoporthoz

Cq Std. Dev A kvantifikációs ciklus szórása a replikátumcsoport esetén

Starting Quantity (SQ) (Indítási
mennyiség)

A cél becsült indítási mennyisége

Log Starting Quantity (Indítási
mennyiség logaritmusa)

Az indítási mennyiség logaritmusa

SQMean (Indítási mennyiség
középértéke)

Az indítási mennyiség középértéke

SQ Std. Dev Az indítási mennyiség szórása a replikátumokban

22. táblázat. A Results (Eredmények) táblázat tartalma
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Standard Curve Results (Standard görbe eredmények) táblázat
A Standard Curve Results (Standard görbe eredmények) táblázat a számított standard görbe
paramétereket jeleníti meg.

Az 23. táblázat a Standard Curve Results (Standard görbe eredmények) táblázatban megjelenő
adatokat definiálja.

Információk Leírás

„Fluor” (vagy „Target) (Fluorofór
vagy Célérték)

Detektált fluorofór (vagy célérték)

„Efficiency %” (Hatásfok %) Reakció hatásfoka

Slope (Meredekség) A standard görbe meredeksége

Y-intercept (Y-metszéspont) Az a pont, amelynél a görbe metszi az Y-tengelyt

R^2 Determinációs együttható

23. táblázat. A Standard Curve Results (Standard görbe eredmények) táblázat tartalma
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A Plate (Lemez) táblázat
A Plate (Lemez) táblázatban egyidejűleg egyetlen fluorofórra vonatkozó adatok lemeztérképe látható.

Egy meghatározott fluorofórra vonatkozó adatok megtekintése

u Kattintson a fülére a táblázat alján.

Az RFU (RFE) táblázat
Az RFU (RFE) táblázat az egyes cellákra vonatkozóan a futtatás egyes ciklusai során leolvasott
relatív fluoreszcencia egységeket (RFU) (RFE) mutatja. A cellaszám az egyes oszlopok tetején, a
ciklusszám pedig az egyes soroktól balra látható.
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Melt Curve (Olvadási görbe) fül
Felelősség-elhárítási nyilatkozat: A Bio-Rad nem biztosít jogokat az olvadás görbe analízis nagy
felbontású olvadási analízisben történő felhasználásához emberi vagy állatorvosi in vitro
diagnosztikákban. Ezen kívül a vásárló felelősségi körébe tartozik a saját specifikus alkalmazásához
esetleg szükséges bármilyen szellemi tulajdonjognak a megszerzése.

DNA (DNS)-megkötő festékek és nem hasítható hibridizációs próbáknál a fluoreszcencia akkor a
legfényesebb, amikor a DNA (DNS) két szála kapcsolódik. Ennélfogva tehát a hőmérséklet
emelkedésével (Tm), a fluoreszcencia állandó mértékben csökken (konstans lejtő). A Tm-nél a
fluoreszcencia drámai mértékben csökken, a lejtő feltűnő megváltozásával. Ennek a változásnak a
sebességét a fluoreszcencia negatív első regressziójának a hőmérséklettel szembeni ábrázolása
határozza meg (-d(RFE)/dT). A fluoreszcencia legmagasabb mértékű változása látható csúcsokat
eredményez és a kettős szálú DNA (DNS) komplexekTm értékét képviseli.

CFX Manager Dx szoftver egy olvadási görbe során begyűjtött „RFU” (RFE) adatokat a hőmérséklet
függvényében ábrázolja. Az olvadási csúcs adatok elemzéséhez a szoftver mindegyik csúcshoz
kijelöl egy kezdő és egy befejező hőmérsékletet a küszöbérték oszlop elmozdításával. A csúcsterület
padlóját az olvadási küszöb oszlop pozíciója adja meg. Egy érvényes csúcsnak egy minimum
magassággal kell rendelkeznie a küszöbérték oszlop és a legmagasabb csúcs magassága közötti
távolsághoz képest.

A Melt Curve (Olvadási görbe) fül a Tm (olvadási hőmérséklet) értéket mutatja az amplifikált PCR
termékekhez, négy nézetben:

n Melt Curve (Olvadási görbe) — az egyes fluorofórok valós idejű adatait RFU(RFE)/hőmérséklet
formában jeleníti meg mindegyik cellánál.

n Melt Peak (Olvadási csúcs) — az RFE adatok negatív regresszióját jeleníti meg az egyes cellák
hőmérsékleteihez.

n Well selector (Cellaválasztó) — a cellákat jeleníti meg az adatok megjelenítéséhez vagy
elrejtéséhez.

n Peak spreadsheet (Csúcs táblázat) — a kiválasztott cellában begyűjtött adatokat jeleníti meg.

Megjegyzés: Ez a táblázat mindegyik jelvonalhoz maximum két csúcsot jelenít meg. Több
csúcs megtekintéséhez kattintson a Melt Curve Data (Olvadási görbe adatok” fülre.
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Az 24. táblázat a(z) 214. oldalon a Melt Curve (Olvadási görbe) táblázatban megjelenő adatokat
határozza meg.

Információk Leírás

Well (Cella) A cella pozíciója a lemezen

Fluor (Fluorofór) Detektált fluorofór

Content (Tartalom) A Mintatípus és a Replikátumszám kombinációja

Sample (Minta) A Plate Editor-ba (Lemez szerkesztő) betöltött minta
neve

Melt Temp (Olvadási hőmérséklet) Az olvadási csúcs hőmérséklete az egyes cellákhoz

Megjegyzés: Ebben a táblázatban csak a két
legmagasabb csúcs jelenik meg.

24. táblázat. A Melt Curve (Olvadási görbe) táblázat tartalma
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A Melt Curve (Olvadási görbe) adatok módosítása
A Melt Curve (Olvadási görbe) adatok módosításához

u Végezze el az alábbiak valamelyikét:

n Kattintson a küszöbérték oszlopokra a Melt Peak (Olvadási csúcs) diagramban, és húzza a
csúcsoknak az adatelemzésbe történő befoglalásához illetve kizárásához.

n Válassza ki a Positive (Pozitív) opciót a Peaks (Csúcsok) legördülő menüben a Melt
Threshold (Olvadási küszöb) vonal fölötti csúcsok táblázatadatainak a megjelenítéséhez,
vagy válassza ki a Negative (Negatív) opciót az Olvadási küszöb vonal alatti csúcsok
táblázatadatainak a megjelenítéséhez.

n Nyissa meg a Trace Styles (Jelstílusok) ablakot a jelvonalak színének a módosításához a
Melt Curve (Olvadási görbe) diagramban és a Melt Peak (Olvadási csúcs) diagramokban.

n Válasszon ki egy számot a Step Number (Lépésszám) választóban a Melt Curve (Olvadási
görbe) adatoknak a protokoll másik lépésében történő megtekintéséhez. A lista egynél több
lépést mutat, ha a protokoll egynél több olvadási görbe lépésben tartalmaz lemez
leolvasásokat.

n Az adatok alkészleteire való fókuszáláshoz válassza ki a cellákat a cellaválasztóban.

n Válasszon ki egy cellacsoportot a lemezben levő cellák alkészleteinek a megtekintéséhez és
elemzéséhez. Válassza ki az egyes cellacsoportokat név szerint a Well Group (Cellacsoport)
legördülő menüből az eszköztárban.
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A Melt Curve Data (Olvadásigörbe-adatok) fül
AMelt Curve Data (Olvadásigörbe-adatok) fül a Melt Curve (Olvadási görbe) fülről származó adatokat
jeleníti meg több olyan táblázatban, amelyek az egyes jelekre vonatkozó összes olvadási csúcsot
tartalmazzák. A CFX Manager Dx szoftver négy táblázatopciót kínál az olvadásigörbe-adatok
megtekintésére:

n Melt Peaks (Olvadási csúcsok) – az egyes jelekre vonatkozó összes adat megjelenítése,
beleértve az összes olvadási csúcsot. Ez az alapértelmezett nézet.

n Plate (Lemez) – az adatoknak, valamint a lemezben található egyes cellák tartalmát feltüntető
nézet megjelenítése.

n RFU (RFE) – az egyes cellákra és egyes hőmérsékletekre vonatkozó RFU (RFE) mennyiségek
megjelenítése.

n -d(RFU)/dT – annak a megjelenítése, hogy a hőmérséklet (T) változásakor mekkora az RFU
negatív változási sebessége. Ez egy első regressziós grafikon a lemezben található egyes
cellákhoz.

Válassza ki az egyes táblázatokat a Melt Curve Data (Olvadásigörbe-adatok) fül alatt megjelenő
legördülő listából.

Melt Peaks (Olvadási csúcsok) táblázat
AMelt Peaks (Olvadási csúcsok) táblázat az összes olvadási görbeadatot megjeleníti.

Az 25. táblázat a(z) 217. oldalon a Melt Peaks (Olvadási csúcsok) táblázatban megjelenő adatokat
definiálja.
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Információk Leírás

Well (Cella) A cella pozíciója a lemezen

Fluor (Fluorofór) Detektált fluorofór

Content (Tartalom) A Plate Editor (Lemez szerkesztő) ablakban felsorolt mintatípus

Target (Célérték) Amplifikációs célérték (gén)

Sample (Minta) A Plate Editor (Lemez szerkesztő) ablakban felsorolt minta név

Melt Temperature (Olvadási
hőmérséklet)

Az egyes termékek olvadási hőmérséklete, a táblázatban
soronként egyetlen csúcsként (legmagasabb) felsorolva

Peak Height (Csúcs magasság) A csúcs magassága

Begin Temperature (Kezdeti
hőmérséklet)

Hőmérséklet a csúcs kezdetén

End Temperature
(Véghőmérséklet)

Hőmérséklet a csúcs végén

25. táblázat. A Melt Peaks (Olvadási csúcsok) táblázat tartalma

A Plate (Lemez) táblázat
A Plate (Lemez) táblázat lemezformátumban jeleníti meg az olvadásigörbe-adatokat.

Megjegyzés: A szoftver által hívott csúcsérték módosításához módosítsa a küszöbértékvonalat
a Melt Curve (Olvadási görbe) fülön látható Melt Peak (Olvadási csúcs) diagramon.

Az 26. táblázat a(z) 218. oldalon a Plate (Lemez) táblázatban megjelenő adatokat határozza meg.
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Információk Leírás

Content (Tartalom) Egy Sample Type (Mintatípus) (kötelező) és egy Replicate # (Replikátumszám)
(opcionális) paraméter kombinációja

Sample (Minta) A minta leírása

Peak 1 (1. csúcs) Az első olvadási csúcs (legmagasabb)

Peak 2 (1. csúcs) A második (alacsonyabb) olvadási csúcs

26. táblázat. A Plate (Lemez) táblázat tartalma

Az RFU (RFE) táblázat
Az RFU (RFE) táblázat az egyes cellákra vonatkozóan az olvadási görbe elkészítésének egyes
ciklusai során leolvasott fluoreszcenciaértékeket mutatja.

Az 27. táblázat az RFU táblázatban megjelenő adatokat határozza meg.

Információk Leírás

Well number (A1, A2, A3, A4, A5) (Cella
száma (A1, A2, A3, A4, A5))

A lemezben található, betöltött cellák pozíciói

Temperature (Hőmérséklet) Az amplifikált célérték olvadási hőmérséklete,
amelyet a rendszer soronként egy cellaként,
valamint az ugyanazon cellában található több
termék esetében több cellaként ábrázol

27. táblázat. Az RFU (RFE) táblázat tartalma
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-d(RFE)/dT táblázat
A -d(RFE)/dT táblázat a változás negatív mértékét mutatja az „RFU”-ban (RFE), a hőmérséklet (T)
változásokként.

28. táblázat a-d(RFU)/dT táblázatban megjelenő adatokat definiálja.

Információk Leírás

Well number (A1, A2, A3, A4, A5)
(Cella száma (A1, A2, A3, A4,
A5))

A lemezben található, betöltött cellák pozíciói

Temperature -d(RFE)/dT
(Hőmérséklet -d(RFE)/dT)

Változás negatív mértéke az RFU-ban (RFE), hőmérséklet (T)
változásokként

28. táblázat. „-d(RFU)/dT” (-d(RFE)/dT) táblázat tartalma
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Az End Point (Végpont) fül
Nyissa meg az End Point (Végpont) fület, hogy elemezhesse a végső relatív fluoreszcencia
egységeket (RFU-kat) a mintával töltött cellákra vonatkozóan. A szoftver az ismeretlen mintákat
tartalmazó cellák RFU-szintjeit összehasonlítja a negatív kontrollokat tartalmazó cellák RFU-
szintjeivel, és az ismeretlent pozitívnak vagy negatívnak „nevezi”. A pozitív minták RFU értéke
nagyobb, mint a negatív kontrollok átlag RFU értékének és a határértéknek az összege.

A végpontadatok elemzéséhez a lemeznek negatív kontrollokat kell tartalmaznia, máskülönben a
szoftver nem bírja elvégezni az „elnevezést”. Futtassa a következő kétféle protokoll egyikét:

n Quantification (Kvantifikáció) protokoll futtatása – egy standard protokoll beállítása. A futtatás
befejeződése után nyissa meg a Data Analysis (Adatelemzés) ablakot, végezze el az
adatelemzési beállításokat a Quantification (Kvantifikáció) fülön, majd kattintson az End Point
(Végpont) fülre egy végpontciklus kiválasztásához.

n End Point Only (Csak végpont) protokoll futtatása – az End Point Only (Csak végpont) protokoll
betöltése a Run Setup (Futtatás beállítása) ablak Plate (Lemez) fülén, egy lemez kiválasztása
vagy létrehozása, majd a futattás elindítása
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Az End Point (Végpont) fül

Az End Point (Végpont) fül megjeleníti az átlag RFU értékeket annak a meghatározása érdekében,
hogy a célértéket amplifikálta-e az utolsó (befejező) ciklus. Ön ezeknek az adatoknak a segítségével
meghatározhatja, hogy egy mintában jelen van-e egy meghatározott célérték-szekvencia (ha igen,
akkor a célérték-szekvencia pozitív). A pozitív célértékek RFU értékei nagyobbak, mint az Ön által
meghatározott megszakítási szint.

Tipp: Végpont típusú protokoll létrehozásához nyissa meg a Protocol (Protokoll) fület (a Run
Setup (Futtatás beállítása) ablakban), majd válassza a Run > End Point Only Run (Futtatás >
Csak végpont futtatása) parancsot.

Amikor a futtatás befejeződik, akkor az adatfájl megnyílik az End Point (Végpont) fülön, amely a
következő szakaszokból tevődik össze:

n Settings (Beállítások) – az adatelemzési beállítások módosítása.

n Results (Eredmények) – a beállítások módosítása után az eredmények azonnali megjelenítése.

n Well Selector (Cellaválasztó) – azoknak a celláknak a kiválasztása, amelyek az Ön által
megjeleníteni kívánt végpontadatokat tartalmazzák.

n RFU spreadsheet (RFU-táblázat) – a kiválasztott cellákban összegyűjtött befejezési RFU
megjelenítése.

Eredmény adatok
A Results (Eredmények) rész a következő adatokat jeleníti meg:

n Lowest RFU value (Legalacsonyabb RFE érték) — az adatokban levő legalacsonyabb RFU
(RFE) érték

n Highest RFU value (Legmagasabb RFE érték) — az adatokban levő legmagasabb RFU (RFE)
érték

n Negative Control Average (Negatív kontroll átlag) — átlag RFU (RFE) a negatív kontrollokat
tartalmazó cellákhoz

n Cut Off Value (Határérték) — a tolerancia RFU (RFE) vagy (a Beállításokban felsorolt Tartomány)
Percentage (Százalék) értékének és a negatív kontrollok átlagának az összeadásával van
kiszámítva. A határértéknél nagyobb RFE-kkel rendelkező minták neve “Positive” (Pozitív) lesz. A
határérték beállításához módosítsa az RFU (RFE) vagy a Percentage of Range (Tartomány
százaléka) értéket

A Cut Off Value (Határérték) kiszámítása ennek a képletnek a használatával történik:

Határérték = Negatív kontroll átlag + Tolerancia
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Válasszon ki egy toleranciát az alábbi módszerek egyikével:

n RFUs (RFE-k) (alapértelmezett) — válassza ezt a módszert egy abszolút RFU (RFE) érték
használatára a toleranciához. A minimum RFU (RFE) tolerancia érték 2. A maximum a
legmagasabb RFE érték abszolút értéke mínusz a legalacsonyabb RFU (RFE) abszolút értéke.
Az alapértelmezett RFU (RFE) tolerancia a teljes RFU (RFE) tartomány 10%-a.

n Percent of Range (Tartomány százaléka— válassza ezt a módszert az RFU (RFE) tartomány
százalék értékének a felhasználásához a toleranciához. A tartomány minimum százaléka 1%. A
tartomány maximum százaléka 99%. A tartomány alapértelmezett százaléka 10%.
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Az End Point (Végpont) fül

A végpont adatelemzés módosítása
Az End Point (Végpont) fülben levő adatok módosításához

u Végezze el az alábbiak valamelyikét:

n Válasszon ki egy fluorofórt a legördülő listából.

n Válasszon ki egy End Cycle to Average (Ciklus befejezése átlaghoz) értéket a ciklusok
számának a beállításához, amelyekkel ki akarja számítani az átlag végpont RFU (RFE)
értéket.

n Válassza ki az RFUs (RFE-k) opciót az adatok relatív fluoreszcencia egységekben történő
megtekintéséhez.

n Válassza ki a Percentage of Range (Tartomány százaléka) értéket az adatoknak az RFU
(RFE) tartomány százalékaként történő megtekintéséhez.

n Az adatok alkészleteire való fókuszáláshoz válassza ki a cellákat a cellaválasztóban.

n Válasszon ki egy cellacsoportot a lemezben levő cellák alkészleteinek a megtekintéséhez és
elemzéséhez. Válassza ki az egyes cellacsoportokat név szerint a Well Group (Cellacsoport)
legördülő menüből az eszköztárban.

RFU (RFE) táblázat végpont analízishez
Az 29. táblázat az RFU (RFE) táblázatban az End Point (Végpont) fülben megjelenő adatokat
definiálja.

Információk Leírás

Well (Cella) A cella pozíciója a lemezen

Fluor (Fluorofór) Detektált fluorofór

Content (Tartalom) A Mintatípus és a Replikátumszám kombinációja

End RFU (Vég RFE) RFU (RFE) a végpont ciklusnál

Call (Lehívás) Pozitív vagy Negatív, ahol a pozitív minták RFU (RFE) értéke a negatív
kontrollok átlag RFE értékénél plusz a Megszakítási értéknél magasabb.

Sample (Minta) A Plate Editor-ba (Lemezszerkesztőbe) betöltött Sample Name
(Mintanév)

29. táblázat. Az End Point (Végpont) táblázat tartalma
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Az Allelic Discrimination (Alléldiszkrimináció) fül
Az Allelic Discrimination (Alléldiszkrimináció) fül segítségével genotípusok rendelhetők az ismeretlen
mintákat tartalmazó cellákhoz. Ezen adatok segítségével Ön beazonosíthatja a különböző
genotípusokkal rendelkező mintákat, ideértve az Allele 1 (1. allél), az Allele 2 (2. allél), a Heterozygote
(Heterozigóta), a No Call (Nincs lehívás) (nincs amplifikáció) és az Undetermined (Meghatározatlan)
típusokat.

Megjegyzés: Az alléldiszkrimációra vonatkozó adatoknak többszörös (legalább két-két fluorofórt
tartalmazó) futtatásokból kell származniuk. Az egyes fluorofórok egy-egy allélt azonosítanak az
összes mintában.

Az alléldiszkrimináció-elemzéshez a celláknak legalább a következőket kell tartalmazniuk:

n Két-két fluorofór minden egyes cellában

n NTC (no template control, magyarul: sablon nélküli kontroll) minták az optimalizált
adatelemzéshez
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Az Allelic Discrimination (Alléldiszkrimináció) fül

A CFXManager Dx szoftver négy opciót kínál az alléldiszkriminációs adatok megtekintésére:

n Allelic Discrimination (Alléldiszkrimináció) diagram – az adatok megjelenítése az Allele 1 (1. allél)
/ Allele 2 (2. allél) paraméterre vonatkozó RFU grafikonján. A grafikonon látható egyes pontok az
egy cellában található mindkét fluorofór adatait jelzik. A Polar Coordinates (Polárkoordináták)
jelölőnégyzet bejelölésével, illetve bejelölésének a megszüntetésével átválthat a Descartes-féle
és a polárkoordináták között. A Descartes-féle koordináták esetében az 1. allélre vonatkozó RFU
az X-tengelyen, a 2. allélre vonatkozó RFU pedig az Y-tengelyen jelenik meg. A polárkoordináták
esetében a szög az X-tengelyen, az origó és az RFU közötti távolság pedig az Y-tengelyen jelenik
meg (az összes NTCmediánja).

n Well spreadsheet (cellatáblázat) – a lemez egyes celláiból gyűjtött alléldiszkriminációs adatok
megjelenítése.

n Well Selector (cellaválasztó) – azoknak a celláknak a kiválasztása, amelyek az Ön által
megjeleníteni kívánt alléladatokat tartalmazzák.

n Selected Fluorophores (Kiválasztott fluorofórok) panel – az allél diszkrimináció diagram X-
tengelyéhez és Y-tengelyéhez tartozó címke módosítása, az elemezni kívánt ciklus módosítása,
valamint annak a módosítása, hogy a rendszer megjelenítse-e a lehívási térképet.

Az alléldiszkriminációra vonatkozó adatok módosítása
A szoftver automatikusan hozzárendel egy genotípust az ismeretlen mintákat tartalmazó cellákhoz, az
NTC-k pozíciói és az ismeretlen adatpontoknak az NTC-khez viszonyított szöge és távolsága alapján.

Az alléldiszkriminációs adatok módosítása

u Végezze el az alábbiak valamelyikét:

n A polárkoordináták megjelenítéséhez jelölje be az „Allelic Discrimination”
(Alléldiszkrimináció) ábrában levő jelölőnégyzetet.

n Egy másik fluorofór megtekintéséhez válassza ki azt a „Selected Fluorophores” (Kiálasztott
fluorfórok) panel legördülő listájából.

n Lehívás módosításához húzzon keresztül az „Allelic Discrimination” (Alléldiszkrimináció)
diagram adatpontján/adatpontjain, és válasszon ki egy opciót a Kiválasztott cellák listából:

o „Allele 1” (1. Allél)

o „Allele 2” (2. Allél)

o „Heterozygote” (Heterozigóta)
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o „Undetermined” (Meghatározatlan)

o „No Call” (Nincs lehívás)

o „Auto Call” (Automatikus lehívás)

Tipp: Válassza ki az „Auto Call” (Automatikus lehívás) opciót az alapértelmezett
lehívásra történő visszaváltáshoz.
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Az Allelic Discrimination (Alléldiszkrimináció) fül

A diagramoknál elérhető menüpontok
A diagramoknál a jobb egérgombra kattintással elérhető közös menüpontokon (lásd: A diagramoknál a
jobb egérgombra kattintással elérhető közös menüpontok a(z) 190. oldalon) kívül vannak olyan
menüpontok, amelyek kifejezetten az Allelic Discrimination (Alléldiszkrimináció) diagramon érhetők el.
Ezeket az 30. táblázat mutatja be.

Menüpont Funkció

Zoom (Nagyítás) A diagramnézet fókuszálása a kiválasztott területre (a kurzornak a
diagramon történő kattintásával és húzásával).

Tipp: Ha a nagyítást szeretné úgy visszaállítani, hogy az
összes adatpont látszódjon, akkor kattintson a jobb
egérgombbal és válassza a Set Scale to Default (Skála
alapértelmezett értékre állítása) elemet.

Well (Cella) A kiválasztott cellához elérhető opciók: kizárólag ennek a cellának
a megjelenítése, ennek a cellának az eltávolítása a nézetből, a szín
beállítása ehhez a jelhez, vagy ennek a cellának a kizárása az
elemzésből.

Selected Wells (Kiválasztott
cellák)

A (kurzornak a diagramon történő kattintásával és húzásával)
kiválasztott cellákhoz elérhető opciók: kizárólag ezeknek a
celláknak a megjelenítése, ezeknek a celláknak az eltávolítása a
nézetből, a szín beállítása ezekhez a jelekhez, vagy ezeknek a
celláknak a kizárása az elemzésből.

30. táblázat. Az Allelic Discrimination (Alléldiszkrimináció) diagramon a jobb és bal
egérgombra kattintással elérhető menüpontok
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Allelic Discrimination (Alléldiszkrimináció) táblázat
Az 31. táblázat az Allelic Discrimination(Alléldiszkrimináció) táblázatban megjelenő adatokat
határozza meg.

Információk Leírás

Well (Cella) A cella pozíciója a lemezen

Sample (Minta) A minta megnevezése

Call (Lehívás) Az allél azonosítása, ideértve: automatikus 1. Allél, 2 Allél,
Heterozigóta, Nincs lehívás, vagy Meghatározatlan

Type (Típus) Auto (Automatikus) vagy Manuális; a lehívás végrehajtásának
módját ismerteti. Az Automatikus azt jelzi, hogy a lehívást a szoftver
választotta ki. A Manuális azt jelzi, hogy a lehívást a felhasználó
választotta ki.

RFU1 RFU (RFE) az 1. Allélhez

RFU2 RFU (RFE) a 2. Allélhez

31. táblázat. Az Allelic Discrimination (Alléldiszkrimináció) táblázat tartalma
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Custom Data View (Egyéni adatnézet) fül

Custom Data View (Egyéni adatnézet) fül
A Custom Data View (Egyéni adatnézet) fül egyszerre több panelt jelenít meg testre szabható
formában.

A Load a Preset View (Előre definiált nézet betöltése) legördülő lista különböző megjelenítési
formátum sablont kínál fel. Az alapértelmezett nézet az elemzés alatt álló fájltól függ. Például,
ha léteznek Melt Curve (Olvadási görbe) adatok, akkor az Amp+Melt (Erősítés + Olvadás)
alapértelmezett nézet jelenik meg.
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Egyéni adatnézet létrehozása
Egyéni adatnézet létrehozásához

u Végezze el az alábbiak valamelyikét:

n Válasszon ki egy másik előre beállított nézetet a legördülő listából.

n Válasszon ki egy másik diagramnézetet az egyes egyedi panelek tetejénél levő legördülő
listából.

n Módosítsa a sorok és az oszlopok számát a fülben.

n Módosítsa az egyes panelméreteket. Húzza el az egyes panelek szélénél levő sávokat.

Kattintson a Save as Preset (Elmentés előre definiált beállításként) gombra a testreszabott nézet
előre beállított sablonként történő elmentéséhez. Kattintson a Manage Presets (Előre definiált
beállítások kezelése) gombra a létező előre beállított nézetek törléséhez, átnevezéséhez vagy
visszaállításához.
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A QC (Minőség-ellenőrzés) fül

A QC (Minőség-ellenőrzés) fül
A QC (Minőség-ellenőrzés) fül segítségével – a QC (Minőség-ellenőrzés) meghatározott szabályok
alapján – gyorsan kiértékelheti a futtatási adatok minőségét.

A CFX Manager Dx szoftver négy opciót kínál a QC (Minőség-ellenőrzés) adatok megtekintésére:

n Amplification chart (Amplifikáció diagram) – az egyes ciklusok során az egyes cellákra
vonatkozó relatív fluoreszcencia egységek (RFU) megjelenítése. A diagramon látható egyes jelek
egyetlen cellában található egyetlen fluorofór adatait jelzik.

n QC rules table (Minőség-ellenőrzési szabályok táblázata) – az elérhető QC (Minőség-
ellenőrzés) szabályoknak, valamint az egyes szabályokat meghatározó beállításoknak a
megjelenítése. A rendszer az alkalmazott QC (Minőség-ellenőrzés) szabályokat pipa jellel jelzi.

n Well Selector (Cellaválasztó) – azoknak a celláknak a kiválasztása, amelyek az Ön által
megjeleníteni kívánt fluoreszcenciaadatokat tartalmazzák.

n QC rule summary pane (Minőség-ellenőrzési szabályok összefoglaló panele) – a
kiválasztott QC (Minőség-ellenőrzés) szabály megjelenítése, valamint az adott szabálynak meg
nem felelő cellák kiemelése.

A QC (Minőség-ellenőrzési) kritériumok módosítása
A QC (Minőség-ellenőrzési) kritériumok módosításához

u A szabálynak a QC (Minőség-ellenőrzés) során való befoglalásához vagy kizárásához válassza
ki vagy ürítse ki a Use (Használat) jelölőnégyzetet.
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A QC (Minőség-ellenőrzés) lépésben meg nem felelő cellák
kizárása
A(z) CFX Manager Dx szoftver a QC (Minőség-ellenőrzés) kritériumainak meg nem felelő cellákat a
„Results” (Eredmények) oszlopban jeleníti meg a QC (Minőség-ellenőrzési) szabályok táblázatában
és az összefoglaló táblában.

A QC (Minőség-ellenőrzés) kritériumainak meg nem felelő cellák kizárásához

u Válassza ki az Exclude Wells (Cellák kizárása) opciót mindegyik kizárandó cellához.
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A Run Information (Futttatási információk) fül

A Run Information (Futttatási információk) fül
A Run Information (Futttatási információk) fülön a protokoll, valamint az egyes futtatásokra vonatkozó
egyéb információk láthatók. Ennek a fülnek a segítségével a következőket teheti:

n A protokoll megtekintése.

n A futtatásra vonatkozó megjegyzések beírása vagy szerkesztése.

n A futtatásra vonatkozó ID (Azonosító) vagy vonalkód beírása vagy szerkesztése.

n A futtatás során esetlegesen előforduló események megtekintése. Ezeknek az üzeneteknek a
segítségével elháríthat egy futtatással kapcsolatos hibát.

Tipp: A protokoll másolásához, exportálásához, illetve nyomtatásához kattintson a jobb
egérgombbal a protokollra. Ha a Notes (Megjegyzések), az ID/Bar Code (Azonosító/vonalkód)
vagy az Other (Egyéb) panelekre a jobb egérgombbal kattint, akkor kivághatja, másolhatja,
beillesztheti, törölheti vagy kijelölheti a szöveget.
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Adatelemzés jelentések
A Report (Jelentés) párbeszédpanel információkat közöl a pillanatnyi adatfájlról a Data Analysis
(Adatelemzés)ablakban. Egy jelentés megnyitásához válassza ki a Tools > Reports.

A Report (Jelentés) párbeszéd az alábbi részekből áll:

n Menü és eszköztár — opciókat biztosít a jelentés vagy sablon formátumához, elmentéséhez, és
kinyomtatásához.

n Opció lista (a párbeszédpanel bal felső oldala) — opciókat biztosít a jelentésben való
megjelenítéshez.

n Opciók panel (a párbeszédpanel bal alsó oldala) — szövegmezőket jelenít meg, amelyekbe
információkat írhat be egy kiválasztott opcióról.

n Előnézet panel (a párbeszédpanel jobb oldala) — a pillanatnyi jelentés előnézetét jeleníti meg.
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Az adatelemzés-jelentések kategóriái
Az 32. táblázat a Data Analysis (Adatelemzés) ablakban található adatok típusától függően az
adatelemzési jelentéshez elérhető összes opciót mutatja.

Kategória Opció Leírás

Header (Fejléc)

A jelentés címe, alcíme és logója

Report Information (Jelentés
információk)

A futtatás dátuma, a felhasználó neve,
az adatfájl neve, az adatfájl útvonala,
valamint a kiválasztott cellacsoport

Audit Information
(Auditinformációk)

Az auditáláshoz szükséges kiegészítő
információk, beleértve az aláírásokat

Notes (Megjegyzések) Az adatjelentésre vonatkozó
megjegyzések

Run Setup (Futtatás beállításai)

Run Information (Futtatási
információk)

A futtatás dátuma, a felhasználó neve,
az adatfájl neve, az adatfájl útvonala,
valamint a kiválasztott cellacsoport

Protocol (Protokoll) A protokoll lépéseinek és opcióinak a
szöveges nézete

Plate Display (Lemezkijelző) A lemez egyes celláiban található
információk lemeznézete

Quantification (Kvantifikáció)

Analysis Settings
(Elemzésbeállítások)

Adatgyűjtési lépés száma, elemzési
mód, valamint a kiindulási
értékkivonási módszer

Amplification Chart
(Amplifikációs diagram)

Amplifikációs diagram a kvantifikációs
adatokat tartalmazó futtatásokhoz

Standard Curve Chart
(Standardgörbe-diagram)

Standardgörbe-diagram

32. táblázat. Adatelemzési jelentések kategóriái az opciók listájában
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Kategória Opció Leírás

Data (Adatok) Az egyes cellákban található adatokat
tartalmazó táblázat

Gene Expression – Bar Chart (Génexpresszió – oszlopdiagram)

Analysis Settings
(Elemzésbeállítások)

Elemzési mód, diagramadatok,
méretezési opció, valamint
diagramhiba

Chart (Diagram) Az oszlopdiagrammásolata

Target Names (Cél nevek) Célértéknevek diagramja

Sample Names (Mintanevek) Mintanevek diagramja

Data (Adatok) Az egyes cellákban található adatokat
tartalmazó táblázat

Target Stability (Célérték-
stabilitás)

A célértékek stabilitásának diagramja

Gene Expression (Génexpresszió) – Clustergram (Klaszter analízis) és Scatter Plo t
(Pontszórási diagram)

Analysis Settings
(Elemzésbeállítások)

Az egyes diagramtípusok beállításai

Chart (Diagram) A diagrammásolata

Data (Adatok) Az egyes célokban található adatokat
tartalmazó táblázat

Melt Curve (Olvadási görbe)

Analysis Settings
(Elemzésbeállítások)

Olvadási lépés száma és a
küszöbértékoszlop beállítása

Olvadásigörbe-diagram Olvadásigörbe-diagram

Melt Peak (Olvadási csúcs)
diagram

Olvadásicsúcs-diagram

32. táblázat. Adatelemzési jelentések kategóriái az opciók listájában, folytatás
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Kategória Opció Leírás

Data (Adatok) Az egyes cellákban található adatokat
tartalmazó táblázat

Allelic Discrimination (Alléldiszkrimináció)

Analysis Settings
(Elemzésbeállítások)

A fluorofórok, a ciklus, valamint a
nézetlehívási térkép megjelenítése

Allelic Discrimination Chart
(Alléldiszkrimináció diagram)

Az alléldiszkrimináció diagram
másolata

Data (Adatok) Az egyes cellákban található adatokat
tartalmazó táblázat

End Point (Végpont)

Analysis Settings
(Elemzésbeállítások)

Fluorofór, az átlagszámításhoz
befejezendő ciklusok száma, a mód, a
legalacsonyabb RFU érték, a
legmagasabb RFU érték, valamint a
megszakítási érték

Data (Adatok) Az egyes cellákban található adatokat
tartalmazó táblázat

QC Parameters (Minőség-ellenőrzési paraméterek)

Data (Adatok) Az egyes QC (Minőség-ellenőrzés)
szabályokhoz tartozó paramétereket
tartalmazó táblázat

32. táblázat. Adatelemzési jelentések kategóriái az opciók listájában, folytatás
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Adatelemzés-jelentés létrehozása
A jelentés elrendezését elmentheti sablonként, amit hasonló jelentésekhez újra felhasználhat.

Adatelemzés jelentés létrehozásához

1. A jelentés létrehozása előtt végezze el a kiválasztott cellákk, diagramok és táblázatok végső
módosításait a Data Analysis (Adatelemzés) ablakban.

2. Válassza ki a Tools > Reports(Eszközök > Jelentések) opciót a Data Analysis (Adatelemzés)
menüsorban a Report (Jelentés) párbeszédpanel megnyitásához.

3. Válassza ki azokat az opciókat, amelyeket szerepeltetni akar a jelentésben. A jelentés
megnyitásakor az alapértelmezett opciók ki vannak választva. Jelölje be vagy ürítse ki a
jelölőnégyzeteket az egész kategóriák vagy egy kategórián belüli egyedi opciók módosításához.

Megjegyzés: A jelentésben megjelenő adatok a Data Analysis ablak füleiben levő pillanatnyi
kiválasztásoktól függenek. Például lehetséges, hogy egy kvantifikációs lefutás nem
tartalmaz egy standard görbét, ennélfogva azok az adatok nem jelennek meg a Data
Analysis (Adatelemzés) ablakban vagy az adatjelentésben.

4. Módosítsa a kategóriák és elemek sorrendjét egy jelentésben. Húzza az opciókat a relatív
helyzetbe. Az elemek csak azokon a kategóriákon belül rendezhetők át, amelyekhez tartoznak.

5. (Opcionális) A Report Options (Jelentés opciók) panelen adja meg a kiválasztott opcióra
vonatkozó információkat:

n Válasszon ki egy, a jelentésben megjelenítendő információ alkészletet.

n Válasszon ki specifikus beállításokat a kijelölt opcióhoz.

n Módosítsa a kiválasztott opcióhoz megjelenítendő szöveget.

6. Kattintson az Update Report (Jelentés frissítése) opcióra a Report Preview (Jelentés előnézet)
esetleges módosításokkal történő frissítéséhez.

7. Nyomtassa ki vagy mentse el a jelentést. Kattintson a Print Report (Jelentés nyomtatása) gombra
az eszköztárban a pillanatnyi jelentés kinyomtatásához. Válassza ki a File > Save (Fájl > Mentés)
opciót a jelentés PDF (Adobe Acrobat Reader fájl) formátumban történő elmentéséhez, és
válasszon ki egy helyet, ahova ki akarja menteni a fájlt. Válassza ki a File > Save As (Fájl >
Mentés másként) opciót — a jelentés új névvel vagy egy új helyre történő elmentéséhez.

8. (Opcionális) Hozzon létre egy jelentés sablont a kívánt információkkal. A pillanatnyi jelentés
beállítások sablonként történő elmentéséhez válassza ki a Template > Save (Sablon > Mentés)
vagy Save As (Mentés másként) opciót. Ezután ha egy új jelentést akar elkészíteni, akkor töltse
be a jelentés sablont.

238 | CFX96 Dx és CFX96 DeepWell Dx rendszerek



Adatelemzés jelentések

Cellacsoport-jelentések létrehozása
Cellacsoport-jelentés létrehozása

1. Válassza ki a Tools > Well Group Reports (Eszközök > Cellacsoport-jelentések) opciót a Data
Analysis (Adatelemzés) ablakban.

2. A Well Groups Reports (Cellacsoport-jelentések) párbeszédpanelben válassza ki a jelentésbe
belefoglalni kívánt cellacsoportokat, amplifikációs lépéseket és olvadási lépéseket.

3. Írja be az útvonalat vagy lépjen abba a mappába, amelybe el kívánja menteni a jelentést.

4. (Opcionális) Válassza ki a Choose a Report Template (Válasszon egy jelentés sablont) opciót, és
lépjen a sablonfájl mappájába.

5. (Opcionális) Válassza ki azOpen Destination Folder (Célmappa megnyitása) parancsot a mappa
megnyitásához és a jelentések megtekintéséhez azok létrehozása után.

6. Kattintson a Create Reports (Jelentések létrehozása) parancsra.
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11. fejezet Génexpresszió-elemzés
A CFXManager Dx szoftvert használhatja génexpresszió-futtatás végrehajtására a reakciókban
szigorúan minősített kontrollokat használva, a minták célkoncentrációi között mutatkozó relatív
különbségek normalizálása céljából. Egy vizsgálandó gén expressziószintjeinek normalizálására
általában egy vagy több referenciagén expressziószintjeit alkalmazzák. A referenciagének figyelembe
veszik az egyes mintákra jellemző betöltési különbségeket és egyéb variációkat, és nem
befolyásolhatják ezek expressziószintjeit a vizsgált biológiai rendszerben.

A két vagy több cellában végbemenő PCR reakciók közötti relatív különbségek értékeléséhez
válassza ki a Gene Expression (Génexpresszió) fület a Data Analysis (Adatelemzés) ablakban.
Például értékelheti egy PCR reakción belül a vírus eredetű génállományok relatív számát vagy a
transzfektált szekvenciák relatív számát. A génexpresszió-vizsgálat legelterjedtebb alkalmazása a
cDNA (cDNS) koncentráció egynél több reakcióban történő összehasonlítása, az állandó állapotú
messenger RNA (RNS) szintjeinek a felbecsülésére.

A szoftver egy cél relatív expressziószintjét az alábbi esetek egyikével számítja ki:

n Egy célszekvencia (1. cél) relatív expressziószintje egy másik célhoz (2. cél) képest; pl. egy gén
mennyisége egy másik génhez képest ugyanazon mintakezelés alatt.

n Egy célszekvencia relatív expressziója egy mintában ugyanazzal a mintával összehasonlítva
eltérő mintakezelés alatt; például egy gén relatív mennyisége saját magához képest eltérő
időbeli, földrajzi, vagy fejlesztési körülmények esetén.

Lemezbeállítás a génexpresszió-elemzéshez
A génexpresszió-elemzés elvégzéséhez a celláknak a következőket kell tartaklmazniuk:

n Kettő vagy annál több célérték – az a két célérték, amelyek különböző amplifikált géneket vagy
szekvenciákat képviselnek az Ön mintáiban.

n Egy vagy több referencia célérték – normalizált expresszió esetében legalább egy célértéknek
referencia célértéknek kell lennie. Végezze el az összes referencia célérték hozzárendelését az
Experiment Settings (Kísérlet beállítások) ablakban, hogy az adatokat normalizált expresszió
módban elemezhesse (ΔΔCq). A referenciát nem tartalmazó futtatásokat a relatív expresszió
mód segítségével kell elemezni (ΔCq).
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n Közös minták – az Ön reakcióinak tartalmazniuk kell közös mintákat (legalább kettő szükséges)
ahhoz, hogy az Ön Gene Expression (Génexpresszió) fülön ábrázolt adatait meg lehessen
tekinteni. Ezeknek a mintáknak az Ön egyes célszekvenciáira vonatkozó különböző kezeléseket
vagy feltételeket kell képviselniük. Rendeljen hozzá egy kontroll mintát (ez egy opcionális lépés)
az Experiment Settings (Kísérlet beállítások) ablakban. Ha nincs kiválasztva kontroll, akkor a
szoftver a legalacsonyabb Cq értéket használja a kontrollként.

A Plate Editor (Lemezszerkesztő) ablakban található, a Gene Expression (Génexpresszió)
beállítására vonatkozó követelmények attól függnek, hogy a reakciótartalmak egyszeres PCR
típusúak-e (értsd: a reakciókban egyetlen fluorofór szerepel) vagy többszörös PCR típusúak-e (értsd:
a reakciókban egynél több fluorofór szerepel).

Vezetett lemezbeállítás
Ha egy adatfájl lemezbeállítása nem tartalmazza az elemzéshez szükséges információkat és a Gene
Expression (Génexpresszió) fül van kiválasztva, akkor azon a helyen, ahol normál esetben az
oszlopdiagram látható, ezen információk beírására vonatkozó utasítások fognak szerepelni.
Normalizált génexpresszióhoz végezze el a következő lépéseket:

1. Határozza meg a Target (Célérték) és a Sample (Minta) neveket a következők bármelyikével:

n Plate Setup (Lemezbeállítás) – a Plate Editor (Lemez szerkesztő) ablak megnyitása.

n Replace Plate File (Lemezfájl cseréje) – a Select Plate (Lemez kiválasztása) böngésző
megnyitása, amelynek a segítségével megkereshet egy korábban elmentett lemezfájlt, amire
a jelenlegi lemezelrendezést szeretné kicserélni.

n Replace PrimePCR File (PrimePCR fájl cseréje) – a Select PrimePCR File (PrimePCR fájl
kiválasztása) párbeszédpanel megnyitása, amelynek a segítségével megkereshet egy
PrimePCR futtatájlt,és azt alkalmazhatja a lemezelrendezésre.

2. Válasszon ki egy vagy több referencia célértéket és egy kontroll mintát az Experiment Settings
(Kísérlet beállítások) párbeszédpanel segítségével.

Ha a lemezelrendezés már tartalmaz a célértékre és a mintára vonatkozó információkat, akkor
kizárólag a második lépés szükséges (ilyen esetben ezt a rendszer narancssárga színnel
kiemeli). Ezt a lépést el kell végezni ahhoz, hogy a rendszer elvégezze a normalizált
génexpresszió elemzését.

Megjegyzés: A klaszter analízisek és pontszórási diagramok adatai kizárólag akkor jelennek
meg, ha a génexpresszió-elemzésre vonatkozó Plate Setup (Lemezbeállítás) alatt
meghatározott, a normalizált génexpresszióra vonatkozó összes követelmény teljesül.
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Génexpressziós diagramok

Génexpressziós diagramok
A CFXManager Dx több nézetben jeleníti meg a génexpresszió-adatokat. Az33. táblázat a
szoftverben elérhető diagramopciókat határozza meg.

Gomb Név Funkció

Oszlopdiagram Normalizált génexpresszió-adatok
megjelenítése oszlopdiagram formátumban.

Klaszter analízis Normalizált expresszióadatok megjelenítése
hierarchiában a különböző célértékekre és
mintákra vonatkozó expresszió hasonlósági
foka alapján.

Pontszórási diagram Egy kontroll célértékei normalizált
expressziójának a megjelenítése egy
kísérleti mintával összehasonlítva.

Eredmények Az összes diagramból származó adatok
összefoglalása.

33. táblázat. A génexpressziós diagramoknál elérhető opciók
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Oszlopdiagram

A rendszer a célértékek relatív expresszióját a következő két nézetben jeleníti meg:

n Gene Expression (Génexpresszió) diagram – a valós idejű PCR adatok megjelenítése a
következők egyikeként:

o ΔΔCq – kontroll minták és referencia célértékek segítségével kiszámított relatív normalizált
expresszió.

o ΔCq – a célgén relatív mennyisége egy mintában egy kontroll mintához viszonyítva.

n Táblázat – a génexpresszió-adatokat tartalmazó táblázat megjelenítése.

Tipp: Az elérhető opciókért kattintson a jobb egérgombbal bármelyik diagramra vagy
táblázatra. A Plate Setup (Lemezbeállítás) legördülő menüben a View/Edit Plate (Lemez
megtekintése/szerkesztése) elem kiválasztásával megnyithatja a Plate Editor (Lemez
szerkesztő) ablakot, amelyben módosíthatja a lemezben található cellák tartalmait.

Tipp: Ha szeretné átrendezni a diagramon a Target (Célérték) és Sample (Minta) nevek
sorrendjét, akkor a jobb egérgombra kattintással elérhető menüből válassza ki a Sort
(Rendezés) elemet.
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Normalizált génexpresszió

Az adatok normalizálásához használja egy vagy több referenciagén mért expressziószintjét
normalizációs faktorként. A referenciagének olyan célok, amelyek a vizsgált biológiai rendszerben
nem szabályozottak, pl. actin,GAPDH, vagy tubulin.

Normalizált génexpresszió (ΔΔCq) analízis beállítása

1. Nyisson meg egy adatfájlt (.pcrd kiterjesztésű).

2. Tekintse át az adatokat a Data Analysis (Adatelemzés) ablak Quantification (Kvantifikáció)
fülében. Végezze el az adatok beállításait, pl. a küszöbérték és az analízis mód módosítását.

3. Zárja be a Gene Expression (Génexpresszió) fület.

4. A Gene Expression (Génexpresszió) fülben kattintson az Experiment Settings (Kísérlet
beállítások) lehetőségre.

5. Az Experiment Settings (Kísérlet beállítások) párbeszédpanelben végezze el a következőket:

a. Válassza ki a Samples (Minták) fület és jelöljön ki egy kontrollt. Kontroll hozzárendelésekor a CFX
Manager Dx szoftver az összes génhez tartozó relatív mennyiségeket a kontroll mennyiségre
normalizálja, ami a beállítás szerint 1.

b. Válassza ki a Target (Cél) fület, és jelölje ki a referenciagéneket. A génexpresszió-
analízishez a mintáiban levő célok között egy referencia szükséges.

6. Válassza ki a Normalized Expression (ΔΔCq) (Normalizált expresszió) lehetőséget, ha az még
nincs kiválasztva, majd tekintse meg az expresszió szinteket a Gene Expression
(Génexpresszió) fülben.

Relatív mennyiség

A relatív mennyiség (ΔCq) adatok definíció szerint nem normalizáltak. Ez a módszer olyan minták
kvantifikálására szolgál, amelyek nem tartalmaznak referencia géneket (célok). A kutatók általában a
futtatás beállításakor a következő szempontok egyikében biztosak:

n Minden minta megegyező mennyiségű RNA-t (RNS-t) vagy cDNA-t (cDNS.t) tartalmaz mindegyik
cellában.

n A betöltött biológiai minta mennyiségében mutatkozó esetleges variancia a futtatás után valamilyen
módszerrel normalizálva lesz a szoftveren kívül végzett adatelemzés során. Például a kutató
választhatja a relatív mennyiségérték elosztását a normalizáló faktorral, esetleg az egyes
mintákhoz betöltött nukleinsav tömegével, vagy azoknak a sejteknek a számával, amelyekből a
nukleinsav izolálva lett.
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Relatív mennyiség (ΔCq) analízis luttatásához

u A Gene Expression (Génexpresszió) fülben válassza ki a Relative Quantity (ΔCq) (Relatív
mennyiség) opciót a Mode (Mód) legördülő listából a jobb oldali táblában.

Tipp: Az eredményeknek a többi génexpresszió futtatások eredményeivel történő
összevetéséhez nyisson meg egy új génvizsgálatot, vagy adjon egy adatfájlt egy létező
génvizsgálathoz.

A célértékekre és a mintákra vonatkozó adatok rendezése
Megjegyzés: Ez az opció kizárólag a génexpresszió diagramokon érhető el.

A Targets and Samples (Célértékek és minták) listák alapértelmezés szerint ábécé sorrendben
jelennek meg. A Sort (Rendezés) párbeszédpanel segítségével a megjelenítést megváltoztathatja
fordított ábécé sorrendre vagy egy kifejezést kézileg áthelyezhet a lista egy másik pontjára.

A célértékek és minták adatainak a rendezése

1. A diagram jobb egérgombra kattintással elérhető menüjében kattintson a Sort (Rendezés)
elemre.

Megjelenik a Gene Expression Chart Sorting (Génexpresszió diagram rendezése)
párbeszédpanel.

2. Ha a listát fordított ábécé sorrendben szeretné megjeleníteni, akkor a párbeszédpanelen
kattintson a Z-A elemre.
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3. Egy kifejezés kézileg történő áthelyezéséhez válassza ki az adott kifejezést, majd a diagramok
között kattintson a megfelelő gombra:

n A kiválasztott kifejezés egyetlen pozícióval történő áthelyezéséhez kattintson a felfelé, illetve
a lefelé mutató nyílra.

n A kiválasztott kifejezésnek a lista tetejére, illetve aljára történő áthelyezéséhez kattintson a
felfelé, illetve a lefelé mutató vonalas nyílra.

4. A módosítások mentéséhez és a Gene Expression (Génexpresszió) fülre történő visszatéréshez
kattintson az OK (Rendben) gombra.

Génexpressziós adatok módosítása
Az analízis mód kiválasztása után— normalizált expresszió (∆∆Cq) vagy relatív mennyiség (∆Cq),
állítsa be a megtekintett adatokat a Gene Expression (Génexpresszió) fülben, a diagram jobb oldalán
levő beállítási opciók módosításával.

Tipp: Az alapértelmezett Gene Expression (Génexpresszió) adatopciók beállítása a User
Preferences (Felhasználói preferenciák) párbeszédablakban történik (lásd: A génexpresszió-adatfájlra
vonatkozó alapértelmezett paraméterek beállítása a(z) 76. oldalon).

Grafikonadatok

A grafikonadatok opciók engedélyezéséhez állítsa az y-tengely értékét „Linear scale” (Lineáris skála)
lehetőségre. A grafikonadatok opciók lehetővé teszik az adatok grafikonon való megjelenítését az
alábbi opciók egyike szerint:

n „Relative to control” (Kontrollhoz képes) — az adatok grafikonon való megjelenítése a tengely 0-
tól 1-ig terjedő skálájával. Ha a lefutásban egy hozzárendel egy kontrollt, akkor válassza ezt az
opciót a cél upregulációjának és downregulációjának az ábrázolásához.

n „Relative to zero” (Zéróhoz képes) — az adatok grafikonon való megjelenítése az origó zérónál
levő helyzetével.

(Kontroll) Control Sample (Kontroll minta)

A (Kontroll)Control Sample (Kontroll minta) legördülő menü segítségével kiválaszthatja azt a mintát ,
amelyet a rendszer a relatív mennyiség normalizálásához fog használni:

Diagrambeállítások

A Show Chart Settings (Diagrambeállítások mutatása) jelölőnégyzet bejelölésekor a következő
(alábbiakban ismertetett) opciók jelennek meg: X-Axis (X-tengely), Y-Axis (Y-tengely), Scaling
(Skálázás), Error Type (Hibatípus) és Chart Error Multiplier (Diagramhiba-szorzó).
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Az X-tengelyre vonatkozó beállítások

Az x-tengelyre vonatkozó beállítások lehetővé teszik a Gene Expression (Génexpresszió) diagram x-
tengely adatainak a kiválasztását:

n Cél — a cél neveket ábrázolja az x-tengelyen.

n Minta— a minta neveket ábrázolja az x-tengelyen.

Az y-tengelyre vonatkozó beállítások

Az y-tengelyre vonatkozó beállítások lehetővé teszik a Gene Expression (Génexpresszió) diagram
ábrázolását az alábbi három skála egyikével:

n Lineáris — válassza ezt az opciót egy lineáris skála ábrázolásához.

Tipp: Az y-tengely Linear (Lineáris) opcióra állítása engedélyezi a Graph Data
(Diagramadatok) legördülő listát, amelyről kiválaszthatja az adatok kontrollhoz viszonyított
vagy zéróhoz viszonyított ábrázolását.

n Log 2— válassza ezt az opciót a minták nagy dinamikus tartományban történő értékeléséhez.

n Log 10— válassza ezt az opciót a minták nagyon nagy dinamikus tartományban történő
értékeléséhez.

Méretezési opciók

Válassza ki a Normalized Gene Expression (ΔΔCq) (Normalizált génexpresszió) lehetőséget és állítsa
be a Control Sample (Kontroll minta) opciót None A Gene Expression (Génexpresszió) diagramban
levő méretezési opciók engedélyezéséhez. Válasszon egyet ezekből a méretezési opciókból az
adatok futtatás beállításainak legjobban megfelelő kiszámításához és közléséhez:

n Unscaled (Nemméretezett) — a méretezetlen normalizált génexpressziót közli.

n Highest (Legmagasabb) — a normalizált génexpressziót az egyes célokhoz úgy méretezi, hogy
az egyes minták expressziószintjét elosztja a legmagasabb szintű expresszióval az összes
mintában.

Ez a méretezési opció a „legmagasabbra méretezett” képletet alkalmazza.
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n Lowest (Legalacsonyabb) — a normalizált génexpressziót az egyes célokhoz úgy méretezi, hogy
az egyes minták expressziószintjét elosztja a legalacsonyabb szintű expresszióval az összes
mintában.

Ez a méretezési opció a „legalacsonyabbra méretezett” képletet alkalmazza.

n Average (Átlag) — a normalizált génexpressziót az egyes célokhoz úgy méretezi, hogy az egyes
minták expressziószintjét elosztja az összes minta mértani középértékével.

Ez a méretezési opció a „átlagra méretezett” képletet alkalmazza.

Hibatípus

Válasszon egy opciót, hogy a rendszer milyen típusú a hibaszámításokat (hibasávokat) jelenítsen
meg a Gene Expression (Génexpresszió) diagramon:

n Standard error of the mean (Középérték standard hibája) (alapértelmezett)

n Standard deviation (Szórás)

Diagramhibasáv szorzója

Válasszon ki egy szorzót a hibaoszlopokhoz a Gene Expression(Génexpresszió) diagramban.
Válasszon egyet a következő egész számokból:
+/- 1 (alapértelmezett), 2, vagy 3. A szorzó típusa változik, amikor kiválasztja a hiba típust:

n SEMs középérték standard hibájához

n Std Devs szórásokhoz

Kísérletbeállítások
Tipp: Ez a párbeszédpanel a Lemez szerkesztőben is elérhető. További információkért lásd:
Kísérletbeállítások módosítása a(z) 139. oldalon.

Az Experiment Settings (Kísérlet beállítások) párbeszédpanelben megtekintheti vagy módosíthatja a
célok vagy minták listáját, kiválaszthatja a referencia géneket, kiválaszthatja a kontrollokat, vagy
beállíthatja az analizálandó Gene Expression Analysis (Génexpresszió elemzés) csoportot, ha
biológiai sor nevek hozzá lettek adva a cellákhoz.
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Az Experiment Settings (Kísérlet beállítások) párbeszédpanel megnyitása

u A a Bar Chart (Oszlopdiagram) fülben, kattintson az Experiment Settings (Kísérlet beállítások)
gombra a jobb oldali panel alján.

Megjelenik az Experiment Settings (Kísérlet beállítások) párbeszédpanel és rajta a Targets
(Célok) fül.

A Targets (Célok) beállítások módosításához

u A Targets (Célok) fülben végezze el az alábbiak valamelyikét:

n Egy cél génexpresszióadat-elemzés referenciájaként történő kiválasztásához jelölje be
annak nevét a Reference (Referencia) oszlopban.

n A cél színének módosításához kattintson annak cellájára a Color (Szín) oszlopban és
módosítsa a színt a megjelenő Color (Szín) párbeszédpanelen.

A szín változása megjelenik a Gene Expression (Génexpresszió) diagramokban.

n Egy korábban meghatározott hatásfok érték használatához szüntesse meg a cél
jelölőnégyzetének bejelölését az Auto Efficiency (Automatikus hatásfok) oszlopban, majd
írjon be egy számot egy cél hatásfok százalékához.

Ha egy cél értékei standard görbét tartalmaznak, a szoftver kiszámítja a cél relatív hatásfokát
az Auto Efficiency (Automatikus hatásfok) használatával.
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A Sample (Biológiai csoport) beállítások módosításához

u A Samples (Biológiai csoportok) fülben végezze el az alábbiak valamelyikét:

n Egy minta génexpresszióadat-elemzés kontrolljaként történő kiválasztásához jelölje be
annak nevét a Control (Kontroll) oszlopban.

n Aminta csoport színének módosításához kattintson annak cellájába a Color (Szín)
oszlopban, és módosítsa a színt a megjelenő Color (Szín) párbeszédpanelben.

A szín változása megjelenik a Gene Expression (Génexpresszió) diagramokban.

n Aminta Gene Expression (Génexpressziós) diagramokban való megjelenítéséhez válassza
ki azt aShow Chart (Diagrammegjelenítése) oszlopban.

n Aminta Gene Expression (Génexpressziós) diagramokból való eltávolításához szüntesse
meg ki annak bejelölését a Show Chart (Diagrammegjelenítése) oszlopban.

Tipp: Aminta csoport adatai megmaradnak a Results (Eredmények) táblázatban.

A Biological Set Analysis Options (Biológiai sor analízis opciók) választás módosítása

u Ha egy vagy több biológiai sort hozzárendelt a lemezen lévő cellákhoz (lásd: Biológiai sorok
hozzárendelése cellákhoz a(z) 132. oldalon), akkor a Biological Set Analysis Options (Biológiai sor
analízis opciók) lista megjelenik az Experiment Settings (Kísérlet beállítások)
párbeszédpanelben, lehetővé téve a választás szükség szerinti módosítását.

n Target vs. Sample (Cél kontra minta) — A rendszer a génexpresszió-számítások során
kizárólag a cellaminta nevét fogja használni.

n Target vs. Biological Set (Célérték kontra biológiai sor) – A rendszer a számítások során
kizárólag a biológiai sor nevét fogja használni.

n Target vs. Sample_Biological Set (Célérték kontra minta_biológiai sor) – A rendszer a
minta nevét és a biológiai sor nevét összevonja, majd az így létrehozott egyetlen nevet fogja
használni a számítások során.

n Target vs. Biological Set_Sample (Cél kontra biológiai sor_Minta) — A rendszer a biológiai
sor nevét és a minta nevét és összevonja, majd az így létrehozott egyetlen nevet fogja
használni a számítások során.
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Minta analízisszámításokból való kizárása

u Jelölje be annak jelölőnégyzetét az Experiment Settings (Kísérlet beállítások) párbeszédpanel
alján.

Megjegyzés: Ez kizárja a kontrollokat és/vagy standardokat a génexpresszió-analízisből.

Stabilitási célérték
A rendszer egynél több referenciagén használata esetén számítja ki a stabilitási célértékeket. A CFX
Manager Dx szoftver két minőségi paramétert számít ki a referenciagénekhez:

n A normalizált referencia gén relatív mennyiségek variációs koefficiense (Coefficient
Variance (CV )). Az alacsonyabb CV érték nagyobb fokú stabilitást jelez.

n M Value (M) (M érték), a referencia génexpresszió stabilitásának a mértéke.

Az ajánlott CV és M értékek a Stability Value (Stabilitás érték) párbeszédpanel alján jelennek meg.

A cél stabilitási érték megtekintéséhez

u A Gene Expression Bar Chart (Génexpresszió oszlopdiagram) fülben kattintson a Target Stability
Value (Cél stabilitás érték) lehetőségre a jobb oldali panel alján.

Megjelenik a Stability Value (Stabilitás érték) párbeszédpanel.

A jobb egérgombra kattintással elérhető menüpontok
Kattintson a jobb egérgombbal a génexpresszió diagramra az 34. táblázat látható pontok
kiválasztásához.

Pont Funkció

Copy (Másolás) A diagram vágólapra másolása.

Save Image As (Kép mentése
másként)

A diagrammentése képfájlként. Állítsa be a kép felbontását és
méreteit, majd válassza ki a fájltípust (PNG, GIF, JPG, TIF vagy
BMP).

Page Setup (Oldalbeállítás) A nyomtatásra vonatkozó oldalbeállítás kiválasztása.

Print (Nyomtatás) A diagram kinyomtatása.

34. táblázat. A jobb egérgombra kattintással elérhető génexpressziós menüpontok
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Pont Funkció

Set Scale to Default (Skálázás
alapértelmezett értékre állítása)

Show All (Összes mutatása) – az összes adat megjelenítése az
oszlopdiagramon. Scroll Bar (Görgetősáv) – görgetősáv
megjelenítése, ha annyi minta található, amennyit nem lehet
egyszerre megjeleníteni a diagram keretében a minimális
oszlopszélesség megtartása mellett.

(Diagrambeállítások) Chart
Options (Diagramopciók)

A (Diagrambeállítások)Chart Options (Diagramopciók) ablak
megnyitása, amelynek a segítségével módosíthatja a grafikont.

Sort (Rendezés) A diagram X-tengelyén megjelenő minták vagy célértékek
sorrendjének rendezése.

Use Corrected Std Devs
(Korrigált szórások használata)

A hibasávok kiszámítása a korrigált szórás képletének a
segítségével.

Use Solid Bar Colors (Egyszínű
oszlopok használata)

Egyszínű oszlopok megjelenítése a diagramon.

X–Axis Labels (X-tengely
címkéi)

Az X-tengely címkéinek a megjelenítése vízszintesen vagy döntve.

34. táblázat. A jobb egérgombra kattintással elérhető génexpressziós menüpontok, folytatás

Adattáblázat
A(z) 35. táblázat a Gene Expression (Génexpresszió) adattáblában megjelenő adatokat határozza
meg.

Megjegyzés: A rendszer a táblában szereplő értékeket a jobb oldali panelen kiválasztott
grafikontípus és preferenciák alapján számítja ki.

Információk Leírás

Cél Az Experiment Settings (Kísérlet beállítások) ablakban kiválasztott
célnév (amplifikált gén).

Minta Az Experiment Settings (Kísérlet beállítások) ablakban kiválasztott
minta- -név.

35. táblázat. A Graphing Bar Chart (Grafikus ábrázolás > Oszlopdiagram) fülön található
táblázatban szereplő információk leírása
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Információk Leírás

Ctrl Az Experiment Settings (Kísérlet beállítások) ablakban kiválasztott
kontrollnév. akkor az Experiment Settings (Kísérlet beállítások)
ablakban a

Relatív mennyiség vagy
expresszió

A kiválasztott módtól függően relatív mennyiség (ΔCq) vagy
normalizált génexpresszió (ΔΔCq).

Relatív mennyiség vagy
expresszió középérték standard
hibája (vagy szórása)

A kiválasztott opciótól függően a relatív mennyiség, illetve a
normalizált expresszió középértékének a közepes hibája, vagy a
relatív mennyiség, illetve a normalizált expresszió szórása.

Relatív mennyiség vagy
expresszió korrigált középérték
standard hibája (vagy korrigált
szórása)

A kiválasztott opciótól függően a relatív mennyiség, illetve a
normalizált expresszió számított középérték standard hibájának a
korrigált értéke, vagy a relatív mennyiség, illetve a normalizált
expresszió számított szórásának a korrigált értéke.

Középérték Cq A kvantifikációs ciklus középértéke .

Cq középérték standard hibája
(vagy szórása)

A kiválasztott opciótól függően a kvantifikációs ciklus középérték
standard hibája vagy szórása .

35. táblázat. A Graphing Bar Chart (Grafikus ábrázolás > Oszlopdiagram) fülön található
táblázatban szereplő információk leírása, folytatás

Show Details (Részletek megjelenítése) opció
A(z) 36. táblázat az oszlopdiagram táblázat jobb gombos menüjéről kiválasztott Show Details
(Részletek megjelenítése) esetén megjelenített adatokat definiálja.

Információk Leírás

Adatkészlet Fluoreszcencia adatok egy fluorofórból az adatfájlban

Relatív mennyiség Minták számított relatív mennyisége

Relatív mennyiség SD A relatív mennyiség számítás szórása

Korrigált relatív mennyiség SD A korrigált relatív mennyiség számított szórása

Relatív mennyiség SEM A relatív mennyiség számítás középértékének standard hibája

36. táblázat. Az oszlopdiagram táblázatban látható információk a Show Details (Részletek
megjelenítése) kiválasztása esetén
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Információk Leírás

Korrigált Relatív mennyiség
SEM

A korrigált relatív mennyiség középértékének számított standard
hibája

Relatív mennyiség (lg) A statisztikai analízishez használt relatív mennyiség Log2 értéke

SD RQ(lg) A relatív mennyiség szórása (log2)

SEM Expresszió(lg) Az expresszió középértékének standard hibája (log2)

Nemméretezett expresszió Számított nemméretezett expresszió

Nemméretezett expresszió SD A nemméretezett expresszió számított szórása

Korrigált Nemméretezett
expresszió SD

A korrigált nemméretezett expresszió számított szórása

Nemméretezett expresszió
SEM

A nemméretezett expresszió számított középértékének standard
hibája

Korrigált Nemméretezett
expresszió SEM

A korrigált nemméretezett expresszió középértékének számított
standard hibája

Nemméretezett expresszió(lg) A nemméretezett expresszió Log 2 értéke

SD Nemméretezett expresszió
(lg)

A nemméretezett expresszió szórása (log2)

SEM Nemméretezett
expresszió(lg)

A nemméretezett expresszió középértékének standard hibája
(log2)

Expresszió Normalizált génexpresszió

Korrigált expresszió SD Számított standard deviáció

Expresszió EM Középérték standard hibája

Korrigált expresszió SEM Középérték számított standard hibája

Expresszió(lg) A statisztikai analízishez használt expresszió (normalizált
expresszió) Log2 értéke

SD Expresszió(lg) Az expresszió szórása (log2)

36. táblázat. Az oszlopdiagram táblázatban látható információk a Show Details (Részletek
megjelenítése) kiválasztása esetén, folytatás
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Információk Leírás

SEM Expresszió(lg) Az expresszió középértékének standard hibája (log2)

Középérték Cq A kvantifikációs ciklus középértéke

Cq SD A kvantifikációs ciklus szórása

Cq SEM A kvantifikációs ciklus standard hibája

36. táblázat. Az oszlopdiagram táblázatban látható információk a Show Details (Részletek
megjelenítése) kiválasztása esetén, folytatás
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Klaszter analízis
A klaszter analízis az adatokat különböző célokhoz és mintákhoz expresszió hasonlósági fokukon
alapuló hierarchiában jeleníti meg.

Megjegyzés: Az oszlopdiagramok relatív expresszióján kívüli bármelyik adatdiagram
megjelenítéséhez ki kell választania egy referenciacélt.

A klaszter analízis a következők szerint ábrázolja egy minta vagy cél relatív expresszióját:

n Upreguláció (vörös) – magasabb expresszió

n Downreguláció (zöld vagy kék) — alacsonyabb expresszió

n Nincs reguláció (fekete)

n Nincs számított érték (fekete, fehér „X”-szel)

Minél halványabb a szín, annál nagyobb a relatív expressziókülönbség. Ha nem számítható ki
normalizált Cq érték, akkor a négyzet fekete színű lesz egy fehér „X”-szel.

Az adatdiagram külső szélein egy dendrogram található, amely a klaszter hierarchiát jelzi. A hasonló
expresszió elrendezésekkel rendelkező célok vagy minták ágai egymáshoz közel lesznek, míg az
eltérő elrendezésűek távolabb lesznek egymástól.

Beállítások
A következő opciókat állíthatja be:

n Cluster By (Csoportosítás a következő szerint:) — válasszon a Targets, Samples, Both, or None
(Célok, Minták, Mindkettő, vagy Egyik sem) lehetőségek közül.

n Size (Méret) — a kép méretét állítja be és módosítja a diagram nagyításának a mértékét.

n Split Out Replicates (Replikátumok különválasztása) —megjeleníti az egyes replikátumok
értékeit.

Tipp: Módosíthatja a színmintát a klaszter analízishez és pontszórási diagramhoz az alapértelmezett
Piros/Zöld színmintáról Piros/Kék színmintára, ennek az opciónak diagram jobb gombos menüjéről
való kiválasztásával.

A jobb egérgombra kattintással elérhető menüpontok
A klaszter analízisnél ugyanazok a menüpontok érhetők el a jobb egérgombra kattintással, mint az
oszlopdiagramnál. Az elérhető opciókat lásd: 34. táblázat a(z) 252. oldalon. Továbbá a Color Scheme
(Színséma) kiválasztásával módosíthatja az alulszabályozás expresszióját a diagramon az
alapértelmezett Red/Green (Vörös/zöld) beállításról a Red/Blue (Vörös/kék) beállításra.
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11. fejezet Génexpresszió-elemzés

Adattáblázat
A táblázat a célérték, a minta és a normalizált expresszió értékeit mutatja. Egy adott célérték mellett
található jelölőnégyzet bejelölésével vagy bejelölésének a megszüntetésével beállíthatja, hogy a
rendszer az adott célértéket belevonja-e a grafikonba, illetve kizárja-e abból.
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Pontszórási diagram

Pontszórási diagram
A pontszórási diagram a célok normalizált expresszióját ábrázolja egy kontrollnál egy kísérleti mintával
szemben. A diagramban levő vonalak a regulációs küszöbértéket jelzik. A vonalak közötti adatpontok azt
jelzik, hogy az adott célhoz (génhez) tartozó expressziókülönbség elhanyagolható a minták között. A
vonalakon kívüli adatpontok meghaladják a regulációs küszöbértéket, és relevánsak lehetnek.

A diagram képe a következő célexpresszió-változásokat mutatja a regulációs küszöbérték alapján:

n Upreguláció (piros színű kör) – viszonylag magasabb expresszió

n Downreguláció (zöld vagy kék színű kör) – viszonylag alacsonyabb expresszió

n Nincs változás (fekete színű kör)

Kattintson valamelyik küszöbérték vonalra, és húzza el a regulációs küszöbérték módosításához.

Beállítások
A következő opciókat állíthatja be:

n Control Sample (Kontroll minta)

n Experimental Sample (Kísérleti minta)

n Regulation Threshold (Szabályozási küszöbérték). Ha Ön növeli vagy csökkenti a szabályozási
értéket (regulation value), akkor a küszöbértéket jelző vonal annak megfelelően mozog a
grafikonon.

A jobb egérgombra kattintással elérhető menüpontok
A pontszórási diagramnál ugyanazok a menüpontok érhetők el a jobb egérgombra kattintással, mint
az oszlopdiagramnál. Az elérhető opciókat lásd: 34. táblázat a(z) 252. oldalon. Továbbá a Symbol
(Szimbólum) kiválasztásával módosíthatja, hogy a rendszer az alapértelmezett kör helyett a
következők közül melyik szimbólumot használja a görbén:

n Triangle (Háromszög)

n Cross (Kereszt)

n Square (Négyzet)

n Diamond (Gyémánt)
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Adattáblázat
A táblázat a kontroll és a kísérleti mintákra vonatkozó cél- és normalizált expresszió értékeit mutatja.
Továbbá azt is jelzi, hogy a célértékek a szabályozási küszöbértékhez viszonyítva up- vagy
downreguláltak-e. Egy adott célérték mellett található jelölőnégyzet bejelölésével vagy bejelölésének
a megszüntetésével beállíthatja, hogy a rendszer az adott célértéket belevonja-e a grafikonba, illetve
kizárja-e abból.
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A Results (Eredmények)

A Results (Eredmények)
A Results (Eredmények) fül egy olyan táblázatot kínál, amely összefoglalja az összes diagramból
származó adatokat. Az 37. táblázat a Results (Eredmények) táblázatban megjelenő adatokat
határozza meg.

Információk Leírás

Cél Célértéknév (amplifikált gén)

Sample (Minta) Mintanév

Mean Cq (Cq középértéke) A kvantifikációs ciklus középértéke

Mean Efficiency Corrected Cq
(A hatásfokkal korrigált Cq
középértéke)

A kvantifikációs ciklus középértéke a reakció hatásosságához
történő helyesbítés után

Normalized Expression
(Normalizált expresszió)

Egy referencia célértékhez normalizált expresszió-célérték (ΔΔCq)

Relative Normalized Expression
(Relatív normalizált expresszió)

Egy kontroll mintához viszonyított normalizált expresszió; más
néven: Fold Change (Változás mértéke)

Regulation (Szabályozás) Az expressziónak egy kontroll mintához viszonyított változása

Compared to Regulation
Threshold (A szabályozási
küszöbértékkel
összehasonlítva)

Egy kísérleti minta up- vagy downregulációja a küszöbérték-
beállítás alapján

37. táblázat. A Results (Eredmények) fülön látható információk

Megjegyzés: A replikátumokra vonatkozó adatok kizárólag azokon az adatelemzési füleken
látható táblázatokban találhatók meg, amelyeken a Split Out Replicates (Replikátumok
szétosztása) elem ki van választva (vagyis a Clustergram (Klaszter analízis) füleken). Ha az
oszlopdiagramon kontroll mintaként a „none” (nincs) opciót választja ki, akkor a génexpresszió-
elemzési táblázatokban található expresszióadatok között eltérések lehetnek.
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Génvizsgálat
Génvizsgálatot hoz létre, hogy egy – a kísérletek között normalizálást végző – futtatások közötti
kalibrátor segítségével összehasonlíthasson egy vagy több valós idejű PCR kísérletből származó
génexpresszió-adatokat. Génvizsgálat létrehozásához adjon hozzá egy vagy több (.pcrd
kiterjesztésű) adatfájlból adatokat a génvizsgálathoz. A szoftver ezeket egyetlen (.mgxd kiterjesztésű)
fájlba csoportosítja.

Megjegyzés: Azt, hogy egy génvizsgálat részeként legfeljebb hány darab mintát elemezhet, az
határozza meg, hogy a számítógép mennyi RAM- és virtuális memóriával rendelkezik.

Futtatások közötti kalibrálás
A rendszer minden egyes génvizsgálat során automatikusan megkísérli elvégezni a futtatások közötti
kalibrálást az egyes célértékekre vonatkozóan annak érdekében, hogy normalizálja a különálló valós
idejű PCR futtatásokban (vagyis a különböző lemezekből generált különböző .pcrd kiterjesztésű
fájlokban) vizsgált célértékek futtatások közötti eltéréseit.

Ahhoz, hogy a szoftver futtatások közötti kalibrátorként érzékeljen egy mintát, az összehasonlítani
kívánt összes lemezben azonosnak kell lennie a célértékek neveinek, a minták neveinek, valamint –
 ha használják őket – a biológiai sorok neveinek.

Megjegyzés: Ahhoz, hogy a rendszer futtatás közötti kalibrálást végezzen, legalább egy
futtatások közötti kalibrátorként érzékelt mintának jelen kell lennie a génvizsgálatban. A
megfelelő – futtatások közötti kalibrátorként érzékelt – mintákat nem tartalmazó célértékeket a
rendszer korrigálás nélkül fogja feldolgozni a génvizsgálatban (nem ajánlott).

A futtatások közötti kalibrátorok kétféleképpen alkalmazhatók:

n Célértékenként – a különböző PCR primerek különböző hatásfokkal rendelkezhetnek. A rendszer
alapértelmezés szerint az ugyanazon lemezben található összes olyan cellára alkalmazza a
futtatások közötti kalibrátort, amelyek azonos nevű célértékkel (például az ugyanazon vizsgálattal
generált Cq értékkel) rendelkeznek.

n A teljes vizsgálatra – a felhasználó kiválaszt egyetlen futtatások közötti kalibrátort, és a rendszer
azt alkalmazza a teljes génvizsgálatra.
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Gene Study (Génvizsgálat) párbeszédpanel
A Gene Study (Génvizsgálat) párbeszédpanel két fület tartalmaz:

n Study Setup (Vizsgálat beállítása) fül — a futtatásokat kezeli a génvizsgálatban.

Fontos: Egy génvizsgálatban az adatfájlok hozzáadása vagy eltávolítása nem változtatja
meg az eredeti fájlban levő adatokat.

n Study Analysis (Vizsgálat analízise) fül —megjeleníti a génexpresszió adatokat kombinált
futtatásokhoz.

Study Setup (Vizsgálat beállítása) fül
Az 38. táblázat a „Study Setup” (Vizsgálat beállítása) fülben megjelenő adatokat definiálja.

Oszlop címe Leírás

File Name (Fájl neve) A futtatás adatfájl (.pcrd kiterjesztés) neve.

File Folder (Fájl mappa) A génvizsgálatban levő egyes futtatások adatfájljait tároló könyvtár

Date Created (Létrehozás
dátuma)

A futtatási adatok begyűjtésének dátuma

Well Group Name
(Cellacsoport neve)

A fájlnak a génvizsgálathoz történt hozzáadásakor kiválasztott
cellacsoport neve

Tipp: Egy cellacsoportnak a génvizsgálatban történő
elemzéséhez az adott cellacsoportot az adatfájl génvizsgálatba
történő importálása előtt ki kell választani a Data Analysis
(Adatelemzés) ablakban.

Step (Lépés) Protokoll lépés, amely tartalmazza a lemez leolvasást a valós idejű
PCR adatok begyűjtéséhez

Run Type (Futtatás típusa) Vagy a felhasználó által meghatározott, vagy PrimePCR (PrimePCR)
futtatás

Protocol Edited (Protokoll
szerkesztve)

Ha ki van választva, akkor azt jelzi, hogy egy PrimePCR (PrimePCR)
futtatáshoz használt protokoll szerkesztve volt

View Plate (Lemez
megtekintése)

Megjeleníti a lemez lemeztérképét a génvizsgálatban szereplő összes
futtatás adataival.

38. táblázat. Study Setup (Vizsgálat beállítása) fül a Gene Study (Génvizsgálat)
párbeszédpanelben.
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Génvizsgálat előkészítése
Génvizsgálat előkészítéséhez

1. Mielőtt adatokat importálna egy génvizsgálatba, végezze el a következőket a Data Analysis
(Adatelemzés) ablakban:

n Ellenőrizze, hogy az ugyanazt a tartalmat tartalmazó minták neve megegyezik. Egy
génvizsgálatban a szoftver feltételezi, hogy a megegyező cél vagy mintanevű cellák
ugyanolyan mintákat tartalmaznak.

n Állítsa be a kiindulási értéket és a küszöbértéket Cq) a Quantification (Kvantifikáció) fülben az
adatok optimalizálására az egyes futtatásokban.

n Válassza ki azt a cellacsoportot, amelyet a génvizsgálatnak tartalmaznia kell.

Egy cellacsoport adatainak a megjelenítéséhez a génvizsgálatban azt a csoportot ki kell
választani az adatfájl importálása előtt.

A Study Setup (Vizsgálat beállítása) fül a génvizsgálatban levő összes futtatás listáját mutatja.

2. A Gene Study (Génvizsgálat) párbeszédpanelben válassza ki a Study Setup (Vizsgálat
beállítása) fület.

3. Kattintson az Add Data Files (Adatfájlok hozzáadása) opcióra egy fájl kiválasztásához a
böngésző ablakból.

Tipp: Futtatások génvizsgálathoz történő gyors hozzáadásához húzza el az adatfájlokat
(.pcrd kiterjesztés) a Study Setup (Vizsgálat beállítása) párbeszédpanelbe.

4. A(z) CFX Manager Dx szoftver az adatfájlok hozzáadásával egyidejűleg automatikusan
végrehajtja a génvizsgálat elemzését. Az eredmények megtekintéséhez válassza ki a Study
Analysis (Vizsgálat analízise) fület.

Futtatások génvizsgálatból történő eltávolításához

u Válasszon ki egy vagy több fájlt a listából, és kattintson a Remove (Eltávolítás) parancsra.

Megjegyzéseknek a génvizsgálathoz történő hozzáadásához

u A fájlokkal és az analízissel kapcsolatos megjegyzéseket írja be a „Notes” (Megjegyzések)
szövegpanelba.
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A Study Analysis (Vizsgálat analízise) fül
A Study Analysis (Vizsgálat analízise) fülön a génvizsgálat során elvégzett összes futtatásból
származó adatok láthatók. A génexpresszióadat-elemzési opciók ugyanazok, mint egyetlen adatfájl
esetében, kivéve a következőket:

n Az oszlopdiagramok esetében az Inter-run Calibration (Futtatások közötti kalibrálás) elemre
kattintáskor megjelennek a futtatások közötti kalibrálási értékek (ha a rendszer kiszámította őket).

Megjegyzés: Kizárólag a következő mintatípusok használhatók futtatások közötti
kalibrátorként:

o Unknown (Ismeretlen)

o Standard

o Positive Control (Pozitív kontroll)

A Negative Control (Negatív kontroll), a no template control (magyarul: templát nélküli kontroll)
(NTC) és a no reverse transcriptase control (magyarul: reverz transzkriptáz nélküli kontroll) (NRT)
mintatípusok nem használhatók futtatások közötti kalibrátorként.
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Génvizsgálat-jelentés létrehozása
Génvizsgálat-jelentés létrehozása

1. Egy jelentés létrehozása előtt szükség szerint módosítsa a génvizsgálat-jelentés adatait és
diagramjaat.

2. Válassza ki a Tools > Reports(Eszközök > Jelentések) opciót a Gene Study (Génvizsgálat)
menüben a Report (Jelentés) párbeszédpanel megnyitásához.

3. Válassza ki azokat az opciókat, amelyeket szerepeltetni akar a jelentésben. A jelentés
megnyitásakor az alapértelmezett opciók ki vannak választva. Jelölje be vagy ürítse ki a
jelölőnégyzeteket az egész kategóriák vagy egy kategórián belüli egyedi opciók módosításához.

A Génvizsgálat-jelentések kategóriái a(z) 267. oldalon felsorolja a megjelenítendő rendelkezésre
álló opciókat.

4. Módosítsa a kategóriák és elemek jelentésen belüli sorrendjét. Húzza az opciókat a szükséges
pozícióba. Az elemek csak azokon a kategóriákon belül rendezhetők át, amelyekhez tartoznak.

5. Kattintson az Update Report (Jelentés frissítése) opcióra a Report Preview (Jelentés előnézet)
esetleges módosításokkal történő frissítéséhez.

6. Nyomtassa ki vagy mentse el a jelentést. Kattintson a Print Report (Jelentés nyomtatása) gombra
az eszköztárban a pillanatnyi jelentés kinyomtatásához. Válassza ki a File > Save (Fájl > Mentés)
opciót a jelentés PDF (Adobe Acrobat Reader fájl) formátumban történő elmentéséhez, és
válasszon ki egy helyet, ahova ki akarja menteni a fájlt. Válassza ki a File > Save As (Fájl >
Mentés másként) opciót a jelentés új névvel vagy egy új helyre történő elmentéséhez.

7. (Opcionális) Hozzon létre egy jelentés sablont a kívánt információkkal. A pillanatnyi jelentés
beállítások sablonként történő elmentéséhez válassza ki a Template > Save (Sablon > Mentés)
vagy Save As (Mentés másként) opciót. Ezután ha egy új jelentést akar elkészíteni, akkor töltse
be a jelentés sablont.
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Génvizsgálat-jelentések kategóriái
Használja a Gene Study Report (Génvizsgálat jelentés) párbeszédpanelt a génvizsgálati adatok
jelentésbe rendezéséhez. Az 39. táblázat a génvizsgálati jelentéshez rendelkezésre álló összes
opciót sorolja fel.

Kategória Opció Leírás

Fejléc

A jelentés címe, alcíme és logója

Report Information
(Jelentés információk)

Dátum, a felhasználó neve, az adatfájl neve,
az adatfájl útvonala, és a kiválasztott
cellacsoport

Gene Study File List
(Génvizsgálat fájl lista)

A génvizsgálatban levő összes adatfájl listája

Notes (Megjegyzések) Az adatjelentésre vonatkozó megjegyzések

Study Analysis: Bar Chart (Adatelemzés: Oszlopdiagram)

Analysis Settings
(Elemzésbeállítások)

A kiválasztott elemzési paraméterek listája

Chart (Diagram) Az adatokat ábrázoló génexpresszió
oszlopdiagram

Target Names (Cél
nevek)

A génexpressziós vizsgálatban levő célokat
sorolja fel

Sample Names
(Mintanevek)

A génvizsgálatban levő minták listája

Data (Adatok) Az adatokat mutató táblázat

Target Stability
(Célérték-stabilitás)

Célérték stabilitási érték

Inter-run Calibration
(Futtatások közötti
kalibrálás)

Futtatások közötti kalibrálási adatok

Study Analysis Klaszter analízis és pontszórási diagram

39. táblázat. Kategóriák egy génvizsgálati jelentéshez
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Kategória Opció Leírás

Analysis Settings
(Elemzésbeállítások)

Az egyes diagramtípusok beállításai

Chart (Diagram) Az adatokat ábrázoló génexpresszió
oszlopdiagram

Data (Adatok) Az egyes célokban található adatokat
tartalmazó táblázat

39. táblázat. Kategóriák egy génvizsgálati jelentéshez, folytatás
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A. melléklet Adatelemzési számítások
A CFXManager Dx szoftver automatikusan kiszámít képleteket, és az eredményeket megjeleníti a
Data Analysis (Adatelemzés) füleken. A jelen mellékletben azt ismertetjük részletesen, hogy a CFX
Manager Dx hogyan számít ki képleteket.

Reakció hatásfoka
Bizonyítékok szólnak amellett, hogy a génexpresszióra vonatkozó adatok elemzésekor a hatásfok
pontos mérése minden primer és próba készletnél pontosabb eredményeket ad. A génexpresszió
számításokban használt alapértelmezett hatásfokérték 100%. A reakció hatásfokának
kiértékeléséhez generáljon egy standard görbét egy reprezentatív minta sorozatos hígításának a
felhasználásával egy releváns dinamikus tartományban, majd jegyezze le az azt követő
génexpresszió-elemzés hatásfokát. Amennyiben a futtatás standard görbét tartalmaz, akkor az Auto
Efficiency (Automatikus hatásfok) be van jelölve a Targets (Célértékek) fülben az Experiment Settings
(Kísérlet beállítások) ablakban, a szoftver automatikusan kiszámítja a hatásfokot, és megjeleníti azt a
Standard Curve (Standard görbe) alatt a Quantification (Kvantifikáció) fülön.

A hatásfok képletekben szereplő hatásfok (E) Pfaffl (2001) és Vandesompele és mtsai. által leírt
„hatásosságra” utal. (2002). Ezekben a publikációkban egy 2-es hatásosság (minden egyik ciklusnál
tökéletes duplázódás) ebben a szoftverben a 100%-os hatásfokkal egyenértékű. Lehetősége van a
hatásfok számításait a szoftverben használtakra konvertálni a következő matematikai összefüggések
alkalmazásával:

n E = (% Hatásfok * 0,01) + 1

n %Hatásfok = (E – 1) * 100
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A. melléklet Adatelemzési számítások

Relatív mennyiség
A relatív mennyiség (ΔCq) képlete bármely minta (releváns gén) esetében a következő:

Megjegyzés: A rendszer ezt a képletet használja a relatív mennyiség kiszámításához, amikor
nincs meghatározva kontroll minta .

Ahol:

n E = a primer és a szondakészlet hatékonysága. A rendszer ezt a hatásfokot a következő képlet
segítségével számítja ki:
(%-os hatékonyság * 0,01) + 1, ahol a 100%-os hatékonyság = 2

n C q (min) = annak a mintának az átlagos Cq értéke, amelynél a legalacsonyabb a vizsgálandó
génre vonatkozó átlagos Cq

n C q (minta) = a minta átlagos Cq értéke

n GOI = gene of interest (magyarul: vizsgálandó gén) (egyetlen célérték)

Relatív mennyiség egy kontroll kiválasztásakor
Ha hozzá van rendelve egy kontroll minta , akkor a rendszer bármelyik vizsgálandó gént (GOI)
tartalmazó mintához a relatív mennyiséget (RQ) ezzel a képlettel számítja ki:

Ahol:

n E = a primer és a szondakészlet hatásfoka. A rendszer ezt a hatásfokot a következő képlet
segítségével számítja ki:
(%-os hatásfok * 0,01) + 1, ahol a 100%-os hatásfok = 2

n Cq (kontroll) = Átlag Cq a kontroll mintához

n Cq (minta) = Átlag Cq bármely GOI-t tartalmazó mintához

n GOI = gene of interest (magyarul: vizsgálandó gén) (egyetlen célérték)
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A relatív mennyiség szórása

A relatív mennyiség szórása
A relatív mennyiség szórásának képlete:

Ahol:

n SD Relative Quantity = a relatív mennyiség szórása

n SD CqGOI sample = a minta (vizsgálandó gén) Cq értékének a szórása

n Relative Quantity = a minta relatív mennyisége

n E = a primer és a szondakészlet hatásfoka. A rendszer ezt a hatásfokot a következő képlet
segítségével számítja ki:
(%-os hatásfok * 0,01) + 1, ahol a 100%-os hatásfok = 2

n GOI = gene of interest (magyarul: vizsgálandó gén) (egyetlen célérték)

Hatásfok korrigált Cq (CqE)
A hatásfok korrigált Cq képlete

Ahol:

n E = Hatásfok

A hatásfokkal korrigált Cq középértéke (MCqE)
A hatásfokkal korrigált Cq középértékének a képlete:

Ahol:

n CqE = hatásfokkal korrigált Cq

n n = replikátumok száma
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Normalizációs tényező
A normalizált expresszió egyenletének a nevezőjét normalizációs tényezőnek szokták hívni.
A normalizációs tényező egy adott mintára vonatkozó összes referencia célérték (gén) relatív
mennyiségének a geometriai középértéke, ahogyan az a következő képletben szerepel:

Ahol:

n RQ = relatív mennyiség

n n = a referencia célértékek száma

n GOI = gene of interest (magyarul: vizsgálandó gén) (egyetlen célérték)
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Normalizált expresszió

Normalizált expresszió
A normalizált expresszió (ΔΔCq) az Ön célértékének (génjének) az Ön biológiai rendszerében
található referencia célértékek (gének vagy szekvenciák) mennyiségéhez normalizált relatív
mennyisége. A referencia célértékek kiválasztásához nyissa meg az Experiment Settings (Kísérlet
beállítások) ablakot, majd kattintson minden egyes referencia génként szolgáló célérték referencia
oszlopára.

A normalizált expresszió képlete (amely a kiszámított relatív mennyiségen (RQ) alapuló kiszámítást
használja):

Ahol:

n RQ = Egy minta relatív mennyisége

n Ref = a referencia célérték egy olyan futtatásban, amelynél az egyes mintákban egy vagy több
referencia célérték található

n GOI = gene of interest (magyarul: vizsgálandó gén) (egyetlen célérték)

Feltéve, hogy a referencia célértékek expressziószintje nem változik az Ön biológiai rendszerében, a
szoftver a normalizált expresszió kiszámítása során figyelembe veszi az Ön egyes mintáiban jelen
lévő betöltési különbségeket vagy sejtszámbeli variációkat.

Normalizált expresszió egy kontroll kiválasztásakor
Amikor kiválaszt egy kontroll mintát az Experiment Settings (Kísérlet beállítások) ablakban, a szoftver
a kontroll minta expressziószintjét 1-re állítja. Ebben a helyzetben a szoftver normalizálja az összes
cél (gén) expresszió relatív mennyiségeit a kontroll mennyiségre (értéke 1). Ez a normalizált
expresszió egyenértékű a nemméretezett normalizált expresszió analízissel egy kontroll
kiválasztásakor.

Megjegyzés: Ez relatív normalizált expresszió (RNE) és változás szorzója néven is ismert.
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A normalizált expresszió szórása
A normalizált expresszió átméretezése a normalizált expresszió szórásának (a kiválasztott
méretezési opciótól függően) a legmagasabb vagy legalacsonyabb expressziószintekhez tartozó
normalizált expresszióértékkel való elosztásával történik. A normalizációs tényező szórásának (SD)
képlete

Ahol:

n RQ = Egy minta relatív mennyisége

n SD = Szórás

n NF = Normalizációs tényező

n Ref = Referencia cél

n n = a referencia célértékek száma

Ha hozzá van rendelve egy kontroll minta, akkor nem szükséges végrehajtani ezt az átméretezési
funkciót a szóráson, amint az a következő képletben látható:

Ahol:

n NE = normalizált expresszió

n RQ = Egy minta relatív mennyisége

n SD = Szórás

n GOI = gene of interest (magyarul: vizsgálandó gén) (egyetlen célérték)
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A legmagasabb expressziószintre skálázott normalizált expresszió

A legmagasabb expressziószintre skálázott normalizált
expresszió

Ha a futás nem tartalmaz kontrollokat, akkor skálázza az egyes célértékek (gének) normalizált
expresszióját (rövidítve: NE) úgy, hogy az egyes minták expressziószintjét elosztja az összes
mintában előforduló legmagasabb expressziószinttel. A szoftver a legmagasabb expressziószintet az
1-es értékre állítja, majd újraskálázza az összes minta expressziószintjeit. A legmagasabb értékre
történő skálázás képlete

Ahol:

n GOI = gene of interest (magyarul: vizsgálandó gén) (célérték)

A legalacsonyabb expressziószintre skálázott normalizált
expresszió

Ha a futtatás nem tartalmaz kontrollokat, méretezze mindegyik cél (gén) normalizált expresszióját
(NE) az egyes minták expresszió szintjének az összes mintában levő legalacsonyabb expresszió
szinttel való elosztásával. A szoftver a legalacsonyabb expresszió szintet 1-es értékre állítja és
újraméretezi az összes minta expressziós szintet. A legalacsonyabb méretezés képlete

Ahol:

n GOI = gene of interest (magyarul: vizsgálandó gén) (célérték)
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Az átlagos expressziószintre skálázott normalizált
expresszió

Ha a futtatás nem tartalmaz kontrollokat, akkor skálázza az egyes célértékek (gének) normalizált
expresszióját (rövidítve: NE) úgy, hogy az egyes minták expressziószintjét elosztja az összes minta
expressziószintjeinek a geometriai középértékével. A szoftver az átlagos expressziószintet az 1-es
értékre állítja, majd újraskálázza az összes minta expressziószintjeit. Az átlagos értékre történő
skálázás képlete

Ahol:

n GOI = gene of interest (magyarul: vizsgálandó gén) (célérték)

n GM = az összes minta normalizált expresszióinak a mértani középértéke
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Améretezett normalizált expresszió szórása

A méretezett normalizált expresszió szórása
Améretezett normalizált expresszió (NE) érték átméretezése a normalizált expresszió szórásának
(SD) (a kiválasztott méretezési opciótól függően) a legmagasabb (MAX) vagy legalacsonyabb (MIN)
expressziószintekhez tartozó normalizált expresszióértékkel való elosztásával történik.

Megjegyzés: Ha hozzá van rendelve egy kontroll minta, akkor nem szükséges végrehajtani ezt
az átméretezési funkciót a szóráson.

Ennek a képletnek a számítása

Ahol:

n NE = normalizált expresszió

n SD = Szórás

n GOI = gene of interest (magyarul: vizsgálandó gén) (célérték)

n MAX = Legmagasabb expressziószint

n MIN = Legalacsonyabb expressziószint

reguláció
A Regulation (Változás szorzójának regulációja) egy célexpresszió növekedésének vagy
csökkenésének a mértéke egy kísérleti mintánál egy kontroll mintáhozés az a következőképpen van
meghatározva:

Ha az Expresszió (kísérleti) > Expresszió (kontroll):

Ha az Expresszió (kísérleti) < Expresszió (kontroll):

Megjegyzés: A Oszlopdiagramhozaz Expression (Expresszió) vagy a relatív mennyiségen vagy
a normalizált expresszión alapul, a kiválasztott módtól függően (lásd:Oszlopdiagram a(z) 244.
oldalon). A szórásdiagramnál és a klaszter analízisnél, reguláció mindig a normalizált
expresszióból van kiszámítva.
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Korrigált értékek kiszámítására szolgáló képletek
A korrigált és a nem korrigált értékek közötti különbség csak akkor látszódik, ha a rendszer a valós
idejű PCR futtatás részeként létrehoz egy standard görbét. A szoftver három egyenlet segítségével
határozza meg a hibapropagációt:

n Standard hiba

n A normalizált expresszió standard hibája

n A normalizált releváns gén (célérték) standard hibája

A standard hiba képlete

Ahol:

n n = a referencia célértékek (gének) száma

n SD = Szórás

A normalizált expresszióban szereplő normalizációs tényező közepes hibájának a képlete:

Ahol:

n n = a referencia célértékek száma

n SE = standard hiba

n NF = Normalizációs tényező

n RQ = relatív mennyiség

A normalizált releváns gén (GOI) standard hibájának a képlete:

Ahol:

n SE = Szórás

n GOI = gene of interest (magyarul: vizsgálandó gén) (egyetlen célérték)

n NF = Normalizációs tényező

n n = a referencia célértékek száma
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B. melléklet A CFX Manager Dx felhasználóinak
és szerepköreiknek kezelése

Ön a CFX Manager Dx szoftverben létrehozhat felhasználókat, és egy-egy szerepkört rendelhet
hozzájuk. A szerepkörök korlátozzák A CFX Manager Dx funkcióihoz történő hozzáférést. Egy
felhasználóhoz egyidejűleg legfeljebb egy szerepkör lehet hozzárendelve. Mindazonáltal a CFX
Manager Dx szoftver rendszergazdái bármikor módosíthatják a felhasználó szerepkörét.

Tipp: A(z) CFX Manager Dx használatához nem szükséges felhasználókat létrehozni. Ha Ön
nem hoz létre felhasználókat, akkor a rendszer az összes tevékenységet az alapértelmezett
felhasználói fiókkal (admin) végzi el.

Fontos: Az admin felhasználó az alapértelmezett rendszergazdai fiók, amelynek a segítségével
Ön kezdetben bejelentkezhet a(z) CFX Manager Dx szoftverbe. Ajánlott létrehozni egy
meghatározott felhasználót, aki a CFX Manager Dx szoftvert kezeli. Ehhez a felhasználóhoz
rendelje hozzá az Administrator (Rendszergazda) szerepkört, és az összes adminisztrációs
feladatot ezzel a felhasználóval végezze el.

Fontos: A(z) CFX Manager Dx szoftvernek nincs olyan funkciója, amely meghatározott idejű
inaktivitás esetében kiléptetné a felhasználót. Ezért azt ajánljuk, hogy aktiválja a Windows
rendszer biztonsági intézkedéseit vagy harmadik felektől származó biztonsági intézkedéseket
(például egy képernyőkímélőt, amelynek a feloldásához be kell jelentkezni).

Felhasználók kezelése
A CFXManager Dx szoftver standard változatában a felhasználói fiókok bármilyen nevet vagy jelszót
használhatnak.

Az egyes felhasználók szerepkörének a kijelöléséhez válasszon a szerepkörök listájából a User
Administration (Felhasználó adminisztráció) ablakban. Ebben a példában a Vendég felhasználó
további jogokat kapott a fájlok kimentéséhez.
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Felhasználók hozzáadása és eltávolítása
Megjegyzés: Kizárólag a CFX Manager Dx rendszergazda tud felhasználókat hozzáadni és
eltávolítani.

Felhasználói fiókoknak a CFX Manager Dx-hez történő hozzáadásához

1. A Home (Kezdőlap) ablakban válassza ki a User > User Administration (Felhasználó >
Felhasználó adminisztrálása) elemet.

Ekkor megjelenik a User Administration (Felhasználó adminisztrálása) párbeszédablak.

2. A Manage Users (Felhasználók kezelése) táblában írjon be egy Felhasználónevet a
felhasználóhoz.

3. Válasszon ki egy felhasználó Role (Szerepkör) lehetőséget.

A szerepkörök határozzák meg a felhasználó jogosultságait. Az alapértelmezett szerepkör a
Principal (Vezető).

Tipp: Mindegyik szerepkörhöz módosíthatja a jogosultságokat. A szerepkör
jogosultságainak a módosítása az adott jogosultságokkal rendelkező összes felhasználóra
vonatkozik. További információkért lásd: A szerepkörökhöz kapcsolódó jogosultságok
kezelése a(z) 281. oldalon.
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Felhasználók kezelése

4. (Opcionális) Írja be a felhasználóhoz a Full Name (Teljes név) és Password (Jelszó) adatokat.

5. Az OK gombra kattintáskor megjelenik egy párbeszédpanel; erősítse meg, hogy szeretné bezárni
az ablakot.

6. Kattintson a Yes (Igen) gombra a párbeszédablak és az ablak bezárásához.

Felhasználó eltávolításához

1. A Manage Users (Felhasználók kezelése) táblában válassza ki a Remove (Eltávolítás)
lehetőséget mindegyik eltávolítani kívánt felhasználóhoz.

2. Az OK gombra kattintáskor megjelenik egy párbeszédpanel; erősítse meg, hogy szeretné bezárni
az ablakot.

3. Kattintson a Yes (Igen) gombra a párbeszédablak és az ablak bezárásához.

Megjegyzés: A szoftverfelhasználók listájában mindig szerepelnie kell egy
Rendszergazdának.

A szerepkörökhöz kapcsolódó jogosultságok kezelése
A(z) CFX Manager Dx következő négy szerepkört tartalmazza:

n Administrator (Rendszergazda) (kötelező) – a rendszergazdák az összes jogosultsággal
rendelkeznek és ezeket a jogosultságokat Ön nemmódosíthatja. A rendszergazdák továbbá
hozzáadhatnak és eltávolíthatnak felhasználókat, valamint módosíthatják az egyes
szerepkörökhöz kapcsolódó jogosultságokat.

Megjegyzés: Kizárólag rendszergazda jogosult módosítani egy szerepkörhöz kapcsolódó
jogosultságokat.

n Principal (Rendszerbiztonsági tag) – a rendszerbiztonsági tag típusú felhasználó alapértelmezés
szerint az összes jogosultsággal rendelkezik

n Operator (Kezelő) – a kezelő típusú felhasználó alapértelmezés szerint az összes jogosultsággal
rendelkezik, kivéve a ciklusok átugrására vonatkozó jogosultságot

n Guest (Vendég) – a vendég típusú felhasználó alapértelmezés szerint csak fájlolvasási
jogosultsággal rendelkezik

Fontos: Egy szerepkörhöz kapcsolódó jogosultságok módosítása az összes olyan felhasználóra
kihatással van, akihez a módosítással érintett szerepkör lett hozzárendelve. A szerepkört nem
lehet testreszabni egy konkrét felhasználóhoz. Legyen körültekintő a szerepkörökhöz kapcsolódó
jogosultságok módosítása során.
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B. melléklet A CFX Manager Dx felhasználóinak és szerepköreiknek kezelése

Az egyes szerepkörökhöz kapcsolódó jogosultságok meghatározása

1. A Home (Kezdőlap) ablakban válassza ki a User > User Administration (Felhasználó >
Felhasználó adminisztrálása) elemet.

2. A Manage Rights (Jogosultságok kezelése) panelen a következőket teheti:

n Ha szeretne eltávolítani egy jogosultságot egy szerepkörből, akkor vegye ki a
jelölőnégyzetéből a jelölést.

n Ha szeretne hozzáadni egy jogosultságot egy szerepkörhöz, akkor jelölje be a
jelölőnégyzetét.

3. Az OK gombra kattintáskor megjelenik egy párbeszédpanel; erősítse meg, hogy szeretné bezárni
az ablakot.

4. A párbeszédpanel és az ablak bezárásához kattintson a Yes (Igen) elemre.

Az összes szerepkörhöz kapcsolódó összes jogosultság alaphelyzetbe állítása

u A User Administration (Felhasználó adminisztrálása) párbeszédpanelen kattintson a Restore
Default Rights (Visszaállítás az alapértelmezett jogosultságokra) elemre.
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Bejelentkezés a CFX Manager Dx szoftverbe

Bejelentkezés a CFX Manager Dx szoftverbe
A CFXManager Dx szoftver a Login (Bejelentkezés) párbeszédpanelen keresztül kezeli azt, hogy ki
jelentkezik be a szoftverbe. Amikor Ön elindítja a szoftvert, a CFX Manager Dx automatikusan
megjeleníti a Login (Bejelentkezés) párbeszédpanelt, ha a User Administration (Felhasználók
kezelése) ablakban kettő vagy annál több felhasználó szerepel.

A CFX Manager Dx a Home (Kezdőlap) ablak tetején mutatja a bejelentkezett felhasználó nevét.

Bejelentkezés a CFX Manager Dx szoftverbe

1. A Login (Bejelentkezés) párbeszédpanelen válassza ki a saját nevét a User Name
(Felhasználónév) legördülő listából.

2. Írja be a jelszavát.

3. A Login (Bejelentkezés) párbeszédpanel bezárásához és a szoftver megnyitásához kattintson az
OK gombra.
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Átváltás másik felhasználóra
Miközben a szoftver fut, Ön átválthat egy másik felhasználóra.

Átváltás felhasználók között

1. A Home (Kezdőlap) ablakban válassza ki a User > Select User (Felhasználó > Felhasználó
kiválasztása) elemet a Login (Bejelentkezés) párbeszédpanel megnyitásához.

2. Válasszon egy nevet a User Name (Felhasználónév) legördülő listából.

3. Írja be az új felhasználó jelszavát.

4. A Login (Bejelentkezés) párbeszédpanel bezárásához és a szoftver megnyitásához kattintson az
OK (Rendben) gombra.

Felhasználói jelszavak módosítása
A CFXManager Dx felhasználók bármikor módosíthatják saját jelszavukat.

A felhasználói jelszavak módosításához

1. A Home (Kezdőlap) ablakban válassza ki a User > Change Password (Felhasználó > Jelszó
módosítása) lehetőséget a Change Password (Jelszó módosítása) párbeszédpanel
megnyitásához.

2. Az Old Password (Régi jelszó) mezőbe írja be a jelenlegi jelszavát.

3. A New Password (Új jelszó) mezőbe írjon be egy új jelszót, majd azt írja be újra a Confirm New
Password (Új jelszó megerősítése) mezőbe.

4. Kattintson az OK (Rendben) gombra a módosítás megerősítésére.
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Bejelentkezés a CFX Manager Dx szoftverbe

Az Ön szerepkörének és jogosultságainak a megtekintése
Tipp: A Principal (Rendszerbiztonsági tag), Operator (Kezelő) vagy Guest (Vendég) felhasználói
szerepkörrel rendelkező felhasználók kizárólag a saját felhasználói beállításaikat,
jogosultságaikat és szerepköreiket tekinthetik meg.

Saját aktuális felhasználói szerepkörének és jogosultságainak a megtekintése

u A Home (Kezdőlap) ablakban válassza ki a User > User Administration (Felhasználó >
Felhasználó adminisztrálása) elemet.

Ha módosítani szeretné a User Administration (Felhasználó adminisztrálása) ablakban látható
felhasználói beállításokat, jogosultságokat és szerepköröket, akkor vegye fel a kapcsolatot a CFX
Manager Dx rendszergazdával.
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B. melléklet A CFX Manager Dx felhasználóinak és szerepköreiknek kezelése
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C. melléklet LIMS integráció
A CFXManager Dx szoftvert konfigurálhatja egy laboratóriumi információkezelő rendszerrel (LIMS)
történő használatra. A LIMS integrációhoz a CFX Manager Dx a LIMS platform által generált
lemezbeállítás információkat (egy LIMS fájl, *.plrn), egy CFX Manager Dx szoftver használatával
létrehozott protokollfájlt (*.prcl), egy meghatározott exportálási helyet és egy meghatározott
exportálási formátumot igényel.

A futtatás befejezését követően a(z) CFX Manager Dx egy adatfájlt (.pcrd) generál, és azt elmenti egy
meghatározott adatexportálási mappa helyre. A CFX Manager Dx egy LIMS-kompatibilis adatfájlt is
létre tud hozni .csv formátumban, azt ugyanarra a helyre elmentve.

LIMS-kompatibilis adatfájlok létrehozása
Ez a függelék azt ismerteti, hogy hogyan kell beállítani a CFX Manager Dx szoftvert LIMS-kompatibilis
adatfájlok létrehozásához, elmentéséhez, és exportálásához.

Az LIMS mappa és az adatexportálási lehetőségek beállítása
A CFXManager Dx szoftver alapértelmezés szerint a következő mappába menti az LIMS
protokollokat, a fájlokat, valamint az adatexportálási fájlokat:
_ C:\Felhasználók\Nyilvános\Nyilvános dokumentumok\Bio-Rad\CFX_Dx\LIMS

Ön beállíthatja a(z) CFX Manager Dx szoftvert úgy, hogy a fájlokat egy másik mappába mentse,
valamint módosíthatja az LIMS adatok exportálására vonatkozó opciókat.
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C. melléklet LIMS integráció

Az LIMS mappa és az adatexportálási lehetőségek beállítása

1. A Home (Kezdőlap) ablakban válassza ki a Tools > Options (Eszközök > Opciók) elemet.

2. Az Options (Opciók) párbeszédpanelen válassza ki a Data Export Settings (Adatexportálási
beállítások) elemet.

3. (Opcionális) Jelölje be az Automatically export LIMS data at end of run (Az LIMS adatok
automatikus exportálása a futtatás végén) elemet.

A szoftver az egyes futtatások után automatikusan exportálja az LIMS adatokat, és elmenti őket a
meghatározott helyre.

4. Az LIMS adatokra vonatkozó alapértelmezett exportálási opciók módosításához kattintson az
LIMS Data Export Settings (LIMS adatexportálási beállítások) elemre.

Fontos: A CFXManager Dx szoftverbe kizárólag olyan LIMS adatok importálhatók vissza,
amelyek eredetileg .csv kiterjesztésű fájlként kerültek exportálásra.

5. Az LIMS Data Export Format Settings (LIMS adatexportálási formátumra vonatkozó beállítások)
párbeszédpanelen válassza ki a szükséges exportálási opciókat, majd kattintson az OK gombra.
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LIMS-kompatibilis adatfájlok létrehozása

6. Az Options (Opciók) párbeszédpanelen keresse meg és válassza ki azt az alapértelmezett
mappát, amelybe szeretné elmenteni az LIMS adatfájlokat. Az egyes fájltípusokhoz más és más
helyet választhat:

n Protokoll

n LIMS fájl

n Adatexportálás

7. A módosítások mentéséhez és az Options (Opciók) párbeszédpanel bezárásához kattintson az
OK gombra.

LIMS protokoll létrehozása
Ha el szeretne indítani egy LIMS futtatást, akkor előbb hozzon létre egy CFX Manager Dx protokollfájlt
(*.prcl) és mentse azt el az erre a célra kijelölt LIMS protokollmappába.

További információkért lásd: 6. fejezet, Protokollok létrehozása.

LIMS fájl létrehozása
A LIMS fájl (*.plrn) a lemezbeállítási részleteket és a protokollfájl nevét tartalmazza. Ezt a fájlt az Ön
belső LIMS rendszere generálja. A(z) CFX Manager Dx a LIMS fájl segítségével létrehoz egy
lemezfájlt, amely egy protokollfájllal használható.

A(z) CFX Manager Dx lemezimportálási sablonfájlt kínál, amelyek szerkesztésével Ön egyedi LIMS
lemezfájlokat hozhat létre.

Tipp: Ezt a feladatot LIMS specialistának kell elvégeznie.

LIMS fájl létrehozása

1. A Home (Kezdőlap) ablakban válassza ki a View > Show > LIMS File Folder (Nézet > Mutatás >
LIMS fájl mappája) elemet.

2. Nyissa meg az LIMS Templates (LIMS sablonok) mappát, és válassza ki azt a .csv fájlt, amelyet
importálni szeretne az Ön belső LIMS rendszerébe.
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C. melléklet LIMS integráció

3. Az LIMS segítségével szerkessze a sablonfájlt úgy, hogy az 40. táblázat felsorolt kötelező
mezőket kitölti.

4. Mentse el a sablont .plrn fájlnévkiterjesztéssel az LIMS File (LIMS fájl) mappába.

Fontos: A(z) CFX Manager Dx kizárólag a .plrn fájlt képes megnyitni. Az LIMS futás
elindításához a .csv fájlt .csv helyett .plrn kiterjesztéssel kell elmentenie.

Oszlop Sor Leírás Tartalom Cél

A 1 Lemezfejléc Ne szerkessze Előre
meghatározott

A,B,C 2 Mező/adat/instrukció Ne szerkessze Előre
meghatározott

B 3 Verzió Ne szerkessze Előre
meghatározott

B 4 Lemezméret Ne szerkessze Előre
meghatározott

B 5 Lemeztípus A következőt írja be: “BR
White”, “BR Clear” vagy
egyéb kalibrált lemeztípus

Kötelező

B 6 Leolvasási mód A következőt írja be:
“SYBR/FAMOnly:”, “All
Channels” vagy “FRET”

Kötelező

40. táblázat. Az LIMS .csv fájl tartalmi elemeinek a definíciói
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LIMS-kompatibilis adatfájlok létrehozása

Oszlop Sor Leírás Tartalom Cél

B 7 Egységek A következők egyikét írja
be a zárójel tartalma
nélkül: “copy number”
(példányszám), “fold
dilution” (hígítási szorzó),
“micromoles” (mikromól),
“nanomoles” (nanomól),
“picomoles” (pikomól),
“femtomoles” (femtomól),
“attomoles” (attomól),
“milligrams” (milligramm),
“micrograms”
(mikrogramm),
“nanograms”
(nanogramm), “picograms”
(pikogramm),
“femtograms”
(femtogramm),
“attograms” (attogramm)
vagy “percent” (százalék)

Kötelező

B 8 Futtatás azonosítója Írja be a futtatás
azonosítására szolgáló
rövid leírást vagy
vonalkódot (maximum 30
karakter hosszúságú
lehet, és vessző beírása
nem engedélyezett)

Opcionális

B 9 A futtatáshoz tartozó
megjegyzés

Írja be a futtatás leírását Opcionális

B 10 Futtatásprotokoll Írja be a protokollfájl nevét
pontosan úgy, ahogyan az
a listában szerepel.

Kötelező

A 11 Adatfájl Írja be az adatfájl nevét Opcionális

40. táblázat. Az LIMS .csv fájl tartalmi elemeinek a definíciói, folytatás
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C. melléklet LIMS integráció

Oszlop Sor Leírás Tartalom Cél

A 12-15 Később kerül
meghatározásra / üres

Ne szerkessze Előre
meghatározott

A 16 Lemezadat Ne szerkessze Előre
meghatározott

A 17-113 Cellapozíció Ne szerkessze Előre
meghatározott

B-G 1. csat. festék, 2. csat.
festék, 3. csat. festék,
4. csat. festék, 5. csat.
festék, FRET

Minden egyes használt
csatornához írjon be egy-
egy kalibrált festéknevet
(például “FAM”)

Kötelező

H Mintatípus A következő mintatípusok
egyikét írja be: “Unknown”
(Ismeretlen), “Standard”,
“Positive Control” (Pozitív
kontroll), “Negative
Control” (Negatív kontroll),
“NTC” vagy “NRT”

Kötelező

I Mintanév Írja be a minta nevét Opcionális

J-O 1. csat. célértéke, 2.
csat. célértéke, 3. csat.
célértéke, 4. csat.
célértéke, 5. csat.
célértéke, FRET
célértéke,

Írja be az egyes használt
csatornák célértéknevét

Opcionális

P Biológiai sor neve Írja be a biológiai sor nevét Opcionális

Q Replikátum Írjon be egy pozitív egész
számot az egyes
replikátumkészletekhez.
Az érték nem lehet nulla.

Opcionális

40. táblázat. Az LIMS .csv fájl tartalmi elemeinek a definíciói, folytatás
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LIMS-kompatibilis adatfájlok létrehozása

Oszlop Sor Leírás Tartalom Cél

R-W 1. csat. mennyiség, 2.
csat. mennyiség, 3.
csat. mennyiség, 4.
csat. mennyiség, 5.
csat. mennyiség, FRET
mennyiség

Írja be a
mennyiségértékeket az
esetleges standardokhoz.
A koncentrációt tizedes
formátumban írja be.

Az összes
standardhoz
kötelező

X Cellamegjegyzés Írjon be cellamegjegyzést
(maximum 20 karakter
hosszúságú lehet)

Opcionális

Y-AD 1. csat. cellaszíne, 2.
csat. cellaszíne, 3.
csat. cellaszíne, 4.
csat. cellaszíne, 5.
csat. cellaszíne, FRET
cellaszíne

Írja be a felhasználó által
esetlegesen
meghatározott
jelstílusszínt 32 bites
egész szám (argb) tizedes
formátumban

Opcionális

40. táblázat. Az LIMS .csv fájl tartalmi elemeinek a definíciói, folytatás

LIMS futtatás indítása
LIMS futtatás indítása

1. Egy (.plrn kiterjesztésű) LIMS fájl megnyitásához tegye a következők egyikét:

n A Home (Kezdőlap) ablakban válassza ki a View > Show > LIMS File Folder (Nézet >
Mutatás > LIMS fájl mappája) elemet, majd nyissa meg a kívánt (.plrn kiterjesztésű) fájlt.

n A Home (Kezdőlap) ablakban válassza ki a File > Open > LIMS File (Fájl > Megnyitás > LIMS
fájl) elemet, majd nyissa meg a kívánt (.plrn kiterjesztésű) fájlt.

A rendszer megnyitja a fájlt a Run Setup (Futtatás beállításai) varázsló Start Run (Futtatás
indítása) fülén. A Start Run (Futtatás indítása) fülön a futtatni kívánt kísérletre vonatkozó
információk láthatók. Ezen kívül megjeleníti az(oka)t a csatlakoztatott műszerblokko(ka)t, amely
(ek)en Ön lefuttathatja a kísérletet.

Kezelési kézikönyv | 293



C. melléklet LIMS integráció

2. A Start Run (Futtatás indítása) fülön válasszon ki egy műszert, majd kattintson a Start Run
(Futtatás indítása) elemre.

Adatok exportálása egy LIMS-be
Amikor befejeződött a futtatás, a CFX Manager Dx egy adatfájlt (.pcrd) generál, és azt a
meghatározott adatexport mappa helyre elmenti.

Az adatfájl LIMS-be történő exportálásához

u Nyissa meg a .pcrd fájlt, és válassza ki az Export > Export to LIMS Folder (Exportálás >
Exportálás LIMS mappába) opciót.

Tipp: Ha kiválasztja az Automatically Export Data after Run (Automatikusan exportálja az
adatokat a futtatás után) lehetőséget a LIMS Options (LIMS opciók) opciókban, akkor a CFX
Manager Dx létrehoz egy LIMS-kompatibilis adatfájlt .csv formátumban, és azt elmenti
ugyanabba a mappába.
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D. melléklet A CFX Manager Dx szoftver
kapcsolódási hibáinak elhárítása

Alkalmazásnapló
Új futtatás elindítása előtt a CFX96 és CFX96 DeepWell műszerek egy öndiagnosztikai tesztet
végeznek annak az ellenőrzése céljából, hogy a műszerek az előírt paramétereken belül működnek-e.
A szoftver ennek a tesztnek az eredményeit a Run Log (Futtatási napló) és Application Log
(Alkalmazásnapló) fájlban rögzíti. Ha egy vagy több kísérletnél problémát észlel, akkor nyissa meg a
futtatási és alkalmazásnaplókat annak a kiderítése érdekében, hogy mikor kezdődött a probléma.

A CFX Manager Dx az alkalmazásnaplóban nyomon követi egy műszer futttatás közbeni állapotára
vonatkozó információkat. Ezek a naplók segítenek nyomon követni a műszereken és a szoftverben
esetlegesen történő eseményeket, valamint segítenek az esetleges hibák elhárításában.

Az alkalmazásnapló megnyitása

u A Home (Kezdőlap) ablakban válassza ki a View > Application Log (Nézet > Alkalmazásnapló)
elemet.
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D. melléklet A CFX Manager Dx szoftver kapcsolódási hibáinak elhárítása

Hibaelhárítás
A szoftver- és műszer-kommunikációs hibák általában megoldhatók a számítógép és a rendszer
újraindításával. Ügyeljen arra, hogy az újraindítás előtt elmentse a folyamatban levő munkákat.

Megjegyzés: Ellenőrizze, hogy a számítógépe elegendő RAMmemóriával és szabad lemeztár
hellyel rendelkezik. A minimum RAM 4 GB, a minimum lemeztár hely pedig 128 GB.

Áramkimaradás
Áramkimaradás esetén a műszer és a számítógép leáll. Ha az áramkimaradás rövid ideig tart, akkor a
műszer folytatni fogja a protokoll futtatását, de az Alkalmazásnaplóban (Application Log) szerepelni
fog egy megjegyzés az áramkimaradásról. A számítógép beállításaitól és az áramkimaradás
időtartamától függően a műszer és a szoftver megpróbálja folytatni a futtatást a protokoll adott
lépésének megfelelően:

n Ha a protokoll éppen egy olyan lépésnél tart, amely nem tartalmaz lemezleolvasási műveletet,
akkor a protokoll tovább fog futni, amint a műszer áramellátása helyreáll.

n Ha a protokoll éppen olyan lépésnél tart, amely tartalmaz lemezleolvasási műveletet, akkor a
műszer megvárja, hogy a szoftver újrainduljon és folytassa a kommunikációt az adatgyűjtéshez.
Ilyen esetben a protokoll csak akkor folytatódik, ha a számítógép nem állította le a szoftvert.
Amikor a számítógép és a szoftver újból elindul, akkor a protokoll folytatódik.

A minták eltávolítása a reakciómodulból áramkimaradás során

Ha áramkimaradás történik, akkor a reakciómodulon található motorizált tetőt kinyithatja és a mintákat
eltávolíthatja.

A reteszelőlemez eltávolítása

1. Nyomja le a reteszelőrudat a reakció modulnak a C1000 Dx PCR készülékből történő
eltávolításához.

2. A reakció modult óvatosan helyezze egy asztalra vagy a laboratóriumi munkapadra.
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Hibaelhárítás

3. A modult úgy helyezze el, hogy a modul elülső része körülbelül 5 centiméterrel nyúljon túl a
szélen.

4. Egy imbuszkulcs segítségével távolítsa el a két nagy csavart, amelyek a reakciómodul elülső
széle alatt (a fedél nyitására szolgáló gomb alatt) találhatók.

Ideális esetben a modul belseje felől kattanó hangot fog hallani, amikor a retesz kioldódik.

Fontos: Amodul elülső szélénél található két kis csavart ne távolítsa el.

5. Felfelé nyomva nyissa ki a reakció modul fedelét. Megfigyelheti, hogy a retesz (sötét színű
műanyag elem) már nem kapcsolódik. Távolítsa el a mintákat a tömbből.
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D. melléklet A CFX Manager Dx szoftver kapcsolódási hibáinak elhárítása

6. Hagyja nyitva a fedelet, majd helyezze vissza és a nagy csavarok segítségével rögzítse a reteszt
a reakció modul összeszereléséhez.

Fájlok letöltése a CFX Manager Dx számítógépre
Letöltheti a készüléken található adat- és naplófájlokat, és azokat egy csatlakoztatott számítógép
merevlemezére másolhatja.

Megjegyzés: A készülék alapon levő valósidejű adat mappában levő összes fájl a számítógépre
lesz elmentve.

A fájloknak a készülékről történő letöltéséhez

1. A Detected Instruments (Felismert készülékek) táblában a Home (Kezdőlap) ablakban a jobb
gombbal kattintson a cél készülékre, és válassza ki az alábbiak egyikét:

n Naplófájlok letöltése

n Adatfájlok letöltése

2. Válasszon ki egy mappa helyet a letöltött fájlok elmentéséhez.

3. Kattintson az Okay (Rendben) gombra.

A CFX Manager Dx szoftver kézi telepítése
A CFX Manager Dx szoftver kézi telepítése

1. Szükség szerint válassza le a számítógépről az esetlegesen hozzá csatlakoztatott készülékeket.

Keresse meg a műszer USB-kábelét a CFX Manager Dx számítógépen, és válassza le ezt a
kábelt a számítógépről. A kábelnek a műszerhez csatlakoztatott vége a helyén maradhat.

2. Jelentkezzen be a CFX Manager Dx számítógépbe rendszergazdai jogosultságokkal.

3. Helyezze be a szoftvert tartalmazó CD-lemezt.

298 | CFX96 Dx és CFX96 DeepWell Dx rendszerek



Hibaelhárítás

4. A Windows Intézőben keresse meg a CD-meghajtót, kattintson a jobb egérgombbal a szoftvert
tartalmazó CD-lemez ikonjára, majd válassza az Explore (Tallózás) elemet a CD ablak
megnyitásához.

5. Kattintson kétszer a CFX_Manager mappára a mappa megnyitásához, majd kattintson kétszer a
setup.exe fájlra a szoftvertelepítési varázsló elindításához.

6. Kövesse a varázsló által megjelenített utasításokat a szoftver telepítéséhez, majd kattintson a
Finish (Befejezés) elemre.

Az illesztőprogramok újratelepítése
A műszer illesztőprogramjainak az újratelepítése

u A Home (Kezdőlap) ablakban válassza ki a Tools > Reinstall Instrument Drivers (Eszközök >
A műszer illesztőprogramjainak az újratelepítése) elemet.

Megjegyzés: Ha az illesztőprogramok újratelepítése és az USB-kapcsolat ellenőrzése után a
szoftver továbbra sem képes megfelelően kommunikálni egy valós idejű rendszerrel, akkor vegye
fel a kapcsolatot a(z) Bio-Rad műszaki támogatási osztályával (Technical Support).
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Minpack szerzői jogi közlemény (1999) University of Chicago (Chicagói Egyetem). Minden jog
fenntartva

A forrás és bináris formákban történő, módosított vagy módosítás nélküli továbbterjesztés és
felhasználás engedélyezett, feltéve, hogy a következő feltételek teljesülnek:

1. A forráskód továbbterjesztett változatának meg kell őriznie a fenti szerzői jogi közleményt, a jelen
feltétellistát, valamint az alábbi jogi nyilatkozatot.

2. A bináris formában továbbterjesztett változatoknál reprodukálni kell a fenti szerzői jogi
közleményt, a jelen feltétellistát, valamint az alábbi jogi nyilatkozatot a terjesztett változathoz
mellékelt dokumentációban és/vagy a terjesztett változathoz mellékelt egyéb anyagokban.

3. A továbbterjesztett változat részét képező végfelhasználói dokumentációban (ha van ilyen)
szerepelnie kell a következő köszönetnyilvánításnak:

„This product includes software developed by the University of Chicago, as Operator of Argonne
National Laboratory.” (A jelen termék az Argonne Nemzeti Laboratórium üzemeltetőjeként eljáró
Chicagói Egyetem által kifejlesztett szoftvert tartalmaz.)
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